
CorelDRAW Help Contents
Help topics for CorelDRAW are divided into eight categories represented by the icons below.
To select a category with the mouse, point to it's icon then click. With the keyboard, press Tab to highlight the 
category you want then press ENTER. For more information on using Help, choose the Using Help icon or press F1. To
return to this screen, select the Contents button at the top of the Help window.

   

   

 Commands
· Control Menu
· File Menu
· Edit Menu
· Transform Menu
· Effects Menu
· Text Menu
· Arrange Menu
· Display Menu
· Special Menu
· Help Menu



 Tools

 Pick Tool

 Shape Tool

 Zoom Tool

 Pencil Tool

 Rectangle Tool

 Ellipse Tool

 Text Tool

 Outline Pen Tool

 Fill Tool



 How To...
· Get Started with CorelDRAW
· View Drawings
· Draw Basic Objects
· Select Objects
· Work with Text and Symbols
· Transform Objects
· Shape Objects
· Outline and Fill Objects
· Arrange Objects
· Create Special Effects
· Create Colors and Manage Color Palettes
· Manage and Print Files
· Work with Bitmaps
· Exchange Information with Other Applications          
· Customize CorelDRAW



 Keyboard
· Dialog Box Keys
· Dialog Box Shortcuts
· Function Keys
· Menu Command Keys
· Toolbox Keys



 Reference
· Import File Filters - Technical Notes        
· Export File Filters - Technical Notes        
· Software-related Information
· Hardware-related Information
· Corel Support Services
· Notes to Upgraders



 Screen

· Drawing window
· Printable Page
· Rulers
· Status Line
· Toolbox
· Color Palette
· Control Menu Box
· Title Bar
· Menu Bar
· Maximize Button
· Minimize Button
· Restore Button
· Scroll Bars
· Preview Screen
· Window Border



 Menu Commands
Listed below are the command menus available on the menu bar. Select a menu to view a 
list of the commands it contains.
· Control Menu
· File Menu
· Edit Menu
· Transform Menu
· Effects Menu
· Text Menu
· Arrange Menu
· Display Menu
· Special Menu
· Help Menu



Control Menu
Restore returns the active window to its former size and location.
Move allows you to use the keyboard to move the active window.
Size allows you to use the keyboard to resize the active window.
Minimize shrinks the active window to an icon.
Maximize enlarges the active window to fill the screen.
Close closes the active window.
Switch To lets you switch among currently open applications.



File Menu
New clears the editing window, allowing you to create a new drawing from scratch.
Open recalls an existing drawing file.
Save saves the current drawing.
Save As saves the current drawing under a new name. Also used to save a drawing in 

a different directory.
Import loads graphics from other applications or sources.
Export saves the current drawing in a format used by other applications.
Insert Object embeds an object from another application into the current drawing.
Print prints the current drawing according to the options you specify.
Print Merge merges text created in a word processor with the current drawing, then prints 

the revised version.
Print Setup lets you choose printers and printer options.
Page Setup lets you change the page size and orientation.
Exit ends the current CorelDRAW session.
1,2,3,4 lists the last four files opened or saved. Choosing the file name or number 

opens the file.



Edit Menu
Undo reverses certain commands or operations.
Redo restores the change reversed by Undo.
Repeat repeats the last command or action.
Cut removes the selected object(s) and places it onto the Clipboard.
Copy puts a copy of the selected object(s) onto the Clipboard.
Paste places the cut or copied object(s) into the current drawing.
Paste Special lets you select the format information will be in when it is pasted into the 

current drawing. Also lets you link the information with the drawing.
Delete deletes the selected object(s) from the current drawing.
Duplicate makes a copy of the selected object(s) and adds it to the current drawing, 

offset from the original.
Copy Style From copies the attributes of the selected object to another object.
Edit Text displays a dialog box that lets you edit and change the attributes 

(typeface, style, size etc.) of the selected text.
Select All selects all objects in the current drawing.
Edit Object opens the application used to create the selected embedded object.
Links displays a list of linked objects in the current drawing, and controls for 

managing the links.



Transform Menu
Move displays a dialog box for moving the selected object(s).
Rotate & Skew displays a dialog box for rotating or skewing the selected object(s).
Stretch & Mirror displays a dialog box for stretching, scaling or mirroring the selected 

object(s).
Clear Transformations clears certain transformations applied to the selected object(s).



Effects Menu
Edit Envelope displays a sub-menu with the four types of envelopes you can apply 

to a selected object.
Clear Envelope removes the last envelope applied to the selected object, restoring it 

to its former shape.
Copy Envelope From applies another object's envelope to the selected object.
Add New Envelope applies a new envelope to the selected object without changing its 

current shape.
Edit Perspective applies a perspective bounding box to the selected object. Dragging 

the handles on the box changes the object's perspective.
Clear Perspective removes the last perspective bounding box applied to the selected 

object, restoring it to its former state.
Copy Perspective From applies another object's perspective to the selected object.
Add New Perspective applies a new perspective bounding box to the selected object 

without changing its current perspective.
Blend Roll-Up displays a roll-up window with controls for blending one object into 

another through a series of intermediate shapes. Also used to 
distribute copies between two identical objects.

Clear Blend clears the intermediate shapes created by blending two objects.
Extrude Roll-Up displays a roll-up window with controls for projecting the edges of an 

object to give it a three-dimensional appearance.
Clear Extrude clears the surfaces created by extruding an object.



Text Menu
Text Roll-up displays a roll-up window for quick access to a variety of text attributes.
Character displays a dialog box for changing the attributes (typeface, style, size etc.) 

of selected text.
Frame displays a dialog box for formatting Paragraph text.
Fit Text to Path fits the baseline of a selected text object to the outline of a selected non-

text object.
Align to Baselinealigns all characters in the selected text object with the text's baseline.
Straighten Text aligns all characters in the selected text object with the text's baseline, and 

resets the character angles to zero.
Spell Checker checks the spelling of text in the current drawing.
Thesaurus substitutes a synonym for the selected word.
Extract saves text objects in the current drawing as ASCII text that you can edit in a 

word processor.
Merge-Back inserts the edited text into the drawing from which it was originally 

extracted.



Arrange Menu
Layers Roll-Up lets you create and manage layers in your drawing.
Align displays a dialog box that allows you to precisely align objects relative to

each other, to the border of the Printable page, or to the nearest grid 
point.

To Front places the selected object on top of all others on its layer.
To Back places the selected object behind all others on its layer.
Forward One moves the selected object up one position in the stacking order.
Back One moves the select object back one position in the stacking order.
Reverse Order reverses the stacking order of the selected objects.
Group groups the selected objects so that they are selected and manipulated 

as a single object.
Ungroup breaks the selected group into individual objects.
Combine makes selected objects into a single curve so that unconnected 

lines/segments can be joined. Also used to create clipping holes or 
masks.

Break Apart breaks a multi-segment object into a collection of single segments that 
can be assigned different attributes.

Convert to Curves converts the selected rectangle, ellipse or text object to a curve object 
that can be edited with the Shape Tool.

Separate separates the original objects from those created by the Blend and 
Extrude commands. Also separates text from the path to which it's fitted 
using the Fit Text to Path command.



Display Menu
Snap To Grid toggles Snap to Grid on and off. When on, objects are forced to the 

nearest grid point when drawn or moved. Snap to Grid also 
constrains the movement of the cursor when you are performing 
certain transformations or when using the Shape Tool.

Grid Setup displays a dialog box for specifying the grid frequency and origin.
Snap To Guidelines toggles Snap to Guidelines on and off. When on, an object can be 

forced into alignment with a guideline when the object is moved or 
drawn near it.

Guidelines Setup displays a dialog box for adding, moving and deleting guidelines.
Snap to Objects toggles Snap to Objects on and off. When on, an object can be forced

into alignment with a stationary object when the object moved or 
drawn near it.

Show Rulers toggles the Rulers display on and off.
Show Status Line toggles the Status Line display near the top of the CorelDRAW 

window on and off.
Show Color Palette displays a sub-menu with commands for toggling the display of the 

color selection palette on and off, and for loading it with either Spot 
or Process color.

Edit Wireframe displays objects in wireframe form for faster screen redraw.
Refresh Window redraws objects on the screen. Use to clear the screen of "dirt" left 

over from earlier manipulations, or to resume drawing after an 
interrupt.

Show Bitmaps toggles the display of bitmaps on and off when you are working in 
wireframe view.

Show Preview displays the current drawing using the entire screen. To return to the 
normal view, press F9.

Preview Selected Only toggles previewing of the selected object(s) only on and off.



Special Menu
On-Screen Keyboard displays a keyboard for entering text and accessing function keys with 

a pen. This command is available if you have set up Windows to use a 
pen as an input device.

Create Pattern saves the selected object for use as a pattern fill.
Create Arrow saves the selected object as an arrowhead or line ending shape that 

you can apply to the end of a line.
Preferences displays a dialog box that allows you to control how CorelDRAW 

performs certain operations.



Help Menu
Contents displays the CorelDRAW Help Contents.
Screen/Menu Help displays the Help pointer for getting Help on a menu command or screen

region.
How to Use Help explains how to use Help.
Search for Help On displays the Search dialog box that lets you find Help information using 

keywords.
Tutorial displays lessons that teach you the basics of using CorelDRAW.
About CorelDRAW displays the version of CorelDRAW you are using.    Also displays 

information about the current drawing, and the amount of free disk 
space available on your system.



Restore command (Control menu)
Returns the active window to the size and location it had before you chose the Minimize or 
the Maximize commands from the Control menu.
You can also restore a window by clicking on its Restore button.

· Does not affect a window moved or resized with the Move or Size commands in the 
Control menu.



Move command (Control menu)
Allows you to move the active window with the Direction keys on the keyboard.

· This command is unavailable if the window is maximized.
· You can also use this command to move Application icons and dialog boxes that have a

Control menu.



Size command (Control menu)
Allows you to resize the active window with the Direction keys on the keyboard.

· This command is unavailable if the window is maximized.



How to...
Resize the CorelDRAW window



Minimize command (Control menu)
Shrinks the active windows to a small icon at the bottom of the screen.

· Using the Minimize command in the Control menu is equivalent to clicking on the 
Minimize button with the mouse.

· You can use the Restore command in the Control menu to restore the minimized 
window to its former size.



Maximize command (Control menu)
Expands the active window to fill the entire screen.

· Using the Maximize command in the Control menu is equivalent to clicking on the 
Maximize button with the mouse.

· You can choose the Restore command in Control menu or click on the Restore button to
return the window to its former size.



Close command (Control menu)
Closes the active window or dialog box. If you have made changes to the current drawing, a 
dialog box appears asking you whether you want to save the drawing.

· Closing CorelDRAW is the same as choosing Exit from the File menu.
· Double-clicking on the Control Menu box is equivalent to choosing the Close command.



Switch To command (Control menu)
Opens the Task List which lists all the applications currently running on your system.

Dialog Box Options

Switch To
Opens the selected application.

End Task
Closes the selected application.

Cancel
Closes the Task List.

Cascade
Overlaps all open applications so that their Title bars are visible.

Tile
Sizes all open applications to fit on the screen.

Arrange Icons
Arranges the icons of all minimized applications evenly across the bottom of the screen.



New command (File menu)
Clears the drawing window so that you can create a new drawing from scratch.

· If you have not saved the current drawing, a prompt appears asking if you want to 
save it first.

· Initially, the new drawing uses the same program settings (Page Setup, Display 
options, New Object Fill and Outline attributes, etc.) in effect for the previous drawing. 
You can change the settings as required.



Open command (File menu)
Loads an existing drawing into CorelDRAW.

· If you have not saved the current graphic, a prompt appears asking if you want to save
it first.

Dialog Box Options

File Name
Use to select the file you want to open. Either type the name of the file or select it from 
the list.

Directories
Use to select the directory in which the file you want to open is stored.

List Files of Type
Selects CDR or PAT as the type of file to be opened. PAT files contain Full Color patterns 
used to fill objects. 

Drives
Use to select the drive in which the file you want to open is stored.

File Viewer
Displays a bitmap representation of the selected file. The Preview option which appears 
when you choose the Options>> button, toggles the display of the bitmap on and off.

Options>>
Displays options for finding and managing files.
Sort by
Sorts files in the File Name list alphabetically or chronologically with the most-recently-
saved file listed first.
Preview
Toggles the File Viewer bitmap on and off.
Keywords
Lets you assign keywords to your files. CorelDRAW uses these keywords to find files 
stored on your system. You can type single words, phrases, or combinations of both. Use 
commas to separate each keyword you type.
Notes
Lets you store remarks with your files.
Find
Displays a dialog box that lets you find files by typing keywords assigned to them.
Mosaic
Opens Mosaic, CorelDRAW's file management utility. Use Mosaic's Help or see the MOSAIC
section of your Utilities Guide for information on opening files using this utility.
Date, File Size
Shows when the selected file was last saved and its size.



Shortcut
Pressing CTRL + O displays the Open Drawing dialog box



How to...
· Open a drawing
· Find files using keywords
· Find files using Mosaic
· Add notes to a files
· Sort files



Keyword Search dialog box
Use this dialog box to specify the keywords you want CorelDRAW to use when searching for 
files. You assign keywords to files from either the Open Drawing or Save Drawing dialog 
boxes.

· You can search using as many keywords as you want if you separate them with either a
comma or a plus ("+") sign.
"," finds files that have at least one of the keywords separated by the comma. 

"+" finds files that have all keywords separated by the plus sign. 
· You can also mix commas and plus signs.

· Search is not case-sensitive, so it does not matter whether you type the keywords in 
uppercase or lowercase letters.
· Leave Search All Directories unchecked if you only want to search the current 
directory.
· Files found during the search are listed in the File Open dialog box under File Name.



How to...
Find files using keywords



Example
Keywords: Europe,map,demographic,highways
Finds files with any of the above keywords



Example
Keywords: cover designs+logos
Finds files with both of the above keywords



Example
Keywords: animals+birds,insects
Finds files that contain both the keywords "animals" and "birds" plus those containing the 
keyword "insects".



Save command (File menu)
Saves the current drawing under the name displayed in the Title bar.

· If you have not saved the drawing yet, the Save Drawing dialog box appears prompting
you to enter a name.

· If you are altering an existing drawing, but want to keep the original version, use the 
Save As command.

· When you save a drawing, the following settings are saved with the file:
Page Size and Orientation
Grid Frequency and Origin
Snap To Grid status
Snap To Object status
Guidelines
Bitmaps
Paper Color

· CorelDRAW creates a backup copy of a drawing every time you save it. The backup 
copy is stored in the same directory as the original, but with a filename extension .BAK.
You can turn this feature off by changing the MakeBackupWhenSave setting in your 
CORELDRW.INI   file  .

· CorelDRAW also has an auto-backup feature that saves the current drawing every ten 
minutes. You change the interval and the directory the backup files are stored in by 
changing the AutoBackupDir and AutoBackupMins settings in your CORELDRW.INI 
file. Auto-backup files have an .ABK file extension and are deleted when you exit 
CorelDRAW or choose the New, Save or Save As commands from the File menu.

Shortcut
Pressing CTRL+S saves current drawing



How to...
Save a new drawing



Save As command (File menu)
Saves a new drawing or a new version of an existing drawing.

Dialog Box Options

File Name
Type a name for the new file. If you want to overwrite an existing file, select its name 
from the list.
The filename precedes the .CDR extension and can contain up to eight characters.

Directories
Use to select the directory in which you want the files stored.

List Files of Type
Use to select CDR as the type of file to be opened.

Drives
Use to select the drive in which you want the file stored.

Version 2.xx
Select to save the file in a format that earlier versions of CorelDRAW can use.

Image Header
Adds an image header to the file. You can specify the type (mono or color) and size of 
header in kilobytes.

Options>>
Displays options for adding keywords and notes to a file.
Keywords
Lets you assign keywords to your files. CorelDRAW uses these keywords to find files 
stored on your system. You can type single words, phrases, or combinations of both. Use 
commas to separate each keyword you type.
Notes
Lets you store remarks with your files.



How to...
· Save a new drawing
· Make a copy of an open drawing
· Add notes to a files
· Find files using keywords



Import command (File menu)
Brings graphics into CorelDRAW from other programs. You can also use this command to 
merge other CorelDRAW (.CDR) files with the current drawing.

Dialog Box Options

File Name
Type the name of the file you want to import, or select it from the list. To list a different 
type of file, choose the type from the List Files of Type box.

Directories
Use to select the directory in which the file you want to import is stored.

List Files of Type
Use to select the type of file you want to import. See Import File Formats.

Drives
Use to select the drive in which the file you want to open is stored.

About...
Displays the developer and version number of the filter used to import the selected file 
type.

See also
Recommended formats for importing graphics from other applications



How to...
Import graphics in other formats



Import File Formats
The term "file format" refers to the way in which a graphic is stored in a computer file. 
Different programs use different formats to store the files they create. For a brief description 
of the formats CorelDRAW imports, choose the file format name. For more information, click 
on  next to the name.

 Illustrator, *.AI  IBM PIF (GDF) *.PIF
 AutoCAD DXF, *.DXF  Lotus PIC *.PIC
 Compuserve Bitmaps, *.GIF  Mac PICT *.PCT
 CorelDRAW, *.CDR  Targa Bitmaps, *TGA
 CorelPHOTO-PAINT *.PCX, *.PCC  Text *.TXT
 CorelTRACE, *.EPS  TIFF 5.0 Bitmaps *.TIF
 GEM files, *.GEM  Windows 3.0 Bitmaps *.BMP
 Computer Graphics Metafile, 

*.CGM
 Windows Metafile, *.WMF

 HP Plotter HPGL, *.PLT

See also
· Recommended formats for importing graphics from other applications
· Importing Kodak Photo CD images



Import File Filters - Technical Notes
Click on  for technical information about CorelDRAW's import filters.

 Illustrator, *.AI
 AutoCAD DXF, *.DXF
 Compuserve Bitmaps, *.GIF
 CorelDRAW, *.CDR
 CorelPHOTO-PAINT *.PCX, *.PCC
 CorelTRACE, *.EPS
 GEM files, *.GEM
 Computer Graphics Metafile, *.CGM
 HP Plotter HPGL, *.PLT
 IBM PIF (GDF) *.PIF
 Lotus PIC *.PIC
 Mac PICT *.PCT
 Targa Bitmaps, *TGA
 Text *.TXT
 TIFF 5.0 Bitmaps *.TIF
 Windows 3.0 Bitmaps *.BMP
 Windows Metafile, *.WMF



Recommended formats for importing graphics from other 
applications
Program Recommended import format
Adobe Illustrator AI (EPS)
Arts & Letters AI (EPS), Clipboard
AutoCAD DXF, HPGL (PLT files)
ASCII text Clipboard and Paragraph text import
CorelDRAW CDR, Clipboard
CorelTRACE CorelTRACE EPS
Excel (Graphs) Clipboard
GEM Artline GEM
GEM Graph GEM
GEM Draw Plus GEM
Harvard Graphics CGM
Lotus 1-2-3 Lotus CGM (more recent versions) or Lotus PIC
Lotus Freelance Plus CGM
MAC-based 
    vector packages

MAC PICT, AI

Micrografx Designer, 
    Graph Plus

AI (EPS)

PC Paintbrush PCX
Scan Gallery TIF

Importing Kodak Photo CD images
CorelMOSAIC can open Kodak Photo CD images and convert them to formats which 
CorelDRAW and CorelPHOTO-PAINT can import. These images are derived from 35mm film 
negatives or slides which have been converted to digital format and stored on a compact 
disc (CD). Refer to CorelMOSAIC's online Help for more information.



CorelDRAW (CDR)
Imports graphics in CorelDRAW's native format. Useful for merging separately created 
graphics into a single drawing.



Import - CorelDRAW (CDR)
Technical Notes

Imported CorelDRAW files appear as a group of objects. Use the Arrange Ungroup command 
to manipulate individual objects in the imported graphic.

Text in Version 2.xx Files
Inter-character spacing may appear slightly off in files created in 1.xx versions of 
CorelDRAW. This happens only to certain typefaces, and is unnoticeable in most cases. 
The effect may be more apparent    when letters are immediately adjacent to other 
graphics elements, or with text fitted to a curve. To correct the spacing, use the Shape 
tool to readjust character spacing. For text on a curve, simply straighten the text and refit
it to the curve.



Windows Metafiles (WMF)
Imports graphics in a format used by many Windows programs, including Harvard Draw, 
Lotus Freelance Graphics and Aldus Persuasion. 



Import - Windows Metafile (WMF)
Technical Notes

CorelDRAW substitutes the following fonts in WMF files:
Windows Font CorelDRAW Font Similar To
Swiss (default) Switzerland Helvetica
Swiss Light Switzerland Light Helvetica Light
Swiss Extrabold Switzerland Black Helvetica Black
Roman Toronto Times Roman
Modern Memorandum American Typewriter
Script Banff Brush Script
Decorative Lincoln Linotext

Bitmap Formats
Imports bitmap graphics created in paint programs such as CorelPHOTO-PAINT (PCX) and 
Windows Paintbrush (BMP). TIFF is a bitmap file format used by many digital scanners.
Compuserve (GIF) and Targa (TGA) are color bitmap formats commonly used to store 
digitized photographs.



Import - BMP, GIF, PCX, PCC, TGA, TIF
Technical Notes

You can import black & white, color and gray-scale bitmap graphics. If you save a color or 
gray-scale bitmap as part of a CDR file, the color and shades of gray will be retained. 

Windows BMP Bitmaps
CorelDRAW imports BMP files conforming to the Windows BMP specification. They may be 
either color, gray-scale or black & white and will print accordingly, depending on your 
printer. 

GIF Bitmaps
CorelDRAW imports GIF files conforming to the 87A and 89A specifications.

PCX, PCC Bitmaps
CorelDRAW imports PCX files conforming to the following specifications: 2.5, 2.8, and 3.0. 
These files can contain 1, 2 or 4 color planes. Files containing 3 color planes cannot be 
imported.

TGA Bitmaps
CorelDRAW imports 16- and 24-bit Targa files.    It also imports the following variations:
· uncompressed color-mapped images
· uncompressed RGB images
· RLE compressed color-mapped images
· RLE compressed RGB images (types 1, 2, 9 and 10 as defined by AT&T Electronic 

Photography and Imaging Center)
TIFF Bitmaps

CorelDRAW imports black & white, color and gray-scale TIFF files conforming to the 5.0 
specification. TIFF files compressed using the CCITT, Packbits 32773 or LZW compression 
algorithms can also be imported. However, you may notice additional loading time with 
these, as CorelDRAW decodes the file compression. Some compression algorithms used to
produce color TIFF files may not be compatible with CorelDRAW's TIFF import. TIFF files 
using JPEG compression fall into this category.



CorelTRACE (EPS)
Imports bitmaps converted to vector graphics by CorelTRACE.



Import - CorelTRACE (.EPS)
Technical Notes

Imported CorelTRACE graphics come into the program as a group of objects. Use the 
Ungroup command in the Arrange menu to manipulate individual objects in the imported 
graphic.



Illustrator (.AI, .EPS)
Imports vector graphics created by IBM PC- and Macintosh-based programs.



Import - Illustrator (.AI, .EPS)
Technical Notes

CorelDRAW provides full support for the Illustrator 88, AI 1.1 and 3.0 formats.
Imported Illustrator graphics come into the program as a group of objects. Use the Ungroup 
command in the Arrange menu so you can manipulate objects in the imported graphic.
NOTE:    The Illustrator filter does not import files exported from CorelDRAW to EPS format, 
but does import files exported to AI. 



GEM Files (GEM)
Imports vector graphics created by programs such as GEM Draw and GEM Artline. Also 
imports GEM files from Ventura Publisher.



Import - GEM Files
Technical Notes

Color in GEM Files
The GEM format only supports 16 standard colors, which CorelDRAW's GEM import filter 
supports.

Object Interior Fills
Objects in GEM that have a solid or percentage fill of a particular color will also have a 
corresponding fill in CorelDRAW. However, custom fills (i.e., grids, hatches, ball bearings, 
etc.) used in the GEM programs are not supported . Objects containing such fills will have 
a tinted color fill in CorelDRAW that corresponds to the color of the pattern fill of the 
original GEM object.

Line End Styles
The types of end styles imported by CorelDRAW's GEM filter depend on the package that 
created the GEM file. From GEM Artline, no end caps or corners will import into 
CorelDRAW. In a file created in GEM Draw, the following will occur in CorelDRAW:
· Round end caps on both ends of a line will be successfully imported
· A round end cap on only one end of a line will be successfully imported
· Lines with arrows will come into CorelDRAW with no end caps, and nothing will appear 

highlighted in the Outline Pen dialog box
Symbols

The symbols available in GEM Artline are created as text objects. They are imported as 
curves in CorelDRAW.

Text in GEM Files
· Except for GEM Artline, text in your GEM file will come into CorelDRAW as editable text.

If your file was created in Artline, your text string will come across as a curve.
· Typefaces correspond as follows:

GEM typeface: CorelDRAW typeface: Similar to:
Dutch Toronto Times
Swiss Switzerland_Narrow Helvetica_Narrow

· Text in the imported file may not align exactly as it did in the original file. This is due to
the differences in font sizes,    and inter-character and inter-word spacing between the 
two programs. Such misalignment is easily corrected in CorelDRAW.

· Unsupported keyboard characters appear as question marks in CorelDRAW. Underlined 
text from the GEM format is not supported.



Computer Graphics Metafile (CGM)
Imports vector graphics from such programs as Harvard Graphics, Lotus Freelance and Arts 
& Letters. Also gives you access to graphics produced on mini and mainframe computers, as
well as clipart from vendors such as MGI and New Vision.



Import - CGM
Technical Notes

Scaling on Importation
The imported file may exceed the printable page area of the screen once it comes in, or it
may not be centered on that page. Click on the Zoom tool and select the Fit in Window 
icon. When the screen has refreshed, you can scale the image and bring it within the print
boundary.

Bitmaps
Bitmaps are not supported in this format.

Markers
CorelDRAW's CGM import filter only accepts markers supported by the CGM standard. 
Private-use markers are ignored.

Text in CGM Files
· Text will be editable, provided the file was exported by the originating program using 

the correct text options (for example, in Harvard Graphics 3.0, you must select the 
CGM font).

· The typeface you see in CorelDRAW will probably not correspond to the one used in the
originating program. However, you can easily change this in CorelDRAW.

· Some characters may not match those in the original file. This can occur if the 
originating application is    DOS-based. The character set IBM applications use differs 
from the one Windows uses.    You can easily change this once the character is in 
CorelDRAW.



Mac PICT (PCT)
Imports graphics created in Macintosh programs such as MacDraw. CorelDRAW can import 
vector and bitmap images contained in these files.



Import - MAC PICT (PCT)
Technical Notes

Objects
Objects that contain a fill and an outline will come into CorelDRAW as a group of two 
objects. One object will be the outline and the other the fill.

Colors
The MAC PICT1 format supports black and white only, whereas the PICT2 format supports 
color. When importing a PICT2 file into CorelDRAW, the import filter will match these 
colors exactly. While not always obvious, PICT fills are often bitmap patterns. CorelDRAW 
will try to maintain these fills as bitmap patterns.

Pattern Outlines
Pattern outlines are converted to a shade of gray based on the pattern's density. The 
shade of gray is then applied to the outline color yielding a certain tint of that color.

Arrowheads and Dashed Lines
These are not supported from MacDraw II into CorelDRAW.

Text
· Text in the PICT file will come into CorelDRAW as editable text.
· Typefaces correspond as follows:

PICT typeface: CorelDRAW typeface:
Times Toronto
Helvetica Switzerland
Symbols Greek/Math Symbols

· Unsupported MAC fonts come into CorelDRAW as Toronto.
· Text alignment may not quite agree with the original file. This is due to the differences 

in font size, and inter-character and inter-word spacing between the two formats. Any 
misalignment is easily corrected in CorelDRAW.

· Unsupported characters appear as question marks in CorelDRAW.
· The following PICT text styles are supported: Bold, Italic, Outline, Shadow and any 

combination of these. Underlined text is not supported.



HP Plotter HPGL (PLT)
Imports vector graphics created by programs such as AutoCAD.



Import - HP Plotter (HPGL)
Technical Notes

Formats Supported
CorelDRAW can interpret a SUBSET of the HPGL and HPGL/2 command set. A stepping 
factor of 1016 plotter units = 1 inch will be used.

Image Size
The HPGL Pen Color Selection dialog box includes a Stretch Factor option for resizing the 
imported image. Use this option to import images larger than CorelDRAW's maximum 
page size.

View
3-D files exported in HPGL format are normally exported in the current view. You should 
therefore choose the view you want to bring into CorelDRAW before exporting the file.

Colors in HPGL Files
The HPGL format does not contain color information. Instead, the various objects in an 
HPGL file have certain "pen numbers" associated with them. When imported into 
CorelDRAW, each pen number is assigned a specific color. You can specify what color you 
want assigned to a particular pen in the HPGL Pen Color Selection dialog box. This makes 
it easy to match the original colors of the graphic.
You can add more pen definitions to the dialog box by editing the [CorelHPGLPen] and 
[CorelHPGLColor] sections of your CORELDRW.INI file. The maximum number of definitions 
allowed is 256.
Pen numbers not defined in the CORELDRW.INI file will default to Black.
NOTE: Any changes made in the HPGL Pen Color Selection dialog box affect both the 
HPGL import and export filters. See Export - HPGL Format before making changes to the 
CORELDRW.INI file.

Fills and Outlines
The color-mapping strategy described above applies to color fills as well as outlines. Note,
however, that only certain types of objects in the HPGL file will be filled in CorelDRAW.

Line Types
CorelDRAW supports numerous HPGL dotted, dashed and solid line types. The pattern 
number of a certain line in an HPGL file will be translated to a CorelDRAW line type 
pattern, as shown in the following table:
HPGL line: CorelDRAW line type:
#0 Solid
#1 Dotted
#2 Small dash
#3 Large dash
#4,5 Dot-dash
#6 Double dot-dash
#7 and over As per # 2

Text in HPGL files
· Text will only come into CorelDRAW as editable text when the application that 

generated the file is capable of exporting text as text.



· Once in CorelDRAW, text strings will be assigned the Monospaced font, but can 
subsequently be assigned any typeface and size.

· Imported text has no outline color, only a fill color. The fill color is based on its 
associated pen number in the original HPGL file.



AutoCAD DXF (DXF)
Imports vector graphics created by AutoCAD.



Import - AutoCAD (DXF)
Technical Notes

Preparing the file in AutoCAD
To create a DXF file from AutoCAD, use the DXFOUT utility while in that program. If the 
image is 3-D, save it with the view that you want to transfer over to CorelDRAW. 
Whenever possible, use polylines rather than regular lines. This reduces the complexity of
the file when it is imported into CorelDRAW.

DXF File Complexity
If your DXF file is too complex to import into CorelDRAW, configure your AutoCAD output 
device as an HP7475 Plotter and perform a Plot-to-File of your drawing. You should then 
be able to import this plot file using CorelDRAW's HPGL import filter.

General notes and limitations on imported DXF files
· CorelDRAW tries to center the imported image in an 18x18 inch area. This size is not 

guaranteed though, especially with 3-D images. Drawings larger than 18x18 inches, 
will be scaled to fit within these dimensions.

· Dashed lines in the DXF file will be given a similar dashed line pattern in CorelDRAW. 
· If you have a problem with the scattering of "dimension entities" in your imported file, 

go back to your original drawing in AutoCAD and explode the dimension entity    before 
creating the DXF file.

· The line width of a polyline is imported as the minimum line width which that polyline 
had in AutoCAD. The maximum line width is 4 inches. Variable line width information is 
not retained when the file is imported.

· Solid and trace entities are filled, provided the view is not    3-D (i.e., they are filled on 
plan x-y axis view only).

· A point is imported as an ellipse of minimum size. An extruded point is imported as a 
line segment with two nodes. PDMODE is not considered.

· Files exported as selected "Entities" only may come into CorelDRAW incorrectly due to 
lack of header information.

AutoCAD features not supported in CorelDRAW
The following features in AutoCAD are not supported when importing a DXF file into 
CorelDRAW:
· Shape entities - CorelDRAW cannot read .SHX files
· Polylines including variable-width polylines, elevation (group 38), mesh M and N vertex 

counts (groups 71 and 72), smooth surface M and N densities (groups 73 and 74) and 
smooth surface type (group 75)

· Special 3-D shapes such as cones, spheres and tori
· 3-D extrusion of circles, arcs, and text
· 3-D extrusion of polylines with width and/or dashed patterns
· Invisible lines in 3-D face entities
· Automatic wireframes
· Hidden lines removal
· Extrusion direction assumed to be parallel to the z-axis
· Binary DXF format
· Paper Space Entities within a Model Space

Text in the DXF File



Text generated in AutoCAD and imported via DXF will show the following differences:
· Various justifications on text entries may not be preserved. Normal text placement (no 

justification) seems to work best.
· CorelDRAW has limits on values for text's point size and skew. If the AutoCAD text 

object exceeds these limits, the object is brought within them when it is imported.

Regarding special characters in text strings:
· Control characters are ignored.
· Overscore and underscore indicators are ignored.
· If a character is referred to by number, the number must be three digits. i.e. character 

65 is %%065.
· %%010 is considered to be a carriage return and line feed.
· Any non-standard characters become a "?" in CorelDRAW, including the degrees 

symbol, the +/- tolerance symbol, and the circle dimensioning symbol.
The typefaces used in AutoCAD are matched with the closest available face in CorelDRAW.
The following table is a guide to the matches made:

DXF typeface: CorelDRAW 
typeface:

Similar to:

Complex Toronto Times
Gothic Frankenstein Fette Fraktur
Greek Symbols Greek/Math Symbols
Italic Toronto Times-Italic
Monotext Monospaced Letter Gothic
Roman Toronto Times
Script Banff Brush Script
Simplex Toronto Times
Standard Toronto Times
Symap Geographic Carta
Symath Symbols Greek/Math Symbols
Symusic Musical Sonata
(other) Toronto Times

IBM PIF (PIF)
Imports vector graphics created on IBM mainframes.



Import - IBM PIF (GDF)
Technical Notes

Unsupported Functions
· No "Set Background Mix" or "Set Foreground Mix" orders are processed, since 

CorelDRAW does not support color mixing. Instead, CorelDRAW will overlay objects in 
the order they are read in. Each will have its own defined color where there is no 
overlap.

· No "Call Segment" orders are processed.
· No "Set Character Set" orders are processed.
· "Set Paper Color" is not supported.
· "Set Pattern Symbol" is not supported.

PIF Line Types
· "1", "3", "4" and "6" become a "three-unit dash followed by a five- unit space" type of 

line in CorelDRAW.
· "2" and "5" become a "one-unit dash followed by a five-unit space" type of line.
NOTE: The translation of line types is not dependent on the contents of the 
CORELDRW.DOT. These conversions are actually a non-alterable part of the PIF import 
filter.

Text in PIF Files
When text strings are imported, the characters are assigned the Monospaced typeface in 
CorelDRAW. If for some reason this is not available, the text is assigned the Toronto 
typeface. If neither one is available, the text will be assigned whatever font resides at the 
top of CorelDRAW's font selection list. The text, spacing and alignment attributes may 
then be changed as desired.



Lotus PIC (PIC)
Imports graphs from spreadsheet programs such as Lotus 1-2-3.



Import - Lotus PIC
Technical Notes

Color
The colors contained in a PIC file are translated to a series of eight gray shades.

Text
· Text contained in the file will come in as editable text.
· "Title" text will come in as the Toronto typeface in CorelDRAW. Any "non-Title" text will 

come in as the Monospaced typeface.



Text (.TXT)
Imports text directly into a Paragraph text frame.



Import - Text (.TXT)
Technical Notes

Allowable formats
CorelDRAW accepts only text in ASCII format. When preparing text for import, use your 
word processor's non-document mode or save the file as "text only" (i.e., ASCII format). 
Text attributes such as bold, italics, and underlining will be ignored, while tabs and 
indents will be converted to spaces.

Character Limits
You can import up to 4000 characters at a time. If you try to import more, CorelDRAW will 
truncate the excess.



Export command (File menu)
Saves the current drawing in a format that other programs can read. 

Dialog Box Options

File Name
Proposes a name for the export file (the same name as the drawing). Either accept it, or 
type in your own. The file extension corresponds to the Export file format selected from 
the List Files of Type box.

Directories
Use to select the directory in which the file you want to export is stored.

List Files of Type
Use to select the type of file you want to export. See Export File Formats.

Drives
Use to select the drive in which the file you want to export is stored.

About...
Displays the developer and version number of the filter used to export the selected file 
type.

Selected Only
Exports only those objects in the drawing that are currently selected.

OK
Exports the file, or displays another dialog box if the file format you are exporting to is 
one of the following:
· Adobe Type 1 Fonts, PFB
· AutoCAD, DXF
· Compuserve Bitmaps, GIF
· HP Plotter HPGL, PLT
· IBM PIF
· lllustrator 88, 3.0, AI
· CorelPHOTO-PAINT, PCX PCC
· Targa Bitmaps, TGA
· TIFF 5.0 Bitmaps, TIF
· TrueType Fonts, TTF
· Windows 3.0 Bitmaps, BMP
· Windows Metafile, WMF
· WordPerfect Graphic, WPG

See also
Recommended formats for exporting graphics to other applications



How to...
· Export graphics for use in other programs
· Export selected objects only



Recommended formats for exporting graphics
To Page Layout and Desktop Publishing programs without graphics editing 
capabilities:

The following recommendations are based on the type of printer you are using. Generally, if 
you have a PostScript printer and the program you are exporting to supports PostScript, use 
the EPS format. Otherwise, use the format shown in the table.

Recommended format for:
Program PostScript 

printers
Non-PostScript 
printers

Ami Professional EPS WMF
Delrina Perform GEM GEM
PageMaker 3.0 EPS WMF
Ventura Publisher 2.0 EPS GEM
WordPerfect 5.x EPS WPG

To page layout and desktop publishing packages with graphics editing 
capabilities:
Program Recommended format
Adobe Illustrator AI
Arts & Letters WMF, EPS (using Decipher)
AutoCAD DXF
GEM Artline GEM
MAC-based vector 
programs

MAC PICT, AI

Micrografx Designer CGM
PC Paintbrush PCX

To graphics devices:
Device Recommended format
Matrix, Genegraphic 
Solataire
film recorders

SCODL (if PostScript 
compatibility is not available)

Computer-driven cutters,
machines and plotters

HPGL or DXF outlines

Export EPS dialog box
Use this dialog box to specify how you want to export your file.
NOTE: CorelDRAW cannot import EPS files it creates. So that you can edit them in the future,
always save files in CorelDRAW format before you export them.

Dialog Box Options

All Fonts Resident
Causes text in the drawing to print using the printer's fonts rather than CorelDRAW's. Use 
this option if you are sending your work to a service bureau that has Adobe versions of 
the fonts you have used. This option is available only when exporting to EPS format.



If the font is not resident in the printer, either the text will print in Courier, or the drawing 
will not print.

Convert Color Bitmaps to GrayScale
Converts colors in the drawing to appropriate shades of gray. Select this option if your 
drawing contains color bitmaps and you plan to print the exported file on a black and 
white printer.

Include Image Header
Includes a bitmap representation of drawings exported in Encapsulated PostScript (EPS) 
format. The bitmap makes positioning, sizing and cropping the drawing in page layout 
programs much easier. It's    also used by graphics file managers such as MOSAIC.
None
Creates a file without an image header.
Low, Medium, High Resolution
Specifies the resolution of the image header. A higher resolution header is more detailed, 
but produces a file larger-sized file. 



HPGL Pen Color Selection
dialog box
Use this dialog box to specify the outline color and image size of files exported and imported
in HPGL format.

Dialog Box Options

Pen Color Selection
Displays the colors assigned to each of the plotter's drawing pens. To change a pen's 
color assignment, open it's list box and choose the color you want. 
Initially, each list contains the 11 standard HPGL colors. You can change the color 
assignments and add or subtract pens as required. See [CorelHPGLPen] and 
CorelHPGLColor.

Stretch Factor
Type an amount in the range 1 to 1000 to resize the image. To maintain its aspect ratio, 
specify equal amounts for horizontal and vertical stretch.

Default Colors
Resets the color assignments to those displayed when you opened the dialog box.
You can change the default color assignment by editing the [CorelHPGLPens] section in 
your CORELDRW.INI file.

Next Page/Previous Page
Scrolls the Pen Color Selection list up or down.

See also
Technical Notes



Export AI dialog box
Lets you choose the version of Adobe Illustrator you want to export to, and whether text is 
exported as text or curves.

Dialog Box Options

Select Format
V3.0 supports more of CorelDRAW's drawing effects and is therefore the recommended 
export format. 
Choose 88 only if you are planning to use the file in an application that does not support 
the V3.0 format. 
Choose AI 1.1 if you are planning to use the file in Adobe Illustrator version 1.1.

Text
Choosing As Curves converts text in the exported file to curves, while leaving text in the 
drawing as text. Use this option if you:
· used fonts in your drawing that are not available in Adobe Illustrator
· are not satisfied with the appearance of the text in Adobe Illustrator.
NOTE: Setting ExportTextAsCurves in the CDrawConfig section of your CORELDRW.INI to 
1 (the default setting) overrides the As Curves options in the Export AI dialog box.

See also
Technical Notes



Export PIF dialog box
Lets you choose how text and curves are exported.

Dialog Box Options

Convert text to
Choosing As Curves converts text in the exported file to curves, and leaves text in the 
drawing as text. Use this option if you:
· used fonts in your drawing that are not available in the application in which you intend 

to use the exported file. 
· are not satisfied with the appearance of the exported text.

Convert curves to
Select Polylines if you want to export curve objects as polylines rather than Bezier 
curves.

See also
Technical Notes



Export Bitmaps dialog box
Use this dialog box to specify how you want to export files in any of the bitmap export 
formats, such as PCX ( PCC), BMP (Windows and OS/2), TIFF, TGA, GIF or TIF.

Dialog Box Options

Color
Exports colors in your drawing. Select the number of colors you want in the exported file 
from the list box.
The greater the number of colors, the larger the exported file.

Grays
Exports colors in your drawing as shades of gray. Select the number of shades you want 
in the exported file from the list box.
You can convert gray shades and colors to black and white by selecting Black and White
from the list box.

Dithered
Dithers the colors and gray shades in the exported file. Dithering may produce better 
results when exporting fewer colors than the original image. If the image contains 
fountain fills or color blends, dithering can cause obvious banding in the exported bitmap.
Here are some guidelines to help you decide whether to dither the bitmap:
· If you are exporting only 16 colors or grays, use dithering.
· If you intend to scale the bitmap in another application, do not use dithering.
· If you intend to edit a color bitmap in another application, export 256 colors and use 

dithering.
Compressed

Compresses the exported file so that it takes less disk space. Compressed files take more 
time to save and load. 
Compression is optional for some bitmap formats; for others, compression is always 
performed.

Resolution
Specifies the resolution (in dots per inch) for bitmaps exported at a size of 1 to 1. Choose 
one of the preset resolutions from the list box, or choose Custom and type or select the 
resolution in the DPI box.
NOTE: As resolution increases, so does the size of the export file and the time required to 
print the image.

Size
Specifies the dimensions of the exported bitmap. Choose one of the preset sizes from the 
list box or choose Custom and type or select the dimensions in the Width and Height 
boxes. 
If the dimensions you choose are not proportional to the bitmap's original aspect ratio, 
CorelDRAW will remove extra pixels. Removing them prevents the bitmap from having 
undefined borders and appearing distorted.

About



Displays the developer and version number of the filter used to export the selected file 
type.

Reset
Returns to the settings in effect when you opened the dialog box.

Projected uncompressed file size
Shows the estimated size of the exported file before compression. Compressed files will 
be smaller than the value displayed.

See also
Technical Notes



Export Adobe Type 1/TrueType Fonts dialog box
Use this dialog box to convert the selected object into an Adobe Type 1 or a TrueType 
compatible typeface character or symbol character.

Dialog Box Options

Typeface Information
Font Family Name/TTF Family Name
Displays the name of the typeface on which the font file selected in the previous dialog 
box is based. If you are creating a new typeface, enter the name you want.
Styles
If the typeface already exists, one of the four styles will be selected. If it does not exist, 
select the style you want to assign to the character you are exporting.
Symbol Font
Check this box if you are creating a new symbol font, or producing a typeface that uses a 
non-Roman alphabet.
Typeface Design Size
Specifies the point size of the character being exported. Leave the value at 720 points if 
you are creating a new typeface character or symbol as described in Creating Adobe Type
1 and TrueType fonts. 
If you are modifying a character in an existing typeface, type or select the size you 
specified when you added the character to the page.
Grid Size (units per EM)
Available when creating a new True Type typeface. While this value can be changed from 
its default of 1024, there is very little reason to do so. Once a Grid SIze has been set for 
the first character in a new typeface, the option becomes unavailable.
Inter Word Spacing (wrt Grid Size)
Specifies the width of the "space" character. You can experiment with different values to 
get the best results.
Load Font Metrics
Displays another dialog box which lets you apply the width and kerning data from an AFM 
file to the typeface you are modifying.

Character Information
Character Number
Prompts you to enter a number from the Windows 3.1 Character Set that corresponds to 
the character you are exporting. The upper box displays the characters as you scroll. 
Characters not in the font file are grayed.
Character Width (wrt Grid Size)
Displays the width of the character you are exporting. If you are modifying an existing 
typeface and want to maintain the original proportions, leave the value unchanged.
If you are creating a new typeface, either specify the Character Width you want, or select 
Auto Width and let CorelDRAW calculate an appropriate width.
Auto Width
Automatically calculates a width for the character being exported. Deselect this option if 
you want to specify a width using the Character Width control.



Delete Character
Deletes the character displayed in the Character Number box from the selected 
typeface style.

Export Character
Exports the character. If you are changing an existing character definition, a message will 
appear asking whether you want to overwrite the definition.

Save Changes
Lets you change existing font information without exporting another character.

See also
Technical Notes



How to...
Create Adobe Type 1 and TrueType fonts



Export WPG dialog box
Lets you specify whether colors in the exported drawing are matched using 16 or 256 colors 
available in WordPerfect. Choosing 16 colors usually produces acceptable results. Choosing 
256 colors gives results that vary depending on the screen and printer drivers WordPerfect is
using.

See also
Technical Notes



Export DXF dialog box
Lets you specify the colors and units of measurement in the exported file.

Dialog Box Options

Standard Colors (7), Full Colors (256)
Exports the standard seven colors available in DXF, or the 255 colors available on 
systems that use the IBM Professional Graphics Controller. Choose seven colors if the 
drawing contains only a few primary colors, or if the colors don't display the way you 
want. If the drawing contains many colors, choose 255 colors, but keep in mind that 
results will vary depending on the type of graphics adaptor and monitor you are using.

Inches, Millimeters
Converts the units of measurement in the drawing to either inches or millimeters.

See also
Technical Notes



Export WMF dialog box
Gives you the option of including an image header with the exported WMF file. Adding the 
header makes it possible to view the contents of the file in programs such as PageMaker, 
Ventura and Word for Windows. However, the presence of this header may also make the 
WMF file impossible to read by certain applications not designed to handle it.



Export File Formats
The term "file format" refers to the way in which a graphic is stored in a computer file. 
Different programs use different formats to store the files they create. For a brief description 
of the formats CorelDRAW exports, choose the file format name. If you want more 
information, click on  next to the name.

 Illustrator 88, 3.0, *.AI, *.EPS  OS/2 Bitmaps, *,BMP
 Adobe Type 1 Font, *.PFB  Matrix/Imapro SCODL, *.SCD
 AutoCAD DXF, *.DXF  PostScript (EPS), *.EPS
 Compuserve Bitmaps, GIF  Targa Bitmaps, *.TGA
 CorelPHOTO-PAINT, *.PCX, *.PCC  TIFF 5.0 Bitmaps, *.TIF
 GEM Files, *.GEM  TrueType Fonts, *.TTF
 Computer Graphics Metafile, 

*.CGM
 Windows 3.0 Bitmaps, *.BMP

 HP Plotter HPGL, *.PLT  Windows Metafile, *.WMF
 IBM PIF, *.PIF  WordPerfect Graphic, *.WPG
 Mac PICT, *.PCT

See also
Recommended formats for exporting graphics from CorelDRAW



Export File Filters - Technical Notes
Click on  for technical information about CorelDRAW's export filters.

 Illustrator 88, 3.0, *.AI, *.EPS
 Adobe Type 1 Font, *.PFB
 AutoCAD DXF, *.DXF
 Compuserve Bitmaps, GIF
 CorelPHOTO-PAINT, *.PCX, *.PCC
 GEM Files, *.GEM
 Computer Graphics Metafile, *.CGM
 HP Plotter HPGL, *.PLT
 IBM PIF, *.PIF
 Mac PICT, *.PCT
 OS/2 Bitmaps, *,BMP
 Matrix/Imapro SCODL, *.SCD
 PostScript (EPS), *.EPS
 Targa Bitmaps, *.TGA
 TIFF 5.0 Bitmaps, *.TIF
 TrueType Fonts, *.TTF
 Windows 3.0 Bitmaps, *.BMP
 Windows Metafile, *.WMF
 WordPerfect Graphic, *.WPG



Illustrator .(AI, .EPS)
Saves drawings in a vector format that many Macintosh-based programs such as Adobe 
Illustrator 88 can read. Only vector objects can be exported in this format; any bitmaps in 
the drawing will be ignored.



Export - Illustrator 88, 3.0 AI
Technical Notes

AI vs. EPS
The AI format is a subset of the EPS format that CorelDRAW also exports. When you 
export to AI, you may sacrifice some of the drawing effects that only EPS supports. But 
unlike EPS, files exported from CorelDRAW in AI format can also be imported into 
CorelDRAW.

Limitations
Fountain fills: These are exported as a series of filled bands, similar to the effect you get 
using CorelDRAW's Blend feature. The number of bands is determined by Preview 
Fountain Stripes setting in the Preferences - Display dialog box.
PostScript textures: If these are included in your file, they will be exported with a fill of 
None.
Arrowhead line caps: These are simulated by drawing them as separate objects.
Fit Text to Path: This function is supported, however, each character is exported as a 
separate text string.
Character attributes: If a text object contains characters with special attributes 
(kerning, rotation, typeface changes and scaling) each is exported as a separate text 
object.

Outline Attributes
To accurately reproduce calligraphic outlines, corner styles, and line caps, set the 
CalligraphicClipboard value in your CORELDRW.INI file to 1. The outlines will export as a 
group of polygons which match the appearance of the outlines in CorelDRAW, but which 
add significantly to the size of the exported file. See CORELDRW.INI   File - [CDrawConfig]  .

Bitmaps
Bitmaps are ignored in the exported file.

General Notes and Suggestions
· Avoid combining objects in your CorelDRAW file. Doing this can lead to the problem 

mentioned above with the "filling of holes" and construction lines.
· If you have combined objects in your file (e.g., text with letters such as "o" and "p" 

which contain holes), and you want these to have a fill and outline of different colors, 
assign the colors in CorelDRAW before exporting the file. If the outline is added after 
the file is imported to a program such as Adobe Illustrator, construction lines will 
become evident.

· If you are creating a file with the intention of printing it in programs such as Ventura or 
PageMaker, then export it using the EPS filter, not the AI filter. The EPS filter supports 
more drawing effects than the AI filter, and generally yields better results.

Text
· If exported text displays in another font or prints in Courier, export the file again with 

the Send Text as Curves selected in the Export AI dialog box. This option should be 
selected whenever your CorelDRAW file contains a font not available in Adobe 
Illustrator.



Adobe Type 1 Fonts (PFB)
Saves a graphic as an Adobe Type 1-compatible text, or a symbol character that can be 
made available for use in other Windows applications through Adobe TypeManager Version 
2.0.



Export - Adobe Type 1/TrueType Fonts
Technical Notes

Limitations
· Type 1 and TrueType fonts exported from CorelDRAW are unhinted.
· Each exported character must comprise a single object or multiple objects combined 

using the Combine command in the Arrange menu. You cannot export multiple objects 
or grouped objects

· Avoid intersecting lines.    Any object in your character should lie completely inside or 
outside of others, as shown in the example below:

· Fill and outline attributes applied to objects are not exported.
· Adobe Type 1 fonts you create are compatible with Adobe TypeManager version 2.0, 

but not with earlier versions.



AutoCAD DXF (DXF)
Saves drawings in a vector format accepted by CAD/CAM programs and devices, such 
AutoCAD and certain computer-driven sign and glass cutters. Only the outlines of objects are
exported.



Export - AutoCAD DXF
Technical Notes

Unsupported CorelDRAW Features
The following are some CorelDRAW features not supported in DXF files imported into 
AutoCAD:
· Fills of all types are ignored.
· Calligraphic pen effects, dashed and dotted lines, and all line weights are converted to  

solid lines 0.003" thick.
· Bitmaps are not exported.
· Curves are exported as polyline segments.

Objects with no Outlines
Filled objects that have no outlines will have an outline appended to them in the DXF 
export process.

File Size
DXF files created with this filter can become quite large, especially if text is exported as 
curves. A complex drawing occupying only 20 or 30 K in CorelDRAW may easily balloon to
500 K or more in the DXF format.

Colors
Options in the Export DXF dialog box control how colors in the CorelDRAW file are 
exported:
Standard Colors (7): Matches colors in the CorelDRAW file to the seven colors available 
in DXF. The configuration of your system determines what colors are actually used. As a 
general rule, you'll get better results when your drawing contains primary colors.
Full Colors (255): May yield a truer representation of your CorelDRAW file. But because 
results vary depending on the video adaptor and driver used in Windows, colors may turn 
out to be very poorly matched.

Text
The ExportTextAsCurves switch in your CORELDRW.INI files lets you export text as text or
curves. With the switch set to "1" (default), text exports as curves so that it's appearance 
is maintained in the exported file. Note, text exported as curves cannot be edited as text 
in the destination application. If the switch is set to "0" the text is exported as editable 
text and will usually appear in the destination application's default font. See CORELDRW.INI
File - [CDrawConfig].



Bitmap Formats
Saves drawings as bitmap graphics. You can use bitmaps in either format in desktop 
publishing programs such as Ventura Publisher or Aldus PageMaker. You can also edit them 
in paint programs such as CorelPHOTO-PAINT and PC Paintbrush.



Export - Bitmaps
Technical Notes

Scaling Bitmaps
If you enlarge a bitmap in another application, you will lose resolution, and it may appear 
jagged. If you shrink a bitmap, the result should be acceptable, but you will be wasting 
disk space storing information which is not used.

File Size
To avoid unnecessarily large bitmap files (a full page at 300 dpi uncompressed can take 
several megabytes of disk space), scale the CorelDRAW graphic so that it's the same size 
as the space it will occupy in your word processing or page layout package.

Compression Schemes
CorelDRAW uses the following compression schemes:
Windows BMP RLE (Run-Length Encoding). Very few applications support 

compressed BMP files, and will generate error messages or display 
the bitmap improperly. 

Compuserve GIF LZW (GIF Version 89A)
CorelPHOTO-PAINT RLE (PCX Version 3.0)
PCX
Targa TGA Exports either RLE-compressed color-mapped images or RLE 

compressed RGB images (types 9 and 10 as defined by AT&T 
Electronic Photography and Imaging Center).    The type of file 
produced depends on the number of colors exported: 24-bit color 
TGA files will be exported as RLE-compressed RGB bitmaps.    Very 
few applications support compressed TGA files.

TIFF PackBits (TIFF Version 5.0)

Fountain Fills
The number of bands used to represent fountain fills in the exported file is determined by 
Preview Fountain Stripes setting in the Preferences - Display dialog box.



GEM Files (GEM)
Saves drawings in vector format for use in GEM Artline, Delrina Perform and Ventura 
Publisher (Version 2.0 and later).



Export - GEM
Technical Notes

Limitations
· Objects' fills and outlines, arrowheads, and segments in dotted and dashed lines are 

exported as separate polygons.
· Fountain fills often appear quite coarse because of the limited color availability in GEM.
· Breaks sometimes occur where outlines come to a point. Whether this is noticeable (or 

even occurs) depends on the size of your objects, the thickness of the outline, and the 
angle at which the outline meets at the point.

· Text is exported as curves and is therefore uneditable.
· Colors in the exported file are matched to the 16 colors GEM supports.
· GEM limits    the number objects per file. This poses problems if the original CorelDRAW 

file contains many complex objects. If the limit is exceeded, a less-than-complete 
image may come into Artline. If this occurs, try simplifying the file, and then re-export 
it to GEM.

Unsupported CorelDRAW Features
· Bitmaps
· Bitmap pattern fills
· PostScript Textures (converted to uniform mid-grey fills)
· Corners (joins) will appear round in GEM Artline
· Dotted and dashed lines

Bezier Curves
Because some applications have trouble interpreting them, Bezier curves are converted 
to line segments. Objects with more than 128 points (after conversion to segments) are 
broken into smaller objects which are then grouped.
Subdividing objects like this produces "clipping lines" that will show in wireframe view if 
you import the exported file into CorelDRAW. The lines will not appear in the printed 
output. They may also appear on screen in Ventura Publisher, but will not print.
If you load the file into GEM Artline, objects that appear to be individual are actually 
groups of smaller objects.



Computer Graphics Metafile (CGM)
Saves drawings in vector format for use in desktop publishing programs, such as Ventura 
Publisher or Aldus PageMaker.



Export - CGM
Technical Notes

Unsupported CorelDRAW Features
· PostScript Textures (converted to solid black)
· Bitmaps

Fountain Fills
The number of bands used to represent fountain fills in the exported file is determined by 
Preview Fountain Stripes setting in the Preferences - Display dialog box.



HP Plotter HPGL (PLT)
Saves drawings in a vector format used primarily by computer-driven sign and glass cutters. 
Only the outlines of objects are exported.



Export - HP Plotter HPGL (.PLT)
Technical Notes

Unsupported CorelDRAW Features
· Fills of all types are ignored.
· Bitmaps
· Calligraphic outlines (these are exported as solid outlines)

Limitations
· Dotted and dashed lines are mapped to HPGL's standard line types
· Bezier curves are converted to line segments

Colors
HPGL files contain "pen numbers" that correspond to the drawing pens available in a 
plotter. These pens are installed by the user and can be any color. The pen numbers and 
color assignments selected in CorelDRAW's HPGL Pen Color Selection dialog box should be
paired with the pen assignments in the plotter.
When the file is exported, the colors it contains are analyzed for their CMYK content. They
are then matched as closely as possible to the pen number and color definitions in the 
[CorelHPGLColors] section of the CORELDRW.INI file.
As many as 256 pens can be defined, but most plotters use eight or fewer pens. For this 
reason, the initial configuration of CorelDRAW only defines the eight most-widely used 
pen colors as follows:
[CorelHPGLPens] [CorelHPGLColors]
P1= Black Black=0,0,0,100
P2= Blue Blue=100,100,0,0
P3= Red Red=0,100,100,0
P4= Green Green=100,0,100,0
P5= Magenta Magenta=0,100,0,0
P6= Yellow Yellow=0,0,100,0
P7= Cyan Cyan=100,0,0,0
P8= Brown Brown=0,50,100,25

NOTE: Any changes made to CorelDRAW's color assignment list affect both the HPGL 
Import and Export filters. See Import HPGL before changing your CORELDRW.INI file.

Page Size and Orientation
So that the image is properly positioned when plotted, make sure the page size and 
orientation of your CorelDRAW file match the plotter page. If the plotted image appears 
distorted, try changing the orientation of the CorelDRAW page then re-export the file.

Unoutlined Objects
Since this filter deals with outlines only, any filled objects in your CorelDRAW file that 
have no outlines will have an outline appended to them in the HPGL export process.

Text
The ExportTextAsCurves switch in your CORELDRW.INI file lets you export text as text or 
curves. With the switch set to "1" (default), text exports as curves so that it's appearance 
is maintained in the exported file. Note, text exported as curves cannot be edited as text 
in the destination application. If the switch is set to "0" the text is exported as editable 
text and will usually appear in the plotter's or destination application's default font. See 



CORELDRW.INI   File - [CDrawConfig]  .



IBM PIF (PIF)
Saves drawings in PIF format which you can convert to GDF format for use by IBM 
mainframe programs. Only vector objects can be exported in this format.    Any bitmaps in 
the drawing will be ignored.



Export - IBM PIF
Technical Notes

Limitations
· Colors in CorelDRAW are color-mapped to provide the best possible match to PIF's 

sixteen-color palette.
· Because of the limited number of colors in PIF, fountain fills will usually not be 

reproduced as precisely as you see them in CorelDRAW.
Outlines Attributes

CorelDRAW will export the following outline effects as polygons, provided you set the 
CalligraphicClipboard value in your CORELDRW.INI file to 1. 
· Objects created using the calligraphic pen
· Line caps
· Custom outline thicknesses
See CORELDRW.INI   File - [CDrawConfig]  .

Unsupported CorelDRAW Features
· PostScript Textures
· Bitmaps
· Two Color and Full Color pattern fills

Text
Most export formats export text objects as editable text. In many cases, however, the text
will be represented in a different font with inaccuracies in size and spacing.
To maintain the exact appearance of your text, set the ExportTextAsCurves value in 
your CORELDRW.INI file to 1 before you export the file. The text will export as a curve 
object,    which means it will not be editable in the destination application. See 
CORELDRW.INI   File - [CDrawConfig]  .



Mac PICT (PCT)
Saves drawings in PICT2 (color) format for use in many Macintosh graphics programs.    Only 
vector objects can be exported in this format. Any bitmaps in the drawing will be ignored.



Export - MAC PICT (.PCT)
Technical Notes

Outline Attributes
CorelDRAW will export the following outline effects as polygons, provided you set the 
CalligraphicClipboard value in your CORELDRW.INI file to 1. See CORELDRW.INI   File -   
[CDrawConfig].
· Calligraphic pen effects.
· Line caps
Calligraphic effects and line caps appear as separate objects grouped with the line they 
are applied to.

Unsupported CorelDRAW Features
· Bitmaps
· PostScript texture fills. These are exported as a gray fill.
· Two-Color and Full-Color pattern fills

Objects with Fills and Outlines
Filled objects with an outline export as a group of two objects. One object will be the 
outline and the other the fill.
Outlines on text will export, provided the text is converted to curves prior to export. 
Convert the text by choosing the Convert to Curves command in the Arrange menu.
Text converted to curves cannot be edited.

Fountain Fills
The number of bands used to represent fountain fills in the exported file is determined by 
Preview Fountain Stripes setting in the Preferences - Display dialog box.

Colors
The colors available on the MAC are device-dependent, varying with the type of display 
you're using. If you have a display that uses 8-bit color, you are limited to a total of 256 
colors. The colors in your CorelDRAW file will be matched as closely as possible. A display 
that uses 24-bit color will display colors that are virtually identical to the ones you used in
CorelDRAW.

Text
All text defaults to the currently active system font in your MAC application. However, you
can maintain the exact appearance of your text by setting the ExportTextAsCurves 
value in your CORELDRW.INI file to 1 before you export the file. The text will export as a 
curve object, which means it will not be editable in the destination application. See 
CORELDRW.INI   File - [CDrawConfig]  .



Matrix/Imapro SCODL (SCD)
Saves drawings in a format which can be processed for output on non-PostScript devices 
such as ink-jet printers, thermal printers and film recorders.



Export - Matrix/Imapro SCODL (.SCD)
Technical Notes

Outline Attributes Option
CorelDRAW will export the following outline effects as polygons provided you set the 
CalligraphicClipboard value in your CORELDRW.INI file to 1. See CORELDRW.INI   File -   
[CDrawConfig].
· Corner types
· Calligraphic Pen effects
· Line caps and arrows
· Fountain fills

Unsupported CorelDRAW Features
· PostScript Textures
· Bitmaps
· Two Color and Full Color pattern fills

Producing Slides with full PostScript Effects
Agfa-Matrix offers an Adobe PostScript RIP for their film recorders. This device virtually 
eliminates all the limitations listed above. Some color slide-making service bureaus have 
this or similar equipment available. See Working with Service Bureaus.

Optimizing your Output
For best results, you should optimize your screen display using one of the RGB PAN files 
supplied with CorelDRAW. See *.PAN Files.

Aspect Ratio
If you are beginning a new drawing, choose Slide in the File Page Setup dialog box. This 
automatically sets the page dimensions to 11.00" by 7.33", the same aspect ratio as a 35 
mm slide. Page orientation will be set to Landscape.
If you are working with an existing drawing, select Slide as your page size. You will then 
have to scale and/or reposition objects in your drawing so that they lie within the page 
boundary. Any objects outside the page area will cause an error message when the file is 
exported. Correct this situation, otherwise these objects will be cropped out of the film 
image and the image will be distorted.

Working in Portrait Orientation
Slides can be produced in Portrait orientation as follows:
1. Whether working on an existing drawing or starting a new one, select Slide as the 

Page Size in the Page Setup dialog.
2. Select Custom and change the Orientation to Portrait. Do not change the page 

dimensions.
3. When your drawing is complete, change the Orientation back to Landscape.
4. Select all objects in the drawing.
5. Rotate the drawing 90 degrees (either clockwise or counterclockwise) to place objects 

onto the landscape page.
6. Export the drawing.



PostScript (EPS)
Saves drawings in vector format for use in desktop publishing and word processing 
programs,    such as Aldus PageMaker and Microsoft Word.    On a .PostScript printer,.graphics
exported in EPS format will print from other programs exactly as they did from CorelDRAW 



Export - Encapsulated PostScript (.EPS)
Technical Notes

Tip on exporting in EPS format
CorelDRAW cannot import EPS files it creates. So that you can edit them in the future, 
always save files in CorelDRAW format before you export them.

Image Header Size
If the program importing the EPS file has a limitation on the image header size, you may 
receive an error message stating that the file you're trying to bring in is too large.To keep 
file size down, choose a Low Resolution image header when exporting the file. The 
setting determines the resolution of the header and has no impact on the print quality of 
your drawing.
A Low Resolution header adds about 2K to the size of a file, whereas a Medium 
Resolution header adds about 8K, and a High Resolution header approximately 32K. 
These sizes    apply to images whose shape is more or less square. When you have a 
graphic file that is larger in one dimension than the other, the header size can grow 
proportionately larger. For instance, a graphic that is twice as long as it is wide can have 
an image header exceeding 64K if 512x512 is chosen as the header resolution.

Image Headers in Ventura Publisher
Ventura Publisher can sometimes crash or hang when trying to import an EPS file with an 
image header greater than 64K. The program can also have problems handling TIFF 
headers when the exported graphic is much larger in one dimension than the other. In 
such cases, the correspondence of the header to the image is often inaccurate. This leads
to misplacement of the graphic on the printed page, and incorrect scaling if you based 
your scaling on the header's appearance.

Colors
PostScript does not support PANTONE coloring. Therefore, spot colors used in CorelDRAW 
are converted to CMYK values in EPS. In most cases, the conversions are very closely 
matched.

File Contents
Along with the graphic, EPS files exported from CorelDRAW contain filename, program 
name and the date.    CorelDRAW automatically determines the size of the bounding box.

Text
· If you have Adobe PostScript typefaces and you want to use them in place of 

CorelDRAW's typefaces, make sure all the necessary fonts have been downloaded to 
your printer. Next, choose All Fonts Resident in the Print dialog box, and then print 
the file. Also choose this option if you are sending your file to a service bureau that has
Adobe versions of the fonts you have used.

· If you want CorelDRAW to always assume that the downloadable typefaces are 
available, then you should modify the PSResidentFonts section of your CORELDRW.INI 
file.

· If a font used in the file is not resident in the printer, either the text will print in Courier,
or the drawing will not print.



TrueType Fonts (TTF)
Saves a graphic as a TrueType compatible text or symbol character which can used in any 
Windows application that uses TrueType fonts. 



Windows Metafile (WMF)
Saves drawings in a vector format that allows it to print on a non-PostScript printer. Aldus 
PageMaker and Microsoft Word are popular programs that can read WMF files.



Export - Windows Metafile (.WMF)
Technical Notes

Unsupported CorelDRAW Features
· PostScript functions including PostScript textures fills and halftone screens.
· Bitmaps.
· Two Color and Full Color patterns appear as gray in the WMF file.

WMF File Complexity
WMF files can be very large if your graphic contains a lot of curves or text. This can cause
problems in programs such as Ventura Publisher and PageMaker, which impose limits on 
the size of imported files.

Image Header
You have the option of including an image header with the exported WMF file. This makes 
it possible to view the contents of the file in programs such as PageMaker, Ventura and 
Word for Windows. However, the presence of this header may also make the WMF file 
impossible to read by certain applications not designed to handle it.

Fountain Fills
The number of bands used to represent fountain fills in the exported file is determined by 
Preview Fountain Stripes setting in the Preferences - Display dialog box.



WordPerfect Graphic (WPG)
Saves drawings for printing on a non-PostScript print from WordPerfect Version 5.0 and later.



Export - WordPerfect (.WPG)
Technical Notes

Outline Attributes
To accurately reproduce calligraphic outlines along with corner styles and line caps, set 
the CalligraphicClipboard value in your CORELDRW.INI file to 1. The outlines will export 
as a group of polygons which match the appearance of the outlines in CorelDRAW, but 
add significantly to the size of the exported file. See CORELDRW.INI   File - [CDrawConfig]  .

Fountain Fills
Fountain fills tend to contain coarse banding.

Unsupported CorelDRAW Features
· PostScript textures fills and halftone screens
· Bitmaps

Colors
Options in the Export WPG dialog box control how colors in the CorelDRAW file are 
exported:
16 Colors
Matches colors in the CorelDRAW file to a standard set of 16 colors. Choosing this option 
usually yields acceptable results on a VGA display.
256 Colors
May yield a truer representation of your CorelDRAW file. But because results vary 
depending on the video adaptor and driver used in WordPerfect, colors may appear as 
shades of gray. If this happens, go back to CorelDRAW and export the file again with 16 
colors selected.

Text
Most export formats export text objects as editable text. In many cases, however, the text
will be represented in a different font with inaccuracies in size and spacing.
To maintain the exact appearance of your text, set the ExportTextAsCurves value in 
your CORELDRW.INI file to 1 before you export the file. The text will export as a curve 
object, which means it will not be editable in the destination application. See 
CORELDRW.INI   File - [CDrawConfig]  .



Insert Object (File menu)
Inserts an embedded object such as a chart, graphic or spreadsheet data created in another 
application.

Dialog Box Options

Object Type
Lists the types of objects you can insert into your drawing. Common objects include 
graphics from Windows Paintbrush and charts from CorelCHART.

Insert
Opens the application you will use to create the object.

See also
Linking and Embedding - An Overview



How to...
· Insert an embedded object from an other application
· Edit an embedded object



Linking and Embedding - An Overview
Linking
Linking lets you can create a CorelDRAW file that includes information from a second file 
created in another application, and then link the two files together. By copying an object 
from a source file (for example, a CorelDRAW drawing) and pasting into a destination file (for
example, a Word for Windows document), CorelDRAW will update the destination file any 
time the information changes in the source file.
You can control when updates occur or have CorelDRAW update the information 
automatically whenever the source file changes.

Embedding
Embedding allows you to create a file that includes information such as graphics and charts 
created in other applications. Only Windows applications that support object embedding can 
supply embedded information. Also, you must have enough memory to run all the 
applications you are using at once.
Embedding is used instead of linking when you want to make changes to the embedded 
information within CorelDRAW. For example, you can embed a chart you created in 
CorelCHART. While you're working on your CorelDRAW file, you may decide that you want to 
edit the chart - for example, change the size of the text. To edit the chart, you simply 
double-click on it. CorelDRAW opens CorelCHART, where you make the editing or formatting 
changes you want. When you switch back to CorelDRAW, the chart is updated with the 
changes you made.
For more information, see "Working with Windows OLE Capabilities" in the "Working with 
Other Applications" chapter of your CorelDRAW User's Guide.



Print command (File menu)
Controls how your files are printed. Options with asterisks are not available if your active 
printer is a non-PostScript device.

Dialog Box Options
 Selected Objects Only  All Fonts Resident*
 Fit to Page  Copies
 Tile  Destination
 Fountain Stripes*  Print to File
 Print as Separations*  For Mac*
 Crop Marks & Crosshairs*  Printer Setup
 Film Negative*  Flatness*
 Include File Info/Within 

Page*
 Screen Frequency*

Shortcut
Pressing CTRL + P opens the Print Options dialog box



How to...
· Select a default printer
· Set up the active printer
· Print a drawing
· Print a drawing to a disk
· Print drawings larger than the printer's paper size
· Print text using your printer's fonts
· Specify the number of stripes used to print fountain fills
· Increase the printing speed of drawings with complex curves
· Print complex drawings on a PostScript printer



Print Only Selected
Prints only the currently selected objects. Use this option if you want to proof portions of a 
complex drawing which takes a long time to print.



Fit to Page
Reduces the drawing to fit on the size of paper in the printer. Use this option to proof large 
drawings that exceed the printer's maximum paper size.



Tile
Prints parts of the drawing outside the Printable Page on additional pages. You will need to 
use this option if you are also using the Scale option to print your drawing at a size larger 
than the printer's paper size.



Print as Separations
Prints each Process color component or Spot color used in the drawing on a separate page.

· Available only when printing to a PostScript Printer
· Automatically selects Crop Marks & Crosshairs, Film Negative, Include File Info 

and then displays the Color Separations dialog box when you click on OK. See Print as 
Separations dialog box.



Print as Separations
dialog box
Prints the drawing on separate pages for each color value in the drawing. Objects filled with 
Process color are printed on four pages, one for each of the CMYK colors. Objects filled with 
Spot color are printed on separate sheets, one for each color used.

· Available only when printing to a PostScript Printer
· CorelDRAW will separate color bitmaps in a drawing and print the black component. No

gray component replacement is performed on the bitmap.

Dialog Box Options

Screen Angles
Controls the screen angles for each of the four Process colors. Unless you specify a 
different one in the PostScript Options dialog box, objects with Spot color print using the 
screen angle selected here.

Screen Frequencies
Controls the screen frequencies for each of the four Process colors. Unless you specify a 
different one in the PostScript Options dialog box, objects with Spot color print using the 
screen frequency selected here.

Separate: Selected Colors
Prints separations for selected colors only. Select the colors by clicking on them in the 
Colors List.

Separate: All Colors
Prints separations for all colors.



How to...
Print color separations



Crop Marks & Crosshairs
Adds crop marks and crosshairs to the printed page. If you are printing color separations, the
color, screen angle and density for each page are also printed.

· For crop marks & crosshairs to appear, the size of the Printable Page (as determined in 
the Page Setup dialog box) must be smaller than the size of the page you are printing 
on.



Film Negative
Creates a reversed image of the drawing for printing on an image setter that images directly
on film.

· This option is selected automatically when you choose Print As Separations. If you 
are not printing to film, deselect Film Negative.



Include File Info/Within Page
These options are available only when printing to a PostScript Printer.

Include File Info
Prints the filename of the drawing, the screen frequency, and the current date and time 
outside the left margin of the Printable Page. Also includes the color name and screen 
angle when printing color separations.
If the size of the Printable Page (as determined by settings in the Page Setup dialog box) 
exceeds the size of the paper you are printing on, the file info will not appear. In this case,
use the Within Page option if your Printable Page is 8.5x11 inches.
For larger page sizes, use the File Page Setup command to define a custom page size that
is smaller than the printer paper. You may then have to resize your drawing to fit on the 
new page size.

Within Page
Prints the file info inside the left margin of the Printable Page.



All Fonts Resident
Prints text in the drawing using the printer's fonts rather than CorelDRAW's. Use this option if
you are sending your work to a service bureau that has Adobe versions of the fonts you have
used.

· If the font is not resident in the printer, the text will print in Courier, or the drawing will 
not print.



Destination
Shows the device name of the currently active printer and the port to which    it is connected.
You can change the active printer with the Printer Setup command in the File menu.



Copies
Prints multiple copies of the current drawing. You can print as many as 10,000 copies, 
depending on the type of printer you are using.



Scale
Resizes the drawing when it is printed. Values below 100 shrink the drawing; values above 
100 enlarge it. Useful for proofing very small or very large drawings.

· You can use this option to print a single page drawing as a large poster if you also 
enable the Tile option.



Fountain Stripes
Determines the number of stripes printers use to render a fountain fill. Values higher than 40
produce a smooth fountain, but at the expense of longer printing times.

· A similar option in the Preferences dialog box controls how many stripes how many 
stripes CorelDRAW uses to display fountain fills on your screen.



Flatness
Determines how many segments the printer uses to draw a curve. Reducing the number of 
segments helps overcome PostScript limitcheck errors, which can prevent drawings with 
complex curves from printing. Remember that curves may become noticeably rough if the 
Flatness setting is increased too much.

Set Flatness to
If you are getting PostScript limit check errors, increase the Flatness setting in increments
of four or five until the drawing prints.

Auto Increase Flatness
Automatically increases the flatness setting in increments of one until the drawing prints. 
If the limit of 10 is reached and a particular object still will not print, the printer will skip 
that object and print the next.



Screen Frequency
Determines the halftone screen frequency used to print your drawing. For this option to have
any effect, you must also select Default as the PostScript Halftone Screen Type in the 
PosScript Options dialog box.

Default Screen Frequency
Uses a screen frequency determined by the particular PostScript printer you are using. 
Select Custom if you are unsure of the printer's frequency or want to use a different one.
If you're printing color separations, you must also select Custom and specify the 
frequency you want to use.

Custom
Lets you specify the screen frequency you want to use to print .    If you are printing color 
separations, you can adjust the screen frequency of each    of the CMYK colors.



Print to File
Creates a PostScript file that can be printed from DOS. Commonly used to print files from 
systems which do not have CorelDRAW installed or when sending files to a service bureau 
for high-resolution printing.
When you choose OK, a dialog box opens, prompting you to type a filename. See Print to File
dialog box.

· Images printed to file always use a default screen frequency of 60 lines per inch. If you 
want to use a different one, specify it using the Custom option.



Print to File dialog box
Use this dialog box to give a name to a file you want to print to disk.

Dialog Box Options

File Name
Type a name for the file. If you want or overwrite an existing file, select its name from the 
list.
The file name precedes the .PRN extension and can contain up to eight characters.

Directories
Use to select the directory in which you want the file printed.

List Files of Type
Shows Print File as file type being created.

Drives
Use to select the drive to which you want the file printed.



How to...
Print a drawing to a disk



For Mac
When printing to file, select this option if you are printing on an image setter controlled by a 
Macintosh computer.

· Available only with Print to File checked and when the active printer is a PostScript 
printer.



Printer Setup
Displays a dialog box for selecting a printer and various printer setup options. See Printer 
Setup command.



Printer Setup command
(File menu)
Use this command to select the printer and printer options you want to use to print your 
drawing.

Dialog Box Options

Printer
Selects the default printer or a printer listed in the box under Specific Printer. Only 
installed printers appear in the list. You install printers through the Windows Control 
Panel.

Orientation
Selects the orientation of the printer page. Choose an orientation that matches the 
orientation specified for your drawing with the Page Setup command.

Paper
Selects the paper size and source. Click on the arrows on the right of the Size and 
Source boxes to see a list of options you can choose.

Options
Displays a dialog box where you can choose default options for the printer you select. For 
more information, choose the Help button after you choose the Options button.



How to...
· Select a default printer
· Set up the active printer



Print Merge command
(File menu)
Inserts text created in a text editor into the current drawing and then sends the revised 
drawing to the printer. Used to create "form" drawings in much the same way that a word 
processor's Merge feature is used to create personalized form letters.

· Avoid merging blended or extruded text, text fitted to a path, or text that has had 
individual character attributes changed.

· Create the merge file with Windows Notepad or a word processor that saves in ASCII 
format.

Dialog Box Options

File Name
Type the name of the file you want, or select it from the list.

Directories
Use to select the directory in which the file you want is stored.

List Files of Type
Shows Text File as file type.

Drives
Use to select the drive in which the file you want is stored.

OK
Opens the Print Options dialog box so that you can specify how you want the file printed.



How to...
Use Print Merge



Page Setup command
(File menu)
Sets the page size, orientation and color.

· When you save a drawing, the Page Setup settings are also saved.
· The settings affect the positioning of the crop marks and crosshairs, as well as the 

dimensions of the Printable Page.
· The page orientation you select here should match the orientation specified with the 

Printer Setup command.

Dialog Box Options

Orientation
Portrait prints the drawing down the length of the paper.
Landscape prints the drawing across the width of the paper.

Page Size
Selects one of seven standard paper sizes. You can specify a custom page size up to 
30x30 inches by choosing Custom, and then typing or selecting the dimensions in the 
Horizontal and Vertical boxes. Slide selects a page dimension with the same aspect 
ratio as a 35mm slide.

Horizontal
Displays the currently select page width.

Vertical
Displays the currently selected page length.

Paper Color
Displays a dialog box that lets you color the Preview screen (and the drawing window, if 
you are working in the editable preview) to match the background of your drawing or the 
paper you plan to print it on. The color you assign does not print. If you want a color 
background that does print, choose Add Page Frame.

Add Page Frame
Places a rectangle with the same dimension as the Page Size behind all objects in the 
current drawing. The default fill and outline attributes are assigned to the frame. You can 
change these as desired.
You must be working in the editable preview to see the frame's attributes.
If you need to change the frame's color or outline, modify the frame directly rather than 
adding another.

Shortcut
Double-clicking on the Printable Page border displays the Page Setup dialog box.



How to...
· Set the dimensions and orientation of the Printable Page
· Add a printable background to a drawing
· Color the drawing window and Preview screen



Exit command (File menu)
Ends the current CorelDRAW session. If you have made any changes since you last saved 
your drawing, you will be asked if you want to save those changes.
The next time you run CorelDRAW, the program will use the same settings in effect during 
the last session. These settings are as follows:

· New Object Outline Pen, Color and Fill Settings
· Page Size and Orientation
· Grid Frequency and Origin and Snap To Grid status
· Snap To Guidelines status
· Show Rulers status
· Show Color Palette status
· Show Bitmap status
· Show Status Line status
· All settings in the Preferences dialog box
· Choice of units for Page Setup, Move, Grid Frequency, Outline Pen and the Preferences 

dialog box
· Disk drive and directory for Open, Save, Export, Import and Print to File dialog boxes
· Paper Color in Page Setup dialog box

Shortcut
Pressing CTRL+X ends the current CorelDRAW session.



File 1, 2, 3, 4 (File menu)
Opens the last four files you closed. Type the number next to the file you want to open, or 
click on its filename.



Undo command (Edit menu)
Returns your drawing to the state it was in before you performed the last operation. Use 
Undo immediately after making a change you do not want implemented.
You cannot Undo the following operations:

· Any change of view (Zoom-in, Zoom-out, etc.)
· Any file operations (Open, Save, Import, etc.)
· Any selection operations (Marquee select, Node select, etc.)

Immediately after selecting Undo, the Redo command becomes available, allowing you to 
restore what you just undid.

Shortcut
Press ALT+BACKSPACE



Redo command (Edit menu)
Restores changes reversed by the Undo command. Redo becomes available immediately 
after you select the Undo command.

Shortcut
Press ALT+ENTER



Repeat command (Edit menu)
Applies, if possible, the most recent command or action to the currently selected object. 
Useful, for example, in situations where you want to rotate a number of objects to the same 
angle.

Shortcut
Press CTRL+R



Delete command (Edit menu)
Deletes the selected objects. If no further action has been performed, you can restore a 
deleted object using the Undo command.

Shortcut
Press the DEL key.



Duplicate command (Edit menu)
Adds a copy of the selected object(s) to the current drawing.

· The copy is placed on top of the original and offset down and to the right. It is also 
selected automatically.

· You can set the amount of offset through the Preferences command in the Special 
menu

· Pressing the + key on the numeric keypad duplicates objects, but places them on top 
of the original with no offset.

Shortcut
· Pressing CTRL+D offsets duplicate from original object
· Pressing the + key on numeric keypad duplicates object with no offset



Cut command (Edit menu)
Removes the selected object(s) from the current drawing and places it onto the Clipboard. 
Once on the Clipboard, you can paste it into another Windows application or CorelDRAW file.

· Objects cut from another CorelDRAW file are pasted into the current drawing at the 
same size and location as the original. If the pasted object is not visible, use the Zoom 
tool Fit in Window option to bring all objects into view.

· Objects cut from other programs are usually pasted onto the center of the Printable 
Page.

· To permanently remove the selected object(s), use the Edit Delete command .

Shortcut
Press SHIFT+DEL

See also
· Allowable Formats
· General Cutting/Copying Limitations
· General Pasting Limitations



How to...
· Copy and cut objects to the Clipboard
· Display the Clipboard



Clipboard - Allowable Formats
Allowable Formats into the Clipboard

CorelDRAW allows two formats to be cut/copied to the Clipboard:
· CF_CORELDRW
· Windows Metafile
Note that most radial fountain fills can be successfully copied, provided the 
ClipboardFountains variable in the CORELDRW.INI file is set to "1". See Customizing the 
CIipboard.

Allowable Formats from the Clipboard
The following formats may be pasted from the Clipboard into CorelDRAW:
· CF_CORELDRW (including monochrome bitmaps)
· Windows Metafile
· ASCII text
· Windows Bitmaps



Clipboard - General Cutting/Copying Limitations
Object Size

If the objects you wish to cut/copy to the Clipboard exceed the CF_CORELDRW limit of 1024
kilobytes, the you will be given the warning:
"CorelDRAW Clipboard format too large to put on Clipboard"
Click on OK to return to your drawing. In most circumstances (unless it is very complex), 
the object will in fact have been copied onto the Clipboard using Window's Metafile 
format. As such, it is available to be pasted, but only into another application capable of 
pasting Metafiles larger than 64 kilobytes.

Unsupported Features
Objects containing the following effects can not be pasted into other applications:
· PostScript textures
· Pattern fills
· Bitmaps



Clipboard - General Pasting Limitations
Unsupported Metafile Features

The following Windows Metafile features cut/copied to the clipboard from other programs 
can not be pasted into CorelDRAW:
· Background commands ( SetBkMode and SetBkColor)
· Pattern fills (only uniform fills are currently supported)
· Clipping regions
· Flood fills
· Individual pixel manipulations
· No ROP2 modes, other than R2_COPYPEN (i.e., no combining of pen colors)
· WINDING polygon fill mode (ALTERNATE mode is supported)

Pasting Text
The amount of text, plus the spacing and text attributes CorelDRAW assigns to text 
pasted from other applications, varies for Artistic and Paragraph text. 

Artistic Text Paragraph Text
Amount 
(see Note)

250 characters 4000

Spacing Program Defaults
Inter-character = 0% of "space" 
width
Inter-word = 0% of "space" width
Inter-line = 100% of point size

Program defaults as per Artistic Text 
unless otherwise set in Text Spacing 
dialog box.

Text Attributes
(Fill, outline, typeface
 & point size)

Current defaults Current defaults

NOTE: CorelDRAW treats text pasted in blocks of 250 characters or less as Artistic text. If 
you paste more than 250, the program treats it as Paragraph text. To transfer more than 
the limits for Artistic text allow, perform the Cut & Paste operation in a series of blocks, 
where each block of text is less than 250 characters.



Windows Screen Capture
Pressing the PRINTSCRN key while running any Windows application puts a bitmap 
representation of your entire screen on the clipboard. To capture just the active application 
window press ALT+PRINTSCRN.
If any editing is required, you can paste the captured image into Windows Paintbrush. Before
pasting it though, choose the Zoom Out command from the View menu to ensure the entire 
image gets pasted into the drawing area.
You can save the modified image as a BMP or PCX file both of which can be imported for use 
in CorelDRAW.



Copy command (Edit menu)
Places a copy of the selected object(s) onto the Clipboard. Once on the Clipboard, you can 
paste the object into another Windows application or CorelDRAW file.

· Objects copied from another CorelDRAW file are pasted into the current drawing at the 
same size and location as the original. If the pasted object is not visible, use the Zoom 
tool Fit in Window option to bring all objects into view.

· Objects copied from other programs are usually pasted onto the center of the Printable
Page.

· Objects pasted from one application into another sometimes undergo unexpected 
alterations. See General Pasting Limitations.

Shortcut
Press CTRL+INS

See also
· Allowable Formats
· General Cutting/Copying Limitations
· General Pasting Limitations



How to...
· Copy and cut objects to the Clipboard
· Display the Clipboard



Paste Special command
(Edit menu)
Inserts information from the Clipboard into your drawing. You can specify the format the 
information will be in and create a link to the application from which the information came.

Dialog Box Options

Source
Displays the type of information you can paste from the Clipboard.

Data Type List Box
Lists the formats in which the information can be pasted.

Paste
Inserts the contents of the CIipboard into your drawing without creating a link.

Paste Link
Inserts the contents of the Clipboard and creates a link to the other application. This 
button is only available if the Clipboard contents come from an application which can link 
to information to CorelDRAW.



How to...
· Create a link
· Edit linked information in the source file
· Jump from a destination file to its source file



Paste command (Edit menu)
Places a copy of the object(s) currently on the Clipboard into your drawing. The original 
remains on the Clipboard until you copy or cut another object or end the current Windows 
session.

· Objects cut/copied from another CorelDRAW file are pasted into the current drawing at 
the same size and location as the original. If the pasted object is not visible, use the 
Zoom tool Fit in Window option to bring all objects into view.

· Objects cut/copied from other programs are usually pasted onto the center of the 
Printable Page.

· Objects pasted from one application into another sometimes undergo unexpected 
alterations. See General Pasting Limitations.

Shortcut
Press SHIFT+INS

See also
· Allowable Formats
· General Cutting/Copying Limitations
· General Pasting Limitations



How to...
· Copy and cut objects to the Clipboard
· Display the Clipboard



Edit Text command
(Edit menu)
Displays a dialog box allowing you to edit the content and attributes of a selected string of Artistic text or 
block of Paragraph text. Attribute changes apply to the entire string or paragraph. If you want 
to make changes to individual characters, use Character command in the Text menu or the 
Text Roll-Up window.

Dialog Box Options

Text Editing Box
Displays the selected text using the Microsoft Windows screen font.

Typeface Selection Box
Displays the names of the available typefaces. Use the scroll bar to the right to scroll through the list. 
The box to the left shows how the first few characters in the Text Editing box appear in the selected 
typeface and style.

Justification
Sets the text alignment. Left, Center and Right positions the text relative to the place 
where you clicked to open the Text dialog box. Full (Left & Right) is only available for 
Paragraph text.
Selecting None allows you to use the Shape tool to change the position of individual 
characters without CorelDRAW automatically repositioning the remaining text.

Style
Selects the styles available for the chosen typeface.

Size
Selects the text size. You can specify size in points from 0.7 to 1440, or in an equivalent unit of 
measure selected in the units box.

Spacing
Displays the Text Spacing dialog box where you can adjust spacing of the text.

Paste
Brings text from the Clipboard into the Text Editing box.

Text with more than 250 characters is automatically pasted as Paragraph text. If you try 
to paste more than 4000 characters, the excess will be dropped.more.

Import
Displays the Import Text dialog box which lets you bring ASCII text from other programs into the Text 
Entry Window. Available when creating or editing Paragraph text only.

Shortcut
Pressing CTRL+T with text object selected displays the Text dialog box



How to...
Edit text in the Text dialog box



Text Spacing dialog box

Controls the spacing between characters, words and lines in the selected string of Artistic text or block of 
Paragraph text. Also controls spacing between paragraphs in a block of Paragraph text.

You can also use the Shape tool to adjust spacing on screen. See Adjusting text spacing.

Dialog Box Options

Inter-Character
Sets spacing between characters as a percentage of the "space" character in the selected font. 
Allowable range: -1600 to +1600.

Inter-Word
Sets spacing between words as a percentage of the "space" character in the selected font. Allowable 
range: -1600 to +1600.

Inter-Line
Sets spacing between lines of text in percentages of the text's point size. Allowable range: 999 to 
+999.

Inter-Paragraph
Applies to Paragraph text only. Sets spacing between paragraphs in percentages of the Paragraph 
text's point size. Allowable range: -999 to +999.

Save as Default
Sets the current values as CorelDRAW's new default text spacing values.



Copy Style From command
(Edit menu)
Copies the attributes of the selected object to another object. When you choose the 
command, a dialog box appears so that you can specify which of the following attributes you
want to copy:

· Outline Pen
· Outline Color
· Fill
· Text Attributes (text objects only)



How to...
· Copy text attributes
· Copy an object's outline
· Copy an object's fill



Select All command (Edit menu)
Selects every object in your drawing, including any not currently in view. Once the objects 
are selected, you can apply any command or operation to them.



Edit Object command
(Edit menu)
Opens the application in which the selected embedded object was created, allowing you to 
make changes to it. When you finish making changes and close the application window, the 
revised object is incorporated into your CorelDRAW file. For example, suppose your file 
contained a chart created with CorelCHART. To edit the chart, select it and choose Edit 
CorelCHART from the Edit menu. CorelCHART will open with the chart displayed for editing.
Note that the command name changes depending on the type of object you select.

Shortcut
Double-clicking on the object with the primary mouse button opens the source 
application.

See also
Linking and Embedding - An Overview



How to...
Edit an embedded object



Links command (Edit menu)
Lists all the links in the current file. This list includes internal links to other CorelDRAW files 
and external links to other Windows applications, such as CorelCHART.

Dialog Box Options

Links
Lists the links in your file along with the application name, item name, and the type and 
status of the link.

Update
Specifies the type of link you want for the links selected in the Links box.
Automatic
Revises your CorelDRAW file whenever a change is made to the linked object.
Manual
Revises your CorelDRAW file when you choose the Update Now button.

Open Source
Opens the application in which the linked object originated. For example, if your file 
contained a CorelCHART graph, CorelCHART would open with the graph displayed.

Update Now
Updates the selected links and closes the dialog box.

Cancel Link
Breaks the selected links so that there is no longer a connection between the CorelDRAW 
file and the object's source application.

Change Link
Displays the Change Link dialog box, which lets you change the selected link to receive 
an object from another application and/or file, or a different object altogether.



How to...
· Update a link
· Change a link
· Cancel a link



Change Link dialog box
Use this dialog box to change the source of existing linked objects.

Dialog Box Options

File Name
Type the name of the new file with the object you want to link.
The file name precedes the .CDR extension and can contain up to eight characters.

List Files of Type
Use to select the application with the changed link if different from the original.

Directories
Use to select the directory in which you want the files stored.

Drives
Use to select the drive in which you want the file stored.



How to...
Change a link



Move command (Transform menu)
Moves the selected object(s) a specific distance or to an exact location. Use the command 
instead of the mouse when you want precise control over the placement of an object or 
group of objects.
You can also use the arrow keys to "nudge" objects by a specified amount. The default 
amount is 0.10 inches, which you can change with the Preferences command in the Special 
menu.

Dialog Box Options

Horizontal
Specifies the distance the object is moved left or right, or the horizontal coordinate for a 
coordinate move. To use a different unit of measurement, open the unit list box and 
choose the unit you want.

Vertical
Specifies the distance the object is moved up or down or the vertical coordinate for a 
coordinate move. To use a different unit of measurement, open the unit list box and 
choose the unit you want.

Leave Original
Moves a copy of the object, rather than the object itself.

Absolute Coordinates
Displays a box with eight nodes allowing you to specify which handle of the object's 
highlighting box will lie on the specified coordinates. Absolute coordinate moves are 
relative to the zero points on the rulers.

Shortcut
Pressing CTRL+L with an object selected displays the Move dialog box.



How to...
· Move objects with numeric precision
· Move objects using the mouse
· Move objects in increments (nudging)



Rotate & Skew command
(Transform menu)
Rotates or skews the selected object(s). Use the command instead of the mouse when you 
want precise control over the amount of rotation or skew.
By default, an object rotates around a point in the middle of its highlighting box, called the 
"center of rotation". You can rotate the object around a different point by dragging the 
center of rotation to a another location.

Dialog Box Options

Rotation Angle
Specifies the angle of rotation.

Skew Horizontally
Specifies the horizontal skew angle.

Skew Vertically
Specifies the vertical skew angle.

Leave Original
Rotates or skews a copy of the object rather than the object itself.

Shortcut
Pressing CTRL+N with an object selected displays the Rotate & Skew dialog box.



How to...
· Rotate objects with numeric precision
· Rotate objects using the mouse
· Move the center of rotation
· Skew objects with numeric precision
· Skew objects using the mouse



Stretch & Mirror command
(Transform menu)
Stretches, scales or mirrors the selected object(s). Use the command instead of the mouse 
when you want    precise control over the amount of stretching or scaling.

· Objects are stretched from both sides of their highlighting box. Values below 100 shrink
them, and values above 100 enlarge them.

· To scale an object, enter equal values in the Stretch Horizontally and Stretch 
Vertically boxes.

Dialog Box Options

Stretch Horizontally
Specifies the amount the object is stretched horizontally.

Stretch Vertically
Specifies the amount the object is stretched vertically.

Horizontal Mirror
Flips the object over from right to left.

Vertical Mirror
Turns the object upside down.

Leave Original
Stretches or mirrors a copy of the object rather than the object itself.

Shortcut
Pressing CTRL+Q with an object selected displays the Stretch & Mirror dialog box.



How to...
· Stretch and scaling objects with numeric precision
· Stretch and scaling objects using the mouse



Clear Transformations command
(Transform menu)
Reverses the following transformations, allowing you to restore an object to its original size 
and orientation:

· resets all rotation and skew transformations to zero.
· returns the center of rotation to the object's center.
· resets to 100% any scaling or stretching.
· removes all transformations applied with the Envelope and Perspective commands.

When applied to a group of objects, only transformations made to the group are cleared. 
Those made to objects before they were grouped are not cleared.



Edit Envelope command
(Effects menu)

Displays a sub-menu with a choice of four envelope editing modes. An envelope is a special 
type of bounding box similar to the box that appears around a selected object. Each of the 
eight handles on the envelope can be dragged independently of the others. As you drag, 
part of the object follows the motion of the handle, causing its shape to change. How the 
shape changes is determined by the editing mode.
With the first three modes, the handles move either vertically or horizontally. The result is a 
smooth, uniform change in shape. With the fourth mode, (Unconstrained) the handles move 
freely. They also have control points that allow you to mold the object virtually any way you 
want.

· If you are not getting the results you want with one mode, choose the Clear Envelope 
or Undo command to restore the object to its former shape, and then select a different 
mode.

· Text reshaped with an envelope remains as text. This means you can edit it and 
change its attributes. You cannot, however, change attributes of individual characters.

· Once you have applied an envelope to a curve object, you cannot select its nodes 
without clearing the envelope or converting the object to curves again.

· If you apply an envelope to an object, and then choose a different editing mode, that 
new mode will apply to all other objects on the screen that also have an envelope. You 
should be careful, therefore, not to move the handles of objects whose shape you do 
not wish to change.



How to...
· Shape an object with an envelope
· Edit an object's envelope



Clear Envelope command
(Effects menu)
Removes the last envelope you applied to the selected object, restoring it to its former 
shape.

· If you have since applied the Edit Perspective command to the object, you must clear 
the perspective before clearing the envelope. To avoid changing the object's 
perspective, duplicate the object using the Duplicate command, then clear the 
perspective. Next, use the Copy Perspective From command to copy duplicate's 
perspective back to the original.

· The Clear Transformations command in the Transform menu restores the selected 
object to its original shape by removing all envelopes at once.



Copy Envelope From command
(Effects menu)
Copies another object's envelope to the selected object.

· The selected object does not need to have an envelope to use this command.
· If you've since applied the Edit Perspective command to the object, you must clear the 

perspective before copying the envelope. To avoid changing the object's perspective, 
duplicate the object with the Duplicate command, then clear the perspective. After 
copying the envelope, use the Copy Perspective From command  to copy the 
duplicate's perspective back to the original.



How to...
Copy an object's envelope



Add New Envelope command
(Effects menu)
Applies a new envelope on top of the existing one without changing the object's shape. You 
can then open the Edit Envelope sub-menu and select a different editing mode. This lets you
experiment with combinations of editing modes without permanently altering the object.

· To reverse changes made with the most recently applied envelope, use the Clear 
Envelope command.



Edit Perspective command
(Effects menu)
Puts a bounding box with handles at each corner around the selected object(s). Dragging the
handles allows you to create one- and two-point perspective views of the object.

· When you apply this command to a text object, it remains as text. This means you can 
edit it and change its text attributes. You cannot, however, change attributes of 
individual characters.

· Once you have added perspective to a curve object, you cannot select its nodes 
without clearing the perspective or converting the object to curves again.

· Depending on the way you move the handles, you will see as many as two vanishing 
points (represented by Xs) on the screen. Dragging these also lets you change the 
object's perspective.



How to...
· Add perspective to an object
· Edit an object's perspective



Clear Perspective command
(Effects menu)
Removes the last perspective bounding box you applied to the selected object, restoring it to
its former state.

· If you have since added an envelope to the object, you must clear the envelope before 
clearing the perspective. To avoid losing the object's shape, duplicate the object with 
the Duplicate command, then clear the perspective. Next, use the Copy Perspective 
From command to copy the duplicate's envelope back to the original.

· The Clear Transformations command in the Transform menu restores the selected 
object to its original state by removing all perspective bounding boxes and envelopes 
at once.



Copy Perspective From
command (Effects menu)
Copies another object's perspective to the selected object.

· The selected object does not need to have a perspective bounding box to use this 
command.

· If you have since applied an envelope to the object, you must clear the envelope 
before copying the perspective. To avoid losing its shape, duplicate it with the 
Duplicate command, then clear the envelope. After copying the perspective, use the 
Copy Envelope From command to copy the duplicate's envelope back to the original.



How to...
Copy an object's perspective



Add New Perspective command
(Effects menu)
Applies a new perspective bounding box on top of the existing one without changing the 
object's perspective. It allows you to experiment with the positioning of the handles without 
permanently altering the object.

· To reverse changes made with the most-recently-applied bounding box, use Clear 
Perspective.



Blend Roll-Up command
(Effects menu)
Blends one object into another through a series of intermediate shapes. Controls in the 
Blend Roll-Up window let you specify the number of intermediate shapes created and the 
range of colors blended . You can also fit objects you've blended to a path.

· The intermediate shapes are dynamically linked. This means you can edit either of the 
blended objects and the blend will reform automatically to incorporate your changes.

· When blending objects with unequal numbers of subpaths, some or all the 
intermediate shapes may be drawn as open paths rather than closed ones. In such 
cases, the intermediate shapes may not print, or may print as outlined shapes rather 
than filled ones.

· You cannot blend objects on different layers.
· Fills blend according to the following rules:

Object fill Intermediate Shapes
No fill in one object No fill
Uniform fill with fountain blend from uniform fill to fountain
Uniform fill with pattern uniform fill
Radial fountains to Linear fountain Radial fountain
Same fountain type in both objects fountain
Pattern in one object only the other object's fill
Pattern in both objects the start object's pattern
Spot color with Process color Process color
Two different Spot colors Process color

Window Controls

Roll window icon 
Hides the controls, leaving just the title bar visible.

Blend Steps/Spacing 
Type or select the number of intermediate shapes you want in the blend. 
When blending on a path, you can specify the spacing between the intermediate shapes 
by choosing Spacing from the list box and typing or selecting the amount in the numeric 
entry box.

Color Wheel 
Displays a color wheel and options for specifying how colors are blended. If either object 
has a fill of None outline colors are displayed.
The default option blends using colors intersected by the line on the color wheel. The 
colors at either end of the line correspond to the colors of the start and end objects.
Rainbow blends using colors along the arc on the color wheel. The colors at either end of
the arc correspond to the colors of the start and end objects. Use the Direction buttons to 
blend either clockwise or counterclockwise between the ends of the arc.

Rotation
Forms an arc or spiral between the start and end objects. Specifying negative values 
changes the direction of the arc or spiral.



The point around which the intermediate shapes rotate depends on the selection mode of
the blend group when you click on the Apply button. In stretch/scale mode, they rotate 
around their own center of rotation. In rotate/skew mode, they rotate around a point 
midway between the centers of rotation of the start and end objects. 

Start Object 
Displays a menu with the following commands:
Show Start
Selects the start object in the selected blend group.
New Start
Displays a special mouse pointer for selecting a new start object.

End Object 
Displays a menu with the following commands:
Show End
Selects the end object in the selected blend group.
New End
Displays a special mouse pointer for selecting a new end object.

Map Nodes
Displays a special mouse pointer for specifying which node on the start and end objects 
you want CorelDRAW to treat as the objects' first node. You could get significantly 
different results depending on which nodes you select.
You can use Map Nodes on an existing blend group or before blending.

Blend on a Path    
Displays a menu with commands for blending objects along a path.
Show Path
Selects the path along which the selected blend group was blended. You can edit the path
with the Shape tool and CorelDRAW will redraw the blend group accordingly.
New Path
Displays a special mouse pointer for specifying a new path for a blend group. You can also
specify a new path for a blend group already blended on a path.
Detach from Path
Separates the blend group from its path.
You can specify where a blend begins and ends along a path by moving the start or end 
object in the blend group. Select the object you want to move, and drag it to the desired 
location along the path. When you release the mouse button, the blend group redraws.

Full Path
Places the start and end objects at either ends of the path. If the path is closed, the end 
object is placed an appropriate distance from the common start/end node of the path.

Rotate All
Rotates the objects in a blend group that has been blended on a path.

Apply
Applies the specified options to objects you want to blend or to an existing blend group.



Shortcut
Pressing CTRL+B displays the Blend Roll-Up window.



How to...
· Use Roll-up windows
· Blend objects
· Blend objects along a path
· Edit a blend
· Rotating intermdiate shapes in a blend
· Chain blends
· Clear intermediate shapes in a blend
· Break the link between blended objects



Clear Blend command (Effects menu)
Deletes the intermediate shapes created by blending two objects.



Extrude Roll-Up command
(Effects menu)
Adds surfaces to the selected object, making it appear three-dimensional. CorelDRAW links 
the object and its surfaces, allowing you to manipulate them as a single entity.
When you select the Extrude command, CorelDRAW displays the Extrude Roll-Up window 
and applies a default wireframe extrusion to the select object. Use the interactive controls 
and those in the Roll-Up window to adjust the direction, depth and other extrusion 
parameters.

Window Controls

Roll window icon 
Hides the controls, leaving just the title bar visible.

Depth 
Alters the depth and direction of the extrusion by moving the vanishing point.

Scale
Controls the depth of the extruded surfaces (i.e., how far they recede toward, or project 
from, the vanishing point). Applies only to perspective extrusions.
You can drag the X marker that appears when you choose Edit to interactively position 
the vanishing point and scale the extruded surfaces.
Perspective
When checked, the extruded surfaces will recede toward the vanishing point. When 
unchecked, the object is extruded so that opposite edges are parallel to one another.
To Front
When checked, the extruded surfaces will project away from the vanishing point. When 
unchecked, the extruded surfaces recede toward the vanishing point.
H, V
Shifts the vanishing point horizontally and vertically by the amount you specify. Specify 
the amount you want relative to the 0,0 points on the rulers.

Rotation 
Displays controls for rotating the object in three-dimensional space. Click on the arrows to
rotate the object in the direction you want.
Click on  to return the object to its original orientation.
For precise control over the amount of rotation, click on  and type or select values in 
the numeric entry boxes.

Lighting 
Displays controls for adjusting the intensity and direction of the light source.
The sphere inside the wireframe box represents the extruded object. The X represents the
light source. To move the light source, click where lines on the wireframe box intersect.
The Intensity control adjusts the object's shading to simulate the effect of varying the 
amount of light directed at the object. Type the value you want to use or drag the slide 
control. 



Clicking on the toggle button turns the light source off.

Coloring 
Displays controls for coloring the extruded surfaces.
Use Object Fill
Fills the surfaces with the object's color.
Solid Fill
Fills the surfaces with a color from the palette displayed by clicking on the color swatch.
Shade
Fills the surfaces with a blend between two colors. Select the colors from the palettes 
displayed when you click on the From and To color swatches.
NOTE: The Lighting control affects the appearance of shaded surfaces. If some of the 
surfaces appear black, and this is not the effect you want, increase the Intensity.

Shortcut
Pressing CTRL+E displays the Extrude Roll-up window.



How to...
· Use Roll-up windows
· Extrude an object
· Edit an extruded object
· Clear extruded surfaces
· Break the link between objects in an extrusion



Clear Extrude command (Effects menu)
Deletes the surfaces created by extruding an object.



Text Roll-Up command
(Text menu)
Displays a Roll-Up window for quick access to a variety of text attributes.
Choosing attributes from the roll-up, then clicking on the Apply button with no text selected,
lets you change the default attributes for the current session.

Window Controls

Roll window icon 
Hides the controls, leaving just the title bar visible.

Justification
Sets the text alignment. Left, Center and Right positions the text relative to the place you 
clicked to begin entering the text. Full (Left & Right) is only available for Paragraph text.
The X button turns off Justification so that you can    use the Shape tool to change the 
position of individual characters without CorelDRAW automatically repositioning the 
remaining text.

Typeface
Displays the names of the available typefaces. Use the scroll bar to the right to scroll 
through the list.

Size
Selects the text size. You can specify size in points from 0.7 to 1440 or in an equivalent 
unit of measurement by clicking on the unit name (e.g., inches).

Style
Selects the styles (bold, italic, underline, superscript and subscript) available for the 
chosen typeface.

Character Kerning
Displays a dialog box for shifting and rotating characters selected with the Text or Shape 
tools.
Horizontal Shift
Moves the selected character(s) toward the beginning of the text string if you enter 
negative values, or toward the end if you enter positive values.
Vertical Shift
Moves the selected character(s) up from the baseline if you enter positive values, or down
if you enter negative values.
Character Angle
Rotates the selected character(s) clockwise about the baseline if you enter negative 
values, or counterclockwise if you enter positive values.

Frame
Displays a dialog box for specifying Frame Attributes for Paragraph text.

Apply



Applies your choices to the selected text.

Shortcut
Pressing CTRL+2 opens the Text Roll-up window.



How to...
· Use Roll-up windows
· Select text on screen
· Apply character attributes
· Format Paragraph text



Character command
(Text menu)
Controls the character attributes (typeface, style, size etc.) of the selected block of text. You 
can change the attributes of individual characters by dragging across them with the Text 
tool, or by selecting their nodes with the Shape tool. Selecting characters individually lets 
you rotate and shift them horizontally and vertically.
Choosing this command with no text on the page lets you select default attributes for new 
text typed during the current session. 

Dialog Box Options

Fonts
Displays the names of the available typefaces. Use the scroll bar to the right to scroll 
through the list.
The window in the lower right corner shows sample characters in the selected typeface 
and style.

Size
Selects the text size. You can specify size in points from 0.7 to 1440, or in an equivalent 
unit of measurement by selecting the unit from the Units list box.

Style
Selects the styles available for the chosen typeface.

Underline
Applies and removes underlining.

Placement
Applies and removes superscripting and subscripting.

Horizontal Shift
Available when you select characters with the Text or Shape tool.
Moves the selected character(s) toward the beginning of the text string if you enter 
negative values, or toward the end if you enter positive values.
You can use the Shape tool rather than Horizontal Shift to interactively shift characters.

Vertical Shift
Available when you select characters with the Text or Shape tool.
Moves the selected character(s) up from the baseline if you enter positive values, or down
if you enter negative values.
You can use the Shape tool rather than Vertical Shift to interactively shift characters.

Character Angle
Available when you select characters with the Text or Shape tool.
Rotates the selected character(s) clockwise about the baseline if you enter negative 
values, or counterclockwise if you enter positive values.



Shortcut
Double-clicking on a character node displays the Character Attributes dialog box.



How to...
· Select text on screen
· Apply character attributes
· Kern text
· Adjust text spacing



cmd2reltp101Bullets command (Text menu)
Applies bullets to the selected text. When you add a bullet to a paragraph, it is automatically
formatted as a hanging indent219_glos_cd.

Dialog Box Options

Bullets On
When checked, applies the bullet(s) to the selected text.

1st, 2nd, 3rd Levels
Lets you apply bullets to three levels of Paragraph text. A paragraph's level is determined 
by the number of tabs used to indent it.

Bullet
Displays the first symbol in the selected category. Click on the symbol to display a list of 
others in the category.

Size
Specifies the size of the symbol in points. 

Distance
Specifies the distance between the bullet and the text.

Vertical Shift
Shifts the bullet up or down.

Symbol #
Displays the Symbol Index Number. Lets you select a symbol by entering its Index 
Number from the Symbol and Clipart Catalog.

Category Selection Box
Lists the Symbols categories. Use the scroll bars to see other categories in the list. 



How to...
Add bullets to a list



Frame command (Text menu)
Controls the appearance of the selected frame of Paragraph text.

Dialog Box Options

Columns
Formats the paragraph into newspaper-style columns and sets the spacing between 
them.
Number
Specifies the number of columns, from 1 to 8, into which the text is formatted.
Gutter Width
Sets the spacing between columns. The maximum spacing is two inches, or an equivalent
value in another unit of measurement.

Units
Specifies the unit of measurement. You can choose inches, millimeters, picas or picas and
points.

Justification
Specifies the position of the paragraph relative to the sides of its frame. You can choose 
Left, Right, Center, Full and None.
Selecting None allows you to use the Shape tool to change the position of individual 
characters without CorelDRAW automatically repositioning the remaining text.

Spacing
Specifies text spacing in percentages of the text's point size.
Paragraph
Sets spacing between paragraphs. Allowable values: -999 to +999.
Line
Sets spacing between lines of text. Allowable values: 0 to 999.
Word
Sets spacing between words. Allowable values: 0 to 16000.
Character
Sets spacing between characters. Allowable values: 0 to 16000.

Hyphenation
Automatic Hyphenation
Hyphenates words automatically when checked.
Hot Zone
Defines how far the end of a line must be from the right margin before CorelDRAW tries to
hyphenate the first word in the next line. A smaller hot zone results in more hyphens and 
less ragged margins.



How to...
· Format Paragraph text



Import Text dialog box
Loads text from an ASCII text file into the selected Paragraph text frame.

· Because CorelDRAW accepts text in ASCII format only, attributes such as bolding, 
italicizing and underlining are not retained in the imported text.

· Tabs and indents in the imported text are converted to spaces.
· As many as 4000 characters are allowed per frame of text. Any characters over this 

limit will be dropped.
· Each line break counts as two characters.
· If you use the Import command in the File menu, you can import text and have 

CorelDRAW create a frame for you.

Dialog Box Options

File Name
Type or select the name of the file you want to import. If the file has a different extension,
type it in place of the TXT extension.

Directories
Use to select the directory in which the file you want to import is stored.

List Files of Type
Shows Text File as file type being imported.

Drives
Use to select the drive to which you want the file printed.



How to...
Import text



Fit Text To Path command
(Text menu)
Fits the selected text object to the path traced by the outline of a selected non-text object. 
The text and the path become a dynamically linked group. This means you can edit the text 
or change the shape of the path and CorelDRAW will automatically refit the text.

· If you want to fit the text to a character, convert the character to a curve object using 
the Convert to Curves command in the Arrange menu.

· You cannot delete the path after fitting the text. If you want to hide the path, click on it 
while holding down the CTRL key, then remove its fill and outline.

Window Controls

Text Orientation
Determines the orientation of the letters on the path.

Rotate Letters: rotates individual characters to follow the contours of the path. 
Vertical Skew: vertically skews each character, creating the impression that the text

is standing upright on the path. The amount of skewing varies with the slope of the path. 
Horizontal Skew: similar to Vertical Skew, but with an added effect that makes 

letters appear to turn into the screen as they wrap around the path. The amount of skewing 
varies with the slope of the path. 

Center Base: centers the base of each letter on the path. 

Vertical Alignment
Determines the text's vertical placement with respect to the path.

Baseline: aligns the baseline of the text with the path.
Top: aligns the ascender line of the text with the path.
Bottom: aligns the descender line of the text with the path.
Variable: allows you to move the text off the path by dragging with the mouse. See 

Adjusting the position of text on a path
Horizontal Alignment

Determines the text's horizontal placement with respect to the path. This option is only 
available when fitting text to an open path.

Start: aligns the text with the start node of the path.
Center: centers the text on the path.
End: aligns the text with the end node of the path.
Variable: allows you to move the text off the path as by dragging with the mouse. 

See Adjusting the position of text on a path

Selects which quadrant of the path you want the text fitted on. This control is available 
when fitting text to objects drawn with the Rectangle and Ellipse tools.

Place on other Side
Fits the text on the opposite side of the path and reverses the path's start and end nodes.



Edit
Displays a dialog box you can use to specify the placement of the text on the path.
Horizontal offset
Specifies how far along the path you want to position the text.
Dist from path
Specifies how far above or below the path you want to position the text.
You can also adjust these parameters interactively. See Adjusting the position of text on a 
path.

Apply
Fits the text to the selected path according to the options you specified.

Shortcut
Pressing CTRL+F opens the Fit text to Path dialog box



How to...
· Use Roll-up windows
· Fit text to a path
· Edit text fitted to a path
· Adjust the position of text on a path
· Detach text from a path



Example



Example



Example



Example



Example



Align to Baseline command (Text menu)
Aligns characters in the selected text object to the baseline.

· Used most often following interactive text kerning.
· Does not affect character angle or horizontal spacing.

Shortcut
Press CTRL+Z



Straighten Text command (Text menu)
Restores all characters in the selected text object to the baseline and resets all character 
attributes (Vertical and Horizontal Shift, Character Angle) to zero. Also returns characters to 
the typeface and point size originally assigned to the text.

· Does not affect text spacing options (Inter-Character, Inter-Word and Inter-Line 
spacing) specified with the Edit Text or Character commands.



Spell Checker command
(Text menu)
Checks the spelling of words in the selected text string or paragraph.

· Since the Spell Checker command is always available; you can use it to check the 
spelling of any words, not just those in the current drawing.

· You can limit spell checking to portions of text by selecting the word(s) with the Text 
tool before choosing the Spell Checker command.

· The CD-ROM version of CorelDRAW provides different dictionaries allowing you to 
check the spelling of words in other languages. You specify which dictionary to use by 
editing your CORELDRW.INI file. See Installing a foreign language dictionary

Dialog Box Options

Word to check/Word not found
Type the word you want to spell check, and then choose the Check Word button. 
If you choose the Check Text button to check all words in the selected text, the box 
displays any misspelled words or words not found in the open dictionaries.

Alternatives
Type a word for the one not found in the dictionary. You can have CorelDRAW suggest 
words by choosing the Suggest button, or by checking the Always suggest option.

Suggest
Displays a list of selected corrections for the word in the Word not found box.

Check Word
Checks the word typed in the Word to check box.

Check Text
Begins checking all words in the selected text.

Ignore
Leaves the word in question unchanged.

Ignore All
Leaves all occurrences of the word in question unchanged in the remainder of the text

Replace
Replaces the word in question with the selected alternative.

Replace All
Replaces all occurrences of the word in question with the selected alternative.

Add
Adds the selected word to the dictionary in the Personal Dictionary box.

Always suggest
Displays suggested corrections without you having to choose Suggest.



Personal Dictionary
Lets you select the dictionary to which you want to add words not found in the main 
dictionary.

Create a personal dictionary
Lets you add your own dictionary to the spell checker. Type a filename for the dictionary 
you want to create, and then choose Create.

Cancel
Closes the dialog box. Choosing Cancel does not undo any changes you have already 
made.



How to...
· Check spelling
· Correct a misspelled word
· Create and add words to a personal dictionary
· Open a personal dictionary



Thesaurus command
(Text menu)
Suggests synonyms for words in your drawing. Use the Text tool to highlight the word you 
want a synonym for, and then choose the Thesaurus command.

· Since the Thesaurus command is always available; you can use it to look up any word, 
not just those in the current drawing.

Dialog Box Options

Synonyms for
Displays the word you selected before choosing the Thesaurus command. If the word is 
not in the Thesaurus, the box is empty.
If you chose the command without selecting a word, you can look up synonyms for any 
word you type in the box. After typing the word, choose the Look Up button.

Definition
Displays a definition for the word in the Synonyms for box.

Definitions
Displays definitions for the selected word. Choose the definition that fits the context of 
the selected word in your drawing. 

Synonyms
Displays synonyms for the word in the Synonyms for box. The list changes according to 
the definition selected.

Lookup
Displays a list of synonyms for the word you typed in the Synonyms for box.

Replace
Replaces the word in the Synonyms for box with the word selected in the Synonyms 
box.



How to...
Use the thesaurus



cmd2reltp123Hyphenation command
(Text menu)
Suggests alternatives for hyphenating text in your drawing. When CorelDRAW encounters a 
word that can be hyphenated, a dialog box appears with a list of hyphenation alternatives. 
You may want to use hyphenation to minimize excessive spacing between characters of 
justified Paragraph text.

· To hyphenate an entire text string or paragraph, position the insertion point at the 
beginning of the string/paragraph before choosing the Hyphenation command.

· To limit hyphenation to portions of a string or paragraph, select the word(s) with the 
Text tool before choosing the Hyphenation command.

· You can have CorelDRAW hyphenate Paragraph text automatically by selecting the 
Automatic Hyphenation option in the Frame dialog box.

· The CD-ROM version of CorelDRAW provides different dictionaries, allowing you 
hyphenate words in other languages. You specify the dictionary you want to use by 
editing your CORELDRW.INI file. See Installing a foreign language dictionary

Dialog Box Options

Hyphenate at
Displays the first word in the string/paragraph that can be hyphenated. Click on the arrow
to display a list of hyphenation alternatives.

Confirm each time
Waits for you to choose how you want a word hyphenated before proceeding to the next 
word. If you turn confirmation off, CorelDRAW will hyphenate all words that can be 
hyphenated.
This option is available when hyphenating entire strings or paragraphs.

Go
Finds the next word that can be hyphenated. This option is available when hyphenating 
entire strings or paragraphs.

Accept
Hyphenates the word at the indicated places. This option is available when hyphenating 
selected words.

Cancel
Closes the dialog box. Choosing Cancel does not undo any hyphenation you have already
accepted.



How to...
Hyphenate words automatically



Extract command (Text menu)
Saves text objects in the current drawing as ASCII text which you can edit in a word 
processor. After editing the text, use the Merge Back command to insert it into your drawing.

· The revised text will appear just as the original text did, provided you did not change 
the attributes of individual characters or apply any of the following commands:
Extrude
Blend
Fit Text to Path

· Do not change the drawing after extracting text from it. If you make any changes,, you 
cannot merge the text later.

· You can only merge the edited text with the drawing from which it was extracted.
· Use Windows Notepad or a word processor that saves in ASCII format to create the 

merge text file.

Dialog Box Options

File Name
Type a name for the file. To overwrite an existing file, select its name from the list.
The file name precedes the .TXT extension and can contain up to eight characters.

Directories
Use to select the directory in which you want the file stored.

List Files of Type
Shows Text File as file type being created.

Drives
Use to select the drive to which you want the file printed.



How to...
Extract and merge text



Merge-Back command
(Text menu)
Inserts text from the selected ASCII file into the current drawing. The ASCII file contains text 
extracted from the drawing with the Extract command and revised in word processor.

· You can only merge the edited text with the drawing from which it was extracted.
· If you made any changes to the drawing following Extract, the Merge Back operation 

will fail.
· The revised text will appear just as the original text did, provided you did not change 

the attributes of individual characters or apply any of the following commands:
Extrude
Blend
Fit Text to Path

Dialog Box Options

File Name
Type the name of the file with the text you want to merge, or select it from the list.

Directories
Use to select the directory in which the file you want is stored.

List Files of Type
Shows Text File as file type being opened.

Drives
Use to select the drive containing the file you want.



How to...
Extract and merge text



Layers Roll-Up command
(Arrange menu)
Helps you organize your drawing by assigning elements to different layers. A drawing can 
have any number of layers, and a guides and grid layer. Controls in the Layers Roll-Up 
window let you create, copy and delete layers, as well as hide, lock and print selected 
layers.
You can also use the Layers command to:

· select the active layer on which you draw objects
· move selected objects to a different layer
· move a layer and its objects in front of or behind other layers

Window Controls

Layers List
Displays the names of the layers in the current drawing. Selecting a layer makes it the 
active layer. Any new objects added to the current drawing are assigned to the active 
layer.
Making a layer active lets you change its attributes.
You cannot make the grid layer the active layer.

Layers Menu Arrow 
New
Displays the Layers Options dialog box, where you assign a name to a new layer and 
specify its attributes.
Edit
Displays the Layers Options dialog box, where you assign a new name to an existing 
layer and change its attributes.
Delete
Deletes the currently selected layer and any objects on it.
MoveTo
Moves the selected object to the layer selected in the Layers list.
CopyTo
Places a copy of the selected object to the layer selected in the Layers list.
MultiLayer
Allows selection of objects across all layers except those which are locked or invisible.

Shortcut
Pressing CTRL+1 opens the Layers Roll-Up window



Layers Options dialog box
Use this dialog box to specify the attributes of the selected layer.

Dialog Box Options

Visible
Makes objects on a layer visible or invisible. Making some layers invisible lets you isolate 
a part of your drawing for easier editing.

Printable
Enables or disables printing of objects on a layer. Printing only selected layers lets you 
proof parts of your drawing more quickly.

Locked
Enables or disables selection of objects on a layer. Locking a layer prevents objects on it 
from being accidently moved or changed in any way.
Though you can add new objects to a locked layer, the object becomes locked once it is    
deselected.

Color Override
Outlines objects on a layer in the selected color. Choose the color you want from the 
palette that appears when you click on the color box. Objects on the selected layer will 
appear with a wireframe outline of the chosen color.
Color Override is useful for identifying which objects are on a particular layer in a complex
drawing. You can also use it to change the color of the guidelines and grid markers.
NOTE: Color Override does not change the objects' fill and outline, only the way they are 
displayed on your screen.

Layer Name
Displays the name of the selected layer or the default name for a newly created layer. 
Type the name you want to assign to the layer in this box.

Setup
This button appears when either the Grid or Guides layer is active. Choosing Setup 
displays either the Grid Setup or Guidelines Setup dialog box.



How to...
· Use Roll-up windows
· Add a new layer
· Change the name of a layer
· Delete a layer
· Change the active drawing layer
· Change the order of layers
· Move an object to a another layer
· Copy an object to a another layer
· Lock a layer
· Make a layer visible or invisible
· Make a layer printable or unprintable
· Work on multiple layers
· Identify objects on a layer
· Rearrange the stacking order of objects on a layer



Align command (Arrange menu)
Aligns the selected objects.

· Objects are aligned with respect to the handles on their highlighting box.
· Select the objects you want to align individually, rather than using the Select All 

command in the Edit menu or the marquee select  option.
· The last object you select maintains its position; all others move to align with this 

object.
· To align to the grid or the center of the page, choose the corresponding option first, 

followed by the Horizontal and Vertical options.

Dialog Box Options

Horizontal
Aligns horizontally with respect to the left, center or right handle.

Vertical
Aligns vertically with respect to the top, center or bottom handle.

Align to Grid
Considers the Horizontal and Vertical options, and then aligns the selected objects to 
the nearest grid point.

Align to Center of Page
Rearranges the selected objects according to the Horizontal and Vertical options, then 
repositions them to the center of the Printable Page.

Shortcut
Pressing CTRL+A with an object(s) selected displays the Align dialog box



How to...
Align objects using the Arrange Align command



To Front and To Back commands
(Arrange menu)
Arrange to Front rearranges the stacking order by moving the selected object to the front 
of the screen. If the front object has a fill, CorelDRAW "knocks out" the area underneath 
wherever it overlaps other objects in your drawing, so that it does not print.
Arrange to Back rearranges the stacking order by moving the selected object to the back 
of the screen. Areas of the object overlapped by other objects with fills are "knocked out" so 
that they will not print.

Shortcuts
· To Front: Press SHIFT+PGUP
· To Back: Press SHIFT+PGDN

See also
How Layers affect the stacking order of objects



Forward One, Back One and Reverse Order commands (Arrange 
menu)
Arrange Forward One rearranges the drawing order by moving the selected object up one 
position.
Arrange Back One rearranges the drawing order by moving the selected object back one 
position.
Arrange Reverse Order reverses the drawing order of the selected objects.

Shortcuts
· Forward One: PGUP
· Back One: PGDN

See also
How Layers affect the stacking order of objects



How Layers affect the stacking order of objects
You use the Arrange Menu To Front, To Back, Forward One, Back One, and Reverse 
Order commands to change the stacking order of objects on a single layer. In a multi-layer 
drawing, the order of the layers determines the absolute arrangement of all objects in the 
drawing. For example, if you have several objects on two different layers, selecting the 
bottom object on the lower layer and choosing To Front puts that object on top of all others 
on its layer. Objects on the upper layer will still overlay any objects on the lower layer.
If you select multiple objects on different layers, the stacking commands in the Arrange 
Menu will function as expected, but will only change an object's order on its particular layer. 
To change an object's order relative to objects on another layer, copy the object to the other 
layer using the CopyTo command in the Layers dialog box. Once it is on the appropriate 
layer, use the stacking commands to move the object to its final position.



Group command
(Arrange menu)
Groups all selected objects together so that they can be selected and manipulated as a 
single object.
When an object in a group is selected, a single highlighting box appears around the entire 
group. Except for those listed below, any command or operation applied to the group affects 
all objects in the group.

· Combine and Break Apart (Arrange menu)
· Edit Text (Edit menu)
· Character, Frame, Fit Text to Curve, Straighten Text and Align to Baseline (Text menu)
· Blend and Extrude (Effects menu)
· Any operations using the Shape Tool

You can also collect groups into larger groups with other objects and/or groups. A single 
group can have as many as 10 sub-levels of grouping.
To break a group apart to make changes to an individual object, use the Ungroup command.
Grouping objects in a multi-layer drawing puts them on the same layer (the currently active 
layer). The objects will still maintain their stacking order relative to other objects in the 
drawing.

Shortcut
Press CTRL+G



How to...
· Group and ungroup objects
· Select individual objects in a group
· Select nested groups



Ungroup commands (Arrange menu)
Breaks up the selected group into its individual objects. If you have grouped groups 
together, Ungroup breaks up one level of grouping at a time.

Shortcut
Press CTRL+U



Separate command (Arrange menu)
Separates the original objects from intermediate shapes created by the Blend command and
the extruded surfaces created by the Extrude command. Also separates text from the path 
to which it's fitted using the Fit Text to Path command.



Combine command
(Arrange menu)
Combines the selected curve/line segments into a single curve object. If you use Combine on
rectangles, ellipses or text objects, CorelDRAW converts them to curves before converting 
them into a single curve object.
Use Combine when you want to:

· save time when editing many nodes or curve/line segments in different curve objects
· join nodes on two different curve objects
· create clipping holes or masks
· conserve memory for drawings which contain many lines and curves that share the 

same outline attributes
You can combine objects on different layers. The combined object will be assigned to the 
uppermost layer occupied by any of the objects before they were combined.

Shortcut
Press CTRL+C



How to...
· Combine separate objects
· Create clipping holes or masks



Break Apart command (Arrange menu)
Converts an object made up of multiple subpaths into individual curve objects. Use Break 
Apart when you want to:

· change an object that you previously combined with others using the Combine 
command in the Arrange menu

· assign different fill or outline attributes to characters in a text object previously 
converted to curves

· fill transparent regions that occur when you combine overlapping objects

Shortcut
Press CTRL+K



Convert To Curves command
(Arrange menu)
Converts the selected rectangle, ellipse or text object to a series of curves and/or lines that 
you can shape with the Shape tool. Objects converted to curves are called curve objects.

· Once an object is converted to curves, it is not possible to return it to its original object
type, except immediately after the conversion using the Undo command in the Edit 
menu.

· Text converted to curves cannot be edited using the Text tool or any of the text editing 
commands.

· If you convert text with overlapping characters to curves, the overlapping areas will be 
transparent. To fill in the entire character, choose the Break Apart command from the 
Arrange menu after the conversion.

· If you applied different outlines and/or fills to individual characters in a string of Artistic
text, converting the string to curves creates a group of objects (one object for each 
different fill/outline combination).

Shortcut
Press CTRL+V



Snap To Grid command
(Display menu)
Toggles Snap To Grid on and off. Working with the grid on makes it easy to accurately align 
and position objects. It also allows you to draw precisely-sized objects.

· When Snap To Grid is on, the cursor is forced to stay on the grid points, except when 
you are:
Selecting an object with the Pick or Shape Tools, or with the Copy Style From mouse 
pointer
Drawing in Freehand or Bezier mode
Rotating/skewing an object with the Pick Tool
Modifying ellipses with the Shape Tool
Zooming in with the Zoom Tool

· When moving objects with Snap To Grid on, the handles on the object's highlighting 
box are forced to the grid points.

· Text snaps to the grid along its baseline when moved vertically. When moved 
horizontally, the text snaps according to the Justification option assigned with the 
Character or Edit Text commands. For example, with Right Justification selected, text 
snaps to the grid along the right edge of its highlighting box.

· When moving rotated text, the handles on its highlighting box snap to the grid.
· The Constrain feature always overrides the grid.
· The Grid Setup command allows you to display the grid and to set the spacing of the 

grid points.
· Snap To Objects and Snap To Guidelines have priority over Snap To Grid. When all three

are on, an object being moved will snap to a snap point on a stationary object no 
matter how close that point is to a guideline or grid point.

· Turning Snap To Grid on will not affect the position of objects already on the screen.

Shortcut
Pressing CTRL+Y toggles Snap To Grid on and off



How to...
Align objects to the grid



Grid Setup command
(Display menu)
Controls the location of the grid's zero point, the spacing of the grid lines, and the grid 
display.

· When you save your drawing, the Grid settings are saved with it.
· If you change the grid spacing, objects in your drawing retain their position even if they

do not line up with the new grid line positions.
· When you change Grid Frequency units, the values in the dialog box are not 

converted. Each time you change units, you must specify the frequency you want to 
use with that unit.

Dialog Box Options

Grid Origin
Determines the zero point of the grid with respect to the lower left corner of the Printable 
Page. Useful as a reference point when sizing and placing objects.
Once you have specified the origin, the 0,0 intersection of the rulers is reset to that point.
Coordinates entered in dialog boxes and certain numerical readouts on the Status Line 
are related to the location of the Grid Origin. For example, the readout on the extreme left
side of the Status Line represents the distance of the cursor from the Grid Origin.
You can also use the ruler crosshairs to set the Grid Origin.
To use a different unit of measurement than the one currently selected, open the units list
and choose the one you want.

Grid Frequency
Determines the number of grid lines per unit of measurement.
To space the grid lines more than one whole unit of measurement apart, enter fractional 
values from the keyboard. For example, to space the grid lines two inches apart, enter 
0.5.
The maximum number of grid lines is 72 per inch, 12 per pica, 1 per point and 2.82 per 
millimeter.
When you change Grid Frequency units, the ruler units and those displayed on the Status 
Line are changed to match.
You can select another unit of measurement from the units box. When you change units, 
you must specify the Grid Frequency you want to use with that unit.

Show Grid
Displays markers showing where the grid lines intersect.
To avoid cluttering the screen, the frequency of the grid marks is determined by the 
current view. When you use the Zoom tool to magnify the view, the frequency of the grid 
marks increases.

Snap To Grid
Forces objects drawn or moved close to a grid line into alignment with the grid. You can 
also turn Snap To Grid on and off with the Snap To Grid command in the Display menu.



Shortcut
Double-clicking on a ruler displays the Grid Parameters dialog box



How to...
· Set the grid parameters
· Align objects to the grid



Snap To Guidelines command
(Display menu)
Toggles Snap To Guidelines on and off. Guidelines are non-printing lines that you can place 
anywhere in the editing window. With Snap To Guidelines on, an object drawn or moved near
a guideline snaps to it. Useful for aligning objects with precision.

· The position of objects already on the screen does not change when you turn Snap To 
Guidelines on.

· Snap To Objects has priority over Snap To Guidelines and Snap To Grid. When all three 
are on, the object being moved will snap to a snap point on a stationary object no 
matter how close that point is to a guideline or grid point. With Snap To Objects off, 
Snap To Guidelines has top priority.

· You can position guidelines by dragging them from the rulers, or by using the 
Guidelines Setup command.



How to...
Align objects to a guideline



Guidelines Setup command
(Display menu)
Lets you add guidelines at specific locations in the drawing window. Also lets you move and 
delete existing ones.

· You can also add, move and delete guidelines by dragging them with the mouse.
· With Snap To Guidelines on, an object drawn or moved near a guideline snaps to it.
· You can add as many guidelines as you need.

Dialog Box Options

Guideline type
Specifies the type of guideline to be added, moved or deleted.

Guideline position
Specifies the location of the guideline relative to the zero points on the rulers.

Snap To Guidelines
Forces objects into alignment with a guideline drawn or moved close to it. You can also 
turn Snap To Grid on and off with the Snap To Guidelines command in the Display menu.

Delete
Removes the guideline at the location displayed in the Ruler Position box.

Move
Moves the guideline to the new location specified in the Ruler Position box. If you have 
added more than one guideline, select the one you want to move by choosing the Next 
button. When its position appears, enter the new location, then choose the Move button.

Add
Adds a guideline at the position specified in the Ruler Position box.

Next
Cycles through all Horizontal or Vertical guidelines in the drawing window.

Shortcut
Double-clicking on a guideline displays the Guidelines dialog box.



How to...
Position guidelines in the drawing window



Snap To Objects command (Display menu)
Toggles Snap To Objects on and off. With Snap To Objects on, you can align any part of a 
moving object to a "snap point" on a stationary object. The location of the snap points varies
with the type of object. Click on the  button next to the object type for information about 
location of its snap points.

· Rectangles 
· Ellipses 
· Lines and curves 
· Text 
· Bitmaps 
· Extrusions and blends
· Linked and embedded objects
If the location used to select the moving object is within the snap range of one of its own 
snap points, the moving object will align with the stationary object on that point; not the 
actual point of selection.
Snap To Objects has priority over Snap To Grid and Snap To Guidelines. If all three are on, an 
object being moved will snap to a snap point on a stationary object no matter how close that
point is to a guideline or grid point.
Turning Snap To Objects on will not affect the position of objects already on the screen.



Rectangles
Simple rectangles and those with rounded corners have nine snap points.



Ellipses

Closed ellipses have four snap points: one at each end of the major and minor axes, and one
in the center.
Open ellipses can have as many as seven snap points: one at the ends of each major and 
minor axes, one in the center, and one at each termination point of the arc.
If the outline of the open ellipse does not pass through the end of a particular axis, then no 
snap point will exist there.



Lines and Curves

Lines and curves drawn with the Pencil tool have snap points at the endpoints and at each 
node in between.



Text

Artistic text has nine snap points, including one in the center. 

Paragraph text has snap points at each corner of its frame.



Bitmaps
Bitmaps have snap points at each corner and in the center. Rotated bitmaps have two 
additional snap points.



Extrusions and blends
The extruded object and the two original objects in a blend have the same snap points they 
had before they were extruded or blended.
Each extruded surface and intermediate shape in a blend has a snap point at its center and 
at the nodes along its outline. 



Linked and embedded objects
Snap points for linked and embedded objects occur at each corner of the object, in the 
center of its highlighting box and at either end of the "slash" used to represent the object in 
wireframe view.



How to...
Align objects using Snap to Objects



Show Rulers command (Display menu)
Turns the horizontal and vertical rulers along the edges of the drawing area on and off. The 
rulers are useful for determining the size and position of objects.

· A dashed line in each of the rulers follows your current cursor position.
· The number of increments (or 'tick' marks) on the ruler is determined by the current 

view. For    more accurate rulers, use the Zoom tool to magnify the view. The more you 
zoom in, the more accurate the rulers become.

· The Grid Frequency units determine the ruler's unit of measurement.
· The Grid Origin determines the location of the zero points on the rulers.
· When the rulers are on, you have access to the ruler cross hairs and the guidelines.



Show Status Line command
(Display menu)
Turns the Status Line near the top of the CorelDRAW window on and off. The Status Line 
displays useful information about objects you have already created, or are currently creating
or modifying.

· The left side of the Status Line always shows the position of the mouse pointer, and 
whether Snap To Grid and Snap To Objects is on.

· The right side of the Status Line shows the selected object's fill and whether it has an 
outline.

· The center portion of the Status Line shows what type of object is currently selected 
(rectangle, text, curve, etc.). Additional information displayed includes the dimensions 
of ellipses and rectangles, the point size of a selected text object, and the layer the 
selected object resides on.



Show Bitmaps command (Display menu)
Turns the display of bitmaps in the drawing area on and off. Using this command increases 
the screen redraw speed when working in wireframe view.

· When turned off, only the bitmap's frame appears.
· Bitmaps are always displayed when a drawing is previewed.



Show Color Palette command
(Display menu)
Displays a sub-menu with commands for turning the color palette on and off, and for loading
the palette with either Process or Spot color.

· You can change the order of the colors on the palette from the either the Uniform Fill or
Outline Color dialog box.

· Depending on settings selected in the Display dialog box, some of the colors on the 
palette will be displayed as pure color or dithered color. These settings are available 
only on specially equipped systems, and have no effect on the printed output.



How to...
· Control the display of colors
· Rearrange colors in the palette
· Change the default color palette



Edit Wireframe command (Display menu)
Toggles between editable preview and wireframe view. Editing a drawing in wireframe view 
is faster since only the object outlines need to be refreshed. To select an object in wireframe 
view,you must click on its outline.



Refresh Window command
(Display menu)
Redraws objects on the screen. Used to clear the screen of "dirt" left over from earlier 
manipulations, or to resume drawing after a display interrupt.

Shortcut
Press CTRL+W or click on scroll bar thumb



Show Preview command
(Display menu)
Removes everything from the screen except your drawing. Preview shows exactly how your 
drawing will appear when printed on all printers except PostScript printers. When printing to 
these devices, you won't be able to preview any PostScript texture fills and halftone screen 
effects in the drawing.

· You cannot edit in the Preview.
· To cancel the Preview, press F9.
· You can program the secondary mouse button to toggle between the editable preview 

and Preview. See the Preferences command.
· Use the Preview Selected Only command in the Display menu if you only want to 

preview portions of your drawing.
· The Paper Color option in the Page Setup dialog box  allows you to color the Preview 

screen to match the background of your drawing, or the color of paper it will be printed
on.

Shortcut
Press SHIFT+F9



How to...
· Color the drawing window and Preview screen
· Interrupt a screen redraw



Preview Selected Only command
(Display menu)
Turns previewing of selected objects on and off.

· When turned on, only the currently selected object appears. Useful for reducing 
redrawing times when working with complex drawings, and for identifying 
superimposed objects.

· When turned off, all objects currently in view in the drawing window are redrawn.



On-Screen Keyboard command
(Special menu)
Displays a keyboard if you have Windows set up to use a pen as an input device. The 
keyboard lets you access the CTRL and SHIFT keys which are needed, for example, to draw 
squares and circles and to select multiple objects. You can also use the keyboard to access 
function keys and to enter text that's difficult to print neatly.

· You can enter keyboard equivalents for CorelDRAW's menu commands by writing in the
Status Line. For example, writing the letter "P" will open the Print Options dialog box.

· Selecting the text tool, then drawing a check mark gesture anywhere in the drawing 
window, displays CorelDRAW's Text dialog box. Once in the Text dialog box, the gesture 
displays the Windows Edit Text dialog box.



Tip
The Windows Gesture Manager lets you create your own gestures for use in CorelDRAW. You 
might, for example, create gestures for accessing menu commands that do not have a 
keyboard equivalent. See the Pen Palette Help for more information.



Create Pattern command
(Special menu)
Lets you create your own Two-Color and Full-Color pattern fills. Patterns you create are 
added to those accessed through the pattern fill icons in the Fill tool Menu and the Fill Roll-
Up window.

· You can create patterns from graphics drawn with CorelDRAW, or imported from other 
sources, such as a scanner or paint program. When you fill an object with the pattern, 
the pattern becomes a tile that repeats in all directions inside the object.

· Patterns created from color bitmaps are converted to a dithered black and white 
image. If the bitmap contained a lot of detail, much of it will be lost in the conversion.

Dialog Box Options

Type
Saves the graphic as a Two-Color or Full-Color pattern.

Resolution
Determines the pattern's resolution. Generally, the higher the resolution, the better the 
pattern will look when printed. If the graphic consists of straight lines, or you intended to 
make a pattern less than 1/4 inch square, use Low resolution.

OK
Displays cross hairs for selecting the graphic. Drag a marquee box around the graphic 
and then respond to prompt. If you select OK and you are creating a full-color pattern, 
another dialog box appears.
File Name
Type a name for the pattern file. If you want or overwrite an existing file, select its name 
from the list.
Directories
Use to select the directory in which you want the file stored.
List Files of Type
Shows Pattern File (PAT) as file type being created.
Drives
Use to select the drive in which you want the pattern stored.
Image Header
Adds an image header to the file. You can specify the type (monochrome or color) and 
size of header in kilobytes.



How to...
Create pattern fills



Create Arrow command
(Special menu)
Lets you create your own arrowheads and line ending shapes.

· Those you create are added to the selection in the Outline Pen dialog box and the Pen 
Roll Up window. CorelDRAW limits the number of arrowheads to 100. If you already 
have this many and want to create new ones, you must delete some of the existing 
ones first.

· When you draw the arrowhead, do not be concerned with how large or small it will look
when its applied to a line. You can adjust the size later using the Arrowhead Editor.

· If the arrowhead consists of more than one object, combine the objects with the 
Combine command    before creating the arrowhead.

· To create an outlined arrowhead instead of a filled one, use the Shape tool to break the
object at a node. If you have drawn an angled object (rectangle, triangle, etc.), convert
it to curves using the Convert to Curves command . Next, use commands in the Node 
Edit menu to add a node between the corners, then break the shape at that node.

· The arrowhead assumes the same outline color and thickness as the line it is applied 
to.



How to...
· Apply arrowheads and line ending shapes
· Create arrowheads and other line ending shapes



Preferences command (Special menu)
Controls settings which affect how CorelDRAW displays objects on the screen and how it 
performs certain operations. You can change these settings at any time.

Dialog Box Options

Place Duplicate
Controls the amount by which objects duplicated with the Duplicate command are offset 
from the original.
Positive values shift the duplicate up or to the right, and negative values down or to the 
left.
To use a unit of measurement other than the one selected, open the units list and choose 
a different one.

Nudge
Controls how far an object moves when you press the Direction keys on the numeric 
keypad.
To use a unit of measurement other than the one selected, open the units list and choose 
a different one.
The maximum allowable value is two inches, or an equivalent amount in the other units of
measure. The minimum varies with the unit of measurement:
Inches 0.001
Millimeters 0.1
Picas, point0,1
Points 0.1

Constrain Angle
Controls the angle of motion when performing any of the following operations with the 
CTRL key held down:
· Skewing or rotating
· Drawing straight lines in Freehand mode
· Adjusting control points when drawing in Bezier mode

Miter Limit
Affects the appearance of corner joints. Any corner that is less than the Miter Limit will 
have a bevelled point.    Those above the limit will come to a sharp point. This limit exists 
to avoid corners that extend far beyond the actual corner at small angles.

Auto-panning
Toggles auto-panning on and off. With auto-panning on, the drawing window 
automatically scrolls when you drag beyond its edges.

Cross Hair Cursor
Turns the mouse pointer into cross hairs that extend the full width and length of the 
drawing window.

Interruptible Display
Allows you to stop a screen redraw by clicking with the mouse or pressing a key. This lets 
you isolate a particular object in a complex drawing, or select a menu command or tool 



without waiting for the screen to redraw completely.
Redrawing resumes after you perform another action, or when you request a redraw with 
the Refresh Window command.

Curves
Displays a dialog box for adjusting settings which affect the way the Pencil tool draws 
lines and curves, and the way it autotraces bitmaps. See Preferences - Curves dialog box.

Display
Displays a dialog box for turning the display of the Page Border on and off, and for 
adjusting settings which affect the way CorelDRAW displays fountain fills, colors, curves, 
and Paragraph text. See Preferences - Display dialog box.

Mouse
Displays a dialog box with a list of functions you can assign to the secondary mouse 
button. See Preferences - Mouse dialog box.

Shortcut
Pressing CTRL+J displays the Preferences dialog box



Preferences - Curves dialog box
Use this dialog box to change the settings which control the way the Pencil tool draws lines 
and curves, and the way it autotraces bitmaps.

Dialog Box Options

Freehand Tracking
Controls how closely CorelDRAW tracks the motion of the mouse when drawing in 
Freehand mode. The lower the number, the rougher the curves tend to appear.

Autotrace Tracking
Controls how closely the Bezier curve follows the edges of a bitmap traced using 
CorelDRAW's autotracing feature. Low numbers (1 to 3 pixels) tend to produce more 
accurate results.

Corner Threshold
Controls when CorelDRAW draws a smooth corner or a cusp when drawing in Freehand 
mode, and when autotracing a bitmap. The lower the number, the greater the tendency 
toward cusps.

Straight Line Threshold
Controls when CorelDRAW draws a straight or curve segment when drawing in Freehand 
mode, and autotracing a bitmap. The lower the number, the greater the tendency toward 
drawing curves.

AutoJoin
Controls the Autojoin radius when drawing in Freehand or Bezier mode. The lower the 
number, the closer the cursor must be to the end node of an existing segment in order for
the next segment to automatically join with it.



Preferences - Display dialog box
Use this dialog box to turn the display of the Page Border on and off and to adjust settings 
which affect the way CorelDRAW displays fountain fills, colors, curves, and Paragraph text.

Dialog Box Options

Preview Fountain Stripes
Determines the number of stripes used to represent fountain fills on the screen. Also 
affects the appearance of fountain fills in drawings exported in the following formats:
· Illustrator (AI, EPS)
· Computer Graphics Metafile (CGM)
· MAC PICT (PCT)
· Windows Metafile (WMF)
· All bitmap formats
Selecting a lower value (less than 20) speeds up screen redraws, but results in noticeable 
banding.
You can control the number of stripes used to print fountains with the Fountain Stripes 
setting in the Print Options dialog box.

Greek Text Below
Simplifies the appearance of Paragraph text below the size specified. If your file contains 
large amounts of small text, selecting a high value (maximum 500) causes the text to 
display as small blocks, resulting in faster screen redrawing. Using this option does not 
affect the appearance of text when printed.
NOTE: Depending on how high you set Greek Text Below, greeked text becomes readable 
when you magnify it with the Zoom tool. For example, 10-point text becomes readable 
with the setting at approximately 125.

Preview Colors
Controls how CorelDRAW displays colors on your screen, and has no effect on the printed 
output. To use these settings, you must have a monitor or graphics adaptor that can 
display 256 simultaneous colors and a Windows screen driver that takes advantage of this
capability.
Whenever settings are changed, update the palette along the bottom of the CorelDRAW 
screen by clicking on either of the palette's scroll arrows with the right mouse button.
256-Color Dithering
Displays color using CorelDRAW's dithering scheme.
Windows Dithering
Displays color using the screen driver's default dithering scheme. If you have a 256-color 
adaptor, your screen may redraw faster with this option selected. However, only 15 of 
these colors will be used in the dithering scheme.
Optimized Palette for Full Screen Preview
Loads your adaptor's palette with pure colors contained in the currently displayed 
drawing. If the number of colors exceeds the capacity of the palette, CorelDRAW will use 
the closest matching color. You can only use this option in Preview mode. Colors in editing
mode are displayed as dithered.

Curve Flatness



Determines the number of line segments CorelDRAW uses to represent curves on the 
screen and on non-Postscript printers. The higher the number, the faster the curves 
redraw and print. Useful for editing and printing proofs of complex drawings.
You can control the number of segments a Postscript printer uses to draw curves with the 
Flatness setting in the Print Options dialog box.

Show Page Border
Toggles the display of the Page Border on and off.



Mouse dialog box
Lets you assign a function to the right mouse button.

Dialog Box Options

Not Used
Leaves the button unassigned.

2x Zoom
Magnifies the area under the cursor by a factor of two each time the right mouse button 
is pressed. Double-clicking returns to the view you were at before the last zoom-in. You 
can zoom in up to 20 times in a row, after which you must double-click on the right mouse
button to zoom out before zooming in again.

Edit Text
Displays the Text dialog box when a text object is selected.

Full Screen Preview
Toggles between a full screen display of the Preview window and the normal display 
mode.

Node Edit
Chooses the Shape tool.



Contents command (Help menu)
Displays the opening CorelDRAW Help screen. From this screen, you can choose the type of 
Help you want. When you are in Help, clicking on the Contents button takes you back to the 
opening screen.

Shortcut
Pressing F1 displays the CorelDRAW Help Contents, or a Help topic on the selected 
command or open dialog box.



Screen/Menu Help command
(Help menu)
Changes the mouse pointer to an arrow with a question mark. You can then click on an 
available menu command or a part of the screen (for example, a tool in the toolbox), to get 
Help about that item. You can also press a function key or key combination such as CTRL+P, 
to get Help about the command or tool associated with it.
NOTE: To get Help on unavailable (gray) commands, select the command and press F1.

Shortcut
Pressing SHIFT+F1 displays the Help pointer.



How to Use Help command
(Help menu)
Displays topics which explain how to use Help. You can access the same information from 
the Help window by choosing the Using Help button, or pressing F1.



Search for Help On command
(Help menu)
Displays the Search dialog box where you enter keywords to search for a specific Help topic. 
The Search dialog box can also be opened by choosing the Search button from the Help 
window.

Shortcut
Pressing CTRL+F1 displays the Search dialog box.



Tutorial command (Help menu)
Displays a window with lessons designed to get you started using CorelDRAW. The Tutorial is 
an option you can choose to install with CorelDRAW. If you chose not to install it, use the 
Setup Program to install the Tutorial on your system. See Installing options with the Setup 
Program.



About CorelDRAW command
(Help menu)
Displays a dialog box with information about which version of CorelDRAW you are running, 
the number of objects and groups of objects in the current drawing, and the amount of 
space available on the drive last used to save or open a file.



 Tools
Listed below are tools available in the toolbox. Select a tool to view information about its 
function.

 Pick Tool
 Shape Tool
 Zoom Tool
 Pencil Tool
 Rectangle Tool
 Ellipse Tool
 Text Tool
 Outline Pen Tool
 Fill Tool



Pick Tool 
Selects objects or groups of objects.
After you select an object, you can use commands in the menus or the toolbox to change its 
appearance.
You can also use the Pick Tool to interactively move, stretch, scale, rotate, and skew objects.

· How you select an object depends on the view you are working in and whether the 
object has a fill.
To select... click on...
a filled object in anywhere on the object
editable preview
an unfilled object the object's outline
in editable preview
an object in the object's outline
wireframe view

· You can also select an object in either view by dragging a marquee box around it.
· When an object is selected, a highlighting box with eight handles appears.
· When you select a single object, the Status Line indicates the type of object selected 

(text, rectangle, ellipse, bitmap or curve), its Outline and Fill attributes, and the layer it 
is on.

· When you select a single group, the number of objects in the group is displayed. If you 
select multiple groups, or objects and groups, the Status Line counts the groups as 
single objects.

NOTE:    If the Multilayer option is selected in the Layers Roll-Up window, you can select any
object on the screen. Otherwise, you can only select objects in the on the active layer.

Shortcuts
· Pressing the SPACE BAR while using any of the drawing tools activates the Pick Tool.
· Pressing the SPACE BAR while the Pick Tool is selected activates last drawing tool used.
· Pressing the ESCAPE key deselects all objects.



How to...
· Select an object
· Select multiple objects
· Select grouped objects
· Deselect an object
· Select next/previous object
· Select individual objects in a group
· Select nested groups
· Select objects on other layers



Shape Tool 
The function of the Shape Tool varies depending on the type of object selected.
Object Type Function
Line/Curve Changing the shape by moving nodes and control points and using the 

Node Edit menu
Text Editing character attributes and interactive kerning
Bitmaps Cropping
Rectangle/Square Rounding corners
Ellipse/Circles Creating arcs and pie wedges

Shortcut
Pressing F10 selects the Shape Tool.



How to...
Shape objects



Node Edit Menu
This menu is available when editing a curve object with the Shape Tool. To display the menu,
double-click on the node or segment you want to edit.
Delete Deletes the selected node or segment. Use to remove surplus nodes from an 

excessively complex drawing and to smooth unwanted bumps along a curve.
Add Adds a node at the spot along the segment that you double-clicked on. Add nodes

if you cannot shape a curve the way you want by moving the existing nodes and 
control points.

Break Splits the curve into two or more subpaths. Useful for separating curves in a 
traced bitmap.

Join Connects two nodes at the beginning or end of curve segments that are part of 
the same path. Use to close an open path or make two different paths into a 
single continuous curve.
You can join nodes on curves that are on separate paths by first combining the 
paths with the Combine command in the Arrange menu.

toLine Changes the selected curve segment to a line segment.
toCurve Changes the selected line segment to a curve segment.
Cusp Changes the selected node to a cusped node. Use when you want to add a sharp 

bend to a curve.
Smooth Changes the selected node to a smooth node. Use when you want a different 

curvature on each side of the node.
Symmet Changes the selected node to a symmetrical node. Use when you want the same 

curvature on both sides of the node.
Align Aligns two nodes and their associated control points. Use to align the edges of 

objects that share a common boundary such as regions of a map.
To align nodes on different paths, you must first combine the paths with the 
Combine command in the Arrange menu.



How to...
· Add nodes to a curve object
· Delete nodes and segments from a curve object
· Determine if you need to add or delete nodes
· Align nodes and control points
· Break a curve object at a node
· Change a segment to a curve or line
· Join nodes to close an open path or connect separate paths
· Make a node smooth, cusped or symmetrical



Zoom Tool 
Displays a menu with five viewing icons.

(Zoom In) Magnifies a portion of the screen.
(Zoom Out) Zooms out by a factor of two 
each time you click or returns to the view you 
were at before the last zoom-in.
(Actual Size) Displays the drawing at the size
at which it will print.
(Fit In Window) Brings all objects in the 
drawing into view.
(Show Page) Displays the entire Printable 
Page .

Shortcuts
· Pressing F2 selects the Zoom-in icon.
· Pressing F3 returns to previous view or zooms out by a factor of two.
· Pressing F4 brings all objects in the drawing into view.



How to...
· Magnify and reduce the view of a drawing
· View all objects in the drawing window
· View drawings at actual size



Pencil Tool 
Draws lines, curves and traces bitmaps. Holding the mouse button down on the Pencil tool 
icon displays a menu that lets you choose the drawing style you want to use.

 Freehand A click and drag style of drawing similar to the way you move a pencil 
on paper.

 Bezier A connect-the-dots style of drawing where you specify the start and end 
points of the line/curve you want to draw which CorelDRAW then connects.

Settings in the Preferences - Curves dialog box let you control the sensitivity of the Pencil 
Tool. For example, you can adjust how closely CorelDRAW follows the motion of the mouse 
when drawing Freehand curves.
Lines and curves drawn with the Pencil tool are automatically assigned the current default 
Outline Pen and Outline Color attributes. For information on changing the defaults, see 
Specify the default outlines attributes for new objects

Shortcut
F5 selects the Pencil Tool.



How to...
· Change the line/curve drawing mode
· Draw curves in Freehand mode
· Draw curves in Bezier mode
· Draw straight lines in Freehand mode
· Draw straight lines in Bezier mode
· Set line and curve drawing preferences
· Trace a bitmap



Rectangle Tool 
Draws rectangles and squares.

· The Status Line displays the dimensions of the rectangle/square as you draw it.
· Objects drawn with the Rectangle tool are automatically assigned the current default 

Fill, Outline Pen and Outline Color attributes. For information on changing the defaults, 
see Specify the default outlines attributes and Specifying the default fill for new 
objects.

· To immediately select the rectangle/square, press the SPACE BAR.
· To switch between the Rectangle tool and the Pick tool, press the SPACE BAR.

Shortcut
Pressing F6 selects the Rectangle Tool.



How to...
· Draw rectangles and squares
· Draw rectangles and squares with round corners



Ellipse Tool 
Draws ellipses and circles.

· The Status Line displays the dimensions of the ellipse/circle as you draw it.
· Objects drawn with the Ellipse tool are automatically assigned the current default Fill, 

Outline Pen and Outline Color attributes. For information on changing the defaults, see 
Specify the default outlines attributes and Specifying the default fill for new objects.

· To immediately select the ellipse/circle, press the SPACE BAR.
· To switch between the Ellipse tool and the Pick tool, press the SPACE BAR.

Shortcut
Pressing F7 selects the Ellipse Tool.



How to...
· Draw ellipses and circles
· Draw arcs and pie wedge



Text Tool 
Adds text and symbols. Holding the mouse button down on the Text tool displays a menu 
with two icons.

 Text Lets you enter text directly on the screen as either strings of Artistic text or 
blocks of Paragraph text. 

Entering text as Artistic text allows you to fit the text to a path and create special 
effects using commands in the Transform and Effects menu. You can add as many strings of 
Artistic text as you want with each string limited to 250 characters.

Paragraph text is intended for text-intensive applications such as ads and brochures. 
You can add as many blocks of Paragraph text as you want with each block limited to about 
4000 characters.

To... do this
Add Artistic Text Select the Text tool and click in the drawing window.
Add Paragraph Text Select the Text tool and drag to set margins.
Edit text Select the Text tool then drag to highlight the text you want to 

edit.    Use the Arrow keys to move the insertion point to where 
the new text should start then type the new text. Use the 
BACKSPACE and DEL keys to delete the highlighted text or type
over it.
OR
Select the text with the Pick tool then choose the Edit Text 
command in the Edit menu. Edit the text in the Text Editing 
window.

Format text Select all the text with the Pick tool, or portions of the Text. 
Choose the Edit Text command or applicable formatting 
commands in the Text menu.

Change Outline or Fill Select the text with the Pick tool or individual characters with 
the Shape tool, and then choose the attributes you want from 
the Outline and Fill tool menus, the Pen and Fill Roll-up 
windows, or the on-screen color palette.

 Symbols Adds symbols to your drawing.
After choosing the Symbols icon, click where you want the symbol to appear. The 

Symbols dialog box will open with a list of the symbols you can choose.
The Text tool remains in Symbol selection mode until you switch to text entry mode 

or exit CorelDRAW.
New text is drawn at 24 points using the normal Avalon typeface. You can specify a different 
default typeface, style and point size. See Changing the default font for new text and 
Changing the default text attributes for the current session.
You can also change the default outline and fill attributes for new text and symbols. See 
Specifying the default outlines attributes and Specifying the default fill for new objects.
The Status Line displays the typeface, style and point size for Artistic text. For paragraph 
text, only typeface and style are displayed.

Shortcut
Pressing F8 selects the Text Tool.



How to...
· Work with Text and Symbols



Symbols dialog box
Lets you select symbols from CorelDRAW's Symbols Library.

· The complete Symbols Library is an installable option selected during the installation of
CorelDRAW. If you chose not to install the complete library, you'll need to run the 
CorelDRAW Setup Program and copy just the Symbols to your hard disk. See Installing 
options with the Setup Program.

· You can use the symbols as they are or edit them just as you would any other object in 
CorelDRAW.

· Symbols are automatically assigned the current default Fill, Outline Pen and Outline 
Color attributes. You can change the defaults by choosing the Outline and Fill tools with
no objects selected. See Specify the default outlines attributes and Specifying the 
default fill for new objects.

Dialog Box Options

Symbol Selection Box
Displays the first symbol in the selected category. Click on the symbol to display a list of 
others in the category.

Category Selection Box
Lists the Symbols categories. Use the scroll bars to see other categories in the list. 

Size
Specifies the size of the symbol. You can also use the Pick Tool to resize the symbol after 
it's been added to your drawing.
If you want to use a different unit of measurement, open the units list and choose the unit
you want.

Symbol #
Displays the Symbol Index Number. If you prefer, you can select a symbol by entering its 
Index Number from the Symbols and Clipart Catalog rather than using the visual selector.

Shortcut
Pressing F8 selects the Text Tool.



How to...
Add symbols



Outline Tool 
Displays a menu from which you can select preset outline thicknesses, and colors. Also 
provides access to dialog boxes for specifying custom outline thicknesses, patterns, pen 
shapes, and colors.
If the selected object is a monochrome bitmap , you can specify the color and halftone 
screen used to print it.

· You can also select outline colors from the on-screen palette or the Pen Roll-Up window.
· The Status Line shows the selected object's outline thickness and color.

Menu Icons

Custom Outline 
Displays the Outline Pen dialog box or the Outline Pen for New Object dialog box if no 
object is selected.
Choose this icon if you want to specify custom attributes including outline thickness, line 
pattern, calligraphic pen effects, and arrowheads. Choose it, with no object selected, if 
you want to change the default Outline Pen attributes.

Pen Roll-Up Window 
Displays a roll-up window for quick access to various outline attributes including line 
thickness, style, color, and arrowheads. See Pen Roll-Up window. 

None 
Removes outlines from the selected object(s).
You can also remove outlines by clicking on the secondary mouse button on the  button 
at the left end of the color palette.

Line Widths 
Selects line thicknesses ranging from 1/4 (hairline), 2, 8, 16, and 24 points.

Custom Outline Color 
Displays the Outline Color dialog box or the Outline Color for New Object dialog box if no 
object is selected.
Choose this icon if you want to specify a custom outline color, or with no object selected, 
change the default Outline Color attributes.

Black, White, Gray 
Selects white, black and five shades of gray (10%, 30%, 50%, 70%, and 90%).

Shortcuts
· Pressing F12 with an object selected displays the Outline Pen dialog box.
· Pressing SHIFT+F12 with an object selected displays the dialog box that was last used 

to specify an object's outline or fill color.





How to...
· Choose a line thickness
· Choose an outline color
· Remove an object's outline
· Choose a dashed and dotted line style
· Copy an object's outline
· Create calligraphic outlines
· Apply arrowheads and line ending shapes
· Edit an arrowhead/line ending shape
· Create arrowheads and other line ending shapes
· Apply halftone screens
· Specify default Outline attributes



Pen Roll-up window
The Pen Roll-up window gives you quick access to a variety of outline attributes.
If you choose an attribute with no object selected and then click on the Apply button, a 
dialog box appears allowing you to assign that attribute as the default for a particular type 
of new object. For example, you can select an outline color and have it assigned as the 
default outline for all objects except text.

Window Controls

Roll window icon 
Hides the controls leaving just the title bar visible.

Thickness Selector
Selects a line thickness from .001 to 0.5 inches. Each click on the scroll arrows changes 
the thickness by .01 inches. Scroll down repeatedly for the hairline or no outline options.

Arrowhead Selectors
Displays a box with a selection of arrowheads you can apply to the ends of open paths. 
The left and right selectors let you choose different arrowheads for both ends of the path.
Use the scroll bars to see other arrowheads in the list. When you find the one you want, 
click on it. To close the box without making a selection, press the ESC key.

Line Style Selector
Displays a selection of dashed and dotted line styles.
Use the scroll bars to see other styles in the list. When you find the one you want, click on
it. To close the box without making a selection, press the ESC key.

Color Selector
Displays a palette of outline colors. Use the scroll bars to see other colors in the list. 
When you find the one you want, click on it. To close the box without making a selection, 
press the ESC key.
You can rearrange colors in the list by dragging them to different spots.

Update From...
Loads the selected object's outline into the roll-up window so that you can make changes 
to it. After making changes choose the Apply button.
You can also use Update From to copy another object's outline to the selected object. 
Click on the object with the outline you want to copy,    click on the Update From... 
button, then on the Apply button. 

Edit
Displays the Outline Pen dialog box where you can access all of the available Outline Pen 
controls.

Apply
Applies your choices to the selected object.



How to...
· Using Roll-up windows
· Choose a line weight
· Choose an outline color
· Remove an object's outline
· Choose a dashed and dotted line style
· Copy an object's outline
· Apply arrowheads and line ending shapes



Outline Pen dialog box
Controls the color, width, and shape of the pen used to draw the object's outline. You can 
also apply arrowheads to lines and choose dashed and dotted outlines from this dialog box.

Dialog Box Options

Color
Displays the object's current outline color and the color's name. Clicking on the color 
button displays a box with other colors you can choose. 
Use the scroll bars to see other colors in the list. When you find the one you want, click on
it. To close the box without making a selection, press the ESC key.

More
Displays the Outline Color dialog box for creating custom colors and selecting them by 
name.

Arrows
Displays a selection of arrowheads and symbols you can apply to the ends of lines.The 
left button selects an arrowhead for the beginning of the line, the right button for the end 
of the line. You can determine which end of the line is the beginning by selecting it with 
the Shape Tool and pressing the HOME key.
Use the scroll bars to see other colors in the list. When you find the one you want, click on
it. To close the box without making a selection, press the ESC key.
You can add arrowheads of your own design to the existing selection using the Create 
Arrow command in the Special menu.

Options
None
Removes the displayed arrowhead.
Swap
Puts the arrowhead at the other end of the line.
Edit
Displays the Arrowhead Editor which let you change the size and placement of the 
arrowhead.
Delete From List
Deletes the displayed arrowhead from the list.

Width
Varies the thickness of the outline.
A value of 0.00 prints a line one pixel wide at the printer's current resolution. If you 
change to a higher resolution printer, be aware that the line will print much thinner.
If you want to use a different unit of measurement, select it from the units box. 
CorelDRAW will automatically convert the displayed value to its equivalent in the unit you 
select.

Style



Displays a box with a selection of dashed and dotted line styles. Use the scroll bars to see
other colors in the list. When you find the one you want, click on it. To close the box 
without making a selection, press the ESC key.
Dotted lines are created by applying round Line Caps to a line style with short, widely 
spaced segments.
You can create your own line styles and have them added to the list in the dialog box. You
do this by editing a section in your CORELDRW.INI file.See CORELDRW.DOT   File  .

Corners
Controls how outlines are drawn on objects with sharp corners. Also selects a square or 
round Pen Shape.
 Mitered
Draws mitered corners. You may need to adjust the Corner Threshold setting in the 
Preferences dialog box to prevent corner points from extending too far. Selecting Mitered 
also selects a square Pen Shape.
 Round
Draws rounded corners. Also selects a round Pen Shape.
 Bevelled
Draws blunted corners. Also selects a square Pen Shape.

Line Caps
Controls how the ends of lines and open curve objects are drawn. The same selection is 
applied to both ends of the line/curve and the ends of all dashed and dotted line 
segments.
 Butt
Squares the line off at each end.
 Round

Draws round caps extending beyond the ends of the line.
 Square

Draws square caps extending beyond the ends of the line.

Calligraphy
Controls the shape and orientation of the Outline Pen. Used to create calligraphic pen 
effects.
Nib Shape
Shows the effects of varying Angle and Stretch. You can vary Angle and Stretch by 
dragging in this box.
Angle
Varies the angle of the pen.
Stretch
Changes the Pen Shape from square to rectangular or from round to elliptical.
Default
Resets Angle to 0.0 degrees and Stretch to 100%.

Behind Fill
Specifies whether the outline is placed behind, or in front of the object's fill. Used when 
creating outlined text.
When placed behind, only half the outline's thickness will be visible.



Scale With Image
Specifies whether the thickness of the object's outline remains the same or changes in 
proportion to the object's size. If selected, the outline thickness increases when the object
is enlarged (either by scaling or stretching) and decreases when reduced. 
Also causes the Pen Shape Angle to rotate along with the object.

Shortcut
Pressing F12 with an object selected displays Outline Pen dialog box.



How to...
· Choose a line thickness
· Choose an outline color
· Remove an object's outline
· Choose a dashed and dotted line style
· Create calligraphic outlines
· Apply arrowheads and line ending shapes
· Edit an arrowhead/line ending shape
· Create arrowheads and other line ending shapes
· Specify default Outline attributes



Outline Pen for New Object dialog box
Lets you specify the Outline Pen attributes assigned to new objects in the current drawing 
and in future drawings.

· This dialog box appears when you choose the pen icon from the Outline Tool menu with
no objects selected. It will also appear if you choose an attribute from the Pen Roll-up 
window with no objects selected, and then click on the Apply button.

· Similar dialog boxes let you define a default Outline Color as well as default Uniform, 
Fountain, and PostScript texture fills.

Dialog Box Options

All Objects
Assigns default attributes to all new objects.

Text Objects
Assigns default attributes to new text objects only.

Other Objects
Assigns default attributes to all new objects except text.

OK
Displays the Outline Pen dialog box.

Shortcut
Pressing F12 with no object selected displays the Outline Pen for New Object dialog 
box.



How to...
Specify the default outline attributes for new objects



Outline Color for New Object
Lets you specify the default Outline Color attributes assigned to new objects in the current 
drawing and in future drawings.

· This dialog box appears when you choose the color wheel icon from the Outline Tool 
menu with no objects selected. You will also see it if you choose a color from the Pen 
Roll-up window with no objects selected, then click on the Apply button.

· Similar dialog boxes let you define default Outline Pen attributes as well as default 
Uniform, Fountain, and PostScript texture fills.

Dialog Box Options

All Objects
Assigns default attributes to all new objects.

Text Objects
Assigns default attributes to new text objects only.

Other Objects
Assigns default attributes to all new objects except text.

OK
Displays the dialog box last used to specify an object's outline or fill color.

Shortcut
Pressing SHIFT+F12 with no object selected displays the Outline Color for New Object 
dialog box.



How to...
Specify the default outline attributes for new objects



Arrowhead Editor
Use this dialog box to size the selected arrowhead or line ending shape and position it with 
respect to the start and end points of the line.

Dialog Box Options

Reference Line
Solid black line representing the line in your drawing to which the arrowhead is applied. 
Used to gauge the arrowhead's size and position.

Moving Handles
Hollow markers along the outline of the arrowhead and at the tip of the Reference line. 
Drag these to move the arrowhead or reference line.

Stretching/Scaling Handles
Solid markers around the arrowhead. Drag the corner handles to scale and the middle 
handles to stretch the arrowhead.

Guidelines
Three dotted lines used to align the arrowhead. As you drag a moving handle close to a 
guideline, the handle snaps to it ensuring precise alignment.

Reflect in X
Flips the arrowhead horizontally.

Reflect in Y
Flips the arrowhead vertically.

Center in X
Centers the arrowhead horizontally with respect to the X marker.

Center in Y
Centers the arrowhead vertically with respect to the X marker.

4x Zoom
Magnifies the arrowhead by a factor of four. Helpful when positioning the arrowhead.



How to...
Edit an arrowhead/line ending shape



Outline Color/Uniform Fill
dialog box
Use these dialog boxes to specify the selected object's outline or fill color.

· You can also select outline and fill colors from the Fill and Outline Pen roll-up windows 
and the on-screen color palette.

· If you are using a color monitor, remember that the colors you see will not match the 
printed colors exactly. To accurately specify Process colors, use the CorelDRAW Process
Color Chart or a TRUMATCH Color Reference if you are choosing colors from the 
TRUMATCH palette. To specify Spot colors, use the PANTONE Color Reference.

· Colors previewed on monochrome monitors and printed on black and white printers will
appear as appropriate shades of gray.

Dialog Box Options

Method
Selects a Color Specification Method.
Process Color
Defines color by combining percentages of Cyan, Magenta, Yellow and Black. Use this 
method if your graphic contains several different colors which you plan to reproduce on 
an offset printing press. Process color can also be used when printing directly to a color 
printer or film recorder.
Spot Color
Defines color using the PANTONE Matching System (PMS). Spot color is appropriate for 
creating graphics that contain only a few colors that you intend to separate on paper or 
film. You can also use it when printing directly to a color printer or film recorder. 
NOTE: If your drawing contains only shades of gray, and you want to apply different 
PostScript halftone screens to them use the Spot method.
For more information on selecting a Color Specification method, see the"Creating and 
Managing Color Palettes" chapter in your CorelDRAW User's Guide.

Model
Displays controls for creating and selecting colors.
CMYK, RGB, HSB
Allows you to create custom process colors using one of three Process color models.
You can create colors by specifying percentages in the text boxes or by dragging color-
adjustment markers in the visual selector.
CorelDRAW automatically performs Gray Component Replacement when you create a 
color with the CMYK visual selector.
If you print color separations, colors specified with the HSB    and RGB models will be 
converted to their CMYK equivalents.
After you create a color, CorelDRAW applies it to the selected object but does not add it 
to the palette unless you type a name in the Color Name box and choose Add Color To 
Palette from the Palette> menu. 
Palette
Allows you to select an existing color. 



Holding the mouse button down on a color and dragging lets you move the color to 
another spot in the palette. When you return to your drawing, the palette at the bottom of
the screen will also show the color in it's new position.
The % tint control below the Spot color palette adjusts the density of the selected Spot 
color. 
Name
Allows you to select colors by name.
Search String
Lets you find a particular color by typing some part of its name. As you type, the list box 
scrolls automatically to the color that most closely matches what you type. For example, 
if you type "or" the color "Pantone Orange 021 CV" will be highlighted. (Note: you do not 
need to type the word "Pantone".)

Color Preview Box
Displays the selected object's current outline/fill color at the top and the new color you 
select or create at the bottom.

Color Name
Displays the selected color's name. When you create a color, type a name for it in this 
box.
If you want to edit an existing color's name, select the color from the palette, then choose
Names from the Color Model menu.

Palette >
Displays a menu with commands for managing the palettes.
Add Color To palette
Adds a color you create to the end of the palette.
Delete Color From palette
Deletes the selected color from the palette. 
Load New Palette
Displays the Open Palette dialog box where you can select different color palettes to load 
into CorelDRAW.
Save Palette
Saves the palette under the name displayed next to the Palette> button. Use this 
command to save a palette that you have modified by adding, deleting or rearranging 
colors.
Save Palette As
Displays the Save Palette dialog box where you can assign a new name to the current 
palette.
Set As Default Palette
Loads the current palette each time you start CorelDRAW.

PostScript Options...
Displays the PostScript Options dialog box. Used to specify halftone screens for Spot 
colors. Also used to specify overprinting of both Spot and Process colors.

Shortcut
Pressing SHIFT+F12 with an object selected displays the dialog box last used to specify 
an object's outline/fill color.





How to...
· Choose an outline color
· Choose a fill color
· Create custom Process colors
· Add a tint of Spot color to the palette
· Open and save a color palette
· Delete a color from a palette
· Rearrange colors in the palette
· Change the default color palette
· Convert a Spot color to its Process color equivalent



PostScript Options
Controls halftone screens used to print the selected object's fill or outline. Also used to 
overprint colors when producing color separations.

· Screens are available only when printing Spot colors on a PostScript printer.
· The effect of varying the halftone screen parameters will not appear on screen, but 

they will show up when printed. The effects of overprinting appear in color proofs and 
in the final printed output only.

· All other objects except those whose screen settings you specify in this dialog box print
using the screen settings specified in the Print Options dialog box.

Dialog Box Options

PostScript Halftone Screen
Type
Lists the types of screens by the shape of the halftone dots.
The Default type uses the printer's default screen parameters unless overridden in the 
Print dialog box. A dot screen with 60 lines per inch at 45 degrees has typical screen 
parameters for a 300 dpi laser printer.
Frequency
Controls the resolution of the screen. The lower the frequency, the more apparent the 
screen will appear when printed.
Choosing an appropriate frequency depends on the resolution of your printer and the 
results you want to achieve. For example, settings of 100 or more are appropriate when 
printing on a high-resolution image setter. When printing on a 300 dpi laser printer, use a 
value from 60 to 80. Values below 40 are useful for creating special effects.
Frequency also affects the number of gray levels in the printed output: the higher the 
frequency, the fewer the number of gray levels.
Angle
Controls the angle of the screen.
Screen angle does not change when you rotate or skew an object. These, along with other
transformations such as stretching and scaling, can significantly change the appearance 
of coarse line screens.

Color Separation
Overprint
Causes the selected object to print on top of the object beneath it. Used to create trap, a 
process that prevents gaps from appearing between adjacent areas of Spot or Process 
color. You can also overprint Spot colors to create certain visual effects.



How to...
· Overprint Spot colors
· Create trap
· Apply halftone screens



Open Palette dialog box
Use this dialog box to load different Process color palettes supplied with CorelDRAW as well 
as ones you have modified and saved with the Save Palette As command .

· The Process color palettes differ in the number and range of colors they contain. They 
also differ in the way in which their colors are displayed on the screen: one uses 
dithered color while the others use pure color.

· The default process color palette, loaded when you first installed CorelDRAW, is the 
CORELDRW.PAL palette. Another palette with the same colors, PURE99.PAL, is provided as
a backup to the default one.

· The TRUMATCH palette lets you specify Process colors using the TRUMATCH Swatching 
System. By using this palette along with a TRUMATCH color reference book, you can be 
reasonably certain how the colors will look when printed.

· There is only one Spot color palette, CORELDRW.IPL.

Dialog Box Options

File Name
Selects the palette you want to open. Either type the name of the file or select it from the 
list.

Directories
Selects the directory in which the palette you want to open is stored.

List Files of Type
Selects Palette File as the type of file to be opened.

Drives
Selects the drive in which the file you want to open is stored.



How to...
Open and save a color palette



Save Palette As dialog box
Allows you to save a palette that you have modified by adding, deleting or rearranging 
colors. Creating custom palettes makes it easier to apply colors to complex drawings that 
uses many colors. They also save time when working on different drawings that use the 
same colors.

· You can create as many custom palettes you want and load them when required with 
the Load New Palette command.

Dialog Box Options

File Name
Type a name for the new palette. If you want or overwrite an existing palette, select its 
name from the list.

Directories
Select the directory in which you want the palette file stored.

List Files of Type
Selects Palette File as the type of file to be opened.

Drives
Selects the drive in which you want the palette file stored.



How to...
Open and save a color palette



Fill Tool 
Displays a    menu with a variety of icons for specifying an object's fill. You can fill an object 
with a uniform color, fountain fill , pattern, shade of gray, or leave it empty.

· You can also fill objects with uniform colors selected from the on-screen palette.
· The Status Line indicates the selected object's fill by color and name for uniform fills. If 

the selected object contains a fountain or pattern fill, the corresponding icon from the 
fly-out menu is displayed.

· Objects must be closed to accept a fill.
· If editable preview is selected, all fills will be displayed on screen except for PostScript 

textures and halftone screens which only show up when printed.
· Fills applied to black and white bitmaps fill the entire bounding box and show through 

the white pixels. You cannot fill color and gray-scale bitmaps.
· You can change the color of black pixels in a black and white bitmap using the color 

wheel icon in the Outline Pen menu.

Menu Icons

Uniform Fill Color 
Displays the Uniform Fill dialog box or the Uniform Fill for New Object dialog box if no 
object is selected.
Choose this icon if you want to select or create a uniform color fill. Choose it with no 
object selected if you want to change the default Uniform Fill attributes.

Fill Roll-Up Window 
Displays a roll-up window for quick access to various fills. See Fill Roll-Up window.

None 
Makes the object transparent allowing objects behind it to show through.
Choosing None with no object selected displays a dialog box for assigning None as the 
fill for new objects. See Fill for New Object dialog box.
You can also remove fills by clicking with the primary mouse button on the  button at 
the left end of the color palette.

Two-color Pattern 
Displays the Two-color Pattern dialog box from which you can choose a two-color pattern 
fill.

Full-color pattern 
Displays the Load Full-color pattern dialog box from which you can choose a full-color 
pattern fill.

Fountain Fill 
Displays the Fountain Fill dialog box for specifying fountain fills.
Choosing this icon with no object selected displays a dialog box for defining a fountain fill 
as the fill for new objects. See Fill for New Object dialog box.



PostScript Textures 
Displays the PostScript Textures dialog box from which you can choose a PostScript 
texture fill.
Choosing this icon with no object selected displays a dialog box for assigning a PostScript 
texture as the fill for new objects. See Fill for New Object dialog box.

White, Black, Gray 
Selects white, black and five shades of gray (10%, 30%, 50%, 70%, and 90%).
Choosing one of these icons with no object selected displays a dialog box for assigning 
white, black, or a shade of gray as the fill for new objects. See Fill for New Object dialog 
box.

Shortcuts
· Pressing SHIFT+F11 with an object selected displays the Uniform Fill dialog box.
· With no object selected, pressing SHIFT+F11 displays the Uniform Fill for New Object 

dialog box.



How to...
· Close paths to accept fills
· Choose a fill color
· Make an object transparent
· Create a fountain
· Choose a Two-color fill pattern
· Choose a Full-color fill pattern
· Choose a PostScript Texture
· Copy an object's fill
· Save, apply and delete a custom fill
· Apply halftone screens
· Create pattern fills
· Edit Two-color pattern fills with the Bitmap Editor
· Edit a Full-color pattern fill
· Specify default fill attributes



Fill Roll-up window
The Fill Roll-up window gives you quick access to a variety of fills.

Window Controls
Roll window icon 

Hides the controls leaving just the title bar visible.

Uniform Fill 
Displays a list of uniform colors. Use the scroll bars to see other colors in the list. When 
you find the one you want, click on it. To close the box without making a selection, press 
the ESC key.
You can rearrange colors in the list by dragging them to different spots.
Clicking on a color with no object selected displays a dialog box for assigning that color as
the default for a particular type of new object.

Fountain Fill 
Displays controls for creating fountain fills.

 Type
Clicking on the left selects a linear fountain, the right a radial fountain.
You can change the angle of a linear fountain or the center of a radial fountain by 
dragging the control in the preview box. 
Holding down the CTRL key while dragging, constrains the angle of a linear fountain to 
multiples of 15 degrees and the amount of offset for a radial fill to 10 percent increments.

 Start/End Colors
Displays a palette for choosing the start and end colors. Click on the left button to specify 
the start color, the right button to specify the end color. 
Clicking on the fountain fill button with no object selected displays a dialog box for 
assigning the currently displayed fountain as the default fill for a particular type of new 
object.

Two-color pattern Fills 
Displays controls for selecting and editing two-color pattern fills.

 Foreground/Background Colors
Displays a palette for choosing the foreground and background colors. Click on the left 
button to specify the foreground color, the right button to specify the background color. 

 Tile Size/Offset
Displays a pair of boxes inside the selected object for scaling and offsetting the pattern 
tiles.
Drag the node along the bottom edge of the boxes to scale the pattern tiles.
Drag the left box to offset the first tile in the pattern.
Drag the right box down to offset alternating columns of tiles.
Drag the right box down and to the left to offset alternating rows of tiles.



 Pattern List
Clicking on the arrow in the top right corner of the preview box displays a list of patterns. 
Click on the pattern you want and choose OK.    Choosing Cancel ignores your selection 
and closes the list.
Choosing File displays a menu for saving, deleting, and importing patterns
Save Current Fill: Saves the two-color pattern fill that's currently displayed in the 
preview box. 
Delete Item: Deletes the selected pattern from the list.
Import Pattern: Displays another dialog box that lets you create a pattern from an 
imported graphic. See Import command.
NOTE: For best results, limit the use to no more than two-colors in the graphic you import.

Full-color pattern Fills 

 Tile Size/Offset
Displays a pair of boxes inside the selected object for scaling and offsetting the pattern 
tiles.
Drag the node along the bottom edge of the boxes to scale the pattern tiles. Holding 
down the CTRL key as you drag maintains the pattern's aspect ratio.
Drag the left box to offset the first tile in the pattern.
Drag the right box down to offset alternating columns of tiles.
Drag the right box down and to the left to offset alternating rows of tiles.

 Pattern List
Clicking on the arrow in the top right corner of the preview box displays a list of patterns. 
Click on the pattern you want and choose OK. Choosing Cancel ignores your selection 
and closes the list.
Choosing File displays a menu for saving, deleting and importing patterns.
Save Current Fill: Saves the full-color pattern fill that's currently displayed in the 
preview box. 
Delete Item: Deletes the selected pattern from the list.
Import Pattern: Displays a another dialog box that lets you create a pattern from an 
imported    graphic. See Import command.

Update From...
Loads the selected object's fill into the roll-up window so that you can make changes to it.
After making changes, choose the Apply button.
You can also use Update From to copy another object's fill to the selected object. Click on 
the object with the fill you want to copy,    click on the Update From... button, then on 
the Apply button. 

Edit 
Displays a different dialog box depending on the type of fill. See Uniform Fill, Fountain Fill,
Two-color Fill Pattern or Full-color Fill Pattern

Apply
Applies your choices to the selected object.





How to...
· Use Roll-up windows
· Save, apply and delete a custom fill
· Choose a Two-color fill pattern
· Choose a Full-color fill pattern



Fill for New Object dialog box
Lets you specify the default Fill attributes assigned to new objects in the current drawing and
in future drawings. You can specify a Uniform Fill (shade of gray, color, black or white), 
Fountain Fill, PostScript Texture, or no fill at all as the default fill.

· A separate dialog box, one for each type of fill, appears when you choose the 
corresponding icon from the Fill menu with no object selected. For example, if you 
choose the Fountain Fill icon, the Fountain Fill for New Object dialog box will appear.

· You can also assign uniform colors and fountains as defaults from the Fill Roll-up 
window. 

· Similar dialog boxes let you define default Outline Pen and Outline Color attributes.

Dialog Box Options

All Objects
Assigns default attributes to all new objects.

Text Objects
Assigns default attributes to new text objects only.

Other Objects
Assigns default attributes to all new objects except text.

OK
Assigns black, white or the selected shade as the default Fill if you choose the 
corresponding icon.
Displays the Uniform Fill, Fountain Fill, or the PostScript Textures dialog box if you choose 
the corresponding icon.

Shortcuts
· Pressing SHIFT+F12 with no object selected displays the Uniform Fill for New Object 

dialog box.
· Pressing F11 with no object selected displays the Fountain Fill for New Object dialog 

box.



How to...
Specify the default fill for new objects



Two-color Fill Pattern
dialog box
Use this dialog box to select, edit, create and import Two-color patterns.

· You can use the drawing tools to design a pattern and then add it to the existing 
selection with the Special Create Pattern.

· Transformations applied to objects with two-color pattern fills do not affect the pattern. 
For example, if you rotate the object, the orientation of the pattern remains constant.

Dialog Box Options

Preview Box
Displays the pattern, if any, in the selected object. The display changes as you choose 
patterns from the Selection Box and adjust the Tile Size and Tile Offset settings.

 Pattern List
Clicking on the arrow in the top right corner of the preview box displays a list of patterns. 
Click on the pattern you want and choose OK. Choosing Cancel ignores your selection 
and closes the list.
Choosing File displays a menu for saving, deleting, and importing patterns.
Save Current Fill: Saves the two-color pattern fill that's currently displayed in the 
preview box. 
Delete Item: Deletes the selected pattern from the list.
Import Pattern: Displays another dialog box that lets you create a pattern from an 
imported graphic. See Import command.
NOTE: For best results limit the use to no more than two-colors in the graphic you import.

Create
Displays the Two-color pattern Editor which lets you create your own patterns and edit 
certain existing ones.

Import
Displays another dialog box that lets you create patterns from imported images in 
Windows Bitmaps (BMP) format. See the Import command.

Back/Front Color
Clicking on the color swatches displays a box with colors you can apply to the background
and foreground of the pattern.    
Use the scroll bars to see other colors in the list. When you find the one you want, click on
it. To close the box without making a selection, press the ESC key.
More
Displays the Uniform Fill dialog box which lets you create custom colors and select colors 
by name.

PostScript Options
Displays the PostScript Options dialog box. If you are producing color separations, you can
use this dialog box to specify halftone screens and overprint colors.



Small, Medium, Large
Selects a pattern tile size of 0.25x0.2, 50.50x0.50, or 1.00x1.00 inches.

Tiling
Displays additional controls for sizing and offsetting the tiles that make up the pattern. 
Width/Height
Specifies a custom pattern tile size up to 3x3 inches. 
If you want to use a different unit of measurement, open the units list then choose the 
unit you want.

First Tile Offset
Specifies the placement of the first tile relative to the upper left corner of the object's 
highlighting box.

Row/Column Offset
Shifts alternating rows or columns by the amount specified.



How to...
· Choose a Two-color fill pattern
· Create pattern fills
· Edit Two-color pattern fills with the Bitmap Editor



Bitmap Pattern Editor
Lets you create your own Two-color patterns. You can also edit existing patterns provided their resolution 
is no more than 64x64 pixels. If the selected pattern's resolution is too high, it will not appear in the 
editor's drawing area when you choose the Create button in the previous dialog box.

Dialog Box Options

Drawing Area
You create patterns by clicking with the primary mouse button to fill a square with black, 
or the secondary button to fill it with white. Holding down the mouse button as you draw, 
lets you fill a wide area of pixels.
Each square represents a pixel. The Bitmap Size options specify the number of pixels 
which in turn determines the resolution of the pattern.

Bitmap Size
Determines the resolution of the pattern. Choose the smallest size (16x16) to create 
simple patterns consisting of rectangular shapes and horizontal or vertical lines. For more 
intricate patterns with curves and diagonal lines, use one of the other two sizes.
NOTE: If you choose a Bitmap Size option, whatever you have drawn up to that point will 
be erased. Also, if you click on OK without drawing anything, an empty pattern is created.

Pen Size
Determines how many pixels are filled when you click in the drawing area. For example, 
2x2 fills four pixels at a time.



How to...
Edit Two-color pattern fills with the Bitmap Editor



Load Full-color Pattern
dialog box
Lists by name the Full-color patterns you can use to fill an object.

· You can use the drawing tools to design a pattern and then add it to the existing 
selection with the Create Pattern command in the Special menu.

· You can bring Full-color patterns into CorelDRAW and then modify them just as you 
would any other CorelDRAW graphic.

· Transformations applied to objects with full-color pattern fills do not affect the pattern. 
For example, if you rotate the object, the orientation of the pattern remains constant.

Dialog Box Options

File Name
Selects the pattern file you want to open. Either type the name of the file or select it from
the list.

Directories
Use to select the directory in which the pattern file you want to open is stored.

List Files of Type
Use to select Pattern File as the type of file to be opened.

Drives
Use to select the drive in which the file you want to open is stored.

Preview Box
Displays a bitmap representation (in black and white) of the selected pattern.

OK
Displays the Full-color Pattern dialog box where you can specify the size of the pattern 
tiles and offset them from one another.



How to...
· Choose a Full-color fill pattern
· Edit a Full-color pattern fill



Full-color Pattern dialog box
Lets you specify the size of the tiles that make up the pattern. Also lets you shift the entire pattern inside 
the object you are filling and stagger the individual pattern tiles.

Dialog Box Options

Preview Box
Displays a tile of the selected pattern.

 Pattern List
Clicking on the arrow in the top right corner of the preview box displays a list of patterns. 
Click on the pattern you want and choose OK. Choosing Cancel ignores your selection 
and closes the list.
Choosing File displays a menu for saving, deleting, and importing patterns.
Save Current Fill: Saves the two-color pattern fill that's currently displayed in the 
preview box. 
Delete Item: Deletes the selected pattern from the list.
Import Pattern: Displays another dialog box that lets you create a pattern from an 
imported graphic. See Import command.

Small, Medium, Large
Selects a pattern tile size of 0.25x0.2, 50.50x0.50 or 1.00x1.00 inches.

Tile Size
Specifies the size of the tiles that make up the pattern.
You can specify a custom size up to 3x3 inches by entering values in the Width and 
Height boxes. The Small, Medium and Large buttons select sizes of 0.25x0.2, 50.50x0.50, 
or 1.00x1.00 inches respectively.
Clicking on the unit name (e.g., inches) changes the unit of measure.

Offsets
Displays another dialog box that lets you shift the entire pattern and stagger the 
individual pattern tiles.
Starting Tile Offset
Determines where, relative to the upper left corner of the object's highlighting box, the 
pattern begins.
Row/Column Offset
Shifts alternating rows or columns by the amount specified.
OK
Returns to Load Full-color pattern dialog box.



Fountain Fill dialog box
Lets you define a fill that blends two-colors or tints of color.

· Choosing the Fountain Fill icon with no object selected displays a dialog box for 
specifying a fountain fill as the default fill for particular types of objects. See Fill for 
New Object dialog box.

· Objects with fountain fills reduce the screen's redrawing speed. You can improve the 
redraw speed by lowering the Preview Fountain Stripes setting in the Preferences - 
Display dialog box.

· A separate Fountain Stripes setting in the Print Options dialog box controls the speed 
and quality with which fountain fills are printed.

Dialog Box Options

Linear
Selects a fountain fill that changes color in one direction.

Radial
Selects a fountain fill that changes color in concentric circles from the center of the object
outwards.

Preview Box
Shows you how the fountain fill will look with the colors you have chosen.

Angle
Determines the angle of gradation from the start to end color in a linear fountain fill. The Preview box 
shows the effect of changing the angle.
If you rotate the object, the fountain angle adjusts automatically.
You can also change the angle by dragging the line that appears when you click in the 
Preview box.
Holding down the CTRL key while dragging, constrains the angle to multiples of 15 
degrees.

From/To
Clicking on the color swatches displays colors you can blend to create the fountain fill.
Use the scroll bars to see other colors in the list. When you find the one you want, click on
it. To close the box without making a selection, press the ESC key.
More
Displays the Uniform Fill dialog box which lets you create custom colors and select colors 
by name.

Edge Pad
Increases the amount of start and end color in the fountain fill. Used primarily with circles 
and irregularly shaped objects in which the first and/or last few bands of color lie between
the object and its highlighting box.

Center Offset for Radial
Repositions the center of a radial fountain fill so that it no longer coincides with the center



of the object. Negative values shift the center down and to the left; positive values shift 
the center up and to the right.
You can also move the center by dragging the crosshairs that appear when you click in 
the Preview box.
Holding down the CTRL key while dragging, constrains the amount of offset to 10 percent 
increments.

PostScript Options
Displays the PostScript Options dialog box. If you are producing color separations, you can
use this dialog box to specify halftone screens and overprint colors.

Shortcuts
· Pressing F11 with an object selected displays the Fountain Fill dialog box.
· Pressing F11 with no object selected displays the Fountain Fill for New Object dialog 

box.



How to...
Creating a fountain fill



PostScript Textures dialog box
Fills the selected object with a special type of pattern fill which will only print on a PostScript 
printer. Adjustable parameters allow you to change the pattern's appearance.

· Objects display in editable preview filled with the letters PS rather than the actual 
texture. You must print to see the texture.

· Some textures are extremely complicated and require several minutes to print. If too 
complicated, the drawing may not print at all.

· Textures that print successfully from CorelDRAW, may be exported in EPS format for 
use in another program.

· When printing color separations the PostScript textures print as black and opaque. This
means objects behind the texture will not show through even if you have made the 
texture transparent.
If, however, you print directly to a color printer, the background object will show 
through the transparent texture.

· Choosing the PostScript Fill icon with no object selected displays a dialog box for 
specifying a PostScript texture as the default fill for new objects. See Fill for New Object
dialog box.

Dialog Box Options

Name
Lists the textures by name.

Parameter
Control the appearance of the texture. The parameters change depending on the texture 
selected.
See "Appendix A" in your CorelDRAW User's Guide for examples of the various textures 
that can be created by changing the parameters.



How to...
Choose a PostScript Texture



CorelDRAW Help Contents
Help topics for CorelDRAW are divided into eight categories represented by the icons below.
To select a category with the mouse, point to its icon then click. With the keyboard, press Tab to highlight the 
category you want then press ENTER. For more information on using Help, choose the Using Help icon or press F1. To
return to this screen, select the Contents button at the top of the Help window.

  

  



How To...

· Get Started with CorelDRAW
· View Drawings
· Draw Basic Objects
· Select Objects
· Work with Text and Symbols
· Transform Objects
· Shape Objects
· Outline and Fill Objects
· Arrange Objects
· Create Special Effects
· Create Colors and Manage Color Palettes
· Manage and Print Files
· Work with Bitmaps
· Exchange Information with Other Applications
· Customize CorelDRAW



Getting Started with CorelDRAW

· Setting up the CorelDRAW Screen
· Creating a new drawing
· Opening a drawing
· Saving a new drawing
· Choosing tools and commands
· Working with dialog boxes
· Using Roll-up windows
· Undoing mistakes
· Repeating an action
· Starting and exiting CorelDRAW
· Installing options with the Setup progra  m  



Viewing Drawings

· Displaying a drawing in editable preview
· Displaying a drawing in wireframe view
· Previewing a drawing
· Magnifying and reducing the view of a drawing
· Viewing all objects in the drawing window
· Viewing drawings at actual size
· Scrolling the drawing window 
· Interrupting a screen redraw
· Refreshing the screen
· Displaying and hiding bitmaps on the screen
· Viewing objects on selected layers
· Speeding up screen redraw
· Coloring the drawing window and Preview screen



Drawing Basic Objects

Rectangles and Ellipses
· Drawing rectangles and squares
· Rounding the corners of rectangles and squares
· Drawing ellipses and circles
· Turning an ellipse or circle into an arc or pie wedge
Lines and Curves
· Changing the line/curve drawing mode
· Drawing curves in Freehand mode
· Drawing curves in Bezier mode
· Drawing straight lines in Freehand mode
· Drawing straight lines in Bezier mode
· Setting line and curve drawing preferences



Selecting Objects

· Selecting an object
· Selecting multiple objects
· Selecting grouped objects
· Deselecting an object
· Selecting next/previous object
· Selecting individual objects in a group
· Selecting nested groups
· Selecting objects on other layers



Working with Text and Symbols

Adding Text and Symbols
· Adding Artistic text
· Adding Paragraph text
· Adding symbols
· Importing text
· Pasting text from the Clipboard
Editing and Formatting Text
· Selecting text on screen
· Editing text in the Text dialog box
· Editing text on screen
· Formatting Paragraph text
· Adjusting text spacing
· Kerning text
· Applying character attributes
· Copying text attributes
· Entering special characters
· Making characters into individual objects
Proofing Text
· Checking spelling
· Correcting a misspelled word
· Creating and adding words to a personal dictionary
· Opening a personal dictionary
· Hyphenating words automatically
· Using the thesaurus
Special Text Features
· Fitting text to a path
· Editing text fitted to a path
· Adjusting the position of text on a path
· Detaching text from a path
· Extracting and merging text
· Creating Adobe Type 1 and TrueType fonts
· Using Print Merge
Changing Default Text Attributes
· Changing the default text spacing
· Changing the default typeface for new text
· Changing default text attributes for the current session



Transforming Objects

· Moving objects with numeric precision
· Moving objects using the mouse
· Moving objects in increments (nudging)
· Rotating objects with numeric precision
· Rotating objects using the mouse
· Moving the center of rotation
· Skewing objects with numeric precision
· Skewing objects using the mouse
· Stretch and scaling objects with numeric precision
· Stretching and scaling objects using the mouse
· Duplicating objects
· Clearing transformations



Shaping Objects

· Rounding the corners of rectangles and squares
· Turning ellipses and circles into arcs and pie wedges 
· Converting rectangles, ellipses and text to curve objects
· Selecting the first/last node on a curve object
· Selecting/deselecting nodes and segments on a curve object
· Shaping a curve object by moving its node and control points
· Adding nodes to a curve object
· Deleting nodes and segments from a curve object
· Determining if you need to add or delete nodes
· Aligning nodes and control points
· Breaking a curve object at a node
· Changing a segment to a curve or line
· Joining nodes to close an open path or connect separate paths
· Making a node smooth, cusped or symmetrical
· Moving hidden control points



Outlining and Filling Objects

Outlining Objects
· Choosing a line thickness
· Choosing an outline color
· Removing an object's outline
· Choosing a dashed and dotted line style
· Copying an object's outline
· Creating calligraphic outlines
· Applying arrowheads and line ending shapes
· Editing an arrowhead/line ending shape
· Creating arrowheads and other line ending shapes
· Applying halftone screens
· Specifying default Outline attributes
Filling Objects
· Closing paths to accept fills
· Choosing a fill color
· Making an object transparent
· Creating a fountain fill
· Choosing a Two-color fill pattern
· Choosing a Full-color fill pattern
· Choosing a PostScript Texture
· Copying an object's fill
· Saving, applying and deleting a custom fill
· Applying halftone screens
· Creating pattern fills
· Editing Two-color pattern fills with the Bitmap Editor
· Editing a Full-color pattern fill
· Specifying default fill attributes



Creating Colors & Managing Palettes

· Creating custom Process colors
· Adding a tint of Spot color to the palette
· Opening and saving a color palette
· Deleting a color from a palette
· Rearranging colors in the palette
· Changing the default color palette
· Converting a Spot color to its Process color equivalent



Arranging Objects

Aligning
· Displaying and hiding the grid
· Setting the grid parameters
· Aligning objects to the grid
· Positioning guidelines in the drawing window
· Aligning objects to a guideline
· Creating guides from objects
· Aligning objects using Snap to Objects
· Aligning objects using the Arrange Align command
· Using the ruler cross hairs
Grouping and Combining
· Grouping and ungrouping objects
· Selecting individual objects in a group
· Selecting nested groups
· Combining separate objects
· Creating clipping holes or masks
Working with Layers
· Adding a new layer
· Changing the name of a layer
· Deleting a layer
· Changing the active drawing layer
· Changing the order of layers
· Moving an object to a another layer
· Copying an object to a another layer
· Locking a layer
· Making a layer visible or invisible
· Making a layer printable or unprintable
· Working on multiple layers
· Identifying objects on a layer
· Rearranging the stacking order of objects on a layer



Creating Special Effects

Shaping with Envelopes
· Shaping an object with an envelope
· Clearing an object's envelope
· Copying an object's envelope
· Editing an object's envelope
Adding Perspective
· Adding perspective to an object
· Clearing a object's perspective
· Copying an object's perspective
· Editing an object's perspective
Blending
· Blending objects
· Blending objects along path
· Editing a blend
· Rotating intermdiate shapes in a blend
· Chaining blends
· Clearing intermediate shapes in a blend
· Breaking the link between blended objects
Extruding
· Extruding an object
· Editing an extruded object
· Clearing extruded surfaces
· Breaking the link between objects in an extrusion



Managing and Printing Files

Managing Files
· Finding files using keywords
· Finding files using Mosaic
· Adding notes to a files
· Sorting files
· Making a copy of an open drawing
· Opening a backup file
· Saving a drawing for use in earlier versions of CorelDRAW
· Saving selected objects only
· Changing the image header used for previewing files

Printing Files
· Selecting a default printer
· Setting up the active printer
· Printing a drawing
· Printing a drawing to a disk
· Printing drawings larger than the printer's paper size
· Printing text using your printer's fonts
· Specifying the number of stripes used to print fountain fills
· Increasing the printing speed of drawings with complex curves
· Printing complex drawings on a PostScript printer
· Printing a drawing without starting CorelDRAW

Special Printing Features
· Printing color separations
· Using Print Merge
· Overprinting Spot colors
· Creating trap



Working with Bitmaps

· Selecting a bitmap
· Coloring a monochrome bitmap
· Cropping a bitmap
· Tracing a bitmap
· Displaying and hiding bitmaps on the screen
· Rotating and skewing a bitmap
· Applying a halftone screen to a bitmap



Exchanging Information with Other Applications

Importing & Exporting
· Exporting graphics for use in other programs
· Exporting selected objects only
· Importing graphics in other formats
· Importing text

Embedding an Object from another application
· Inserting an embedded object from an other application
· Editing an embedded object

Linking an object from another application
· Creating a link
· Updating a link
· Editing linked information in the source file
· Jumping from a destination file to its source file
· Changing a link
· Canceling a link
Exchanging Information through the Clipboard
· Copying and cutting objects to the Clipboard
· Displaying the Clipboard



Customizing CorelDRAW

Using the Preferences command
· Assigning a function to the secondary mouse button
· Changing the Nudge distance
· Changing the mouse pointer to a cross hair cursor
· Changing the amount of offset for duplicated objects
· Controlling the appearance of corner joints
· Enabling and disabling the Auto-panning and Interruptible display features
· Controlling the display of colors
· Controlling the display and printing of fountain fills
· Controlling how accurately CorelDRAW traces bitmaps
· Increasing the redraw speed of Paragraph text
Using the CorelDRAW.INI File
· Controlling the appearance of the toolbox, color palette and dialog boxes
· Controlling the display of objects when moving
· Specifying backup file creation options
· Specifying the CorelDRAW window size on start-up
· Installing a foreign language dictionary
· Customizing the CIipboard
· Controlling how CorelDRAW exports text
· Changing the default typeface for new text
Setting other preferences
· Specifying the default outline attributes for new objects
· Specifying the default fill for new objects
· Changing the 0,0 point on the rulers
· Changing the color of guidelines and grid markers
· Changing the unit of measurement on the rulers
· Displaying and hiding the rulers, color palette, and Status Line
· Changing default text attributes for the current session
· Changing the default color palette



Exchanging Information with Other Applications
Importing and Exporting
CorelDRAW includes a wide variety of file format filters which allow you to exchange 
graphics between CorelDRAW and other applications.
Importing gives you access to graphics created in other illustration programs and 
presentation packages as well as clipart and scanned images. Once a graphic has been 
imported, you can modify it using CorelDRAW's tools and features. A single drawing can 
consist of any number of imported graphics in any of the supported formats. You can even 
import objects from other CorelDRAW files.
Exporting saves CorelDRAW files in formats used by programs. In particular, this lets you 
create graphics for many popular desktop publishing and word processing programs.
Because each format handles information in a graphics file differently, it is not always 
possible to precisely translate the contents of one format to another. The amount of 
variation depends on the graphic and the format used to import or export it. See Export File 
Formats.

Linking
Linking lets you create a CorelDRAW file that includes information from a second file created 
in another application and then link the two files together. By copying an object from a 
source file (for example, a CorelDRAW drawing) and pasting into a destination file (for 
example, a Word for Windows document), CorelDRAW will update the destination file any 
time the information changes in the source file.
You can control when updates occur or have CorelDRAW update the information 
automatically whenever the source file changes.

Embedding
Embedding lets you insert information into your drawings that were created in other 
applications. Charts, graphics and spreadsheet data are examples of information you can 
embed. Only Windows applications that support object embedding can supply embedded 
information. Also, you must have enough memory to run CorelDRAW and the other 
applications you are using at the same time.
Embedding is used instead of linking when you want to make changes to the embedded 
information within CorelDRAW. Suppose you embedded a graph from CorelCHART and decide
you want to change it. To do this, simply double-click on the graph. CorelDRAW opens 
CorelCHART where you make the changes you want. When you return to CorelDRAW, the 
chart is updated with the changes you made.

Using the Clipboard
The Clipboard is a temporary storage area used to transfer text, graphics and other 
information between Windows applications. In CorelDRAW, the Clipboard is a convenient way
to move objects from one drawing file to another.
You transfer information to the Clipboard using the Cut, Copy and Paste commands in the 
Edit menu.
The information you place on the Clipboard remains on the Clipboard until you exit Windows 
or replace it with other information.



Exporting graphics for use in other programs
You can export your CorelDRAW files in formats that other programs can accept. 

To export graphics for use in other programs:
1. Open the CorelDRAW file you want to export.
2. Choose Export from the File menu.
3. From the List Files of Type box, choose the export format you want.
4. Do one of the following:

· Accept the name displayed in the File Name box for the graphic you are exporting.
· Type a new name in the File Name box.
· Select an existing name from the File Name list.
CorelDRAW automatically adds the extension that corresponds to the export format 
you selected.
If you want to save the file in a different drive or directory, select the drive from the 
Drives box and the directory from the Directories box.

5. Choose OK.
Depending on the format selected, another dialog box may appear. Select the options 
you want from the dialog box, then choose OK.



Tip
If you want to use your CorelDRAW graphic in an application that supports "Object Linking", 
consider linking the graphic to that application instead of exporting it. This way, if you 
change the graphic, CorelDRAW will automatically update the graphic in the other 
application. For more information, see Exchanging Information with Other Applications.



Exporting selected objects only
You can export only the parts of a drawing that you want to use in another application. 

To export selected objects only:
1. Open the CorelDRAW file you want to export.
2. Choose Export from the File menu.
3. Turn on the Selected Object(s) Only check box.
4. From the List Files of Type box, choose the export format you want.
5. Do one of the following:

· Accept the name displayed in the File Name box for the graphic you are exporting.
· Type a new name in the File Name box.
· Select an existing name from the File Name list.
CorelDRAW automatically adds the extension that corresponds to the export format 
you selected.
If you want to save the file in a different drive or directory, select the drive from the 
Drives box and the directory from the Directories box.

6. Choose OK.
Depending on the format selected, another dialog box may appear. Select the options 
you want from this dialog box then choose OK.



Importing graphics in other formats
Your drawing can include graphics in a wide variety of other formats.

To import graphics from other programs:
1. Choose Import from the File menu.
2. From the List Files of Type box, choose the import format you want.

The File Name box shows files in the current directory with the chosen format's 
extension. If the file you want is another drive or directory, select the drive from the 
Drives box and the directory from the Directories box.

3. In the File Name box, type or select the file you want to import.
4. Choose OK.



Inserting embedded objects from other applications
Embedding lets you include objects (i.e., information) from other applications in your 
drawing. Charts,    graphics and spreadsheet data are examples of the types of objects you 
can embed. If you want to edit an embedded object, you can open the application that 
created it from within CorelDRAW. 
Object Linking is another way of including objects from other applications. With linking, you 
can share the same information with other files. See Creating links.
You can insert an embedded object either by opening the source file from CorelDRAW or by 
pasting the object from the source file.

To embed an object in your drawing:
1. Choose Insert Object from the File menu. 
2. In the Object Type box, select the type that describes the application you will use to 

create the object.
NOTE: The list includes items from applications on your system that support object 
linking and embedding. You need to install these applications using their Setup 
programs for them to appear on the list.

3. Choose OK to open the source application.
4. Create or select the information you want to embed in your CorelDRAW file.
5. Once the information is created/selected, do one of the following:

· From the source application's File menu, choose Update, Exit or Exit and Return.
· In some applications, a dialog box appears prompting you to update. Choose Yes or 

OK.
6. Close the source application.
7. The embedded object appears in the center of your drawing. Select the object and 

move it to wherever you want.
To paste an embedded object from the source application:

1. Open the application in which you want to create the object to embed in CorelDRAW.
2. Copy the information to the Clipboard.
3. Open CorelDRAW.
4. Choose Paste from the Edit menu.

NOTE: If you are pasting a CorelDRAW object, choose Paste Special from the Edit menu.



Editing an embedded object
You can edit an embedded object by opening the application that created it from within 
CorelDRAW.

To edit an embedded object:
1. Do one of the following:

· Open the source application by double-clicking on the embedded object.
· Select the embedded object then choose Edit "name of the object" from the Edit 

menu.
2. Make the changes you want.
3. Do one of the following:

· From source application's File menu, choose Update, Exit or Exit and Return.
· In some applications, a dialog box appears prompting you to update. Choose Yes or 

OK.



Creating a link
You can add information to your drawing from another file and then link the two files. Any 
changes you make to the information in the source file is reflected in your drawing through 
this link.
If you have not already done so, save the source file before starting this procedure.

To create a link:
1. Start the application used to create the information you want to add to your 

CorelDRAW file.
2. Open the file with the information you want to add to your CorelDRAW file.
3. Select the required information.
4. Choose Copy from the application's Edit menu.
5. Open CorelDRAW and choose Paste Special from the Edit menu.
6. From the Data Type box, select the type of information you want to add to your 

CorelDRAW file. See Paste Special command.
7. Choose the Paste Link button.

CorelDRAW positions the linked object in the center of your page. Select the object and
move it to wherever you want.



Updating a link
You can have links in your CorelDRAW files updated either automatically or manually. 
Choosing automatic updates each destination file immediately after a change to the source 
file is made. Choosing manual lets you update a link only when you specify.

To specify automatic or manual link updating:
1. Select the linked information in the destination file you want to update.
2. Choose Links from the Edit menu.
3. Select the Update option you want.
4. Choose OK.

To update a link manually:
Use this procedure any time you want to manually update the destination file.

1. Select the linked information in the destination file you want to update.
If you have more than one link in the file that you want updated, hold down the CTRL 
key as you select the linked information.

2. Choose Links from the Edit menu.
Select any other links in the Links box you want updated.

3. Choose the Update Now button.
CorelDRAW reflects any changes made in the source file since the last update in the 
destination file for each selected link.

To update all links in a file:
1. Select the entire CorelDRAW destination file by choosing Select All from the Edit menu.
2. Choose Links from the Edit menu.
3. Choose the Update Now button.



Editing linked information in the source file
You can edit a source file created in CorelDRAW at any time. The changes you make are 
reflected in the destination files according to the update option you selected. See Updating a
link.

To edit linked information in the source file:
1. Open the source file.
2. Make the changes you want to the linked information.
3. Choose Save from the File menu.



Jumping from a destination file to its source file
If you need to change the contents of linked information in a destination file make them in 
the source file. If you make the changes in the destination file, CorelDRAW will ignore them 
when it updates the link.

To jump from a destination file to its source file:
1. Select the linked information you want to edit in the destination file.
2. Choose Links from the Edit menu.
3. Choose the Open Source button.
4. Make the changes in the source file.
5. Choose Save from the File menu.
6. If you want, you can close the file and exit the source application.

If you don't need further updates from the source file you can cancel the link. See Canceling 
a link.



Changing a link
You can change the source file name and type for any links in your CorelDRAW files.

To change a link:
1. Select the linked information in your CorelDRAW file.
2. Choose Links from the Edit menu.
3. Choose the Change Link button.
4. Do one or both of the following for the selected link:

· Type a new name for the source file in the File Name box.
· Select a new file type from the List Files of Type box.

5. Choose OK.



Canceling a link
If you cancel a link, CorelDRAW no longer updates the information in the destination file.

To cancel a link:
1. Select the linked information.
2. Choose Links from the Edit menu.
3. Choose the Cancel Link button.

A message will appear asking you to confirm cancellation of the link.
4. Choose Yes to cancel the link.



Cutting and copying objects to the Clipboard
The Clipboard is a temporary storage area used to transfer text and graphics between 
Windows applications. You can also use the Clipboard to move objects between CorelDRAW 
files.

To place a copy of an object on the Clipboard:
1. Select the object you want to copy.
2. Choose Copy from the Edit menu.
3. Open the CorelDRAW file or other application into which you want the object copied.
4. Choose Paste from the Edit menu.

To cut an object from a drawing and place it on the Clipboard:
1. Select the object you want to cut.
2. Choose Cut from the Edit menu.
3. Open the CorelDRAW file or other application into which you want the object placed.
4. Choose Paste from the Edit menu.



Displaying the contents of the Clipboard
The Clipboard is a temporary storage area used to transfer text and graphics between 
Windows applications. You can also use the Clipboard to move objects between CorelDRAW 
files.

To display the Clipboard:
1. Open the Windows Program Manager.
2. In the Main program group, double-click on the Clipboard Viewer icon

To close the Clipboard:
· Press ALT+F4.



Customizing CorelDRAW
You can customize the CorelDRAW screen and the way certain commands and features work.
For example, you can turn the rulers, color palette and Status Line on and off. You can also 
specify if and when you want CorelDRAW to automatically save your files.
You can choose some of your preferences with commands in the Display menu. Others are 
set in a series of dialog boxes displayed by choosing the Preferences command in the 
Special menu. The remaining preferences are set in your CORELDRW.INI   file  , which is a text 
file you can edit using Windows Notepad or another ASCII text editor.



Assigning a function to the secondary mouse button
You can assign one of several CorelDRAW functions to the secondary mouse button.
NOTE: Swapping the primary and secondary mouse button using the Windows Control Panel 
switches the secondary mouse button function in CorelDRAW to the primary button.

To assign a function to the secondary mouse button:
1. Choose Preferences from the Special menu.
2. Choose the Mouse button.
3. Select the function you want.

Not Used Leaves the button unassigned.
2x Zoom Magnifies the area under the cursor by a factor of two each time

you press the secondary mouse button.
Edit Text Displays the Text dialog box when a text object is selected.
Full Screen Preview Toggles between a full screen Preview and the drawing window.
Node Edit Selects the Shape tool.

4. Choose OK.



Changing the Nudge distance
The Nudge feature uses the Arrow keys on your keyboard to move objects in small 
increments. You can specify how far objects move with each press.

To change the Nudge distance:
1. Choose Preferences from the Special menu.
2. In the Nudge box, type or select the distance you want.

If you want to use a different unit of measurement, select it from the units box. 
CorelDRAW will automatically convert the Nudge value to its equivalent in the unit you 
select.

3. Choose OK.



Changing the mouse pointer to a cross hair cursor
You can turn the mouse pointer into cross hairs that extend the full width and length of the 
drawing area. When you move off the drawing area, the normal pointer reappears allowing 
you to select commands and tools.

To change the mouse pointer to a cross hair cursor:
1. Choose Preferences from the Special menu.
2. Choose Cross Hair Cursor.
3. Choose OK.



Changing the amount of offset for duplicated objects
You can specify how much CorelDRAW offsets an object you duplicate with the Duplicate 
command in the Edit menu.

To change the amount offset for duplicated objects:
1. Choose Preferences from the Special menu.
2. Under Place Duplicate, type or select the amount of horizontal and vertical offset you

want.
If you want to use a different unit of measurement, select it from the units box. 
CorelDRAW will automatically convert the Place Duplicate value to its equivalent in the 
unit you select.

3. Choose OK.



Controlling the appearance of corner joints
With the Miter Limit control, you can specify the angle below which CorelDRAW bevels the 
corners in your drawings. You may need to adjust the Miter Limit to avoid corners that 
extend far beyond the actual corner at small angles.

To control the appearance of corner joints:
1. Choose Preferences from the Special menu.
2. In the Miter Limit box, type or select the angle you want.
3. Choose OK.



Enabling and disabling the Auto-panning and Interruptible Display 
features
With Auto-panning, the drawing window automatically scrolls whenever you drag beyond its 
borders. 
With Interruptible Display, the screen stops redrawing when you click with the mouse or 
press a key. This lets you select a menu command or tool without waiting for the screen to 
redraw completely. Redrawing resumes after you perform another action. Click on a scroll 
bar thumb or when you choose the Refresh Window command in the Display menu.

To enable or disable the Auto-panning and Interruptible Display features:
1. Choose Preferences from the Special menu.
2. Select or clear the Auto-Panning and/or Interruptible Display check boxes.
3. Choose OK.



Controlling the display of colors
CorelDRAW provides controls which can speed up the redraw speed of your screen. To use 
the color controls you must have a 256-color monitor.

To control the display of colors:
1. Choose Preferences from the Special menu.
2. From the Preferences dialog box, choose the Display button.
3. Under Preview Colors choose the options you want.

256-Color Dithering Displays color using CorelDRAW's dithering scheme.
Windows Dithering Displays color using the screen driver's default dithering 

scheme. If you have a 256-color monitor your screen may 
redraw faster with this option selected. However, only 15 of 
these colors will be used in the dithering scheme.

Optimized Palette Uses pure color to
for Full Screen represent colors in your drawing.
Preview The use of this option applies only to Preview mode; colors in

editing mode display as dithered.
4. Choose OK.



Controlling the display and printing of fountain fills
Printing proofs of a drawing with fountain fills can take less time if you reduce the number of
stripes the printer uses to create them. Similarly, using fewer stripes to display fountains can
improve the redraw speed of your screen.
When you are ready to print the final version of your drawing, reset the number of stripes so 
that the fountains print the way you want.

To control the display of fountain fills:
NOTE: This procedure also determines the number of stripes used to represent fountains 
exported in certain formats. See Preferences - Display dialog box

1. Choose Preferences from the Special menu.
2. Choose the Display button.
3. In the Preview Fountain Stripes box, type or select the number of stripes you want.

Lower values produce coarser fountains which take less time to redraw and print.
4. Choose OK.

To control the printing of fountain fills:
1. Choose Print from the File menu.
2. In the Preview Fountain Stripes box, type or select the number of stripes you want.

Lower values produce coarser fountains which take less time to print.
3. Choose OK.



Controlling how accurately CorelDRAW traces bitmaps
CorelDRAW provides a number of adjustable settings which affect the way the Autotrace 
feature traces bitmaps.

To control how accurately CorelDRAW traces bitmaps:
1. Choose Preferences from the Special menu.
2. Choose the Curves button.
3. Adjust the following as required:

Autotrace controls how closely the Bezier curve follows the edges of the 
Tracking bitmap. Low numbers (1 to 3 pixels) tends to produce more accurate 

results.
Corner sets the threshold for deciding
Threshold whether the Bezier curve rounds a corner smoothly or with a sharp 

change in direction. Low numbers (1 to 3 pixels) tends to produce more 
sharp corners.

Straight Line sets the threshold for deciding
Threshold whether a segment should be made a line or curve. Low numbers (1 to 

3) tend to produce more curve segments.
4. Choose OK.



Increasing the redraw speed of Paragraph text
"Greeking" Paragraph text while you work on other elements in your drawing reduces the 
time required to redraw your screen.

To increase the redraw speed of Paragraph text:
1. Choose Preferences from the Special menu.
2. From the Preferences dialog box, choose the Display button.
3. In the Greek Text Below box, type or select the value you want. Text below the size 

you specify will display as small rectangles.
4. Choose OK.



Controlling the appearance of the toolbox, color palette and dialog 
boxes
If you prefer, you can turn off the gray background in all of CorelDRAW's dialog boxes and in 
the Status Line. With the background off, you can use the Windows Control Panel to select 
your own color scheme.
For easier selection on high resolution monitors, you may want to enlarge the display of the 
toolbox and color palette.

To turn off the gray background:
1. Using Windows Notepad or other ASCII text editor, open the CORELDRW.INI file in your 

CorelDRAW directory.
2. In the [CDrawConfig] section, locate the line 3DLook.
3. Change "1" to "0".
4. Save the file.
For the change to take effect, you must exit and then restart CorelDRAW.

To install the larger size toolbox and color palette:
1. Using Windows Notepad or other ASCII text editor, open the CORELDRW.INI file in your 

CorelDRAW directory.
2. In the [CDrawConfig] section, locate the lines BigToolbox and BigPalette. 
3. Change "0" to "1".
4. Save the file.

For the change to take effect, you must close and then restart CorelDRAW.



Controlling the display of objects when moving
When you use the mouse to move objects, CorelDRAW displays a dotted rectangle instead of
the objects to minimize screen redrawing. If want, you can have CorelDRAW display the 
objects whenever you stop dragging. This way you can see the objects at different locations 
without having to release the mouse button with each move.
You can also specify how long you must pause before CorelDRAW begins displaying the 
objects.

To display objects when moving:
1. Using Windows Notepad or other ASCII text editor, open the CORELDRW.INI file in your 

CorelDRAW directory.
2. In the [CDrawConfig] section, locate the line ShowObjectsWhenMoving.
3. Change "0" to "1".
4. Locate the line DelayToDrawWhileMoving.
5. Type a value in the range 1 to 32000 milliseconds.
6. Save the file.

For the change to take effect, you must close and then restart CorelDRAW.



Specifying backup file creation options
CorelDRAW has two backup file creation features which you can configure to suit your needs.
AutoBackupMins creates a backup file at 10 minute intervals. You can change the interval 
and the directory the backup files are stored in. BackUpWhenSave creates backup files 
whenever you save a file using the Save or Save As command.
Though not recommended, you can turn off both file backup features. See CORELDRW.INI - 
{CDrawConfig].

To specify backup file creation options:
1. Using Windows Notepad or other ASCII text editor, open the CORELDRW.INI file in your 

CorelDRAW directory.
2. In the [CDrawConfig] section, locate the following lines and make the changes you 

want.
AutoBackupDir Type the path name to the sub directory where you want 

CorelDRAW to store automatic backup files.
AutoBackupMins 0 = off

N = number of minutes between backups
MakeBackupWhenSave 0 = off

1= on
3. Save the file.

For the change to take effect, you must close and then restart CorelDRAW.



Specifying the CorelDRAW window size on start-up
You can have CorelDRAW open at full screen size instead of the less than maximum default 
size.

To specify the CorelDRAW window size on start-up:
1. Using Windows Notepad or other ASCII text editor, open the CORELDRW.INI file in your 

CorelDRAW directory.
2. In the [CDrawConfig] section, locate the line MaximizeCDraw.
3. Change "0" to "1".
4. Save the file.

For the change to take effect, you must close and then restart CorelDRAW.



Installing a foreign language dictionary
If you have the CDROM version of CorelDRAW, you can install dictionaries to hyphenate and 
check the spelling of words in other languages.

To install a foreign language dictionary:
1. Using Windows Notepad or other ASCII text editor, open the CORELDRW.INI file in your 

CorelDRAW directory.
2. In the [CDrawConfig] section, locate the line SpellLanguage.
3. Type the language you want to install. Your choices are:

English, French, German, Swedish, Spanish, Italian, Danish, Dutch, Finnish
4. Locate the lines SpellDict and HyphenateDict and change them to match the 

SpellLanguage you specified.
Language SpellDict HyphenateDict
Danish idnf9111.dat hdnry141.dat
Dutch iduf9121.dat hdurs241.dat
English ienm9150.dat hecrp301.dat
Finnish ifnf9110.dat hfnry141.dat
French ifrf9121.dat hfnry141.dat
German igrf9112.dat hgrrs141.dat
Italian iitf9110.dat hitrs141.dat
Spanish ispf9110.dat hsprs141.dat
Swedish iswf9111.dat hswrs241.dat

5. Save the file.

For the change to take effect, you must close and then restart CorelDRAW.



Customizing the CIipboard
You can customize the Clipboard to: 

· improve appearance of radial fountains pasted into other applications and printed on 
PostScript printers.

· ignore calligraphic PostScript applied to objects.
· paste text as curve objects rather than editable text.

To customize the Clipboard:
1. Using Windows Notepad or other ASCII text editor, open the CORELDRW.INI file in your 

CorelDRAW directory.
2. In the [CDrawConfig] section, locate and make the changes you want to the following 

lines.
ClipboardFountains 0 = Enable high-quality cutting/copying 

1 = Disable high-quality cutting/copying
CalligraphicClipboard 0 = Keep calligraphic outlines

1 = Ignore calligraphic outlines
TextOnClpMetafile 0 = paste text as curve objects

1= paste text as text
4. Save the file.

For the change to take effect, you must close and then restart CorelDRAW.



Controlling how CorelDRAW exports text
To maintain the appearance of text in a drawing exported to applications that do not support
TrueType fonts, you need to convert the text to curves objects. You can have CorelDRAW 
perform the conversion automatically at the time of export. The conversion affects the 
exported file only, not the text in your drawing.
NOTE: You cannot edit text converted to curves in the destination application.

To export text as curves at time of export:
1. Open the CORELDRW.INI file in your CorelDRAW directory by using Windows Notepad or 

another ASCII editor. 
2. In the [CDrawConfig] section, locate the line ExportTextAsCurves.
3. Change "0" to "1".
4. Save the file.

For the change to take effect, you must close and then restart CorelDRAW.



Changing the default font for new text
New text added with the Text tool is automatically drawn at 24 points using the normal 
Avalon typeface. You can specify a different typeface, style and point size as defaults for 
subsequent sessions of CorelDRAW.
NOTE: You can also change the defaults attributes used for the current session only. See 
Changing default text attributes for the current session

To change the default font for new text:
1. Open the CORELDRW.INI file in your CorelDRAW directory by using Windows Notepad or 

an other ASCII editor.
2. In the [CDrawConfig] section, locate the line DefaultFont. 
3. Type your preferences as follows separating each parameter with a comma:

<fontname>,<nStyle>,<nnSize> 
where...
fontname is the name as it appears to the left of the = sign in the 

[PSResidentFonts] list.
nStyle is 1 for normal, 2 for bold, 4 for italic and 8 for bold italic.
nnSize is a number from 0.7 to 1440.

4. Save the file.

For the change to take effect, you must close and then restart CorelDRAW.



Specifying default outline attributes for new objects
Whenever you create a new object, CorelDRAW uses the current default attributes to outline 
it. These attributes determine the shape, thickness and color of the outlines. You can change
the default attributes and have CorelDRAW apply them to all objects, text only or all objects 
except text.
You can use the Outline tool menu or the Pen Roll-Up window to change the defaults.

To change the default Outline Pen attributes using the Outline tool menu:
1. With no objects selected, click on the Outline tool.
2. Do one of the following:

· Choose the icon that corresponds to the line weight you want to assign as the 
default for new objects.
All other Pen Attributes, except Angle and Stretch which are reset to their original 
default values (0 degrees and 100% respectively), remain unchanged.

· Choose the pen icon.
3. In the Outline Pen for New Object dialog box, choose the type of objects to which you 

want the defaults to apply.
4. Choose OK.
5. Specify the attributes you want.
6. Choose OK.

Now, whenever you add the type of object specified, CorelDRAW will outline it with the 
new default attributes.

To change the default Outline color using the Outline menu:
1. With no objects selected, click on the Outline tool.
2. Do one of the following:

· Choose white, black or the shade of gray icon you want to assign as the default for 
all new objects.

· Choose the color wheel icon.
3. In the Outline Color for New Object dialog box, choose the type of objects to which you 

want the defaults to apply.
4. Choose OK.
5. Create the color you want or select an existing one from the palette in the dialog box.
6. Choose OK.

Now, whenever you add the type of object specified, CorelDRAW will outline it with the 
new default color.

To change the Outline Pen and color using the Pen Roll-Up window:
1. Choose the Pen Roll-Up icon from the Outline tool menu.
2. With no objects selected, choose the line thickness, style, and color you want.
3. Choose the Apply button.
4. In the Outline Pen for New Object dialog box, choose the type of objects to which you 

want the defaults to apply.
5. Choose OK.

Now, whenever you add the type of object specified, CorelDRAW will outline it with the 
new default pen attributes and color.



Specifying the default fill for new objects
Whenever you create a new object, CorelDRAW fills it with the current default fill. You can 
change the default fill and have CorelDRAW apply it to all objects, text only or all objects 
except text. 
You can use the Fill Outline tool menu or the Fill Roll-Up window to change the defaults.

To change the default fill using the Fill tool menu:
1. With no objects selected, click on the Fill tool.
2. Choose the icon that corresponds to the type of fill you want to assign as the default 

for newly created objects. You can choose any icon except the Two-color and Full-color 
Pattern fill icons.

3. In the Fill for New Object dialog box, choose the type of objects to which you want the 
defaults to apply.

4. Choose OK.
If you chose the Uniform Fill, Fountain Fill or PostScript Textures icon, the dialog box 
associated with that icon appears.

5. Specify the fill you want.
6. Choose OK.

Now, whenever you add the type of object specified, CorelDRAW will fill it with the new 
default fill.

To change the default fill using the Fill Roll-Up window:
1. Choose the Fill Roll-Up icon from the Fill tool menu.
2. With no objects selected, choose the Uniform fill or Fountain fill you want to assign as 

the new default fill.
3. Choose the Apply button.
4. In the Fill for New Object dialog box, choose the type of objects to which you want the 

new default to apply.
5. Choose OK.

Now, whenever you add the type of object specified, CorelDRAW will fill it with the new 
default fill.



Setting default Tab stops
You set the distance between default tab stops for the selected frame of Paragraph text.

To set default Tab stops:
1. With the Pick tool, select the Paragraph for which you want to set default tab stops.
2. Do one of the following:

· Choose the Frame command from the Text menu.
· Choose the Frame button from the Text Roll-Up window.

3. In the Tab Stops box, type or select the distance you want between tab stops.
If you want to use a different unit of measurement, select it from the units box. 
CorelDRAW will automatically convert the Tab Stop value to its equivalent in the unit 
you select.

4. Choose OK.



Changing the 0,0 point on the rulers
You can move the 0,0 points on the rulers from their initial position at the lower left corner of
the Printable page. CorelDRAW uses the 0,0 points as the basis for determining the cursor 
and object position information you see in the Status Line. The coordinate values you specify
in some dialog boxes are also based on the position of the 0,0 points.

To reposition the 0,0 points using the ruler cross hairs:
To do this procedure you must display the rulers using the Show Rulers command in the 
Display menu.

1. Move the cursor over the area where the rulers meet.
2. Hold the mouse button down and drag the cross hairs onto the drawing window.

NOTE: If Snap to Grid is on, the cross hairs are forced to the grid.
3. Release the mouse button when the cursor is where you want the 0,0 points.

To reposition the 0,0 points using the Grid Setup command:
1. From the Display menu, choose the Grid Setup command.
2. Under Grid Origin, specify where you want the 0,0 points relative to the lower left 

corner of the Printable page.
3. Choose OK.



Changing the color of guidelines and grid
Instead of blue, you can have CorelDRAW display the guidelines and grid in green, red black 
or any other color you want.

To change the color of the guidelines and grid markers:
1. Choose the Layers Roll-Up command from the Arrange menu.
2. Double-click on the one (Guidelines or Grid) you want to change.
3. Click on the color swatch next to Color Override.
4. Choose the color you want.
5. Choose OK.



Changing the unit of measurement on the rulers
You can change the unit of measurement that appears on the rulers. Each ruler can use a 
different unit.

To change the unit of measurement on the rulers:
1. Choose the Grid Setup command from the Display menu.
2. From the horizontal units list box under Grid Frequency, select the unit of 

measurement you want the horizontal ruler to use. From the vertical units list box, 
select the unit of measurement for the vertical ruler.
NOTE: The Grid Frequency values are not converted when the unit of measurement is 
changed. Thus, when you change units, you must specify the Grid Frequency you wish 
to use with that unit.

3. Choose OK.



Displaying and hiding the rulers, color palette, and Status Line
If you don't need them, you can hide the rulers, color palette, or Status Line to increase the 
size of the drawing area.

To hide the rulers and Status Line:
1. From the Display menu, choose Show Rulers or Show Status Line if a check mark 

appears next to the command name.
To display the rulers and Status Line:

1. From the Display menu, choose Show Rulers or Show Status Line. 
To hide the color palette:

1. Choose Show Color Palette From the Display menu.
2. From the sub-menu choose No Palette.

To display the color palette:
1. Choose Show Color Palette From the Display menu.
2. From the sub-menu choose either Spot Colors or Process Colors.



Changing default text attributes for the current session
Using the Text Roll-Up window, you can specify the alignment, typeface, style and size 
CorelDRAW applies to new text added during the current session.
NOTE: You can also specify the default font (typeface, style and size), and spacing in effect 
each time you start the program. See Changing the default font for new text and Changing 
the default text spacing

To change the default text attributes for the current session:
1. With no text selected, choose the Text Roll-Up command from the Text menu.
2. Choose the attributes you want to assign as the new defaults.
3. Choose the Apply button.

A dialog box appears asking you whether you want to change the default text 
attributes.

4. Choose Yes to use your selections as the new defaults for the current session.



Changing the default color palette
You can specify which color palette CorelDRAW displays along the bottom of the screen each 
time you start the program.
CorelDRAW supplies several different Process color palettes and a single Spot color palette. 
The Process color palettes have different numbers and ranges of color. With some palettes, 
the difference is in whether the colors display on the screen as dithered or pure. 
NOTE: The palette displayed in the Pen and Fill Roll-Up windows is determined by the default
fill and outline color. See, Specifying the default outline attributes or Specifying the default 
fill for new objects.

To change the default color palette:
1. Choose the color wheel icon from the Fill or Outline tool menu.
2. Choose the Palette> button.
3. Choose Load New Palette.
4. In the File Name box, type or select the palette you want to open.
5. Choose OK.
6. Choose the Palette> button.
7. Choose Save as Default Palette
8. Choose OK.



Arranging Objects
CorelDRAW provides many powerful features to help you arrange and organize your 
drawings. For example, with the "Snap To" commands in the Display menu, you can align 
objects to the grid, to guidelines and to other objects quickly and precisely. For measuring 
and checking alignment, CorelDRAW provides rulers and cross hairs.
If you are planning a complex drawing, the Layers command can make your job much easier.
Using Layers lets you organize your drawing on a series of invisible planes with each plane 
containing a portion of your drawing. To speed up editing and screen redrawing, you can 
make the layers you are not currently working on invisible. Other handy Layers features 
include:

· Printing selected layers only for faster printing.
· Locking layers to prevent accidental changes to objects on the layer.
· Displaying and printing the grid and guidelines.
· Changing the order of layers.
· Drawing objects on the guides layer and using them as guidelines.

To change the stacking order of objects on a layer, you can use the To Front, To Back, Back 
One, Forward One and Reverse Order commands in the Arrange menu.
With the Group command in the Arrange menu, you can "bind" objects together and then 
select and manipulate them as a single unit. The Combine command groups objects in a way
that lets you:

· Speed up screen redrawing for graphics which contain many lines and curves.
· Join two line/curve segments together.
· Create clipping holes.



Displaying and hiding the grid
The grid, which appears as a series of dots in the drawing area, helps you to layout your 
drawing. 

To display/hide the grid using the Grid Setup command:
1. Choose Grid Setup from the Display menu.
2. Choose Show Grid.
3. Choose OK.

To display/hide the grid using the Layers Roll-Up window:
1. Choose Layers from the Display menu.
2. Double-click on Grid.
3. Choose Visible.
4. Choose OK. 



Setting the Grid parameters
You can specify the origin and size of the grid using the Grid Setup command or the Layers 
Roll-Up window.

To set the Grid parameters from the Grid Setup command:
1. Choose Grid Setup from the Display menu.
2. In the Horizontal and Vertical boxes under Grid Origin, type or select the start point of

the grid relative to the lower left corner of the Printable Page.
The 0,0 points on the rulers will move to the coordinates you specify.
If you want to use a different unit of measurement, select it from the units box. 
CorelDRAW will automatically convert the value to its equivalent in the unit you select.

3. Under Grid Frequency, specify the number of grid lines per unit of measure you want.
If you want the grid lines spaced more than one whole unit apart, enter a fractional 
value. Entering 0.5, for example, spaces them two inches apart.
NOTE: You can select another unit of measurement from the units box. When you 
change units, you must specify the Grid Frequency you want to use with that unit. 
Changing the Grid Frequency unit also changes the corresponding ruler unit.

4. Turn on the Show Grid check box if you want to display the grid in the drawing 
window.    Turn on the Snap to Grid check box if you want objects to snap to the grid.

5. Choose OK.
To set the Grid parameters from the Layers Roll-Up window:

1. Choose Layers from the Display menu.
2. Double-click on Grid.
3. Choose Setup.
4. Specify the parameters you want as described above.
5. Choose OK. 



Aligning objects to the grid
You can align objects to the grid visually or have them snap to the grid for precise 
positioning.

To visually align objects to the grid:
To do this procedure you need to display the grid. See Displaying and hiding the grid.

· Select the object and move it to align with the desired grid point.
To snap objects to the grid:

1. Turn on Snap to Grid by choosing the command from the Display menu.
Snap to Grid is on when a check mark appears beside the command.

2. Select the object and move it to align with the desired grid point.
As you move, the mouse pointer is forced to stay on the grid.
You can adjust the spacing between the grid points with the Grid Setup command in 
the Display menu.



Positioning guidelines in the drawing window
Guidelines are alignment aids you either drag from the rulers or position precisely with a 
dialog box. You can set the guidelines to have objects snap to them for exact alignment, or 
you can use them for visual positioning.

To drag guidelines from the rulers:
1. If they are not already displayed, use the Show Rulers command in the Display menu 

to display the rulers.
2. Move the cursor over the top ruler for a horizontal guideline or the side ruler for a 

vertical guideline.
3. Hold the mouse button down and drag onto the drawing window.
4. Release the mouse button when the guideline is where you want it.

If Snap to Grid is on, the guideline is forced to the grid.
To reposition a guideline, drag it to a new position.
To remove a guideline, drag it off the drawing window.

5. Repeat steps 1-3 to add more guidelines.
To position guidelines using the Guidelines Setup command:

1. Choose Guidelines Setup from the Display menu.
2. Choose the type of guideline you want.
3. Specify where you want the guideline placed relative to the 0,0 points on rulers.
4. Choose the Add button.

If you want to delete or move a guideline, double-click on it to display the Guidelines 
dialog box. Choose the Delete button or specify a new position and choose the Move 
button.
If you want to delete or move several guidelines, use the Next button to cycle through 
them.

5. Repeat steps 1 to 4 to add, move or delete more guidelines.
To position guidelines from the Layers Roll-Up window:

1. Choose Layers from the Display menu.
2. Double-click on Guides.
3. Choose Setup.
4. Follow steps above to position the guidelines.
5. Choose OK. 



Aligning objects to a guideline
You can align objects along a guideline visually or have them snap to the guideline for 
precise positioning.

To visually align objects to a guideline:
· Select the object and move it to align with the guideline.

To snap objects to a guideline:
1. Turn on Snap to Guidelines by choosing the command in the Display menu.

Snap to Guidelines is on when a check mark appears beside the command.
2. Select the object and move it to align with the guideline.

The object snaps to the guideline when one of the sides of its highlighting box is 
moved near it.



Creating guides from objects
You can create a guide from any object and use it as an alignment aid for precise drawing. 
You might want to use this feature to create a polar grid by drawing a series of evenly 
spaced concentric circles with lines radiating from the center. 
Objects on the drawing layers always snap to the guide objects even if Snap to Objects is 
turned off.

To create guides from objects:
1. Choose Layers from the Arrange menu.
2. Select Guides to make the guides layer the active layer.
3. Draw objects you want to use as guides.

The objects you draw will appear as dashed outlines.



Aligning objects using Snap to Object
You can align any part of a moving object to a snap point on a stationary object. The location
of snap points varies depending on the type of object. See the Snap to Object command.

To align objects using Snap to Object:
1. Turn on Snap to Object by choosing the command from the Display menu.

Snap to Object is on when a check mark appears beside the command.
2. Select the object at the spot you want to snap to another object.

In wireframe view and for objects without fills, you can select any spot on the object's 
outline. In full-color mode, you can select anywhere on a filled object.

3. Drag the selected object to the snap point on the stationary object with which you 
want to align. 



Aligning objects with the Align command
The Align command in the Arrange menu lets you precisely align objects to each other, to 
the center of the page or to the grid.

To align objects with the Arrange Align command:
1. Hold down the SHIFT key and click on the objects you want to align.

The last object you select maintains its position; all other objects move to align with 
this object.

2. Choose Arrange Align from the Arrange menu.
3. Choose the alignment options you want.

CorelDRAW aligns the objects using the handles on their highlighting boxes.
If you want to align the object to the center of the page or to the nearest grid point, 
choose that option first then specify the horizontal and/or vertical options.

4. Choose OK.



Using the ruler cross hairs
Checking the alignment of objects and measure distances is easy with the ruler cross hairs.

To access the ruler cross hairs:
1. If they are not already displayed, use the Show Rulers command in the Display menu 

to display the rulers.
2. Move the mouse pointer over the area where the rulers meet.
3. Hold the mouse button down and drag the cross hairs onto the drawing window.

If Snap to Grid is on, the cross hairs are forced to the grid.
When you release the mouse button, the 0,0 points on the ruler reset to the spot on 
which the mouse pointer was pointing.



Grouping and ungrouping objects
Grouping objects binds them together into a single unit. By grouping objects that represent a
complete element (e.g. a logo), you can prevent them from be accidentally altered.

To group objects:
1. Select the objects you want to group.
2. Choose Group from the Arrange menu.

The objects are now a group. Selecting any object in the group results in the selection 
of all other objects in the group.
You can still edit individual objects in a group, by holding down the CTRL key and 
clicking on the object.

To ungroup objects:
1. Select any object in the group.
2. Choose Ungroup from the Arrange menu.

The objects can now be selected individually.
If you have grouped two or more groups together, choose Ungroup from the Arrange 
menu to ungroup one level at time.
You can select a group within a group by holding down the CTRL key and clicking on an 
object in the group you want to select.



Selecting individual objects in a group
You can select and edit an object in a group without ungrouping them.

To select an object in a group:
· Hold down the CTRL key and click on the object.

If have nested groups (groups within groups), continue clicking until the object you 
want is selected.



Selecting nested groups
You can select and edit an object in a nested group without ungrouping.

To select an object in a nested group:
· Hold down the CTRL key and click on an object in the group you want to select.



Combining separate objects
Combining objects allows you to join separate paths and create clipping holes or masks. You 
can also combine paths with the same attributes to speed up screen redrawing.

To combine separate objects:
1. Select the objects you want to combine.

If you select rectangles, ellipses or text objects, CorelDRAW automatically converts 
them to curve objects before combining.

2. Choose Combine from the Arrange menu.
The objects are now one single curve object.

You can separate the combined objects into individual curve objects by choosing the Break 
Apart command from the Arrange menu.



Creating clipping holes or masks
Joining two or more closed paths creates a transparent opening that lets an underlying 
image show through.

To create clipping holes or masks:
1. Select the objects you want to use to create the mask.
2. Choose Combine from the Arrange menu.
3. Fill and outline the mask.

Any closed paths within the mask will be transparent.
4. Move the mask so that it overlaps the object you want to show through the transparent

areas.
5. Place the mask on top of the other object using the To Front or Forward One commands

in the Arrange menu.



Deleting an object
Though you will probably find using the DEL key more convenient, you can also delete 
objects by choosing the Delete command in the Edit menu.

To delete an object:
1. Select the object you want to delete.
2. Choose Delete from the Edit menu or press the DEL key.



Adding a new layer
You can add as many layers as you need to organize objects in your drawing.

To add a new layer:
1. Choose Layers from the Arrange menu.
2. Click on .

3. Choose New.
4. Accept the name CorelDRAW proposes for the layer or type a new one.
5. Choose OK.

The new layer becomes the active layer.



Changing the name of a layer
You can rename layers    other than the "Guides" and "Grid" layers in your drawings.

To rename a layer:
1. Choose Layers from the Arrange menu.
2. Do one of the following:

· Double-click on the layer name you want to change.
· Click on  and choose Edit.

4. Type a new name.
5. Choose OK.



Deleting a layer
You can delete a layers    and all the objects on it.

To remove a layer:
1. Choose Layers from the Arrange menu.
2. Click on .

3. Choose Delete.
The layer below the one deleted becomes the active layer.



Changing the active layer
Any objects you add to a drawing are placed on the active drawing layers . You can change 
the active layer at any time.
Making the Grid and Guides layers active lets you change the color of the grid markers and 
guidelines. With the Guides layer active, you can draw objects on it and use them as guides. 
See Creating guides from objects.

To change the active a layer:
1. Choose Layers from the Arrange menu.
2. Click on the name of the layer you want to make the active layer.



Changing the order of layers
The Layers Roll-Up window lists the names of the layers in the current drawing. The order of 
the names corresponds to the order the layers are stacked in the drawing. Objects on a 
higher layer display and print on top of objects which are on layers lower in the list.
You can move a layer and the objects on it to a different position in the stacking order.

To change a layer's position in the stacking order:
1. Choose Layers from the Arrange menu.
2. Hold the mouse button down on the name of the layer you want to move and drag it to

the desired position.



Moving an object to an other layer
You can move an object from one layer to another.

To move an object to another layer:
1. Select the object(s) you want to move.
2. Choose Layers from the Arrange menu.
3. Click on .

4. Choose MoveTo.
5. Click on the name of the layer to which you want to move the object(s).

If you move an object to a layer that is below it in the Layers list, the object is placed 
behind all other objects on the lower layer. 
Similarly, moving an object to a layer higher in list, places it in front on all objects on 
the higher layer.



Copying an object to another layer
You can copy an object and place it on another layer.

To copy an object to another layer:
1. Select the object(s) you want to copy.
2. Choose Layers from the Arrange menu.
3. Click on .

4. Choose CopyTo.
5. Click on the name of the layer to which you want to copy the object(s).

If you copy an object to a layer that is below it in the Layers list, the object is placed 
behind all other objects on the lower layer. 
Similarly, copying an object to a layer higher in list, places it in front on all objects on 
the higher layer.



Locking a layer
By locking layers you are not currently working on, you can prevent accidentally changing 
objects on those layers.

To lock and unlock a layer:
1. Choose Layers from the Arrange menu.
2. Do one of the following:

· Double-click on the name of the layer you want to lock.
· Click on  and choose Edit.

4. Choose Locked.
To unlock a layer, choose Locked to remove the check mark.

5. Choose OK.



Making a layer visible or invisible
When you are working on a complex drawing, hiding objects on layers you are not currently 
working on makes editing easier and speeds up screen redrawing.

To make layers visible or invisible:
1. Choose Layers from the Arrange menu.
2. Do one of the following:

· Double-click on the name of the layer you want to make visible or invisible.
· Click on  and choose Edit.

4. Choose Visible to remove the check mark and make the layer invisible.
To make an invisible layer visible, choose Visible again.

5. Choose OK.



Making a layer printable or unprintable
Making some layers unprintable allows you to print certain portions of your drawing more 
quickly.

To make layers printable or unprintable:
1. Choose Layers from the Arrange menu.
2. Do one of the following:

· Double-click on the name of the layer you want to make printable or unprintable.
· Click on  and choose Edit.

4. Choose Printable to remove the check mark and make the layer unprintable.
To make an unprintable layer printable, choose Printable again.

5. Choose OK.



Working on multiple layers
Turning Multilayer selection on, allows you to select and edit objects on any layer that isn't 
locked. Turning Multilayer selection off, restricts object selection to objects on the active 
layer.

To turn Multilayer selection on or off:
1. Choose Layers from the Arrange menu.
2. Click on  

3. Choose Multilayer to remove the check mark and restrict object selection to the 
current layer.

To turn Multilayer selection back on, choose Multilayer again.



Identifying objects on a layer
You can easily identify which objects belong to the different layers in your drawing by 
displaying them as wireframes of a particular color.
NOTE: Using this feature affects the way objects display not the way they print. 

To identify objects on a layer:
1. Choose Layers from the Arrange menu.
2. Do one of the following:

· Double-click on the name of the layer on which you want to identify objects.
· Click on  and choose Edit.

4. Choose Color Override.
5. Click on the color swatch to the right of Color Override.
6. Click on the color you want to apply to the objects on the selected layer.

Any objects on the selected layer will appear as wireframes in the color you choose. To 
restore the objects actual fill and outline, turn Color Override off.

7. Choose OK.
8. Repeat steps 2 to 7 for other layers.



Rearranging the stacking order of objects on a layer
Five commands in the Arrange menu allow you to change the stacking order of objects on a 
single layer. Select the object you want to change, then choose the command.

To Front moves the selected object to the front of its layer.
To Back moves the selected object to the back of its layer.
Forward One moves the selected object on top of the object that's in front of it.
Back One moves the selected object in back of the object that's behind it.
Reverse Order reverses the order of the selected objects.

You can select more than one object on a layer and move them using the first four of these 
commands. The objects will move together while keeping the same order relative to each 
other.



Object Stacking Order
Five commands in the Arrange menu--To Front, To Back, Forward One, Back One and Reverse 
Order--allow you to rearrange the order of objects on a single layer. 
When you add a new object to a layer, CorelDRAW automatically places it on top of all other 
objects on that layer. You can think of a drawing, then, as a series of objects stacked on top 
of each other. 
The order of stacking is evident when you display or print overlapping objects with 
contrasting outlines or fills. An object that's higher in the stacking order appears and prints 
on top of those lower in the order. If objects do not overlap, the stacking order isn't obvious; 
and, therefore, neither is the effect of changing their order.
NOTE: Grouping objects puts them in the same position in the stacking order. Also, if you 
select more than one object and then choose one of    first four of these commands, the 
objects will move together while keeping the same order relative to each other.



Working with Bitmaps
Bitmaps are graphics composed of pixels arranged to represent an image. Paint programs 
such as CorelPHOTO-PAINT and image scanners generate this type of graphic.
Unlike vector graphics, bitmaps have a fixed resolution. This is not a problem as long as the 
bitmap is displayed or printed at the resolution at which it was created. Enlarging the 
bitmap, however, spreads the pixels apart making the graphic look jagged. Reducing the 
bitmap also causes distortion as pixels are eliminated to squeeze the bitmap down to its new
size.
You can import bitmaps into CorelDRAW in order to include them in a drawing. Bitmaps 
imported for this reason can be moved, cropped, and in the case of monochrome bitmaps, 
colored. You can also scale, rotate or skew a bitmap though not always with good results.
CorelDRAW's autotracing program, CorelTRACE, lets you turn bitmaps into a vector graphics 
that you can edit, scale, print, etc., without distortion. For autotracing simple bitmaps, you 
can use the Pencil tool in CorelDRAW. 
CorelDRAW allows you to export graphics as bitmaps. This lets you use your drawings in 
applications that do not accept vector graphics.



Selecting a bitmap
The view you are working in determines how you select a bitmap.

To select a bitmap in editable preview:
1. Choose the Pick tool.
2, Click anywhere on the bitmap.

To select a bitmap in wireframe view:
1. Choose the Pick tool.
2. Click on the box that encloses the bitmap.

Handles appear around the bitmap to indicate that it has been selected.
You can also marquee-select a bitmap in either view.

NOTE: Unless Multilayer selection in turned on, you can only select objects on the active 
layer. See Working on multiple layers.



Coloring a monochrome bitmap
You can change the color of the pixels in a monochrome bitmap.

To color a monochrome bitmap:
1. Select the bitmap you want to color.
2. To change the color of the foreground (black) pixels, do one of the following:

·™ Click on the color wheel icon in the Outline tool menu. Choose or create a 
color using controls in the Outline Color dialog box.

· Using the secondary mouse button, click on the color you want from the palette 
along the bottom of the screen.

· From the Pen Roll-Up window, choose the color you want from the palette displayed 
when you click on the color swatch.

3. To change the color of the background (white) pixels, do one of the following:
· Click on the color wheel icon in the Fill tool menu. Choose or create a color using the 

controls in the Outline Color dialog box.
· Using the primary mouse button, click on the color you want from the palette along 

the bottom of the screen.
· From the Fill Roll-Up window, click on the color you want from the palette displayed 

when you click on the bucket icon.



Cropping a bitmap
You can crop a bitmap to eliminate portions of the image you don't want to display or print.

To crop a bitmap:
1. Using the Shape tool, select the bitmap that you want to crop.
2. Place the mouse pointer over a corner handle to crop in two directions or a side handle 

to crop in one direction.
The pointer changes to a cross.

3. Drag the handle towards the center of the bitmap to crop the bitmap along that edge. 
Drag the handle away from the center of the bitmap to reveal parts hidden by previous
cropping operations.

4. Release the mouse button to redraw the bitmap with the specified cropping.
The Status Line shows the amount of cropping.

5. Drag other handles until only the desired portion of the bitmap is visible.



Tracing a bitmap
Though not as powerful as CorelTRACE, CorelDRAW's built-in autotracing feature lets you 
turn bitmaps into vector graphics that you can edit, scale, print, etc., without distortion.

To trace a bitmap:
1. Select the bitmap.
2. Click on the Pencil tool.

The mouse pointer changes to a cross.
3. Use the Zoom tool to magnify a section of the bitmap.
4. Click just to the left of a dark area in the bitmap you want to trace. The usual 

procedure is to trace the outer edges of the dark areas first, then the edges of any 
light-colored areas.
CorelDRAW will find the dark area to the right of the cursor and draw a path around it.

5. Repeat step 4 for the rest of the areas you want traced.
6. Select any closed paths you want filled.

If you want to see the paths more clearly, switch to wireframe view then choose Show 
Bitmaps from the Display menu to hide the bitmap.

7. Fill the closed paths.
If necessary, bring the paths forward using the To Front or Forward One commands in 
the Arrange menu.
If you want to make the interior areas transparent, combine the paths into a single 
curved object with the Combine command in the Arrange menu then fill the resulting 
object.

8. When you are finished, you can select the bitmap and delete it.
You can control how accurately CorelDRAW traces the bitmap by adjusting settings through 
the Preference command in the Special menu. See Controlling how accurately CorelDRAW 
trace bitmaps.



Displaying and hiding bitmaps on the screen
Bitmaps, especially color ones, can slow down the redrawing speed of your screen. If you're 
working in wireframe view , you can keep the redrawing speed up by hiding the bitmaps.
If you're working in editable preview, you can put bitmaps on a separate layer and then 
make the layer invisible. See Making a layer invisible.

To display and hide bitmaps on the screen:
· If you want to hide bitmaps, choose Show Bitmaps from the Display menu to remove 

the check mark.
· To display bitmaps you've hidden, choose Show Bitmaps again.



Rotating and skewing Bitmaps
You can rotate and skew bitmaps just as you would any other object. However, a bitmap 
rotated or skewed at any angle other than 0 or 180 degrees is displayed as a grayed 
rectangle. The white triangle in the corner of the rectangle indicates the orientation of the 
bitmap.
You must use a PostScript printer to print rotated or skewed bitmaps.



Applying a PostScript halftone screen to a bitmap
You can apply screens to bitmaps in your drawing if you're printing to a PostScript printer. 
The screen's effect on bitmap can only be seen when you print the image.

To apply a screen to a bitmap:
1. Select the bitmap you want to color.
2. Select the Outline tool.
3. Click on the color wheel icon.
4. Choose Spot as the Color Method.
5. Choose PostScript Options.
6. Choose the settings you want. See PostScript Options.
7. Choose OK.



Managing and Printing Files
Managing Files
With CorelDRAW, you don't need to remember what each of your files contain to find a 
particular graphic. You can quickly find the file you want using either Mosaic or the File Find 
command.
Mosaic is a visual file manager that lets you scan through thumbnail views of your files plus 
images in the Clipart libraries. When you locate the graphic you're looking for, simply 
double-click on it to load it into CorelDRAW. A file previewer in the Open Drawing dialog box 
also lets you see thumbnails of your files before you open them. 
The File Find command locates files using keywords you assigned to your files when they 
were saved.
Other features that make working with your files easier include:

Sorting Sorts files by name or date saved.
Annotating Lets you attach notes to your files.
Automatic Backup Creates backup files at regular intervals and whenever you save the

file you are working on.
Save as Version 2.xx Lets you save your files in a format that earlier versions of 

CorelDRAW can use.
Printing Files
Like most CorelDRAW users, you will probably print your work on a desktop laser printer. 
These devices    are generally divided into two classes: PostScript and Non-PostScript. While 
the latter produces excellent output, only PostScript printers can handle all of the special 
drawing effects    CorelDRAW creates. For more information, see PostScript vs. Non-
PostScript.
Before you print, you'll need to install and select the printer you want to use to print your 
file. You can do this with the Printer Setup command in the File menu.
Except for a few special PostScript effects, your drawing will print exactly as it appears in 
CorelDRAW. To avoid losing work in the event of a printer problem, you should always save 
your drawing before printing.



PostScript vs. Non-PostScript
PostScript is a "page description language" - a set of instructions that tell a printer how to 
output text and graphics on a page. It is one of two languages most commonly used by laser
printers. The other is PCL for printer control language. Hewlett Packard developed PCL for its
LaserJet printers, but it is now widely available on printers from other manufacturers.
While it produces excellent results on PCL printers, the ideal output device for CorelDRAW is 
a PostScript printer. This is because CorelDRAW and PostScript handle graphics as objects. 
PCL, on the other hand, handles them as bitmaps. Besides printing faster, object-based 
graphics can also be printed at higher resolutions than PCL graphics and without any loss in 
quality.
Some other advantages of PostScript include the ability to

· produce color separations,
· select halftone screens,
· print CorelDRAW's PostScript Texture fills.

PostScript has one drawback: objects in PostScript are limited in the number of paths they 
can contain. If you exceed this limit, the object (or the entire drawing) will not print. The 
maximum number of paths varies from printer to printer, and is usually only exceeded by 
complex drawings.
CorelDRAW provides a "flatness" control which simplifies objects that are too complex to 
print. You can adjust the flatness control manually or have CorelDRAW adjust it in steps until 
the drawing prints. 



Finding files using keywords
The Find command helps you locate files based on keywords you assigned to them. After a 
list of files with the keywords you specified appears, a file previewer will show you what each
file contains.
You can assign keywords to a file when you open it, and when you save it.

To assign keywords to your files:
1. Do one of the following:

· In the Save Drawing dialog box, choose the Options>> button.
· In the Open Drawing dialog box, select the name of the file to which you want to 

assign keywords, then choose the Options>> button.
2. In the Keywords box, type the keywords you want to assign to the file.

When typing more than one keyword, separate each with a comma. You can type as 
many keywords as you want.

3. Choose OK.
To find files using keywords:

1. Choose Open from the File menu.
2. Choose Options.
3. Choose Find.
4. In the Keywords box, type the keyword(s) you want to use to search for files.

When typing more than one keyword, separate each with a comma.
A comma is treated as an "or" statement and a plus sign as an "and" statement. See 
Keywords Search dialog box.
Choose Search All Directories if you want CorelDRAW to search all directories in the 
current drive.

5. Choose Search.
CorelDRAW displays the files it finds in the File Name box. 



Finding files using CorelMOSAIC
CorelMOSAIC is CorelDRAW's visual file manager. It helps you locate files by giving you 
thumbnail views of what each of your CorelDRAW files contains.

To find files using CorelMOSAIC:
1. Choose Open from the File menu.
2. Choose Options.
3. Choose Mosaic.

CorelMOSAICc opens with thumbnail views of CorelDRAW files in the current directory.
Only files with image headers created in CorelDRAW Version 2.0 and later appear.
To search other drives and directories, choose the Open Directory command in 
CorelMOSAIC's File menu.

4. When you locate the file you want, double-click on it's thumbnail to open it.
To close Mosaic, press ALT+F4.

Use CorelMOSAIC's online Help for more information about using this program.



Adding notes to a file
You can annotate your CorelDRAW files with descriptions, comments or any other 
information you want to record about a file.

To add notes to a file:
1. From the File menu, choose Save if you are saving the file for the first time, or Save As 

if you want to add notes to a previously-saved file.
2. Choose Options.
3. In the Notes box, type the information you want to record about the file.
4. Choose OK.

Once you've added notes to a file, you can edit them either in the Open Drawing or Save 
Drawing dialog boxes. In the Open Drawing dialog box, select the file in the File Name box 
then choose the Options button.



Sorting files
You can sort your drawing files in alphabetical order by filename or by date. Sorting by date   
saves with the most recent files listed first.

To sort files:
1. Choose Open from the File menu.
2. Choose Options.
3. From the Sort box, choose the type of sorting you want.



Making a copy of an open drawing
If you are editing a file and want to keep the original, or you want to save the file in a 
different location you can make a copy of the file by saving it under another name of in 
another drive or directory. 

To make a copy of an open drawing:
1. Open the drawing you want to copy
2. Choose Save As from the File menu.
3. In the File Name box, type a new name for the drawing.

To save the file in a different drive or directory, type the entire path name in the File 
Name box. Or, select the drive from the Drives box and the directory from the 
Directories box.

4. Choose OK.



Opening a backup file
CorelDRAW creates a backup copy of an open file at regular intervals. They have an .ABK 
extension, and are stored in your AUTOBACK directory. If the original file is damaged or a 
problem occurs requiring you to restart your computer, you can open the backup copy.
CorelDRAW also creates a backup copy with the extension .BAK each time you save an open 
file. These are stored in your CORELDRW directory.    They are automatically deleted when you
exit CorelDRAW.

To open a backup file:
1. Choose Open from the File menu.
2. In the File Name box, change the CDR extension to ABK or BAK, and then press Enter.

You can include all three extensions by typing a comma in between them. For example,
C:\CORELDRW\*.CDR,*.ABK,*.BAK.

3. If the file you want is in another drive or directory, type the entire path name in the 
File Name box. Or, select the drive from the Drives box and the directory from the 
Directories box.

4. In the File Name box, type or select the name of the file you want to open.
5. Choose OK.

After opening the file, choose Save As from the File menu and save it with a .CDR 
extension.



Saving drawings for use in earlier versions of CorelDRAW
You may want to save your drawing so that it can be used in versions 2.0 and 2.01 of 
CorelDRAW.
NOTE: If your drawing contains text in a typeface not supplied in version 2.0/2.01,    convert 
the text to curves using the Convert to Curves command in the Arrange menu before you 
save the file.

To save a drawing in CorelDRAW 2.xx format:
1. Open the drawing.
2. Choose Save As from the File menu.
3. Choose Version 2.xx.

To keep the original drawing, do one of the following:
· In the File Name box, type a different name for the 2.xx drawing.
· Save the drawing in another drive or directory. Select the drive from the Drives box,

and the directory from the Directories box.
4. Choose OK.



Saving selected objects only
You may want to save portions of an existing drawing in a new file.

To save selected objects only:
1. Select the objects you want to save.
2. Choose Save As from the File menu.
3. Choose Selected Only.

To keep the original drawing, do one of the following:
· In the File Name box, type a different name for the new file.
· Save the drawing in another drive or directory. Select the drive from the Drives box,

and the directory from the Directories box.
4. Choose OK.



Changing the image header used for previewing files
Image headers allow you to see a bitmap representation of a file's contents before you open 
it. By default, CorelDRAW adds a color header to a file when you save it. You can specify a 
monochrome header instead, or turn the header off.

To change the image header of an open file:
1. From the File menu, choose Save if you are saving the file for the first time, or Save As 

if you want to change the header of a file you previously saved.
2. Under Image Header, choose the type of header you want use.

Choosing a larger size creates a higher resolution bitmap.
For image headers to appear in the Open dialog box, the Preview check box that appears 
when you choose the Options button must be turned on.



Opening Clipart files
CorelDRAW supplies a wide assortment of clipart images that you can use in your drawings. 
The images are stored in compressed Libraries normally installed at the same time as 
CorelDRAW. To access the images, you need to extract them from the Clipart Libraries using 
Mosaic.

To open clipart files:
1. Do one of the following:

· Open Mosaic from the Windows Program Manager by double-clicking on the Mosaic 
icon in the Corel Applications Group.

· In CorelDRAW, choose Open from the File menu, click on the Options button, then 
on Mosaic.

2. Choose Expand from the Library menu.
3. Select the drive/directory the Clipart Libraries are stored in.
4. Click on the name of the library that contains the image you want, or type the name in 

the Library Name box.
5. Choose OK.
6. Double-click on the image you want.
7. Specify the directory in which you want to store the uncompressed image.
8. Choose OK.

After a few seconds, the image will appear in CorelDRAW.



Selecting a default printer
When you print from CorelDRAW, your drawing is automatically sent to the default printer. If 
you have installed other printers, you can specify which one you want CorelDRAW to use. 
The printer you specify remains active until you exit CorelDRAW.

To select a printer:
1. Choose Print Setup from the File menu.

You can also select a printer from the Print Options dialog box. See Print command.
2. From the box under Specific Printer, choose the printer you want to use.

Only installed printers appear. For information on installing printers, see your Microsoft 
Windows User's Guide.

3. Choose the Orientation and Paper options you want to use.
NOTE: When you print a drawing, a message will appear if the orientation of printer 
page and the Printable page (as specified with the Page Setup command) do not 
match. The message will ask if you want CorelDRAW to change the orientation of the 
printed page to match the Printable page. You can disable this message by editing your
CORELDRW.INI file. See WarnBadOrientation.

4. Choose OK.



Setting up the active printer
You can specify the default settings for the active printer from CorelDRAW.

To setup the active printer:
1. Choose Print Setup from the File menu.

You can also select a printer from the Print Options dialog box. See Print command.
2. Choose Options.
3. Select the options you want.

Choose the Help button for information about the options.
4. Choose OK.



Printing a drawing
You can print an entire drawing, selected objects only, or selected layers only.

To print an entire drawing:
1. Choose Print from the File menu.
2. Select the options you want.
3. Choose OK.

To print selected objects:
1. Select the objects you want to print,
2. Choose Print from the File menu.
3. Check the Selected Objects Only check box.
3. Select the options you want.
4. Choose OK.

To print selected layers:
1. From the Layers Roll-Up window, choose which layers you want to print. See Making a 

layer printable or unprintable.
2. Choose Print from the File menu.
3. Select the options you want.
4. Choose OK.



Printing a drawing to a disk
Printing a drawing to a disk allows you to print it from a computer that does not have 
CorelDRAW installed. You would normally use this feature when you want to send your 
drawing to a service bureau for high-resolution printing.

To print a drawing to a disk
1. Choose Print from the File menu.
2. Check the Print to File check box.

If you are sending the drawing to a service bureau that uses Macintosh computers, 
check the For Mac check box.

3. Select any other options you want.
4. Choose OK.

Another dialog box appears, prompting you to give the file a name. Either accept the 
name shown (the same name as the file you are printing), or type your own in the File 
Name box.
CorelDRAW will print the file to the current directory. To print it to another drive or 
directory, type the path name in the File Name box. Or, select the drive from the 
Drives box, and the directory from the Directories box.

5. Choose OK.
Another dialog box appears, displaying the current print options for the selected 
printer.

6. Choose the options you want.
7. Choose OK.



Printing drawings larger than the printer's paper size
CorelDRAW provides three options for printing drawings that exceed the size of the paper in 
your printer. They affect the printed size; they do not affect the drawing's size.

To print drawings larger than the printer's paper size:
1. Choose Print from the File menu.
2. Choose one of the following options:

Fit to Page Reduces the drawing to fit on the size of paper the printer is using.
Tile Prints parts of the drawing outside the boundaries of the printer paper on 

additional pages.
Scale Reduces the drawing to a percentage of its original size.

4. Select any other options you want.
5. Choose OK.



Printing text in a drawing using your printer's fonts
Are fonts used in your drawing resident in your PostScript printer? If so, your drawing will 
print more quickly if you use your printer's fonts.
The following procedure can also be used to reduce the size of files created when a drawing 
is printed to a disk. You may want to take advantage of this when sending your work to a 
service bureau that has Adobe versions of the fonts you used.
NOTE: If a font used in the drawing is not resident in the printer, either the text will print in 
Courier, or the page will not print.

To print text in a drawing using your printer's fonts:
1. Choose Print from the File menu.
2. Turn on the All Fonts Resident check box.
4. Select any other options you want.
5. Choose OK.



Specifying the number of stripes used to print fountain fills
When proofing drawings with fountain fills, you may want to speed up printing by reducing 
the number of stripes used to print the fountains. The fewer the stripes, the coarser the 
fountain appears, and the faster the drawing prints.
When you are ready to print the final version of your drawing, increase the number of stripes
to the default setting (128 for PostScript printers and 64 for non-PostScript printers) or 
higher.

To specify the number of stripes used to print fountain fills:
1. Choose Print from the File menu.
2. In the Fountain Stripes box, select the number of stripes you want.
3. Select any other options you want.
4. Choose OK.



Increasing the printing speed of drawing with complex curves
When proofing drawings with complex curves, you may want to speed up printing by 
increasing the "flatness" setting. The higher the setting, the rougher the curves appear and 
the faster the drawing prints.
When you are ready to print the final version of your drawing, reset the flatness to the 
default value (1.00).
Use the procedure appropriate for the type of printer you are using.

PostScript printers:
You can also use this procedure to simplify curves too complex to print. See Printing complex
drawings on a PostScript printer.

1. Choose Print from the File menu.
2. In the Set Flatness To box under Flatness, type or select the flatness setting you 

want.
3. Select any other options.
4. Choose OK.

Non-PostScript printers:
This procedure also improves the redraw speed of the screen.

1. Choose Preferences from the Special menu.
2. Choose the Curves button.
3. Under Curve Flatness, select the flatness setting you want.

Draft produces the fastest printing/redrawing times but the roughest curves. 
To specify a value between Normal and Draft, choose Custom and type or select the 
value you want.

4. Choose OK to close the dialog box.
5. Choose OK to close the Preferences dialog box.



Printing complex drawings on a PostScript printer
Printing a drawing that contains complex curve objects sometimes produces a "limitcheck 
error" that causes the printer to stop printing. When this happens, you can use the Flatness
control in the Print Options dialog box to    simplify your drawing. You can adjust the control 
manually or have CorelDRAW adjust it in steps until the drawing prints.
NOTE: The flatness value affects the appearance of your drawing: If it is set too high, curves 
may become noticeably rough.

To simplify a complex drawing:
1. Choose Print from the File menu.
2. Choose one of the following Flatness options:

Set Flatness To Lets you type or select a flatness value. As a general rule, try 
increasing the value in increments of 4 or 5 until the drawing 
prints.

Auto Increase Automatically increases the flatness value in increments of two 
until the drawing prints. If a limit of 10 plus the current Set 
Flatness To value is reached and a particular object still will not 
print, the printer will skip that object and print the next.

3. Choose OK.
Other measures you can take to simplify a drawing:

· Lower the PSComplexityThreshold setting in your CORELDRW.INI file.
· Avoid converting large text strings to curves. If you must convert them, use the Break 

Apart command in the Arrange menu to break the resulting curves into smaller objects.
Next, use the Combine command to combine the paths of letters such as "O" and "B" 
which have holes.

· Avoid combining such text with other objects (for example, to create clipping holes or 
masks).

· Remove extraneous objects and nodes. Each object adds 150 bytes to the file; control 
points and nodes each add 1 byte.



Printing a drawing without starting CorelDRAW
You can print a drawing without having to start Windows or CorelDRAW.

To print a drawing from DOS:
1. From the DOS command prompt type:

win drive\directory\coreldrw.exe /p filename.cdr
where 
drive and directory are the drive and directory where CorelDRAW is located and 
filename is the name of the file you want to print.
NOTE: If the file is a different directory than CorelDRAW, type the drive and directory in
which the file is located.

2. Press ENTER.
This starts Windows and opens the CorelDRAW Print Options dialog box.

3. Choose the options you want.
4. Choose OK.

To print a drawing from Windows:
1. Open the Program Manager.
2. Choose Run from the File menu.
3. Type drive\directory\coreldrw.exe /p filename.cdr

where
drive and directory are the drive and directory where CorelDRAW is located and 
filename is the name of the file you want to print.
NOTE: If the file is a different directory than CorelDRAW, type the drive and directory in
which the file is located.

4. Choose OK.
The CorelDRAW Print Options dialog box will appear.

5. Choose the options you want.
6. Choose OK.

NOTE: You can assign a Program Item icon to the file so that it prints without having to type 
the path and filename. See your Windows User's Guide for details on assigning Program Item
icons.



Printing color separations
You can print both Spot and four-color process separations from CorelDRAW. Provided you 
have a PostScript printer driver installed and selected, you don't actually need a PostScript 
printer connected to your system to create four-color process separations. You can print the 
separations to disk and then output them on another computer connected to a PostScript 
printer.    See Printing a drawing to a disk.

To print color separations:
1. Choose Print from the File menu.
2. Turn on the Print As Separations check box.

CorelDRAW automatically turns on the Crop Marks & Crosshairs, Film Negative 
and Include File Info check boxes.
NOTE: The Crop marks, crosshairs and File Info (file name, date, and color separation 
information) will print only when the page size of the drawing is smaller than the paper
size you are printing on. If the page size is 8.5x11 inches, choosing Within Page will 
print the File information inside the left margin of your drawing. To print outside the 
margin, the page size must be smaller than the paper size.

3. Select any other options you want.
4. Choose OK to display the Color Separations dialog box.

By default, CorelDRAW prints one page for each of the Process and Spot colors listed. 
To print selected colors only, choose Selected Colors and then click on the colors you 
want to print.
You can adjust the screen angle and frequency for each of the four process colors. It's 
best not to change these values unless your service bureau or commercial printer 
advises otherwise to avoid moire patterns.

5. Choose OK.



Using Print Merge
CorelDRAW can automatically merge a drawing with information in a text file and send the 
result to the printer. Print Merge is ideal for creating personalized certificates or similar 
documents in which text changes from one copy of the document to the next.

To prepare the Merge file:
1. Open a new document in your word processor.
2. Type the number of strings of Artistic text or frames of Paragraph text in the drawing 

you want replaced, then press ENTER.
You can replace as many strings or frames in the drawing as you wish, but each 
string/frame must be unique.

3. Type the text exactly as it appears in the drawing, putting a backslash (\) before and 
after each string/frame.
Each string/frame can be typed back to back (e.g., \Name\Company\Address\), or on 
separate lines as follows:
\Name\
\Company\
\Address\

4. Type the text you want inserted into the drawing, putting a backslash (\) before and 
after each string/frame.
The replacement strings/frame can be typed back to back, or on separate lines.
For every text string/frame entered in step 3, there must be a corresponding one 
entered in step 4.
You can enter multiple sets of replacement strings/frames as long as each set is 
complete.

5. When you are finished, save the file in ASCII format.
To merge the text file with the drawing:

1. Open the drawing you want to merge the text with.
2. Choose Print Merge from the File menu.
3. Select the text file.
4. Choose OK.
5. Select any print options you want.
6. Choose OK.

CorelDRAW merges the text with the drawing and sends the result to the printer.
For more information, see "Using Print Merge" in the "Managing and Printing Files" chapter of
your CorelDRAW User's Guide.



Overprinting Spot colors
Normally, whenever you print two overlapping spot colors, the top color knocks out the color
beneath it. For certain visual effects, you may want both colors to print.    

To overprint Spot colors:
1. Select the object on top of the one you want to overprint.
2. Select the Fill tool.
3. Click on the color wheel icon.
4. From the Uniform Fill dialog box, choose the PostScript Options button.
5. Turn on the Overprint check box.
6. Choose OK.

To overprint the object's outline, use the same procedure, but access the PostScript Options 
dialog box from the Outline tool menu.



Creating trap
You can use CorelDRAW's Overprint feature to create trap.

To create trap:
1. Select the object on top of the one you want to trap.
2. The remaining steps depend on the fill and outline attributes of the object you are 

trapping.
Fill only
· Give the object an outline about 0.30 points thick.
· Assign the object's fill color to the outline.
Outline only
· Duplicate the object you are trapping and place the duplicate on top of the original.
· Increase the thickness of the duplicate's outline by 0.30 points.
Color of topmost object darker than the object beneath it
· Duplicate the object you are trapping and place the duplicate on top of the original.
· Give the duplicate a fill of None.
· Increase the duplicate's outline by about 0.30 points and assign the outline the 

same color as the object underneath it.
White outline or no outline and white fill
· No trap required.

3. With the object or its duplicate selected, click on Outline tool.
4. Click on the color wheel icon.
5. Choose the PostScript Options button.
6. Turn on the Overprint check box.
7. Choose OK.

Also, make sure the Overprint check box is turned off for the object's fill.
The effects of trap only show in the press proofs and in the final printed artwork.

NOTE: To trap text filled with black, designate the text to overprint through the Fill tool's 
PostScript Options dialog box.
For more information see "Overprinting to Create Trap" in the "Managing and Printing Files" 
chapter in your CorelDRAW User's Guide.



Outlining and Filling Objects
Outline and Fill Attributes
When you add an object to a drawing, it is automatically given a set of default outline and fill
attributes. These vary with the type of object and can be changed using the Outline and Fill 
tools.
Open paths are given outline attributes such as thickness and color, line style (solid, dashed,
etc.) and line ending shape (round, square, arrowhead, etc.).
Closed paths are given a fill attribute and some of the outline attributes of an open path. The
fill attribute can be a solid color, a fountain fill or a pattern. You can turn either set of 
attributes off and leave the other visible. Turning off a rectangle's fill for example, makes it 
transparent, allowing objects behind it to show through.
Text is given the same attributes as open and closed paths, and others such as typeface and
style, point size, inter-line spacing and so on.

Choosing Attributes
For flexibility and ease of use, CorelDRAW offers four ways to select fill and outline 
attributes. 

Fly-out menus Provide quick access to pre-defined line thicknesses and colors for 
outlining and filling objects. You display the fly-out menus by clicking 
on the Outline and Fill tools.

Color Palette Lets you select Outline and Fill colors with the click of a mouse button. 
A command in the Display menu turns the palette on and off and loads 
it with Spot or Process color.

Roll-Up Window Lets you apply a wide range of attributes with one or two clicks of your 
mouse. You can have the window open as you work or hide the 
controls, leaving just the Title bar visible. You display the roll-up 
windows by clicking on icons in the in the fly-out menus.

Dialog Boxes Give you access to all available attributes plus controls for specifying 
attributes such as line thickness with numeric precision. You display the
dialog boxes by clicking on icons in the fly-out menus and the Edit 
button in the roll-up windows.



Choosing a line thickness
You can choose a variety of common line thicknesses from the Outline tool menu and specify
others with the Pen Roll-Up window and the Outline Pen dialog box.

To select a line thickness from the Outline tool menu:
1. Select the object you want to outline.
2. Select the Outline tool.
3. Click on the line thickness you want. The choice of thicknesses is 1/4 point, 2, 8, 16, 

and 24 points.
To select a line thickness from the Pen Roll-Up window:

1. If the window is not displayed, click on  in the Outline tool menu.
2. Select the object you want to outline.
3. Select the line thickness you want by clicking on the Thickness Selector arrows.

Each click changes the thickness by .01 inches. Click the down arrow repeatedly to 
select hairline or no outline at all.

4. Click on the Apply button.
To select a line thickness from the Outline Pen dialog box:

1. Select the object you want to outline.
2. Select the Outline tool.
3. Click on the pen icon.
4. In the Width box, type or select the line thickness you want.

To use a different unit of measurement, select it from the units box. CorelDRAW will 
automatically convert the Width value to its equivalent in the unit you select.

5. Choose OK.



Choosing an outline color
For outlining in black, white and shades of gray, you can use icons in the Outline tool. To 
outline in color, you can use the Pen Roll-Up window, the on-screen color palette, or the 
Outline Color dialog box.

From the Outline tool menu:
1. Select the object you want to outline.
2. Select the Outline tool.
3. Click on black, white or the shade of gray you want. The shades vary in increments of 

20% from 10% to 90%.
From the Pen Roll-Up window:

1. If the window is not displayed, click on  Outline tool menu.
2. Select the object you want to outline.
3. Click on the Color Selector bar.
4. Click on the color you want.
5. Click on the Apply button.
From the on-screen Color Palette:

1. If the palette is not displayed, choose Show Color Palette from the Display menu. Then 
from the sub-menu, choose either Spot Colors or Process Colors.

2. Select the object you want to outline.
3. Select the color you want from the palette by clicking on it with the secondary mouse 

button.
To scroll the palette one color at a time, click on an arrow at either end of the palette 
with the primary mouse button. Click with the secondary mouse button to scroll the 
width of the screen.

From the Outline Color dialog box:
1. Select the object you want to outline.
2. Do one of the following:

· From the Outline tool menu, click on the color wheel icon.
· From the Pen Roll-Up window, click on the Edit button, then under Color choose the 

More button.
3. Next to Method, choose the color specification method (Spot or Process) you want to 

use.
4. Do one of the following:

· To choose a color by sight, choose Palette from the Model box then click on it.
If you want a lighter shade of the selected Spot color, type or select a value in the 
%Tint box. 

· To choose a color by name, choose Names from the Model box, then click on the 
name of the color.
The Search option lets you locate a Spot color by typing part of its name. As you 
type, the list of names scrolls to the color that most closely matches what you type. 
You do not need to type the word Pantone.

· To create a Process color, choose CMYK, RGB or HSB from the Model box. Create the
color you want using the numeric controls or the color adjustment markers. See 
Creating custom Process colors.

5. Choose OK.



6. If you are using the Pen Roll-Up window, click on the Apply button.



Removing an object's outline
While you can remove an object's outline using the Pen Roll-Up window and the Outline Pen 
dialog box, it's quicker to use the Outline Pen menu or the on-screen color palette.

From the Outline tool menu:
1. Select the object with the outline you want to remove.
2. Select the Outline tool.
3. Click on the  button.

From the on-screen color palette:
1. If the palette is not displayed, choose Show Color Palette from the Display menu. Then 

from the sub-menu, choose either Spot Colors or Process Colors.
2. Select the object with the outline you want to remove.
3. Click with the secondary mouse button on the  button at the left end of the palette.



Choosing a dashed and dotted line style
You can outline objects with a variety of dashed and dotted line styles.    You can even create
you own line styles and have them added to the existing selection. See CORELDRW.DOT   File  .

From the Pen Roll-Up window:
1. If the window is not displayed, click on  in the Outline tool menu.

2. Select the object you want to outline with a dashed and dotted line.
3. Click on the Line Style Selector bar to display a list of line styles.
4. Click on the style you want.
5. Click on the Apply button.
From the Outline Pen dialog box:

1. Select the object you want to outline.
2. Select the Outline tool.
3. Click on the pen icon.
4. Click on the Style box to display a list of line styles.
5. Click on the style you want.

If you want dash segments with rounded ends, choose the second option under Line 
Caps.
To create a dotted line, apply round caps to a line style with short, widely spaced 
segments.

6. Choose OK.



Copying an object's outline
Once you apply an outline to an object, you can quickly apply the same outline to another 
object.

Using the Copy Style From command:
1. Select the object with the outline you want to change.
2. From the Edit menu, choose Copy Style From.
3. Choose Outline Pen and/or Outline Color.
4. Choose OK.

The mouse pointer becomes an arrow with the word From?
5. Click on the outline of object with the outline you want to copy.

Using the Pen Roll-Up window:
1. If the window is not displayed, click on  in the Outline tool menu.

2. Select the object you want to change.
3. Choose the Update From button.

The mouse pointer changes to an arrow with the word From?
4. Click on the object with the outline you want copied.
5. Click on the Apply button.



Creating calligraphic outlines
Calligraphic outlines have a varying thickness that give an object a hand-drawn appearance.

To create a calligraphic outline:
1. Select the object with the outline you want to change.
2. Do one of the following:

· From the Outline tool menu, click on the pen icon.
· From the Pen Roll-Up window, click on the Edit button.

3. In the Width box, type or select the line thickness you want.
To use a different unit of measurement, select it from the units box. CorelDRAW will 
automatically convert the Width value to its equivalent in the unit you select.

4. Define the Nib Shape of the Outline Pen by choosing a Corners option. The first and 
third options make the nib square; the second makes it round.
You can adjust the shape of the nib even further with the Stretch setting. Lowering the
value makes a square nib rectangular and a round nib oval.

5. Enter the pen angle you want in the Angle box. The angle controls the orientation of 
the pen to the drawing surface.
You can interactively adjust Stretch and Angle by dragging in the Nib Shape box.

6. Choose OK.
NOTE: To change line widths after creating the calligraphic outline, use the Width setting in 
the Outline Pen dialog box. Selecting a line width from the Outline menu will reset the Angle
to zero degrees and Stretch to 100 percent.



Applying arrowheads and other line ending shapes
CorelDRAW provides an assortment of arrowheads and other line ending shapes that you can
apply to the ends of an open path. You can also add arrowheads of your own design to the 
existing selection. See Creating arrowheads and other line ending shapes.
After selecting the arrowhead/line ending shape, you can resize it and adjust its position 
relative to the end of the path. See Editing an arrowhead or line ending shape.

From the Outline Pen dialog box:
1. Select the path to which you want to apply the arrowhead/line ending shape.
2. Select the Outline tool.
3. Click on the pen icon.
4. To apply an arrowhead to the start of the path, click on the left box under Arrows, then

click on the arrowhead you want.
5. To apply an arrowhead to the end of the path, click on the right box under Arrows, 

then click on the arrowhead you want.
If necessary, you can swap the arrowheads by choosing either of the Options buttons, 
followed by Swap.
To remove an arrowhead from a path, click on the appropriate box under Arrows and 
select the first option in the list.

6. Choose OK.
From the Pen Roll-Up window:

1. If the window is not displayed, click on  in the Outline tool menu.
2. Select the path to which you want to apply the arrowhead/line ending shape.
3. To apply an arrowhead to the start of the path, click on the left Arrowhead Selector, 
then click on the arrowhead you want.
4. To apply an arrowhead to the end of the path, click on the right Arrowhead Selector, 
then click on the arrowhead you want.

To remove an arrowhead from a path, click on the appropriate Arrowhead Selector and 
choose the first option in the list.

5. Click on the Apply button.



Editing an arrowhead or line ending shape
When you apply an arrowhead to a path, its size is determined by the thickness of the path's
outline. If you increase the thickness, the arrowhead size increases proportionately. To get a 
larger arrowhead without changing the outline of the path, use the Arrowhead Editor. You 
can also use the Editor to adjust the arrowhead's position relative to the end of the path.

To edit an arrowhead or line ending shape:
1. Select the path with the arrowhead/line ending shape you want to edit.
2. Do one of the following:

· From the Outline tool menu, click on the pen icon.
· From the Pen Roll-Up window, click on Edit.

3. Under Arrows, choose the Options button that's beneath the arrowhead you want to 
edit.

4. Choose Edit. 
5. Do one or more of    the following:

· To stretch the arrowhead/shape, drag on the solid handles between the corners of its
highlight box. Drag the corner handles to scale it.

· To move the arrowhead/shape, drag the hollow nodes along its outline. To ensure 
precise alignment as you approach the dashed lines, the node you are using to 
move snaps to the line.

· To move the solid black line representing the line the arrowhead/shape will be 
applied to, drag the node at its end.

· To center the arrowhead/shape on the line, choose the Center buttons.
· To flip the arrowhead over, choose the Reflect buttons.

6. Choose OK to return to the Outline Pen dialog box.



Creating arrowheads and other line ending shapes
If none of the arrowheads and line ending shapes suit your needs, you can use the drawing 
tools to create your own. 
After you create the arrowhead/line ending shape, you can resize it and adjust its position 
relative to the end of the path. See Editing an arrowhead or line ending shape.

To create arrowheads and other line ending shapes:
1. Draw the arrowhead/line ending shape.

You can draw more than one object, provided you combine them using the Combine 
command in the Arrange menu.
The arrowhead/line ending shape assumes the fill and outline attributes of the line to 
which it is applied.

2. Select the arrowhead/line ending shape.
3. Choose Create Arrow from the Special menu.

A confirmation box appears, asking whether you want to create an arrowhead from the 
selected object.

4. Choose OK.
CorelDRAW adds the arrowhead to the end of the arrowhead list in the Outline Pen 
dialog box and the Pen Roll-Up window.

To create outlined arrowhead/line ending shapes:
· Before choosing Special Create Arrow, convert the object to curves using the Convert 

To Curves command in the Arrange menu. Then, using the Shape tool, break each of 
the objects at a node.

· If the object is a triangle, rectangle or other angled shape, convert it to curves. Using 
the Shape tool, add a node between the corners, and then break the object at that 
node.



Closing paths to accept fills
You can only fill objects that form a "closed' path. To fill an open path, you must close it by 
joining the nodes at the two ends. 

To close an open path:
1. Find the nodes on the ends of the path you want to close.
2. Using the Shape tool, select the nodes by dragging a marquee box around them, or by 

holding down the SHIFT key and clicking on them.
3. Double-click on one of the selected nodes.

The Node Edit menu appears.
4. Choose the Join button.



Choosing a fill color
From the Fill tool menu, you can fill objects with black, white and five shades of gray. To fill 
objects with a uniform color, you can use the Fill Roll-Up window, the on-screen Color Palette 
or the Uniform Fill dialog box.

From the Fill tool menu:
1. Select the object you want to outline.
2. Select the Fill tool.
3. Click on black, white or the shade of gray you want. The shades vary in increments of 

20% from 10% to 90%.
From the Fill Roll-Up window:

1. If the window is not displayed, click on  in the Fill tool menu.
2. Select the object you want to outline.
3. Click on the Uniform Fill button (the one with the bucket).
4. Click on the color you want.
5. Click on the Apply button.
From the on-screen Color Palette:

1. If the palette is not displayed, choose Show Color Palette from the Display menu.    
From the sub-menu, choose either Spot Colors or Process Colors.

2. Select the object you want to fill.
3. Select the color you want from the palette by clicking on it with the primary mouse 

button.
To scroll the palette one color at a time, click on an arrow at either end of the palette 
with the primary mouse button. Click with the secondary mouse button to scroll the 
width of the screen.

From the Uniform Fill dialog box:
1. Select the object you want to fill.
2. Do one of the following:

· From the Fill tool menu, click on the color wheel icon.
· From the Fill Roll-Up window, choose the Edit button.

4. Next to Method, choose the color specification method (Spot or Process) you want to 
use.

5. Do one of the following:
· To choose a color by sight, choose Palette from the Model box then click on it. .

If you want a lighter shade of a selected Spot color, type or select a value in the 
%Tint box. 

· To choose a color by name, choose Names from the Model box, and then click on 
the name.
The Search option lets you locate a Spot color by typing part of its name. As you 
type, the list of names scrolls to the color that most closely matches what you type. 
You do not need to type the word "Pantone".

· To create a Process color, choose CMYK, RGB or HSB from the Model box. Create the 
color you want using the numeric controls or the color adjustment markers. See 
Creating custom Process colors.

6. Choose OK.
7. If you are using the Fill Roll-Up Window, click on the Apply button.





Making an object transparent
You may want to remove an object's fill so that objects behind it show through.
You can remove fills using the Fill Roll-Up window and the Uniform Fill dialog box, but it's 
quicker to use the Fill tool menu or the on-screen color palette.

From the Fill tool menu:
1. Select the object with the fill you want to remove.
2. Select the Fill tool.
3. Click on the  button.

From the on-screen Color Palette:
1. If the palette is not displayed choose Show Color Palette from the Display menu. Then 

from the sub-menu choose either Spot Colors or Process Colors.
2. Select the object whose fill you want to remove.
3. Click with the primary mouse button on the  button at the left end of the palette.



Creating a fountain fill
A fountain fill is one that flows smoothly from one color to another. The fill can flow in a 
straight line across the object (linear), or in concentric circles from the center of the object 
out (radial).
You can use a dialog box or the Fill Roll-Up window to create fountain fills.

From the Fountain fill dialog box:
1. Select the object you want to fill.
2. Select the Fill tool.
3. Click on the Fountain fill icon.
4. Choose the type of fountain you want (Linear or Radial).
5. Click on the From color button and then on the color you want as the start color.
6. Click on the To color button and then on the color you want as the end color.

To create your own colors or select existing ones by name, choose the More button.
NOTE: If you are using Spot color, and plan to create color separations, use tints of the 
same color to specify the start and end colors.

7. To specify the angle of a Linear fountain do one of the following:
· Type or select the angle in the Angle box.
· Hold the mouse button down in the Preview box and drag. Holding down the CTRL 

key as you drag constrains the angle to 15-degree increments.
8. To offset the center of a Radial fountain do one of the following:

· In the X and Y boxes under Center Offset, type or select the amount of offset.
· Hold the mouse button down in the Preview box and drag. Holding down the CTRL 

key as you drag constrains the amount to 20-percent increments.
9. To increase the percentage of start and end color in the fountain, type or select the 

percentage in the Edge Pad box.
10. Choose OK.

From the Fill Roll-Up window:
1. If the window is not displayed, click on  in the Fill tool menu.

2. Select the object you want to fill.
3. Click on the Fountain fill button.
4. Click on to create a linear fountain,    or on 

 to create a radial fountain.
5. Click on the left color button, , and then on the color you want as the start color.
6. Click on the right color button, , and then on the color you want as the end color.
7. Do any of the following:

· To change the angle of a Linear fountain, hold the mouse button down in the upper 
Preview box and drag. Holding down the CTRL key as you drag constrains the angle 
to 15-degree increments.

· To offset the center of a Radial fountain, hold the mouse button down in the upper 
Preview box and drag. Holding down the CTRL key as you drag constrains the 
amount to 20-percent increments.

8. Click on the Apply button.



Choosing a Two-Color fill pattern
You can fill objects with a pattern composed of repeating bitmap images. CorelDRAW 
supplies a collection of black and white bitmap patterns to which you can add color. You can 
also create your own patterns from imported bitmaps or from images drawn in CorelDRAW. 
See Creating a pattern fill.

From the Two-color pattern dialog box
1. Select the object you want to fill.
2. Select the Fill tool.
3. Click on Two-color pattern icon (checkerboard).
4. Click on the arrow in the preview box.
5. Click on the pattern you want and choose OK.
6. To color the pattern:

· Click on the Back color button and then on the color you want for the background 
color.

· Click on the Front color button and then on the color you want for the foreground 
color.

To create your own colors or select existing ones by name, choose the More button.
7. To specify the pattern size, do one of the following:

· Choose Small, Medium or Large to select a predefined size of 0.25x0.2, 
50.50x0.50 or 1.00x1.00 inches.

· Choose the Tiling button and type or select a custom size (up to 3x3 inches) in the 
Width and Height boxes.

To use a different unit of measure, select it from the units box. CorelDRAW will 
automatically convert the displayed value to its equivalent in the unit you select.

8. To offset the pattern tiles:
· Choose the Tiling button.
· To offset the entire pattern horizontally and/or vertically, type or select the amount 

of offset in the X and Y boxes under First Tile Offset.
· To offset alternating row or columns of tiles, choose Row or Column under 

Row/Column Offset, then type or select the amount of offset.
9. Choose OK.

From the Fill Roll-Up window:
1. If the window is not displayed, click on  in the Fill tool menu.

2. Select the object you want to fill.
3. Click on the Two-color pattern button (checkerboard).
4. Click on the arrow in the preview box.
5. Click on the pattern you want and choose OK.
6. To color the pattern:

· Click on the left color button, , and then on the color you want for the foreground
color.

· Click on the right color button, , and then on the color you want for the 
background.

7. To scale the pattern tiles:
· Choose the Tile button. A pair of boxes appear inside the object you are filling.
· Drag the small square along the bottom edge of the boxes to scale the pattern.

8. To offset the pattern tiles:



· Choose the Tile button. A pair of boxes appear inside the object you are filling.
· To offset the entire pattern, hold the mouse button down inside the left box and 

drag.
· To offset alternating columns of tiles, hold the mouse button down inside the right 

box and drag down.
· To offset alternating rows of tiles, hold the mouse button down inside the right box 

and drag down and to the left 
9. Click on the Apply button.

NOTE: You can store the pattern fill you created and use it again to fill other objects. See 
Saving, applying and deleting a custom fill.



Choosing a Full-color fill pattern
CorelDRAW supplies an extensive selection of Full-color pattern fills composed of repeating 
vector images. You can also create your own patterns from imported images, or from images
drawn in CorelDRAW. See Creating a pattern fill.

From the Full-color pattern dialog box
1. Select the object you want to fill.
2. Select the Fill tool.
3. Click on the Full-color pattern icon (double-headed arrow).
4. Click on the pattern filenames to display a sample of the pattern in the preview box.
5. Click on the arrow in the preview box.
6. Click on the pattern you want and choose OK.
7. To specify the size of the pattern, do one of the following:

· Choose Small, Medium or Large to select a predefined size of 0.25x0.2, 
50.50x0.50 or 1.00x1.00 inches.

· Choose the Tiling button and type or select a custom size (up to 3x3 inches) in the 
Width and Height boxes.

To use a different unit of measure, select it from the units box. CorelDRAW will 
automatically convert the displayed value to its equivalent in the unit you select.

8. To offset the pattern tiles:
· Choose the Tiling button.
· To offset the entire pattern horizontally and/or vertically, type or select the amount 

of offset in the X and Y boxes under First Tile Offset.
· To offset alternating row or columns of tiles, choose Row or Column under 

Row/Column Offset, then type or select the amount of offset. 
9. Choose OK.

From the Fill Roll-Up window:
1. If the window is not displayed, click on the roll-up window icon in the Fill tool menu.
2. Select the object you want to fill.
3. Click on the Full-color pattern button (double-headed arrow).
4. Click on the arrow in the preview box.
5. Click on the pattern you want and choose OK.
6. To scale the pattern tiles:

· Choose the Tile button. A pair of boxes appear inside the object you are filling.
· Drag the small square along the bottom edge of the boxes to scale the pattern.

7. To offset the pattern tiles:
· Choose the Tile button. A pair of boxes appears inside the object you are filling.
· To offset the entire pattern, hold the mouse button down inside the left box and 

drag.
· To offset alternating columns of tiles, hold the mouse button down inside the right 

box and drag down.
· To offset alternating rows of tiles, hold the mouse button down inside the right box 

and drag down and to the left 
8. Click on the Apply button.

NOTE: You can store the pattern fill you created and use it again to fill other objects. See 



Saving, applying and deleting a custom fill.



Choosing a PostScript texture
PostScript textures are pattern fills that you can change by altering a set of variables. These 
patterns don't appear on screen,    and require a PostScript printer to print.
For samples of the textures, see Appendix A in your CorelDRAW User's Manual.

To choose a PostScript texture:
1. Select the object you want to fill.
2. Select the Fill tool.
3. Click on the PS icon.
4. Click on the name of the texture you want.
5. Adjust the parameters to customize the texture as required.
6. Choose OK.



Copying an object's fill
Once you apply a fill to an object, you can quickly apply the same fill to another object.

Using the Copy Style From command:
1. Select the object whose fill you want to change.
2. From the Edit menu, choose Copy Style From.
3. Choose Fill.
4. Choose OK.

The mouse pointer becomes an arrow with the word From?
5. Click on the outline of the object with the fill you want to copy.

Using the Fill Roll-Up window:
1. If the window is not displayed, click on  in the Fill tool menu.

2. Select the object you want to change.
3. Click on the Update From button.

The mouse pointer becomes an arrow with the word From?
4. Click on object with the fill you want copied.
5. Click the Apply button.



Saving, applying and deleting a custom fill
Saving pattern fills you've created lets you quickly apply them to objects in other drawings. 
Although you use the Fill Roll-Up window to save them, the fills could have been created 
using either the roll-up window or a dialog box. 

To save a fill created with the Fill Roll-Up window:

1. If the window is not displayed, click on  in the Fill tool menu.
2. Select the object with the fill you want to save.
3. If the object's fill is not displayed in the preview box, click on the Update From 
button.
4. Click on the arrow in the preview box.
5. Click on File, then choose Save Current Fill.

CorelDRAW adds the fill to the first empty square.
To apply a custom fill:

1. If the window is not displayed, click on  in the Fill tool menu.
2. Select the object you want to fill.
3. Click on the button that corresponds to the type of fill you want to apply.
4. Click on the arrow in the preview box.
5. Click on the fill you want, then choose OK.
6. Click on the Apply button to fill the selected object.
To delete a custom fill:

1. If the window is not displayed, click on  in the Fill tool menu.
2. Click on the button that corresponds to the type of fill you want to delete.
3. Click on the arrow in the preview box.
4. Click on the fill you want to delete
5. Click on File, then choose Delete Item.



Applying halftone screens
Filling and outlining objects with Spot color allows you to apply halftone screens to them. You
can apply a single screen to the entire drawing or different screens to individual objects. The
halftone screen's effect on your drawing won't appear on screen. To see it, you must print 
your drawing on a PostScript printer.

To apply halftone screens to all objects:
Screens applied using this procedure affect objects which have not been assigned other 
screens from the PostScript Options dialog box.

1. Choose Print from the File menu.
2. Do one of the following:

· If you are printing a composite of your drawing and you want to use the printer's 
default screen frequency, choose Default Screen Frequency. 
NOTE: Different printers will have different default screen values depending on their 
resolution. If you do not know your printer's default value or want to use a different 
one, choose Custom and type or select the frequency in the adjacent box.

· If you are printing color separations or printing to file, choose Custom and type or 
select the frequency in the adjacent box.
The Color Separations dialog box that appears when you choose OK allows you to 
specify screen frequencies and angles for each of the process colors, and any Spot 
colors used in your drawing. Change these values only on the advice of your service 
bureau or commercial printer to avoid moire patterns.

3. Select any other options you need.
4. Choose OK.

To apply halftone screens to individual objects:
Objects you don't apply screens to using this procedure print using the screen settings 
specified in the Print Options dialog box. 

1. Select the object with the screen settings you want to adjust.
2. Select the Fill tool to apply a screen to the object's fill or the Outline tool to apply it to 

object's outline.
3. Click on the color wheel icon.
4. Choose the PostScript Options button.
5. Choose the screen settings you want.
6. Choose OK.



Creating a pattern fill
You can design your own Two-Color and Full-Color fill patterns to supplement those supplied 
with CorelDRAW. Virtually any graphic may be used as the basis for your pattern: a simple 
shape, a piece of text, a color vector illustration, or even an imported bitmap and vector 
image. See the following topics for more information:
· Creating pattern fills using the Create Pattern command
· Creating Two-color pattern fills with the Bitmap Editor
· Creating pattern fills from imported images



Creating pattern fills using the Create Pattern command
The Create Pattern command lets you create your own Two-color and Full-color pattern fills. 
You can create the pattern from a graphic designed in CorelDRAW or from bitmap and vector
graphics you import into the program. The graphic becomes a tile which repeats to form a 
pattern inside any closed path to which it's applied.

To create a pattern fill using the Create Pattern command: 
1. Load the bitmap or vector graphic you want to make into a pattern or draw it.
2. Choose Create Pattern from the Special menu.
3. Choose the type of pattern you want to create.

If you choose Two-color, specify the resolution you want.
If the bitmap contains color, choose Full-color.
The mouse pointer changes to a set of crosshairs.

4. Select the graphic, or portion of the graphic you want to make into a pattern by holding
down the mouse button and dragging a marquee box around it.

5. Release the mouse button.
A confirmation box appears, asking you whether you want to create a pattern from the 
selected area.

6. Choose OK.
If you are creating a Full-color pattern, another dialog box appears prompting you to 
give the pattern a name. Type a name in the File name box and choose OK.
CorelDRAW adds the pattern to those accessed through the Two-color and Full-color 
pattern icons in the Fill tool menu and in the Fill Roll-Up window.

For more information, see "Creating Pattern Fills Using the Create Pattern Command" 
Pattern" in the "Filling Objects" chapter of your CorelDRAW User's Manual.



Creating Two-color pattern fills using the Bitmap Editor
CorelDRAW's Bitmap Editor lets you create your own Two-color pattern fills. Patterns you 
create are added to the ones supplied with the program.

To create Two-color pattern fills using the Bitmap Editor:
1. Select the object you want to fill with the pattern. 
2. Do one of the following

· From the Fill tool menu, click on the Two-color pattern button (the checkerboard)
· From the Fill Roll-Up window click on the Two-color pattern button then choose the 

Edit button.
· If you are using the Fill Roll-Up window and want to modify the pattern in an object, 

click on the Update From button. Next, click on the object then on the Edit button.
4. Choose the Create button.
5. Choose the Bitmap Pattern size you want. The size you choose determines the 

resolution of the pattern.
6. Choose the Pen Size you want. The size you choose determines how many squares in 

the drawing area are filled when you click with the mouse.
7. Click with the primary mouse button to fill squares in the drawing area with black.

To erase, click with the secondary mouse button.
Holding down the mouse button and dragging fills/erases a wide area of squares.

8. When you are finished drawing, choose OK.
CorelDRAW adds the pattern to the end of the list displayed when you click on the 
arrow in the pattern preview box.



Creating pattern fills from imported images
CorelDRAW allows you to create pattern fills from images in any of the formats the program 
imports. You can use multi-colored images to create Full-color patterns. But for Two-color 
patterns, you should use images with no more than two colors.
You can use a dialog box or the Fill Roll-Up window to import the images.

From a dialog box:
1. Select the object you want to fill with the pattern. 
2. Select the Fill tool.
3. Click on the pattern button that corresponds to the type of pattern you want to create.
4. Choose the Import button.
5. From the List Files of Type box, choose the format of the image you want to import.
6. In the File Name box, type or select the name of the file you want to import.

If the file you want is in another drive or directory, select the drive from the Drives box
and the directory from the Directories box.

7. Choose OK.
CorelDRAW adds the pattern to the end of the list displayed when you click on the 
arrow in the pattern preview box.

From the Fill Roll-Up window:
1. If the window is not displayed, click on  in the Fill tool menu.

2. Click on the button that corresponds to the type of pattern you want to create.
4. Click on the arrow in the pattern preview box.
5. Click on File, then choose Import Pattern.
5. From the List Files of Type box, choose the format of the image you want to import.
7. In the File Name box, type or select the name of the file you want to import.

If the file you want is in another drive or directory, select the drive from the Drives box
and the directory from the Directories box.

8. Choose OK to close the Import dialog box.
The pattern appears in the preview box and is added to the end of the pattern list.

9. To fill an object with the pattern, select the object, then click on the Apply button.



Editing Two-color pattern fills with the Bitmap Editor
You can use CorelDRAW's Bitmap Editor to modify some of the simpler Two-color patterns 
supplied with the program. If the pattern you selected for editing is too complex, it will not 
appear in the Editor.
When you modify a pattern, CorelDRAW keeps the original and adds the modified version to 
the end of the existing collection.

To edit a Two-color pattern fill with the Bitmap Editor:
1. Select the object you want to fill with the pattern.
2. Do one of the following

· From the Fill tool menu, click on the Two-color pattern button (the checkerboard).
· From the Fill Roll-Up window, click on the Two-color pattern button, then click the 

Edit button. 
· To edit the pattern in an object, choose the Update From button in the Fill Roll-Up 

window, click on the object, then on the Edit button.
3. Click on the arrow in the pattern preview box.
4. Click on the pattern you want to edit.
5. Choose the Create button.
6. Click with the primary mouse button to fill squares in the drawing area with black.

To erase, click with the secondary mouse button.
Holding down the mouse button and dragging fills/erases a wide area of squares.

7. When you are finished editing, choose OK.
8. Choose OK to close the Two-color pattern dialog box.

When you open the dialog box again, you will find the modified pattern at the end of 
the pattern list box.



Editing a Full-color pattern fill
You can load a Full-color pattern into CorelDRAW to change its color or make other 
modifications.

To edit a Full-color pattern fill:
1. Choose Open from the File menu.
2. From the List Files of Type box, choose *.PAT.
3. In the File Name box, type or select the name of the pattern you want to edit.
4. Choose OK.
5. Edit the pattern just as you would any other CorelDRAW graphic.
6. Use Save command to save the pattern under a new name.



Creating Colors and Managing Color Palettes
With CorelDRAW's powerful color-handling capabilities, it's easy to give your work some eye-
catching appeal.
CorelDRAW comes with a number of color palettes.    Each contain a particular set of colors. 
One of these palettes contains spot colors defined using the Pantone Matching System--a 
color specification method used when exact colors are required. You can choose from over 
700 spot colors and create many more by adjusting the tint.
The other palettes supplied with the program contain colors defined using the process color 
method. This method of specifying color is based on the principle that virtually any color can
be represented by overlaying cyan, magenta yellow, and black. The default process color 
palette contains about 100 named colors. For creating your own process colors, CorelDRAW 
offers a choice of three color models: CMYK, RGB and HSB.
The TRUMATCH palette lets you specify process colors using the TRUMATCH Swatching System.
By using this palette along with a TRUMATCH color reference book, you can be reasonably 
certain how the colors will look when printed.
You have the option of assigning names to the colors you create and adding them to the 
palette. You can also delete colors and rearrange their order in the palette. And when you're 
finished, you can save the palette under a new name and have CorelDRAW load it 
automatically when you start the program.
The ability to customize palettes is especially useful when you're working on a drawing that 
uses many colors. By limiting the palette to the colors you're using, you'll find it easier to 
apply them to other objects in the drawing. Also, if you're working on different drawings that
use the same colors, a custom palette will help you to apply them consistently.



Creating a custom Process color
You can create your own Process colors and use them to fill and outline objects. 

To create a custom Process color:
1. Select the object you want to fill or outline with the color.
2. Do one of the following:

· From the Fill or Outline tool menu, click on the color wheel icon.
· From the Fill Roll-Up window, click on the Uniform Color button, and then choose the 

Edit button.
· From the Pen Roll-Up window, choose the Edit button.    From the Outline Pen dialog 

box, choose the More button.
3. If it is not already selected, choose Process.
4. From the Model box, choose the model--CMYK, RGB, or HSB--you want to use to create

the color. See Color Models.
5. Define the color by entering exact percentages in the numeric entry boxes or use the 

color-adjustment markers in Visual Selector boxes.
6. If want to add the color to the palette:

· Type a name in the Color Name box.
· Choose the Palette button, and then choose Add Color to Palette.
· Choose OK

7. If you are using a Roll-Up window, click on the Apply button.
NOTE: You can save the revised palette under a new name by choosing the Palette button 
and then Save Palette As. See Opening and saving a color palette.



Adding a tint of Spot color to the palette
Instead of adjusting the tint control every time you want to re-use a particular tint of Spot 
color, you can just add the tint to the palette.

To add a tint of Spot color to the palette:
1. Select the object you want to outline or fill with the tint of Spot color.
2. Do one of the following:

· From the Fill or Outline tool menu, click on the color wheel icon.
· From the Fill Roll-Up window, click on the Uniform Color icon, and then choose the 

Edit button.
· From the Pen Roll-Up window, choose the Edit button. Then, from the Outline Pen 

dialog box, choose the More button.
3. If it is not already selected, choose Spot.
4 Click on the color whose tint you want to change.
5 Adjust the %tint setting to get the desired tint.
6 Choose the Palette button, and then choose Add Color to Palette.

The tint is added next to the color you clicked on.
7. Choose OK.
8. If you are using a Roll-Up window, click on the Apply button.

NOTE: You can save the revised palette under a new name by choosing the Palette button 
and then Save Palette As. See Opening and saving a color palette.



Opening and saving a color palette
CorelDRAW supplies several different Process color palettes and a single Spot color palette. 
The Process color palettes have different numbers and ranges of color. With some palettes, 
the difference is in whether the colors display on the screen as dithered or pure. 
If you have a TRUMATCH color reference book, you can use the TRUMATCH palette to specify 
process colors.
You can add, delete and rearrange colors in these palettes and then save them under a new 
name. 

To open a color palette:
1. Select an object.

If you are using the Pen or Fill Roll-Up window, you do not need to select an object.
2. Do one of the following:

· From the Fill tool menu, click on the color wheel icon.
· From the Fill Roll-Up window click on the Uniform Color button, and then choose the 

Edit button.
· From the Pen Roll-Up window, choose the Edit button, then from the Outline Pen 

dialog box choose the More button.
3. Choose the Method that corresponds to the palette you want to open.
4 Choose the Palette button, and then choose Load New Palette.
5. In the File Name box, type or select the name of the palette you want to open.

If you saved a palette in another drive or directory select the drive from the Drives 
box and the directory from the Directories box.

6. Choose OK.
To save a color palette:

1. From the Outline or Uniform Color dialog box, choose the Palette button.
2. Do one of the following:

· To replace the current palette, choose Save Palette.
· To save the palette under a new name or in another drive or directory, choose Save 

Palette As.
In the File Name box, type or select a new name. To save the palette in another 
drive or directory, select the drive from the Drives box, and the directory from the 
Directories box.

3. Choose OK.



Deleting a color from a palette
You can customize any of the palettes supplied with CorelDRAW by deleting colors.
NOTE: Before you delete colors from the Spot color palette, make a backup copy of it by 
saving the CORELDRW.IPL file under a new name or in a different location. If you need to 
restore colors you deleted, you can open the backup file. To restore colors in the default 
process color palette (CORELDRW.PAL), open the PURE99.PAL file. See, Opening and saving a
color palette.

To delete a color from a palette:
1. Select an object.

If you are using the Pen or Fill Roll-Up window, you do not need to select an object.
2. Do one of the following:

· From the Fill tool menu, click on the color wheel icon.
· From the Fill Roll-Up window, click on the Uniform Color button, and then choose the 

Edit button.
· From the Pen Roll-Up window, choose the Edit button, and then from the Outline Pen

dialog box, choose the More button.
3. Choose the Method option that corresponds to palette from which you want to delete 

colors.
4. From the Model box, choose Palette or Names.
5. Click on the color you want to delete.
6 Choose the Palette button, and then choose Delete Color From Palette.
7. Repeat steps 5 and 6 to delete other colors.
8. Choose OK.



Rearranging the order of colors
in a palette
If you use some colors more often than others, you can make them easier to find by moving 
them to the beginning of the palette.

To rearrange the order of colors in a palette:
1. Select an object.

If you are using the Pen or Fill Roll-Up windows, you do not need to select an object.
2. Do one of the following:

· From the Fill tool menu, click on the color wheel icon then choose Palette from the 
Model box.
Select the palette you want to rearrange by choosing the corresponding Method 
option.

· From the Fill Roll-Up window, click on the Uniform Color button.
· From the Pen Roll-Up window, click on the Color Selector bar.

3. Hold the mouse button down on the color you want to move, and drag.
As you begin dragging, a black dot appears.

4. Release the mouse button when the black dot is over the square you want the color 
moved to.
The other colors shift to the left.

5. Repeat steps 3 and 4 to move other colors.
6. Choose OK.

NOTE: You can save the revised palette under a new name by choosing the Palette button 
and then Save Palette As. See Opening and saving a color palette.



Converting a Spot color to its Process color equivalent
You can convert the Spot color outline or fill of a selected object into its Process color 
equivalent.
NOTE: While the converted color appears the same on screen, it will not match the Spot 
color exactly when printed. 

To convert a Spot color to its Process color equivalent:
1. Select the object with the fill or outline color you want to convert.
2. Do one of the following:

· From the Fill or Outline    tool menu, click on the color wheel icon.
· From the Fill Roll-Up window, click on the Uniform Color button, and then choose the 

Edit button. 
· From the Pen Roll-Up window, choose the Edit button, and then from the Outline Pen

dialog box, choose the More button.
3. Choose Process as the Method.

To add the converted color to the end of the palette, type a name in the Color Name 
box. Next, choose the Palette button, then Add Color to Palette.

4. Choose OK.



Color Models
CorelDRAW provides three different color models for creating process colors: CMYK (cyan, 
magenta, yellow, black), RGB (red, green, blue) or HSB (hue, saturation, brightness).
You can create colors using the model you are most comfortable with. If you are going to 
produce color separations, CorelDRAW will convert any RGB and HSB colors into their CMYK 
equivalents. The conversion will not be exact, however, since the RGB and HSB models 
create color in a fundamentally different way than the CMYK model.

CMYK Model
The CMYK model, as its name suggests, is based on the colors of the inks used in four-color 
printing. By combining percentages of cyan, magenta, yellow and black, you can reproduce 
virtually any color you want.
The advantage of the CMYK model is that you can specify your colors using CMYK color 
reference charts and be reasonably certain of what the colors will look like when printed. No 
such charts exist for specifying colors with the RGB and HSB models.
When you use the Visual Selector to specify colors, CorelDRAW automatically adjusts the 
amount of black through a process called Gray Component Replacement (GCR). If you are 
specifying colors numerically, you must do the gray replacement yourself by entering 
appropriate percentages of black.
If your drawing contains large areas of black, you will want to override the GCR process and 
increase the percentages of cyan, magenta and yellow. Doing this makes the blacks look 
much darker. Ask your printer or service bureau for advice on the exact percentages you 
should use.

RGB Model
The RGB color model uses percentages of red, green and blue to create colors. Each 
component has 100 levels of intensity, ranging from black to the component's full intensity. 
Thus, to produce pure red for example, set Red to 100 and Green and Blue to 0. Similarly, 
set Green to 100 and the others to 0 to produce pure green. To produce a dark but pure 
shade of one of the three, lower its setting while leaving the others at 0.
White is produced by setting all three components to 100. Setting them all to 0 produces 
black. Equal amounts of each produces varying shades of gray.

HSB Model
The HSB model, creates color by varying three parameters: hue, saturation and brightness. 
Hue refers to the quality which makes a particular color different from another. Blue, red, 
and green, for example, are all hues. Saturation refers to the purity or intensity of a color. By
varying the intensity, you can make the color lighter or darker. Brightness refers to the 
percentage of black in a color, where 0 percent is black and 100 percent is white.



Creating Special Effects
The Effects menu contains some of CorelDRAW's most powerful commands for manipulating 
objects. 
A unique feature of these commands, when applied to text, is the ability to edit the text 
without disturbing the effect you've created. In the case of Blend and Extrude, you can edit 
the original objects--for example, change their outlines and fills--and have CorelDRAW 
automatically adjust the blend or extrusion.

Envelope 
Imagine the way an image drawn on a sheet of rubber distorts when you pull on its edges. 
You get the same effect in CorelDRAW by applying an envelope to an object and dragging its 
handles. Envelopes are useful when you want to mold text to fit the contours of a particular 
shape.

Perspective 
You can create one- and two-point perspective views of an object by dragging handles on a 
special bounding box. 

Blend 
The Blend command blends the shape and color of one object with those of another through 
a series of intermediate objects. You can use Blend to create airbrush effects and highlights 
or to create evenly spaced copies between two identical objects. You can even blend objects 
along a path.

Extrude 
The Extrude command projects surfaces from an object to give it a three-dimensional 
appearance. The object and surfaces form a dynamic group that responds collectively to any
commands or operations you apply to the extrusion.
Controls in the Extrusion Roll-Up window allow you to manipulate the extrusion in several 
ways. For example, you can specify a parallel or perspective extrusion, rotate the extrusion 
in three-dimensional space, and shade the surfaces to simulate the effect of light striking 
the extrusion.











Shaping an object with an envelope

Envelopes allow you to distort the shape of an object or group of objects. You have a choice 
of four envelope editing modes, each of which reshapes the object in a different way.    

To shape an object with an envelope:
1. Select the object you want to reshape.
2. Choose Edit Envelope from the Effects menu.
3. Select the editing mode you want to use.

The Shape Tool becomes selected and a bounding box with eight handles appears 
around the object.

4. Select one of the handles and drag it in the desired direction.
With the first three editing modes, the side handles move in a single direction while the
corner handles move in two directions. 
With the fourth mode, the handles move freely. They also have control points that you 
can move to fine tune the shape of the object.
By holding down the CTRL and/or SHIFT keys, you can move opposing handles the same
amount in the same or opposite directions.

5. Drag other handles until the object is shaped the way you want.
If you are not getting the results you want with one mode, you can clear the envelope 
with the Clear Envelope command and use a different mode.



Clearing an object's envelope
You can restore an object to the way it was before you reshaped it with an envelope. If you 
applied more than one envelope, you'll need to repeat the following procedure for each 
envelope.

To clear an object's envelope:
1. Select the object with the envelope you want to clear.
2. Choose Clear Envelope from the Effects menu.



Copying an object's envelope
Once you've reshaped an object with an envelope, you can quickly apply the same shaping 
to another object.

To copy an object's envelope:
1. Select the object to which you want the Envelope copied.
2. From the Effects menu, choose Copy Envelope From.

The mouse pointer changes to an arrow with the word From?
3. Click on the object with the envelope you want to copy.

The selected object is redrawn with the same shape as the other object.



Editing an object's envelope
Normally, you edit an object's envelope by adjusting its handles with the Shape tool. To 
experiment with the positioning of the handles without permanently altering the object,    
you use the Add New Envelope command to add another envelope over the existing one. 
When you're through experimenting, you can remove the envelope with the Clear Envelope 
command.



Adding perspective to an object
You can add perspective to an individual object or a group of objects.

To add perspective to an object:
1. Select the object.
2. Choose Edit Perspective from the Effects menu.

The Shape Tool becomes selected and a bounding box with four handles appears 
around the object.

3. Drag the handles to achieve the desired perspective as follows:
· For one-point perspective drag either horizontally or vertically. 

To constrain the handle's motion to one of these axes, hold down the CTRL key while 
dragging. Holding down the CTRL and SHIFT keys moves opposing handles the same 
amount in the same or opposite directions.

· For two-point perspective , drag on a diagonal toward the center of the object.
NOTE: As you drag, vanishing points represented by Xs appear. You can drag these to 
change the object's perspective.

4. Release the mouse button to redraw the object in its new perspective.



Clearing an object's perspective
You can restore an object to the way it was before you applied the Edit Perspective 
command to it. If you applied the command more than once, you'll need to repeat the 
following procedure to clear each bounding box.

To clear an object's perspective:
1. Select the object with the perspective you want to clear.
2. Choose Clear Perspective from the Effects menu.



Copying an object's perspective
Once you apply perspective to an object, you can quickly apply the same perspective to 
other objects in your drawing.

To copy an object's perspective:
1. Select the object to which you want the perspective copied.
2. From the Effects menu, choose Copy Perspective From.

The mouse pointer changes to an arrow with the word From?
3. Click on the outline of the object whose perspective you want to copy.

The selected object is redrawn with the same perspective as the other object.



Editing an object's perspective
Normally, you edit an object's perspective by adjusting the bounding box handles with the 
Shape tool. To experiment with the positioning of the handles without permanently altering 
the object, you use the Add New Perspective command to add another bounding box over 
the existing one. When you're through experimenting you can remove the bounding box with
the Clear Perspective command.



Blending two objects
The Blend command blends two objects through a series of intermediate shapes. You can 
blend different line thicknesses, an open path with a closed one, and similar or dissimilar 
fills. When you blend objects with dissimilar fills, CorelDRAW fills the intermediate shapes as 
follows:
Object fill Intermediate Shapes
No fill in one object No fill
Uniform fill with fountain blend from uniform fill to fountain
Uniform fill with pattern uniform fill
Radial with Linear fountain Radial fountain
Same fountain type in both objects fountain
Pattern in one object only the other object's fill
Pattern in both objects the top object's pattern
Spot color with Process color Process color
Two different Spot colors Process color

To blend two objects:
1. Select the two objects you want to blend.
2. Choose Blend Roll-Up from the Effects menu.
3. In the text entry box below Steps, type or select the number of intermediate shapes 

you want CorelDRAW to create.
4. To specify how colors are blended do the following:

· Click on the color wheel icon.
· Click on Rainbow if you want CorelDRAW to blend using the widest range of colors 

possible. The colors used will be those along the arc on the color wheel. Choose the 
Direction buttons to blend using colors opposite to those along the arc.

5. To specify which nodes CorelDRAW uses as the start nodes do the following:
· Click on the Map Nodes button. The mouse pointer changes and nodes appear on 

one of the objects.
· Click on the node you want as this object's start node. 
· When the arrow flips over, click on the node you want as the other object's start 

node.
Selecting different combinations of nodes can produce very different results when 
blending dissimilar shapes. 

6. Click on the Apply button.



Blending objects along a path
You can blend two objects and then fit the blend to any path. The path and the blend 
become a dynamically-linked group, which means you can edit the path and have 
CorelDRAW automatically adjust the blend.

To blend objects along a path:
1. Blend the two objects.
2. Click on the  button.

3. Choose New Path.
4. Click on the path you want to blend along.
5. Do any of the following optional steps:

· Choose Full Path if you want the blend to extend the full length of the path. 
Otherwise the blend will attach itself to the closest point on the path.
NOTE: You can also adjust where the blend begins and ends by selecting the top or 
bottom object and dragging it along the path. 

· Choose Rotate All if you want to rotate the blend along a curved path.
· Choose Spacing from the list box at the top of the roll-up window and type or select

the amount of spacing you want between the intermediate shapes.
6. Click on the Apply button.



Editing a blend
Blending two objects creates a dynamically-linked group of objects that you can edit by:

· selecting different options from the Blend Roll-Up window.
· changing the position, size, shape, outline or fill of either of the start or end objects or 

the path along which they were blended.
· blending to a new object or along a new path.
· changing the intermediate shapes by splitting the blend group.
· reversing the direction of the blend.

CorelDRAW reblends automatically, following changes to the original objects, the path or the 
intermediate shapes.

To edit a blend group from the Blend Roll-Up window:
1. If the Roll-Up window is not already displayed, choose Blend Roll-Up from the Effects 

menu.
2. Select the blend group.

If the group is part of a compound blend, hold down the CTRL key and click on an object
in the group.

3. Choose the options you want to use.
4. Click on the Apply button.

To edit the original objects or the path along which they are blended:
1. Click on the object or the path you want to change.

You can also use the and 
 buttons in the Blend Roll-Up window to select the    objects or path.

2. Edit the object or path.
When you finish, the objects automatically reblend.

To blend with a new object or along a new path:
1. Select the blend group.
2. Do one of the following:

· Click on  and choose New Start. 
· Click on  and choose New End.
· Click on and choose New Path.

3. Click on the new object or path.
4. Click on the Apply button.

To edit the intermediate shapes:
1. Select the blend group.
2. Hold down the CTRL key and click twice on the intermediate shape you want to edit is 

selected.
The blend group splits into two linked groups with the object you clicked on, becoming 
the start object in one group and the end object in the other. Editing this object affects 
both groups.
You can select one of the blend groups and make changes that won't affect the other 
group. For example, you can specify a different numbers of steps.

3. Edit the intermediate shape.



When you finish, the objects automatically re-blend.
To reverse the direction of the blend:

1. Select the blend group.
2. Choose Reverse Order from the Arrange menu.



Rotating intermediate shapes in a blend
Blending with rotation produces different results depending on the selection mode the 
objects are in when you click on the Apply button. In stretch/scale mode, each intermediate 
shape will rotate around its own center of rotation. In rotate/skew mode, the shapes will 
rotate around a point midway between the start and end objects.
You can also change the location of the midway point (i.e., the axis of rotation) to alter the 
appearance of the blend.

To rotate the intermediate shapes in a blend:
1. Do one of the following:

· To rotate each intermediate shape around its own center of rotation, simply select 
the two objects you want to blend.

· To rotate around a point midway between the two objects, select the two objects, 
then click on either one to enter rotate/skew mode.

2. Choose Blend Roll-Up from the Effects menu.
3. Type or select the number of intermediate shapes you want CorelDRAW to create.
4. In the Rotation box, type or select the angle of rotation you want. (You can enter 

negative values by typing a minus sign before the number.)
5. Choose any other others you want.
6. Click on the Apply button.

To change the axis or rotation between the start and end objects:
1. Select either the start or end object in the rotated blend.
2. Click on one of the selected objects.

The handles on the objects' highlighting box change to double-headed arrows.
3. Drag the center of rotation marker in the middle of the highlighting box to the desired 

spot.
4. If you want, repeat steps 1 to 3 for the other object.
5. Choose the options you want to use from the Blend Roll-Up window.
6. Click on the Apply button.

CorelDRAW rotates the blend around a point midway between each object's center of 
rotation.



Chaining blends
Once you've created a blend, you can select any of the objects in the blend group and blend 
it with another object. You can repeat this process as often as you want to create a chain of 
blend groups.

To chain blends:
1. Select the desired object in the blend group. To select an intermediate shape hold 

down the CTRL key, and then click on the shape.
2. Select the object you want to blend with.
3. Choose Blend from the Effects menu.
4. Choose the options you want to use from the Blend Roll-Up window.
5. Click on the Apply button.



Clearing intermediate shapes in a blend
The Clear Blend command lets you quickly delete the intermediate shapes in the selected 
blend(s).

To clear the intermediate shapes in a blend:
1. Select the blend group(s).
2. Choose Clear Blend from the Effects menu.



Breaking the link between blended objects
You can break the link between the original objects and the intermediate shapes in a 
blend(s).

To break the link between blended objects:
1. Select the blend group(s).
2. Choose Separate from the Arrange Menu.

The original objects are separated from the blend while the intermediate shapes 
remain grouped.



Extruding an object
The Extrude command projects surfaces from an object to give it a three-dimensional 
appearance. 
Choosing the Extrude command displays the Extrude Roll-Up window and applies a default 
wireframe extrusion to the selected object. You can drag the X control to adjust the depth 
and direction of the extrusion, or use the numeric controls in the roll-up window. Other 
controls in the Roll-Up window let you:

· specify a parallel or perspective extrusion.
· rotate the extrusion.
· change the color of the extruded surfaces.
· apply a light source to enhance the 3-D effect.

To extrude an object:
1. Select the object you want to extrude.
2. Choose Extrude from the Effects menu.
3. Do one of the following:

· Specify the depth and direction of the extrusion by dragging the X control on the 
screen.

· Type or select values in the Depth box and in the H (horizontal) and V (vertical) 
boxes. 

4. To create a parallel extrusion, click on the Perspective box to remove the check mark.
5. To extrude the object toward the screen, click on the To Front box.
6. Click on the Apply button.

You can choose the Edit button at any time to redisplay the X control.
To rotate an extrusion:

1. Click on the  button.
2. Do one of the following:

· Click on the arrow buttons to rotate the extrusion in the direction you want.
· Click on  and type or select values in the numeric entry boxes. 
To see a wireframe of the extrusion as it's being rotated, choose the Edit button.

3. When the extrusion is in the position you want, click on the Apply button.
To return the extrusion to its original position, click on the X button.

To change the color of the extruded surfaces:

1. Click on the  button.
2. Do one of the following

· To fill the surfaces with a solid color, click on Solid. Next, click on the color button 
and then on the color you want to use.

· To fill the surfaces with a graduated color, choose Shade to Back. Next, click on the
From and To color buttons and then on the colors you want to use.

3. Click on the Apply button.
To color the surfaces the same as the object, click on Use Object Fill. 

To apply a light source:

1. Click on the  button.



2. Click the on the On/Off box to turn the light source on.
The sphere represents the extrusion, while the X represents the light source.

3. Move the light source by clicking where lines on the wireframe box intersect.
You can adjust the intensity of the light source by dragging the slide control.

4. Click on the Apply button. 
To color the surfaces the same as the object, choose Use Object Fill.



Editing an extruded object
Extruding an object creates a dynamically-linked group of objects which you can edit by:

· selecting different options from the Extrude Roll-Up window.
· changing the position, size, shape, outline or fill of the extrusion.
· node editing text to change the attributes of individual characters or other objects to 

change their shape. 
NOTE: Node editing is not permitted on objects extruded with the To Front option, 
rotated with the Rotation controls, or altered with the Envelope and Perspective 
commands.

To edit an extrusion from the Extrude Roll-Up window:
1. If the Roll-Up window is not already displayed, choose Extrude from the Effects menu.
2. Select the extrusion group.
3. Choose the options you want to use.
4. Click on the Apply button.

To change the position, size, shape, outline or fill of the extrusion:
1. Select the extrusion.
2. Make the changes you want.

The extrusion reforms automatically.
To node edit an extrusion:

1. Select the Shape tool.
2. Click on the extruded object.
3. Click on the node you want to use to edit the object. 

In the case of text, double-clicking on a node displays the Character Attributes dialog 
box where you can choose a different font, size, style etc.

4. Make the changes you want.
The extrusion reforms automatically.



Clearing extruded surfaces
The Clear Extrude command lets you quickly delete the surfaces created by extruding an 
object.

To clear the extruded surfaces:
1. Select the extruded object.
2. Choose Clear Extrude from the Effects menu.



Breaking the link between objects in an extrusion
You can break the link between the original object and the extrude surfaces.

To break the link between objects in an extrusion:
1. Select the extrusion.
2. Choose Separate from the Arrange Menu.

The original object is separated from the extrusion, while the extruded surfaces remain
grouped.



Working with Text and Symbols
Adding Text and Symbols
CorelDRAW's powerful text-handling capabilities let you add and manipulate text with ease. 
You enter text directly on the screen as either strings of Artistic text or blocks of Paragraph 
text. You can add symbols from the Symbol Library, which is a collection of predrawn graphic
symbols relating to business, transportation, sports and many other subjects.
As with other objects, text and symbols you add are given a default outline and fill. You can 
change the defaults at any time using the Outline and Fill tools. For more information, see 
Specifying a default outline and Specifying a default fill.

Editing and Formatting Text
You can edit existing text on the screen or from a dialog box. As long as you don't convert it 
to curves, text remains editable even after you transform it or apply special effects to it. 
Some of the formatting you can apply to text includes changing typeface, point size, and 
spacing. When you add a string or block of text, every character must use the same 
formatting. Once the text is added, however, each character can have its format changed.
Formatting features available for Paragraph text allow you to:

· Flow text into columns.
· Justify text left and right
· Hyphenate text automatically.

You can carry out formatting changes using commands in the Text menu or with the Text 
Roll-up window.

Proofing Text
CorelDRAW's proofing tools can help improve your writing by finding spelling errors, correctly
hyphenating words, and finding synonyms for a word.

Special Text Features
Some of the special text features in CorelDRAW allow you to: 

· Fit text to the outline of another object.
· Create your own Adobe Type 1 and TrueType compatible typefaces and symbols and 

use them in other Windows applications.
· Extract text from a drawing, edit it in a word processor, then merge it back into the 

drawing.



Adding Artistic text
Entering text as Artistic text allows you to fit the text to a path and create special effects 
with it using commands in the Transform and Effects menu. You can add as many strings of 
Artistic text as you want, with each string limited to 250 characters.

To add Artistic text:
1. Select the Text tool.
2. Click on the spot where you want the text to begin.
3. Type the text. 

To end a line and start a new one, press the ENTER key.
Once the text is on the page, you can use the Text Roll-up window or the Character 
command to change the font, point size and other character attributes. See Applying 
character attributes.



Adding Paragraph text
If you are working on a newsletter, brochure or some other text-sensitive application, you 
should enter your text as Paragraph text. Compared with Artistic text, Paragraph text offers 
more formatting options. For example, you can flow Paragraph text into columns.
You can add as many blocks of Paragraph text as you want, with each block limited to about 
4000 characters.

To add Paragraph text:
1. Select the Text tool. 
2. Position the cursor where you want the top left margin of the text to be.
3. Drag to where you want the bottom right margin of the text to be, then release the 

mouse button.
Later, you can use the Pick tool to adjust the margins. See Formatting Paragraph text. 

4. Type the text.
Text wraps from one line to the next automatically. To insert a blank line (between 
paragraphs, for example) press the ENTER key.
Once the text is on the page, you can use the Text Roll-up window or the Character 
command to change the font, point size and other character attributes. See Applying 
character attributes.
To change paragraph formatting, choose Frame from the Text menu or use the Text 
Roll-up window. See Formatting Paragraph text.



Adding symbols
CorelDRAW's Symbol Library contains thousands of predrawn graphic symbols ranging from 
arrowheads and bullets to business and sports related symbols. You can use the symbols as 
they are, or edit them the same way you would any other object.

To add a symbol to a drawing:
1. Hold the mouse button down on the Text tool.

2. When the fly-out menu appears click on .
The Text tool remains in Symbol selection mode until you click on     to switch back 
to text mode or exit CorelDRAW.

3. Click where you want the symbol to appear.
The Symbols dialog box appears.

4. Do one of the following:
· Choose the symbol you want by entering its index number in the Symbol # box. 

(Index numbers are listed in the Symbol and Clipart Libraries Catalog.)
· Choose the Symbol category from the list box on the right. Click on the symbol 

preview box, scroll through the list of symbols, then click on the one you want.
5. Specify the height you want the symbol drawn at.

Once it is added to the drawing, you can use Pick tool and scale the symbol to any size 
you want.
To use a different unit of measurement, select it from the units box. CorelDRAW will 
automatically convert the value to its equivalent in the unit you select.

6. Choose OK.
The symbol is automatically selected and assigned the default Outline and Fill 
attributes.



Importing text
If you are creating Paragraph text, and the text you want to use already exists, use the 
following procedure to import it into CorelDRAW.
NOTE: The text you plan to import must be in ASCII format. You can import up to 4000 
characters per block of Paragraph text. Any characters over this limit will be dropped.

To import text into a new frame:
1. Do one of the following:

· To import text into a new frame, choose Import from the File menu, then choose Text
from the List Files of Type box.

· To import text into an existing frame, select the frame, choose Edit Text from the 
Text menu then choose the Import button.

2. In the File Name box, type or select the name of the file you want to import. 
Only files with the extension TXT appear in the list. If the file you want use as different 
extension, type it in place of TXT.
If the file you want is in another drive or directory, select the drive from the Drives box
and the directory from the Directories box.

3. Choose OK.
Text added to a new frame appears on screen while text added to an existing frame 
appears in the Text Editing window. 

4. Do one of the following for text imported into an existing frame:
· Edit the text and apply attributes while it's in the Text Editing window then choose 

OK. See Editing text in the Text dialog box.
· Choose OK to add the text to the frame and edit and apply attributes to it on screen.

See Applying character attributes and Formatting Paragraph text.



Pasting text from the Clipboard
You can use the Clipboard to bring in text from another CorelDRAW file or application.
NOTE: Text with more than 250 characters is automatically pasted as Paragraph text. If you 
try to paste more than 4000 characters, the excess will be dropped.more.

To paste text into CorelDRAW:
1. From the other CorelDRAW file or application, cut or copy the text to the Clipboard. 
2. Open the drawing you want to paste the text into.
3. Do one of the following:

To... do this.
Add a new string Choose Paste from the Edit
of Artistic text menu to paste the text in the center of the page.

OR
Choose the Text tool, click where you want the text to appear on 
the page, then choose Paste from the Edit menu.

Add a new block Choose the Text tool, drag 
of Paragraph text to draw a frame then choose Paste from the Edit menu.
Add to existing text Choose the Text tool, click where you want the text inserted 

then choose Paste from the Edit menu.
OR
Select the existing text then choose Edit Text from the Edit menu. 
Click where you want the text inserted then choose Paste followed 
by OK.



Selecting text on screen
CorelDRAW offers several ways of selecting text depending on what type of changes you 
want to make.
Use To
Text tool Add, delete, replace, or change the attributes text on screen.
Pick tool Change the attributes of all characters or edit the text in a dialog box.
Shape tool Kern and change the attributes of individual characters.

To select text with the Text tool:
1. Move the crossbar over the text you want to select.

The crossbar changes to a vertical bar called the insertion point.
2. Do one of the following:

· Hold the primary mouse button down and drag across the text you want to select.
· Click to position the insertion point in the text you want to select, hold down the 

SHIFT key, then press the arrow keys to select the text one character at a time.
To select text with the Pick tool:

Do one of the following: 
· To select Paragraph text, click on the frame that encloses it.
· To select text while working in wireframe view or text that does not have a fill, click 

anywhere on the text's outline.
· To select filled text while working in the editable preview, click anywhere on the text.

To select characters with the Shape tool:
1. Click on the outline of the text object from which you want to select a character. For 

Paragraph text, click on the frame that encloses the paragraph.
Nodes appear next to each character along with a pair of handles for adjusting 
spacing.

2. Do one of the following:
· To select a single character click on the node to its left.
· To select multiple characters, hold down the SHIFT key and click on the nodes of each

character you want selected. 
Or hold down the mouse button and drag a dotted rectangle--called a marquee--so 
that it completely encloses the nodes of the characters you want selected.

To deselect a character from a group of selected characters:
· Hold down the SHIFT key and click on the node of the character you want to deselect.



Editing text in the Text dialog box
Although you can edit text on screen, you may find it easier to use the Text dialog box if you 
applied transformations or special effects to the text.

To edit existing text:
1. Select the Pick tool.
2. Click on the text string or the frame around the paragraph text you want to edit.
3. Choose Edit Text from the Edit menu.
4. Edit the text using the following techniques:

To Do this
Move insertion point Point and click on the new location, or press the followings keys 

or combinations of keys:
, ¯, ¬, ® moves in direction of arrow
HOME moves to start of current line
CTRL+HOME moves to start of text
END moves to end of current line
CTRL+END move to end of text
PgUp/PgDn scrolls the text box

Select text Drag across the text with the mouse, or hold down the SHIFT key 
and press the ¬, ®, HOME or END key.

Delete text Press BACKSPACE or DEL key to delete one character at a time or 
select the characters and press the DEL key. 

Add text Move the insertion point where you want the text to start, then 
type.    

Replace text Select text and begin typing.
Begin new line Press ENTER.
Copy to Clipboard Select text and press CTRL+INS.
Cut to Clipboard Select text and press SHIFT+DEL.
Paste Press SHIFT+INS. 

5. When you are finished, choose OK. 



Editing text on screen
You can edit text directly on screen. If you applied transformations or special effects to the 
text, you may find it easier to edit from the Text dialog box. See Editing text in the Text 
dialog box.

To edit text on screen:
1. Select the Text tool.
2. Position the insertion point in the text you want to edit.
3. Edit the text using the following techniques:

To Do this
Move insertion point Point and click on the new location, or press the followings keys 

or combinations of keys:
, ¯, ¬, ® moves in direction of arrow
HOME moves to start of current line
CTRL+HOME moves to start of text
END moves to end of current line
CTRL+END move to end of text

Select any text Drag across the text with the mouse, or hold down the SHIFT key 
and press the ¬, ®, HOME or END key.

Select a word Double-click on the word
Delete text Press BACKSPACE or DEL key to delete one character at a time or 

select the characters and press the DEL key. 
Add text Move the insertion point where you want the text to start, then 

type.    
Replace text Select text and begin typing.
Begin new line Press ENTER.
Copy to Clipboard Select text and press CTRL+INS or choose Copy from the Edit menu.
Cut to Clipboard Select text and press SHIFT+DEL or choose Cut from the Edit menu.
Paste Press SHIFT+INS or choose Paste from the Edit menu.



Formatting Paragraph text
After adding a block of Paragraph text you can use the mouse to resize the margins and the 
Frame command to apply formatting options.

To resize the margins of a Paragraph:
1. Select the Pick tool.
2. Click on the frame that encloses the paragraph.
3. To move one margin, drag the center handle next to it in the desired direction. To move

adjacent margins, drag the corner handles.
4. Release the mouse button when the margins are the desired size.

To format a Paragraph:
1. Select the Pick tool.
2. Click on the frame that encloses the paragraph.
3. Choose Frame from the Text menu or the Text roll-up window.
4. Type or select the settings you want.

To use a different unit of measurement, select it from the units box. CorelDRAW will 
automatically convert the value to its equivalent in the unit you select.

5. Choose OK.



Setting tab stops
You can use the Frame command to change the default tab spacing for Paragraph text.

To set default tab stops:
1. Select Pick tool.
2. Click on the frame that encloses it the Paragraph text.
3. Choose Frame from the Text menu or the Text Roll-Up window.
4. In the Default Tabs box, type or select the tab settings you want.

To use a different unit of measurement, select it from the units box. CorelDRAW will 
automatically convert the value to its equivalent in the unit you select.

5. Choose OK.



Setting, changing and clearing tab stops
You can use the Frame command to change the default tab spacing for Paragraph text. 
Adding, moving and clearing tabs is done with the mouse and the Paragraph text ruler.

To set default tab stops:
1. Select Pick tool.
2. Click on the frame that encloses the Paragraph text.
3. Choose Frame from the Text menu or the Text roll-up window.
4. In the Default Tabs box, type or select the tab settings you want.

To use a different unit of measurement, select it from the units box. CorelDRAW will 
automatically convert the value to its equivalent in the unit you select.

5. Choose OK.
To add tabs:

1. Select the Paragraph text.
2. Click the spot on the Paragraph text ruler where you want to set the tab.

To move tabs:
1. Select the Paragraph text.
2. Drag the tab marker, () in the Paragraph text ruler to the new location.

To clear tabs:
1. Select the Paragraph text.
2. Drag the tab marker, () either up or down on the Paragraph text ruler you want to 

clear. 



Adding bullets to a list
CorelDRAW can automatically format lines of Paragraph text into a bulleted list. You choose 
the symbol you want to use as the bullet from the thousands available in the Symbols 
Library. 

To add bullets to a list:
1. Create the list as Paragraph text, separating each item by pressing the ENTER key 

twice.
2. Select the text to which you want to add bullets by dragging across it with the mouse.
3. Choose Frame from the Text menu or the Text roll-up window.
4. Choose the Bullets button.
5. Do one of the following:

· Choose the symbol you want by entering its index number in the Symbol # box. 
Index numbers are listed in the Symbol and Clipart Libraries Catalog.

· Click on the Symbol category in the list box on the right, then on the symbol you 
want in the display box along the bottom.

CorelDRAW automatically sizes the bullet in proportion to the text. 
6. Choose OK.

The symbol appears with the default Outline and Fill attributes, which you can change 
in the same way as you would other objects.



Adjusting text spacing 
You can adjust the spacing between characters, words, lines and paragraphs of text on 
screen, from a dialog box, or from the Text Roll-up window. 

To adjust text spacing with numeric precision
1. Select the Pick tool.
2. Click on the Artistic text string, or the frame around the Paragraph text.
3. Do one of the following:

· Choose Frame from the Text menu or Text Roll-up window. 
· For Artistic Text only, choose Edit Text from the Edit menu, then choose the Spacing

button.
4. Type or select the amount of spacing you want.
5. Choose OK.

To adjust text spacing on screen:
1. Select the Shape tool.
2. Click on the Artistic text string or the frame around the Paragraph text.

Nodes appear next to each character, along with a pair of handles for adjusting 
spacing.

3. Do one of the following:
To adjust
spacing between Do this
Characters Move the mouse pointer over  and drag to the right to 

increase the spacing or left to decrease it.
Words Move the mouse pointer over , hold down the CTRL key, and drag to the right to 
increase the spacing or left to decrease it.
Lines (Artistic text) Move the mouse pointer over  and drag down to increase the spacing
or up to decrease it.
Lines (Paragraph text) Move the mouse pointer over , hold down the SHIFT key, and 
drag down to increase the spacing or up to decrease it.

Paragraphs Move the mouse pointer over , hold down the CTRL key, and 
drag down to increase the spacing or up to decrease it.



Kerning text
Kerning text means to adjust the spacing between pairs of letters. Text with certain letter 
pairs, such as AV, often looks better when the letters are moved closer together. You can 
kern text on screen or enter values in a dialog box.

To kern text with numeric precision:
1. If not already selected, select the text you want to kern with the Shape tool.

Nodes appear next to each character, along with a pair of handles for adjusting 
spacing.

2. Click on the node to the left of the character you want to shift.
To shift consecutive characters, click on the their nodes while holding down the SHIFT 
key or drag a marquee box around them. 

3. Choose Character from the Text menu, or Character Kerning from the Text Roll-up 
window.

4. In the Horizontal Shift box, type or select the amount by which you want the 
selected character shifted. 
Negative values shift to the beginning of the string or paragraph, while positive values 
shift to the end.

5. Choose OK.
To interactively kern text:
NOTE: To prevent CorelDRAW from repositioning the remaining text, select the text with the 
Pick tool, choose Edit Text from the Edit menu, then select None as the Justification option.

1. If not already selected, select the text you want to kern with the Shape tool.
Nodes appear next to each character, along with a pair of handles for adjusting 
spacing.

2. Hold the mouse button down on the node to the left of the character you want to shift.
To shift consecutive characters, click on the their nodes while holding down the SHIFT 
key or drag a marquee box around them. 

3. Drag the character to the desired position. 
To force the character to remain on the baseline, hold down the CTRL key while 
dragging. You can also choose Align to Baseline from the Text menu after kerning to 
undo any vertical shifting. 

4. Release the mouse button.



Changing the default text spacing
You can change the default spacing for both Artistic and Paragraph text, or for Artistic Text 
only. 

To change the default text spacing:
1. Select the Text tool.
2. Do one of the following:

· To change the defaults for Artistic text only, click in the drawing window.
· To change the defaults for Artistic and Paragraph text, drag to create a frame of any 

size.
3. From the Text dialog box, choose the Spacing button.
4. Type or select the amount of spacing you want.
5. Choose the Save as Default button.
6. Choose OK. 



Copying text attributes
The Copy Style From command lets you copy the attributes (typeface, point size, spacing 
etc.) of one string of Artistic text to another, or one block of Paragraph text to another. 
Character attributes--horizontal shift, vertical shift, and angle--cannot be copied.

To copy text attributes:
1. Select the text with the attributes you want to change.
2. From the Edit menu, choose Copy Style From.
3. Choose Text Attributes.
4. Choose OK.

The cursor becomes an arrow with the word From?
5. Click on the text with the attributes you want to copy.



Entering special characters
You can access special characters not available on the keyboard by entering a four-digit 
code. A list of these characters is provided on the Character Reference Chart supplied with 
CorelDRAW. 

To enter special characters:
1. Hold down the ALT key.
2. Type the character's four-digit code using the numeric keypad.
3. Release the ALT key.

NOTE: While they display correctly in the drawing window, some characters may 
appear as some other character or as a black square when they are entered in the Text
dialog box. 



Converting Artistic text to curves
Converting Artistic text to curves lets you modify the letter shapes using the Shape tool and 
assign different outlines and fills to individual characters. 
NOTE: Once you convert text to curves, you can no longer edit it or change its text or 
character attributes. 

To convert text to curves: 
1. Select the text with the Pick tool.
2. Choose Convert To Curves from the Arrange menu.
3. Choose Arrange Break Apart from the Arrange menu.

Each character is converted to a curve object which you can individually select and 
manipulate.



Checking spelling
The Spell Checker command lets you check your text for spelling errors. If an unrecognized 
word is found, you can correct the word if it misspelled, or add it to a personal dictionary if it 
is correctly spelled. 

To check spelling:
1. Select the text you want to spell check.
2. Choose Spell Checker from the Text menu.

When a word that is not in the dictionary is found, CorelDRAW displays it in the box 
under Word not Found.

3. Do one of the following for each unrecognized word:
· Correct the spelling if the word is misspelled. See Correcting a misspelled word.
· Choose the Ignore button to leave the current word unchanged.
· Choose the Ignore All button to skip the current word and any further occurrences 

of it    during the current spelling check.
· Add the word to a personal dictionary. See Creating and adding words to a personal 

dictionary.
4. When all words have been checked, a message box appears. Choose OK to return to 

your drawing.
NOTE: You can open a personal dictionary and have CorelDRAW refer to it, along with the 
standard dictionary during a spelling check. See Opening a personal dictionary.



Correcting a misspelled word
You can correct misspelled words found during a spelling check by selecting a suggested 
correction or typing your own.

To correct a misspelled word:
1 Do one of the following:

· Type the correct spelling in the Alternatives box.
· Choose the Suggest button and select one of the alternative spellings displayed.
NOTE: If you want the alternative spellings to appear automatically, select the Always 
suggest check box.

2 Choose the Replace button to correct the current word, or the Replace All button to 
correct all occurrences of the word.

3. When all words have been checked, a message box appears. Choose OK to return to 
your drawing.



Creating and adding words to a personal dictionary
Creating personal dictionaries lets you supplement the standard dictionary with words it 
does not contain. Once you create a personal dictionary, you can have CorelDRAW refer to it 
as well as the standard dictionary during a spelling check. See Opening a personal 
dictionary.

To create a personal dictionary:
1. Choose Spell Checker from the Text menu.
2. Choose the Create button.
3. Type a name for the dictionary, up to eight characters.
4. Press the ENTER key.

To add a word to a personal dictionary:
1. Select the text you want to check.
2. Choose Spell Checker from the Text menu.
3. When CorelDRAW displays a word you want to add to a personal dictionary, select the 

dictionary from the Personal Dictionaries list box.
4. Choose the Add button.



Opening a personal dictionary
You can open a personal dictionary and have CorelDRAW refer to it along with the standard 
dictionary during a spelling check.

To open a personal dictionary:
1. Select the text you want to check.
2. Choose Spell Checker from the Text menu.
3. Click on the arrow in the Personal Dictionary box.
4. Select the dictionary you want to use.
5. Choose the Check Text button to begin the spelling check.



Hyphenating words automatically
You can have CorelDRAW insert hyphens in words of Paragraph text automatically. 
Hyphenating words at the end of lines produces less-ragged margins and helps to reduce 
unwanted gaps between words of justified text.

To hyphenate words:
1. Select the frame of text you want to hyphenate.
2 Choose Frame from the Text menu.
3. Click on Automatic hyphenation.
4. Type or select the Hot Zone setting you want to use.

The Hot Zone setting specifies how far the end of a line must be from the right margin 
before CorelDRAW tries to hyphenate the first word in the next line. A smaller hot zone 
results in more hyphens and less-ragged margins.

5. Choose OK.



Using the thesaurus
You can use the Thesaurus command to look up synonyms for a selected word.

To use the thesaurus:
1. Using the Text tool, select the word for which you want to look up synonyms.
2. Choose Thesaurus from the Text menu.

CorelDRAW lists possible definitions for the selected word in the Definitions box.
Synonyms for the first definition appear in the Synonyms box.

3. Do one or more of the following:
· Select other definitions to see their synonyms.
· Select the synonym you want to replace the selected word in the drawing, then 

choose the Replace button.
· Choose the Cancel button to close the Thesaurus dialog box without changing the 

selected word in the drawing.



Fitting text to a path
Text normally rests on an imaginary straight line called the baseline. While you cannot edit 
the baseline, you can fit it, along with the text, to a path of any shape. You can use an 
ellipse, rectangle, line, curve and even a letter converted to a curve object as the path.
The text and path become a dynamically-linked group, which means you can edit the text or 
path and have CorelDRAW automatically refit the text to the path.

To fit text To a path:
1. Select the text and the path.
2. Choose Fit Text to Path from the Text menu.

The Fit Text to Path Roll-Up window appears.
3. Choose options that determine how you want CorelDRAW to fit the text to the path.

Click on To
 in 1st box Display a list of text orientation options.
 in 2nd box Display a list of vertical placement options. The last option in the list lets you 

adjust the alignment by dragging with the mouse. See Adjusting the position of text on a 
path.

 in 3rd box Display a list of horizontal placement options if you are fitting text to an open 
path.

Select the quadrant on a closed path to which you want the text fitted. You can also 
move the text along the path by dragging it with the mouse. See Adjusting the position of 
text on a path.

Place on Fit the text on the opposite
other side side of the path.

You can also specify horizontal and vertical placement, by choosing the Edit button 
and typing, or selecting numeric values in the Horizontal Offset and Dist from Path 
boxes.

5. Choose the Apply button.



Editing text fitted to a path
Fitting text on a path creates a dynamically-linked group of objects which you can edit by:

· selecting different options from the Fit Text to Path Roll-Up window.
· editing the shape of the path.
· editing the text.

When you finish editing, CorelDRAW refits the text to the path automatically.

To edit text on path from the Fit Text to Path window:
1. If the Roll-Up window is not already displayed, choose Fit Text to Path from the Effects 

menu.
2. Select the text/path group.
3. Choose the options you want to use.
4. Choose the Apply button.

To edit the shape of the path:
1. Select the Shape tool.
2. Click on the path.
3. Shape the path by moving selected nodes and control points. See Shaping a curve 

object by moving its nodes and control points.
To edit the text:

1. Select the Pick tool.
2. Hold the CTRL key down and click on the text.
3. Choose Edit Text from the Edit menu.
4. Make the changes you want.
5. Choose OK.



Adjusting the position of text on a path
After fitting text to a path, you can use the mouse to move it along the path, or to adjust the
distance between the text and the path.

To move text along the path:
1. Select the Shape tool.
2. Hold down the SHIFT key and click on the nodes next to each character, or drag a 

marquee box around them.
3. Drag in the desired direction.

A dashed outline of the text appears.
4. Release the mouse button when the outline is positioned where you want the text to 

appear on the path. 
To adjust the distance from the path:

1. Select the Pick tool.
2. Hold the CTRL key down and click on the text.
3. Drag away from the path in the desired direction.

A slide control appears.
4. Release the mouse button when the slide control is the distance you want the text to 

appear from the path. 



Detaching text from a path
You can break the link between the text and the path to which it is fitted. Once the link is 
broken, you can use the Straighten Text command in the Text menu to straighten the 
baseline of the text.

To detach text from a path:
1. Select the text/path group.
2. Choose Separate from the Arrange Menu.



Wrapping Paragraph text around objects
You can make Paragraph text flow around objects by molding the shape of    its frame.

To wrap Paragraph text around an object:
1. Select the Shape tool.
2. Click on the frame around the Paragraph text.

Handles appear at the corners and midway along the sides of the frame.
3. Shape the frame by holding the mouse button down on the handles and dragging.

You can also shape the frame by dragging the control points that extend from a 
selected handle. 



Extracting and merging text
Does text in your drawing need major revision? You can make those revisions faster and 
easier by saving the text in a file that you can edit in a word processor. When you finish 
editing, CorelDRAW will automatically insert the revised text into your drawing.
The revised text will appear just as the original text did, provided you did not change the 
attributes of individual characters or apply any of the following commands:

· Extrude
· Blend
· Fit Text to Path

To extract text from a drawing:
1. Open the file with the text you want to extract.
2. Choose Extract from the Text menu.

The Extract dialog box appears, prompting you to give the extracted text file a name.
3. Accept the suggested name or type a new one.
4. Choose OK.

To merge text with a drawing:
1. Load the text file into Windows Notepad or other text editor.
2. Edit the text, making sure not to change the filename at the top and the codes before 

and after each text string.
3. When you are finished editing, save the file as an ASCII text file, then go back to 

CorelDRAW.
4. Open the drawing from which you extracted the text.
5. Choose Merge-Back from the Text menu.
6. In the File Name box, type or select the name of the text file.
7. Choose OK.

Within a few seconds, the drawing will appear with the changes you specified.
If you save the revised file at this point, CorelDRAW will overwrite the original. To keep 
the original, choose Save As from the File menu and save the revised file under a 
different name or in another drive or directory.



Applying character attributes
CorelDRAW provides several ways to apply character attributes (typeface, size, spacing etc.) 
to a selected block of text.

To apply character attributes to a selected block of text:
1. Select the Pick tool.
2. Select the text to which you want to apply attributes.
3. Choose one of the following commands:

Choose To
Edit Text (Edit menu) Apply any of the available attributes.
Character (Text menu) Apply font, size, style, subscript and superscript.
Frame (Text menu) Apply formatting options to paragraph text and adjust the 

spacing of Artistic text.
Text Roll-up (Text menu) Display the text Roll-Up Window for quick access to all 

available attributes.
4. Choose the attributes you want.
5. Choose OK.
You can apply different attributes to individual characters in the same text block by 
highlighting the individual characters with the mouse or selecting them with the Shape 
tool. See Selecting text on screen.



Creating Adobe Type 1 and TrueType compatible fonts
You can create your own typefaces and symbol sets, or customize the typefaces supplied 
with CorelDRAW. Typefaces you create can be used in any application that supports Adobe 
Type 1 or TrueType fonts. For more information, see "Creating and Modifying Typefaces" in 
the "Adding and Editing Text" chapter of your CorelDRAW User's Guide.
NOTE: To add the character you are creating to an existing typeface, make a copy of the 
typeface and store it under a new name, but in the same directory as the existing typeface. 
The character you create will be added to the renamed typeface.

To convert an object to a typeface character:
1. Choose Page Setup from the File menu.
2. Choose Custom and set the vertical and horizontal dimensions to 750 points.
3. Set the basepoint for the character by placing a vertical guideline 30 points in from 

the left side of the page border, and a horizontal guideline 30 points from the bottom 
of the page border.

4. Turn off Snap to Guidelines by choosing the command from the Display menu.
5. Scale the object you want to export to a height of 720 points.

If the object is a character from an existing typeface, use the Character command or 
the Text Roll-up window to scale the character.

5. Align the bottom and rightmost edges of the object you want to export to the 
guidelines.

6. Convert the object to curves using the Convert to Curves command in the Arrange 
menu.

7. Do the following:
· If the object is an uppercase character, establish a cap height reference by placing 

a guideline on the topmost edge of the character.
· If the object is a lowercase character, establish an X-height reference by placing a 

guideline on the topmost edge of the character.
· If the object is a lowercase character with a descender, establish a reference for the

descender line by placing a guideline on the lowermost edge of the character.
8. Use the Shape tool to modify the object the way you want.
9. Choose Export from the File menu.
10. From the List Files of Type box, choose either TrueType Font or Adobe Type 1 Font.
11. Do one of the following:

· If you are creating a new typeface, type the name you want to assign to the 
typeface in the File Name box.

· If you are adding a character to an existing typeface, change to the directory 
containing the typeface, then select the typeface name from the list under the File 
Name box.

12. Choose OK.
13. Provide the required information in the Export Adobe Type 1 or TTF dialog box. See 

Export Adobe Type 1/TFF dialog box.
14. Choose OK.



Setting up the CorelDRAW Screen
You can tailor the CorelDRAW screen to better suit your needs. For example, you can hide 
certain parts of the screen, such as the Status Line or the rulers. The screen setup you 
choose becomes the default setup used each time you start CorelDRAW.
The table below lists all the screen-related items you can change along with the original 
default settings and the options you can choose. The Command/Action column shows the 
command or action you use to change each item. If you want step-by-step instructions, click 
on . 

Item Default Option Command/Action
Page Size,
Orientation

Letter 
(8.5x11 in.)
Portrait

Legal, Tabloid
Slide, Custom
A3, A4, A5, B5
Landscape

Page Setup, 
File menu 

Page 
Background

None Any color Page Setup,
File menu 

Working 
View

Editable
Preview

Wireframe Edit Wireframe, 
Display menu

Window 
Size

Less than
maximum

Maximized
Any size

Click 
Drag window border
Size, Control menu

Color
Palette

On Off Show Color Palette, 
Display menu

Color
Method

Process Spot Show Color Palette, 
Display menu

Status
Line

On Off Show Status Line,    
Display menu

Printable
Page Border

On Off Preferences,
Special menu

Rulers Off On Show Rulers, 
Display menu

Ruler
Units

Inches millimeters
picas
points

Grid Setup, 
Display menu 

Setting the size and orientation of the Printable Page
You can change the size and orientation of the Printable Page to match the page size of the 
printer or other output device you are using.

To set the size and orientation of the Printable Page:
1. Choose Page Setup from the File menu.
2. Select the Orientation option you want.

NOTE: When you print the drawing, a message will appear if the Printable Page and 
printer page orientation (as specified with the Printer Setup command) do not match. 
The message will ask if you want CorelDRAW to change the printer orientation to 
match Printable Page. 

3. Do one of the following:
· Choose one of the preset page sizes.



· Choose Custom and type or select the Horizontal and Vertical dimensions you 
want.

If you want to use a different unit of measurement, select it from the units box. 
CorelDRAW will automatically convert the value to its equivalent in the unit you select.

4. Choose OK.



Adding a printable background to a drawing
You can apply a printable background frame to your drawing. The frame is sized to fit the 
page and is automatically placed behind all objects on the screen. It's assigned the default 
fill and outline which you can change the same way as you would for any other object.

To add a printable background to a drawing:
1. Choose Page Setup from the File menu
2. Choose the Add Page Frame button.
3. Choose OK.

To remove the printable background:
1. Select the frame.
2. Press the DEL key or choose Clear from the Edit menu.



Sizing the CorelDRAW windows
You can resize the CorelDRAW screen so that it takes up more or less space on your screen.
NOTE: The CorelDRAW window opens at less than full-screen size each time you start the 
program. If you prefer, you can have it open at maximum size by changing a line in the 
CORELDRW.INI file. See Specifying the CorelDRAW window size on start-up.

To adjust the size of the CorelDRAW screen with the keyboard:
1. If they are not already displayed, click on  to display CorelDRAW's window borders.

2. Press ALT+Spacebar then S.
3. Press the Arrow key that corresponds to the side, top or bottom border you want to 
move.
4. Press the Arrow keys to move the border.
5. Press the ENTER key when the window is the size you want.
To adjust the size of the CorelDRAW screen with the mouse:

1. If they are not already displayed, click on  to display CorelDRAW's window borders.
2. Do one of the following:

· Drag the side, top or bottom border to resize the window in one direction.
· Drag a corner of the border to resize the window in horizontally and vertically. 

3. Release the mouse button when the window is the size you want.



Creating a new drawing
The New command clears the drawing window allowing you to begin a new drawing. 

To create a new drawing:
· Choose New from the file command.

If you have made changes to the current drawing that have not been saved, 
CorelDRAW asks you if you want to save them before clearing the drawing window. 
Choose Yes to save the changes, No to ignore them or Cancel to cancel the 
command.



Opening a drawing
The Open command opens drawings previously saved to disk. You can also open a recently 
saved drawing by choosing its name (or the number beside it) from the File menu.

To open a drawing:
1. Choose Open from the File menu.
2. In the File Name box, type the name of the drawing you want to open or select it from

the list.
If the drawing you want is in another drive or directory, select the drive from the 
Drives box and the directory from the Directories box.
Choosing the Options button reveals options which let you search for files using either
keywords or Mosaic. See Finding files using keywords and Finding files using Mosaic.

3. Choose OK.
To open a recently saved drawing:

1. Choose Open from the File menu.
2. Choose the name or number of the drawing you want to open.
3. Choose OK.



Saving a new drawing
The Save command displays a dialog box where you can give a new drawing a filename and 
specify a location in which to store it.

To save a file for the first time:
1. Choose Save from the File menu
2. Do one of the following:

· To save the drawing in the current drive and directory, type a name up to eight 
characters in the File Name box.

· If you want to save the drawing in a different drive or directory, type the entire path 
name in the File Name box. Or, select the drive from the Drives box and the 
directory from the Directories box.

3. Choose OK.



Choosing commands and tools
You can choose commands and tools with the mouse or by pressing keys.

To choose a menu command with the mouse:
1. Point to the menu name.
2. Click with the primary mouse button.
3. Point to the command name.
2. Click with the primary mouse button.

To choose a menu command by pressing keys:
1. Press the ALT key.
2. Press the underlined letter in the name of the menu you want to open.
3. Press the underlined letter in the name of the command you want to choose.

To close a menu without choosing a command:
· Move the mouse pointer away from the menu and click with the primary mouse button 

or press ESC.
To choose a Tool with the mouse:

· Point to the tool button and click with the primary mouse button. 
With the Zoom, Outline and Fill tools a flyout menu appears. Point to the icon 
representing the function you want and click with the primary mouse button.
The Pencil and Text tools have flyout menus opened by pointing to the tool and holding
down the primary mouse button.

To choose a Tool by pressing keys:
Tool Key
Pick SPACEBAR
Shape F10
Zoom F2 (zoom-in function)
Pencil F5
Rectangle F6
Ellipse F7
Text F8
Outline F12 for Outline Color, SHIFT and F12 together for Outline Pen
Fill F11 for Fountain fill, SHIFT and F11 together for Uniform Fill



Working with dialog boxes
Whenever CorelDRAW needs information to carry out a command, it displays a dialog box.

To set options in a dialog box:
Do one of the following:
· Point to the option and click with the primary mouse button.
· Hold down the ALT key and press the underlined character in the option name.

To select an item in a list box:
Do one of the following:
· Click on the scroll arrows to display the option you want, point to it, then click with the 

primary mouse button.
· Hold down the ALT key, press the underlined character in the list name, press  or ¯ to 

highlight the option you want.
To select an item in a drop-down list box:

Do one of the following:
· Click on down arrow, point to the option you want, then click with the primary mouse 

button.
· Hold down the ALT key, press the underlined character in the list name, release the ALT 

key, then press  or ¯ to highlight the option you want.
To type in a text box:

If the box you want to type in is empty, do one of the following:
· Point to the text box and begin typing.
· Hold down the ALT key, press the underlined letter in the text box label, then begin 

typing.
If the box already contains text do one of the following:
· Hold down the primary mouse button, move the mouse pointer over the text you want 

to replace, then start typing.
· Hold down the ALT key, press the underlined letter in the text box label, then begin 

typing.
To edit in a text box:

Do any of the following:
To Do this
Move insertion point Point and click on the new location, or press the ®, ¬, HOME or END 

key.
Select text Drag with the mouse, or hold down the SHIFT key and press the ®, 

¬, HOME or END key.
Delete text Press the BACKSPACE or DEL key to delete one character at a time or 

select the characters and press the DEL key. 
Replace text Select text and begin typing.

To carry out the options you set:
· Choose OK or press the ENTER key.

To close a dialog box without carrying out the options you set:
· Choose Cancel or press the ESC key.





Using Roll-up windows
Commands such as Blend and Extrude use Roll-Up windows instead of dialog boxes to 
request information from you. In other cases, you have a choice between using a Roll-Up 
window or a dialog box. For example, you can select different types of fills and text 
attributes from a Roll-Up window. 
Roll-Up windows contain many of the controls found in dialog boxes: command buttons, text 
boxes, drop-down list boxes and so on. But unlike most dialog boxes, the window stays open 
after you apply the selected options. This lets you makes adjustments and experiment with 
different options without having to continually re-open a dialog box. When you are not using 
a window, you can hide the controls leaving just the Title bar visible.

To carry out you selections:
· Click on the Apply button.

To roll a window up and down:
Do one of the following:
· Click the arrow in the top right corner.
· Click on  and choose Roll up or Roll down. 

To close a Roll-Up window:
Do one of the following:
· Click on  and choose Close.

· Click on the window and press the ESC key.
To move a Roll-Up window:

· Point to the Title bar, hold the primary mouse button down and move to the new 
location.

To arrange open Roll-Up windows:
1. Click on 

2. Do one of the following:
· Choose Arrange to roll-up the active window move it to the top right corner of the 

drawing window.
· Choose Arrange All to roll-up all open windows and move some to the top right 

corner and others to the top left corner of the drawing window.



Undoing mistakes
If you make a mistake or change your mind about an action you just performed, the Undo 
command will often reverse that action. Actions you cannot undo:

· any change of view (zooming, scrolling etc.)
· any file operation (open, saving, importing etc.)
· any object selection operations.

To undo the last action you performed:
· Choose Undo from the Edit menu.

Immediately after using Undo, the Redo command becomes available allowing you to restore
what you just undid.



Repeating an action
You can use the Repeat command to repeat the last action on the same object or on another
object. For example, if you rotate an object, choosing Repeat rotates that object or another 
one you select by the same amount.

To repeat an action:
· Choose Repeat from the Edit menu.



Starting and exiting CorelDRAW
You can start CorelDRAW from either Windows or the DOS command prompt. To exit the 
program, choose Exit from the File menu.

To start CorelDRAW from the Windows Program Manager:
1. Open the group window with the CorelDRAW icon.
2. Double-click on the CorelDRAW icon.

To start CorelDRAW from the command prompt:
1. At the command prompt, type win coreldrw.

If an error message appears, the path statement in your AUTOEXEC.BAT file does not 
include the directory containing CorelDRAW. Change to the CORELDRW directory and try
again.

To exit CorelDRAW:
· Choose Exit from the File menu.

If you have made changes to the current drawing that have not been saved, 
CorelDRAW asks if you want to save them before closing. Choose Yes to save the 
changes, No to ignore them, or Cancel to cancel the command.



Installing options with the Setup program
You can run the Corel Setup program to install any optional items you chose not to install 
when you first set up CorelDRAW.

To install options with the Setup program:
1. Insert the CorelDRAW Setup disk (disk 1) in your floppy disk drive. 
2. From the Program Manager File menu, choose Run. 
3. Type the drive letter followed by :\setup, and then choose OK.
4. Follow the instructions on the screen. 

When the installation options window appears, choose the Custom Installation 
button.

5. Select the options you want to install.
6. Choose the buttons on the right side of the dialog box to further specify your 

installation choices.
7. Clear all other check boxes.
8. Choose the Setup button, and then follow the instructions that appear on the screen.



Transforming Objects
Transforming an object in CorelDRAW means to change its orientation or appearance without
altering its basic shape.
The transformations you can perform are:

· Stretch
· Scale
· Rotate
· Skew
· Mirror
· Move

You can perform all of these transformations using either the mouse or commands in the 
Transform menu. Using a command allows you to enter exact values for precise 
transformations. Some precision is also possible with mouse transformations. For example, 
moving an object while holding down the CTRL key forces it to move either horizontally or 
vertically.
Whether you use a command or the mouse, you can have CorelDRAW transform a copy of 
the selected object rather than the object itself.
You can perform any number of transformations on an object or group of objects.



Moving an object with numeric precision
The Move command in the Transform menu allows you to move objects by a specific amount
or to a specific location. You can also move objects visually with the mouse or nudge them 
with the arrow keys.

To move an object by a specific amount:
1. Select the object(s) you want to move.
2. Choose Move from the Transform menu.
3. If it's checked, choose Absolute Coordinates.
4. Type or select the distance you want the object moved in the Horizontal and Vertical 

boxes.
If you want to use a different unit of measurement, select it from the units box. 
CorelDRAW will automatically convert the value to its equivalent in the unit you select.
You can choose Leave Original to move a copy of the selected object while leaving 
the original behind.

6. Choose OK.
To move an object to a specific location:

1. If the rulers are not already displayed, choose Show Rulers from the Display menu.
2. Select the object(s) you want to move.
3. Choose Move from the Transform menu.
4. Choose Absolute Coordinates.

Nine buttons appear. One button for each handle on the selected object's highlighting 
box and one for the object's center. These are used to indicate which part of the object 
will lie on the specified coordinates. For example, if you want the object centered on 
the coordinates, click on the center button. 

5. Click on the button you want to use.
6. In the Horizontal and Vertical boxes, type or select the coordinates where you want 

the object moved. Specify the coordinates from the rulers.
If you want to use a different unit of measurement, select it from the units box. 
CorelDRAW will automatically convert the value to its equivalent in the unit you select.
You can choose Leave Original to move a copy of the selected object while leaving 
the original behind.

7. Choose OK.



Moving an object using the mouse
Dragging objects with the mouse lets you position them interactively. You can also move 
objects with numeric precision and by nudging them with the arrow keys. 

To move an object using the mouse:
1. Select the object(s) you want to move.
2. Press and hold the mouse button.
3. Drag the object to the location you want.

As you drag, the object's outline is replaced by a dotted rectangle.
The Status Line shows distance moved.

4. Release the mouse button to complete the move.
To leave the original object behind:

· While dragging, press the secondary mouse button.
To constrain the object's movement:

· Holding down the CTRL key while dragging, forces the object to move vertically or 
horizontally.



Moving objects in increments (nudging)
You can use the arrow keys (also called the "direction" or "cursor" keys) to move objects by a
specified amount. The default amount is 0.10 inches which you can change with the 
Preferences command in the Special menu.

To move an object in increments:
1. Select the object(s) you want to move.
2. Press an arrow key ( , ¯, ¬, ®) to move the object vertically or horizontally.

Holding down an arrow key moves the object in continuous steps.
To leave the original object behind:

· Press the secondary mouse button before pressing the arrow keys. 



Rotating an object with numeric precision
The Rotate & Skew command in the Transform menu allows you to rotate objects to a 
specific angle. You can also rotate objects interactively with the mouse.

To rotate an object with numeric precision:
1. Select the object you want to rotate.
2. Choose Rotate & Skew from the Transform menu.
3. Type or select the angle you want in the Rotation box.

You can choose Leave Original to rotate a copy of the selected object while leaving 
the original behind.

4. Choose OK.



Rotating an object using the mouse
You can interactively rotate objects by dragging them with the mouse. If you want numeric 
precision, use the Rotate & Skew command in the Transform menu.

To rotate an object using the mouse:
1. Do one of the following:

· Double-click on the object you want to rotate, or click once if it's already selected.
· If the object is unfilled or you are working in wireframe view, double-click (or click) 

on it's outline.
The handles on the object's highlighting box change to double-headed arrows.

2. Move the mouse pointer over one of the corner arrows until it becomes a cross.
3. Drag in a circular motion around the object.

As you drag the object's outline is replaced by a dotted rectangle.
The Status Line shows the rotation angle.

4. Release the mouse button to complete the rotation.
To leave the original object behind:

· Press the secondary mouse button before you begin rotating.
To constrain the angle of rotation:

· Holding down the CTRL key while dragging forces the object to rotate in 15 degree 
increments.
You can specify a different angle by choosing Preferences from the Special menu and    
typing or selecting the angle you want in the Constrain Angle box.



Moving an object's center of rotation
By default, an object rotates around a point (called the "center of rotation") in the middle of 
it's highlighting box. You can rotate the object around a different point by moving the center 
of rotation to another spot.

To move an object's center of rotation:
1. Do one of the following:

· Double-click on the object you want to rotate or click once if it's already selected.
· If the object is unfilled or you are working in wireframe view, double-click (or click) 

on it's outline.
The handles on the object's highlighting box change to double-headed arrows.
The center of rotation marker is in the middle of the box.

2. Drag the center of rotation to the desired spot.
3. Release the mouse button to complete the move.

When you rotate the object it will turn on that spot.
To return the center of rotation to the middle of an object's highlighting box:

· Hold the CTRL key down and drag the center of rotation to the middle of the object.



Skewing an object with numeric precision
The Rotate & Skew command in the Transform menu allows you to skew objects by a specific
amount. You can also skew objects interactively with the mouse.
NOTE: CorelDRAW uses the object's center as a reference when skewing with the Rotate & 
Skew command, and a corner handle on it's highlighting box when skewing with the mouse.

To skew an object with numeric precision:
1. Select the object(s) you want to skew.
2. Choose Rotate & Skew from the Transform menu.
3. Type or select the angle you want in the Skew Horizontally and/or Skew Vertically 

boxes.
You can choose Leave Original to skew a copy of the selected object while leaving the
original behind.

4. Choose OK.



Skewing an object using the mouse
You can interactively skew objects by dragging them with the mouse. If you want numeric 
precision, use the Rotate & Skew command in the Transform menu.
NOTE: CorelDRAW uses the object's center as a reference when skewing with the Rotate & 
Skew command, and a corner handle on it's highlighting box when skewing with the mouse.

To skew an object using the mouse:
1. Do one of the following:

· Double-click on the object you want to skew or click once if it's already selected.
· If the object is unfilled or you are working in wireframe view, double-click (or click) 

on it's outline.
The handles on the object's highlighting box change to double-headed arrows.

2. Move the mouse pointer over the top middle or bottom middle arrow to skew the 
object horizontally or the side arrows to skew the object vertically.

3. Drag in the desired direction.
As you drag, the object's outline is replaced by a dotted rectangle.

4. Release the mouse button to complete the skew.
To leave the original object behind:

· Press the secondary mouse button before you begin skewing.
To constrain the object 's movement:

· Holding down the CTRL key while dragging forces the object to skew in 15 degree 
increments.
You can specify a different angle by choosing Preferences from the Special menu and    
typing or selecting the angle you want in the Constrain Angle box.



Stretching, scaling or mirroring an object with precision
The Stretch & Mirror command allows you to precisely resize objects either proportionally 
(scale) or in different vertical and horizontal proportions (stretch). You can also create a 
mirror image of an object by flipping it across an imaginary line through the center of the 
object.
All of these transformations can be done interactively using the mouse.
NOTE: CorelDRAW uses the object's center as a reference when transforming with the 
Stretch & Mirror command, and a corner handle on it's highlighting box when transforming 
with the mouse.

To stretch, scale or mirror an object with precision:
1. Select the object(s) you want to stretch or scale.
2. Choose Stretch & Mirror from the Transform menu.
3. Do one of the following:

· To stretch an object, type or select the amount of vertical and/or horizontal stretch 
you want.

· To scale an object, type or select equal amounts for horizontal and vertical stretch.
· To create a mirror image, choose one or both of the Mirror options.
You can choose Leave Original to stretch/scale/mirror a copy of the selected object 
while leaving the original behind.

4. Choose OK.



Stretching, scaling or mirroring an object using the mouse
You can interactively resize objects either proportionally (scale) or in different vertical and 
horizontal proportions (scale). You can also create a mirror image of an object by flipping it 
across an imaginary line through the center of the object.
For numeric precision, use the Stretch & Mirror command in the Transform menu.
NOTE: CorelDRAW uses the object's center as a reference when skewing with the Rotate & 
Skew command, and a corner handle on it's highlighting box when skewing with the mouse.

To stretch or scale an object using the mouse:
1. Select the object(s) you want to stretch or scale.
2. Move the mouse pointer over one of the handles between the corners to stretch the 

object or over the corner handles to scale it.
The pointer becomes a cross.

3. Drag the handle in the desired direction.
As you drag, the object's outline is replaced by a dotted rectangle.

4. Release the mouse button when the object is the desired size.
To stretch/scale in 100% increments:

· Hold down the CTRL key while dragging.
To leave the original object behind:

· Press the secondary mouse button before you begin stretching or scaling. 
To stretch/scale in multiple directions:

· Hold down the SHIFT key while dragging to stretch the object in two directions or scale 
it in all four directions.

To stretch/scale in 100% increments from the object's center:
· Hold down the CTRL and SHIFT key while dragging.

To create a mirror image of the object:
· Hold down the CTRL key while dragging a side handle across the object instead of away

from it.
· If you want to leave the original behind, start dragging across the object. Then with the

mouse button still held down, press the secondary mouse button. Next, hold down the 
CTRL key and finish dragging.



Duplicating objects
The Duplicate command in the Edit menu makes a copy of the selected object or group of 
objects and offsets it slightly from the original.
You can change the amount of offset by choosing Preferences from the Special menu and 
then specifying the amount in the boxes under Place Duplicate.

To duplicate an object or group of objects:
1. Select the object or group of objects.
2. Choose Duplicate from the Edit menu.



Clearing transformations
With the exception of moves, you can quickly reverse all transformations applied to an 
object or group of objects.
NOTE: If you selected a group, only transformations performed on the group are cleared; 
transformations performed on the objects before they were grouped are not cleared.

To clear transformations:
1. Select the object or group of objects whose transformations you want to clear.
2. From the Transform menu, choose Clear Transformations.



Shaping Objects
Objects created with the Ellipse, Rectangle and Text tools are constructed from basic 
elements called paths. A line, for example, is a path drawn between a start and endpoint. 
Circles and rectangles are represented by paths as well.
The Shape tool allows you to change the characteristics of the path and the endpoints 
(called "nodes") which in turn allow you to reshape the object. For example, you can convert 
a straight line to a curve and then manipulate the curve to shape it any way you want. 
In order to edit paths and nodes, you must first convert the object to curves using the 
Convert to Curves command in the Arrange menu. This step isn't necessary for objects 
drawn with the Pencil tool--they are automatically drawn as curves.
Two special types of shaping don't require converting the object to curves:

· rounding the corners of rectangles and squares.
· creating arcs and pie wedges from ellipses and circles.

Keep in mind that you cannot edit text after you convert it to curves. 



Rounding the corners of a rectangle or square
You can use the Shape tool to round off the corners of a rectangle or square.

To round the corners of a rectangle or square:
1. Click on the rectangle/square with the Shape tool.

If the rectangle/square is unfilled or you are working in wireframe view, click on the 
outline.

2. Drag one of the corner nodes along the outline of the rectangle/square. 
As you drag, the four corner nodes each divide into two nodes with a round corner 
forming in between. As you continue to drag, the corners become increasingly round.

3. Release the mouse button when the rectangle/square is shaped the way you want.
The amount of rounding (the corner radius) is displayed on the Status Line.



Turning an ellipse or circle into an arc or pie wedge
You can use the Shape tool to turn an ellipse or circle into an arc or pie wedge.

To turn an ellipse or circle into an arc or pie wedge:
1. Click on the ellipse/circle with the Shape tool.

If the ellipse/circle is unfilled or you are working in wireframe view, click on its outline.
A single node appears at the top or bottom of the ellipse/circle.

2. Drag the node around the outside of the ellipse/circle to create an arc or around the 
inside to create a pie wedge.
As you drag, the node divides into two nodes with the arc/pie wedge forming in 
between. 

3. Continue dragging until the arc/pie wedge is the shape and size you want.
The Status Line shows the position of the two nodes and the distance (the total angle) 
between them in degrees.
If you are creating the arc/pie wedge from an ellipse, the word "distorted" appears 
after the total angle. This means, for example, that a 45 degree angle will be an eighth 
of the way around the ellipse rather than actually being at 45 degrees.



Converting rectangles, ellipses and text to curve objects
To change the shape of objects added with the Rectangle, Ellipse and Text tools, you must 
first convert them to curves.

Converting rectangles, ellipses and text to curve objects
1. Select the object with the Pick tool.
2. Choose Convert to Curves from the Arrange menu.

Though it looks the same, the object is now a curve object that you can reshape by 
manipulating its nodes and control points with the Shape tool. 



Selecting the first/end node on a curve object
The HOME and END keys let you quickly select the first or end node in a curve object.

To select the first or end node in a curve object:
1. Click on the curve object with the Shape tool.

If the object is an unfilled, closed path, or you are working in wireframe view, click on 
the path.

2. Press the HOME key to select the first node and the END key to select the end node.
On a closed curve, the first and last nodes are the same.



Selecting and deselecting a node or segment on a curve object
You use the Shape tool to select nodes and segments on a curve object. Once you select a 
node or segment, you can change its characteristics by applying commands from the Node 
Edit menu. You can also move a selected node and its associated control points.

To select a single node or segment on a curve object:
1. Select the Shape tool.
2. Click on the node or segment.

The selected node or the node following the selected segment becomes highlighted in 
one of two ways: hollow if the associated segment is a line; solid if it's a curve.
The Status Line shows the type of node (smooth, cusped or symmetrical) and segment 
(line or curve).
Control points appear extending from the selected node and those on either side of it.

To select multiple nodes or segments:
Do one of the following:

· Hold down the SHIFT key and click on the nodes/segments you want to select.
· Drag a marquee box around the nodes/segments you want to select.

To deselect one or more nodes/segments:
Do one of the following:

· Hold down the SHIFT key and click on the nodes/segments you want to deselect.
· Hold down the SHIFT key and drag a marquee box around the nodes/segment you 

want to deselect.
To deselect all nodes:

· Click on any white space away from the outline of the curve.



Shaping a curve object by moving its nodes and control points
You can change the shape of a curve object by moving its nodes and control points. 
Normally, you move the nodes first to make coarse adjustments then fine tune the shape by 
moving the control points.

To shape a curve object by moving its nodes:
1. Click on the curve object with the Shape tool.

If the object is an unfilled, closed path or you are working in wireframe view, click on 
the path.

2. Click on the node or the segment preceding the node you want to select.
Control points appear extending from the selected node and those on either side of it.

3. Drag the node.
As you drag, the segments on either side of the nodes move. The node's control points 
also move so that the angles at which the curve enters and leaves the node remain 
unchanged.

To shape a curve object by moving several nodes and segments at once:
1. Select the nodes and segments you want to move by holding down the SHIFT key and 

clicking on them or by dragging a marquee box around them.
2. Drag any of the selected nodes.

To shape a curve object by moving its control points:
1. Click on the curve object with the Shape tool.

If the object is an unfilled, closed path or you are working in wireframe view, click on the 
path.

2. Click on the node or the segment preceding the node you want to select.
Control points appear extending from the selected node and those on either side of it.

3. Drag the control points one at a time until the curve is the shape you want.
The control points move differently depending on whether the node they are 
associated with is smooth, cusped or symmetrical. This, in turn, affects the shape of 
the curve.

To constrain the movement of the node or control point:
· Holding down the CTRL key while dragging forces the node/control point to move 

horizontally or vertically from its starting point.



Adding nodes to a curve object
If shaping a curve object by moving the existing nodes and control points isn't giving you the
results you want, you can add more nodes. See Determining if you need to add or delete 
nodes

To add a single node:
1. Click on the curve object with the Shape tool.

If the object is an unfilled, closed path or you are working in wireframe view, click on 
the path.

2. Double-click on the node or the spot along the segment where you want the node 
added.

3. From the Node Edit menu, choose Add.
If you clicked on a node, the new node appears midway along the adjacent segment. If 
you clicked on a segment, the node appears on the spot you clicked on.

To add several nodes at once:
1. Click on the curve object with the Shape tool.

If the object is an unfilled, closed path or you are working in wireframe view, click on 
the path.

2. Use marquee-select or multiple-select to select the segments or the nodes that follow 
the segments along which you want the nodes added.

3. Double-click on one of the selected nodes or segments.
4. From the Node Edit menu, choose Add.

An additional node appears between each of the selected segments.



Deleting nodes and segments from a curve object
Deleting closely bunched nodes and segments helps to simplify complex curve objects.You 
can also delete them to smooth unwanted bumps along a curve. See Determining if you 
need to add or delete nodes

To delete a node or segment from a curve object:
1. Click on the curve object with the Shape tool.

If the object is an unfilled, closed path or you are working in wireframe view, click on 
the path.

2. Double-click with the Shape tool on the node or segment you want to delete. 
To delete several nodes/segments at once, select the nodes/segments by dragging a 
marquee box around them or by holding down the SHIFT key and clicking on them.

3. From the Node Edit menu, choose Delete.
The curve redraws without the deleted node/segment. The position of the deleted 
node/segment determines the amount of change in the shape of the curve.



Aligning nodes & controls points
Suppose you have two curve objects that are required to fit together like pieces of a puzzle, 
for example, the regions of a map. The easiest way to create a seamless fit is by aligning 
nodes and control points on the objects. To do this you must first combine the objects with 
the Combine command in the Arrange menu. After you align the nodes and/or control points,
you can use the Break Apart command to separate the objects.
You can also align just the nodes.

To align nodes & controls points:
1. Click on the curve object with the Shape tool.

If the object is an unfilled, closed path or you are working in wireframe view, click on 
the path.

2. Click on the node you want to realign.
3. Hold down the SHIFT key and click on the node you want to align with.
4. Double-click on one of the selected nodes.
5. From the Node Edit menu, choose Align.
6. From the Node Align dialog box, deselect any options you do not want. For example, if 

you only want to align horizontally, deselect Align Vertical. All three options must be 
selected to align the shape of the curves as well as the nodes.

7. Choose OK.
8. Repeat steps 2 to 7 as often as you need.



Breaking a curve object
You can turn a curve object that forms a closed path into an open one by breaking the path 
at any point. You can also break an open path into one or more subpaths. 

To break a curve object:
1. Click on the curve object with the Shape tool.

If the object is an unfilled, closed path or you are working in wireframe view, click on 
the path.

2. Double-click on the point where you want to break the path.
To break the path at several nodes at once, select the nodes by dragging a marquee 
box around them or by holding down the SHIFT key and clicking on them.

3. From the Node Edit menu, choose Break.
Two superimposed nodes appear at each break. Though you can move the new node, 
its associated segment is still part of the original curve object.



Changing a segment to a curve or line
You can change a curve segment to a line segment and visa versa.

To change a segment to a curve or line:
1. Click on the curve object with the Shape tool.

If the object is an unfilled, closed path or you are working in wireframe view, click on 
the path.

2. Double-click on the segment or the node that follows the segment you want to change.
To change several segments at once, select them or their associated nodes by 
dragging a marquee box around them or by holding down the SHIFT key and clicking on
them.

3. From the Node Edit menu, choose ToLine or ToCurve.
If you chose ToLine, the curve segment redraws as a straight line.
If you chose ToCurve, the line segment will appear unchanged. However, if you select 
a node at either end of the segment, control points will appear indicating that it is now 
a curve.



Determining if you need to add or delete nodes
A curve requires more nodes if you cannot shape it the way you want by moving the existing
nodes. You need to delete nodes if you want to remove unwanted dips or bumps associated 
with them.
There are three rules of thumb for determining if you need to add or delete nodes on a 
curve.

For curves 
moving in one 
direction, you 
need a node 
every 120 
degrees.
For curves 
changing 
direction 
smoothly, you 
need a node for 
at least every 
two points at 
which the curve 
changes 
direction.

For curves 
changing 
direction at a 
cusp (pointed 
corner) you need
a node at every 
cusp.

Joining nodes to close an open path or connect separate paths
You can close an open path by joining it's two end nodes. You can also join end nodes on 
separate paths by first combining the paths into one object with the Combine command in 
the Arrange menu.

To join two nodes to close an open path:
1. Find the nodes on the ends of the path you want to close.
2. Using the Shape tool, select the nodes by dragging a marquee box around them or by 

holding down the SHIFT key and clicking on them.
3. Double-click on one of the selected nodes.
4. From the Node Edit menu, choose Join.

The curve redraws as a closed path that can then be filled with the Fill tool.
To join two nodes to make a single curve from separate paths:



1. Select the paths you want to join with the Pick tool.
2. Choose Combine from the arrange menu.
3. Find the nodes on the ends of the paths you want to join.
4. Using the Shape tool, select the nodes by dragging a marquee box around them or by 

holding down the SHIFT key and clicking on them.
5. Double-click on one of the selected nodes.
6. From the Node Edit menu, choose Join.

The curve redraws as a single open path.



Making a node smooth, cusped or symmetrical
CorelDRAW provides three type of curve nodes. The type determines how the shape of a 
curve passing through a node changes when you move its control points.

· Cusp nodes allow the curve to bend sharply.
· Smooth nodes allow a different curvature on each side of the node.
· Symmetrical nodes keep the same curvature on both sides of the node.

To make a node smooth, cusped or symmetrical:
1. Click on the curve object with the Shape tool.

If the object is an unfilled, closed path or you are working in wireframe view, click on 
the path.

2. Double-click on the node you want to change. To change several nodes at once, select 
them by dragging a marquee box around them or by holding down the SHIFT key and 
clicking on them.

3. Choose Smooth, Cusp or Symmet.
Unless the curve passed through the node on a fairly sharp angle, changing the node's 
type will not noticeably affect its shape. It will, however, affect the way in which you 
can reshape the curve by adjusting the node's control points.



Moving a control point hidden under a node
A node can sometimes hide a control point making it unselectable.

To move a control point hidden under a node:
1. Deselect all nodes on the curve object by clicking away from it with the Shape tool.

If necessary, use the Zoom tool to magnify the area around the node.
2. Hold down the SHIFT key and drag the control point out from under the node.



Drawing Basic Objects
A basic object is any object you draw with the Rectangle, Ellipse or Pencil tool.
The technique you use to draw is essentially the same for each of the tools: Select the tool, 
click anywhere on the page, and drag the mouse. If you hold down the CTRL key as you drag,
you can constrain the motion of the mouse to draw perfect squares or circles. 
For flexibility, you have the choice between two Pencil drawing modes. Freehand mode, 
which is the default mode, is suitable for sketching; Bezier mode is designed for precision 
drawing. The Pencil tool flyout menu, displayed when you hold the mouse button down on 
the Pencil tool, lets you switch freely between modes. 
When you finish drawing an object, CorelDRAW automatically selects it. This allows you to 
immediately use another tool or the menu commands to modify the object. 
All new objects you add are given a default outline and fill. You can change the defaults at 
any time by choosing the Outline or Fill tools with no objects selected. For more information, 
see Specifying a default outline and Specifying a default fill for new objects.



Drawing rectangles and squares
The Rectangle tool lets you draw rectangles and squares.

To draw a rectangle:
1. Select the Rectangle tool.
2. Position the crossbar where you want one corner of the rectangle to appear.
3. Hold the mouse button down and drag up or down on a diagonal. 
4. When the rectangle is the size and shape you want, release the mouse button.

To draw a rectangle from the center out:
· Hold down the SHIFT key as you drag.

To draw a square:
· Hold down the CTRL key as you drag.

To draw a square from the center out:
· Hold down the CTRL and SHIFT keys as you drag. 



Drawing ellipses and circles
The Ellipse tool lets you draw ellipses and circles.

To draw an ellipse:
1. Select the Ellipse tool.
2. Position the crossbar where you want one corner of the ellipse's highlighting box to 

appear
3. Hold the mouse button down and drag up or down on a diagonal. 
4. When the ellipse is the size and shape you want, release the mouse button.

To draw an ellipse from the center out:
· Hold down the SHIFT key as you drag.

To draw a circle:
· Hold down the CTRL key as you drag.

To draw a circle from the center out:
· Hold down the CTRL and SHIFT keys as you drag. 



Changing the line/curve drawing mode
CorelDRAW provides two styles or modes for drawing lines and curves:

· Freehand mode, which is the default mode, lets you draw by dragging the mouse as 
you would a pencil on paper. Use this mode for doing quick sketches where precision 
isn't critical. 

· Bezier mode is a connect-the-dots style of drawing that lets you draw smooth flowing 
curves with ease. Use this mode when you want to draw with precision.    

To change the line/curve drawing mode:
1. Hold the mouse button down on the Pencil tool.

2. When the flyout menu appears click on  to select the Bezier mode.

The Pencil tool remains in Bezier mode until you click on  to switch back to 
Freehand mode or exit CorelDRAW.



Drawing curves in Freehand mode
To draw curves in Freehand mode, you drag the mouse as you would a pencil on paper.
When you finish drawing, nodes appear at points along the curve. Moving the nodes and 
their control points with the Shape tool allows you to change the shape of the curve.

To draw curves in Freehand mode
1. Select the Pencil tool.

If you don't see the Freehand icon, , select it from the flyout menu displayed by 
holding the mouse button down on the Pencil tool.

2. Draw the curve by dragging the crossbar along the desired path.
If you want to backtrack, you can erase part of the path you have drawn by holding 
down the SHIFT key while continuing to drag. When you release the SHIFT key, you will 
resume drawing your line.

3. When you reach the end of your curve, release the mouse button.
There is a slight pause while CorelDRAW determines where to position the nodes along 
the curve you have just drawn.
If you want to draw a second curve connected to the first, start dragging from the 
endpoint of the last segment.
In order for the line segments to connect, you must click within five pixels of the 
endpoint. You can adjust this by choosing Preferences from the Special menu, clicking 
on the Curves button and then specifying the number of pixels in the AutoJoin box.



Drawing curves in Bezier mode
To draw curves in Bezier mode, you click to place the nodes at either end of the curve and 
then drag to position the control points. When you're done, CorelDRAW connects the nodes 
with a curve. 
Later, you can shape the curve by moving the nodes and control points with the Shape tool.

To draw curves in Bezier mode:
1. Select the Pencil tool.

If you don't see the Bezier icon, , select if from the flyout menu displayed by 
holding the mouse button down on Pencil tool.

2. Position the crossbar where you want the curve to start.
3. Press and hold down the mouse button.

A node indicating the start point of the curve appears.
4. Drag in the direction you want the curve to be drawn.

As you drag, two control points move in opposite directions from the node. The 
distance between the control points and the node determines the height or depth of 
the curve. The angle of the control points determines the slope of the curve.

5. When the control points are in the desired position, release the mouse button. 
Holding down the CTRL key as you position the control points forces them to move in 
15 degree increments. You can specify a different angle by choosing Preferences from 
the Special menu and typing or selecting the angle you want in the Constrain Angle 
box.

6. Move the crossbar where you want the curve segment to end, then press and hold the 
mouse button. 
A second node is set down and connected to the first.

7. Drag to position the control points that will determine the height and slope of the next 
curve segment. 
If you want to draw a curve with no change of direction (i.e., a curve with one bump) 
drag in the direction the curve is moving through the end node. Dragging in the 
opposite direction creates a curve with a smooth change in direction (i.e., a curve with 
two bumps).

8. Release the mouse button.
The curve segment will be redrawn between the two points.

9. Repeat steps 6 through 8 as many times as you want. 
To draw a closed shape in Bezier mode:

1. Draw the shape segment by segment as described above.
2. After drawing the next to last segment, connect it to the start node on the first 

segment by clicking on top of the node and dragging.
To draw a curve segment in Bezier mode that is unconnected to the previous one:

· Press the SPACEBAR twice before you define the start point of the new segment. 



Drawing straight lines in Freehand mode
You can draw straight lines at any angle in Freehand mode.

To draw a straight line in Freehand mode:
1. Select the Pencil tool.

If you don't see the Freehand icon, , select if from the flyout menu displayed by 
holding the mouse button down on the Pencil tool.

2. Click once on the spot where you want the line to begin.
3. Move the crossbar to where you want the line to end then click.
4. Release the mouse button.

If you want to draw another line connected to the first, click on the endpoint of the last 
line and continue drawing. You can streamline this action by double-clicking to finish 
each line segment and start the next. Remember to click once, not double-click, when 
you finish the final segment.
In order for the line segments to connect, you must click within five pixels of the 
endpoint. You can adjust this by choosing Preferences from the Special menu, clicking 
on the Curves button and then specifying the number of pixels in the AutoJoin box.
If you make a mistake, choose Undo from the Edit menu to delete the last segment.

To draw lines vertically, horizontally or in increments of 15 degrees:
· Click to start the line, then hold down the CTRL key as you drag the crossbar. 

You can specify a different angle by choosing Preferences from the Special menu and 
typing or selecting the angle you want in the Constrain Angle box.



Drawing straight lines in Bezier mode
You can draw straight lines at any angle in Bezier mode.

To draw a straight line in Bezier mode:
1. Select the Pencil tool.

If you don't see the Bezier icon, , select if from the flyout menu displayed by 
holding the mouse button down on the Pencil tool.

2. Position the crossbar on the spot where you want the line to start and click once.
Do not move the mouse as you click or you will begin drawing a curve instead of a 
straight line.

3. Move the crossbar to where you want the line to end, then click once.
A single line segment will be drawn between the two points.

4. Continue moving the crossbar and clicking to create as many connected line segments 
as you need. 
If you make a mistake, choose Undo from the Edit menu to delete the last segment. 

To draw a closed shape in Bezier mode:
1. Draw the shape segment by segment as described above.
2. After drawing the next to last segment, connect it to the start node on the first 

segment by clicking on top of the node and dragging.
To draw a line segment in Bezier mode that is unconnected to the previous one: 

· Press the SPACEBAR twice before you define the start point of the new segment.



Setting line and curve drawing preferences
CorelDRAW provides several adjustable settings that affect the way lines and curves are 
drawn.    

To set line and curve drawing preferences:
1. Choose Preferences from the Special menu.
2. Choose the Curves button.
3. Adjust the following as required:

Setting Purpose
Freehand Controls how closely
Tracking CorelDRAW tracks the motion of the mouse when

drawing in Freehand mode. The lower the number, the rougher your 
curves tend to appear.

Corner Controls when CorelDRAW
Threshold draws a smooth corner or a cusp 

when drawing in Freehand mode. The lower the number, the greater the 
tendency toward cusps.

Straight Line Controls when CorelDRAW
Threshold draws a straight or curve segment when 

drawing in Freehand mode. The lower the number, the greater the 
tendency toward drawing curves.

AutoJoin Determines how close the cursor must be to the end node of an existing 
segment in order for the next segment to join with it automatically. 
Applies to both Freehand and Bezier mode.

Constrain Controls the angle of motion
Angle when performing any of the following actions

with the CTRL key held down:
· Skewing or rotating
· Drawing straight lines in Freehand mode
· Adjusting control points when drawing in Bezier mode

4. Choose OK.



Viewing Drawings
CorelDRAW provides two ways to view your drawings on the screen.

· Editable Preview, which is the default view, displays your drawing as it will look when 
printed. You'll see all fills (except PostScript textures and halftone screens), outline 
attributes and text attributes. You can edit in editable preview and immediately see the
effects of your changes.

· Wireframe view, enabled by choosing Edit Wireframe from the Display menu, displays 
your drawing in outline form. If you're working on a complex drawing, wireframe view 
can save time on screen redrawing. You can apply fill and outline attributes in 
wireframe view, but you must switch to editable preview to see them.

Here are some other ways you can control the view in CorelDRAW:
· Zoom Tool: Lets you magnify parts of your drawing, bring all objects on the screen into 

view, show only objects on the Printable Page, show objects at printed size and zoom-
out by factors of two. 

· Auto-panning: Scrolls the drawing window automatically when you drag beyond the 
edges of the window. 

· Scroll bars: These appear along the bottom and right side of the drawing window and 
allow you to move the drawing window vertically and horizontally.    

· Layers: Organizing your drawing in layers then making certain layers (and objects on 
them) invisible saves time on screen redrawing. 

· Interruptible display: Saves time by allowing you to select a menu command or tool 
without waiting for the screen to redraw completely.



Displaying a drawing in editable preview
Editable preview is the default view you'll probably use to create and edit most of your 
drawing. It shows outlines, fills (except PostScript textures and halftone screens), and text 
attributes as they will appear when printed.

To display drawings in editable preview:
· Choose Edit Wireframe from the Display menu.



Displaying a drawing in wireframe view
As your drawing becomes more complex, you may notice the screen taking longer to redraw.
Wireframe view increases redrawing speed by displaying objects without their outline and fill
attributes. You can apply attributes in wireframe view, but you must switch to editable 
preview (or choose Show Preview from the Display menu) to see them.

To display drawings in wireframe view:
· Choose Edit Wireframe from the Display menu.

When wireframe view is enabled, a check mark appears beside the command.



Previewing a drawing
The Show Preview command removes everything but your drawing from the screen. You 
cannot edit your drawing in preview mode.
To save time on screen redrawing, you can preview just the selected object(s).

To preview a drawing:
· Choose Show Preview from the Display menu.

To return to normal view:
· Press any key.

To preview selected object(s) only:
1. Select the object(s) you want to preview.
2. Choose Preview Selected Only from the Display menu.



Magnifying and reducing the view of a drawing
The Zoom tool lets you magnify objects to get a closer look or reduce them so that you can 
see more of your drawing.

To magnify the view of a drawing:
1. Select the Zoom tool.

2. Click on .
3. Position the magnifying glass at the top left corner of the area you want to magnify.
4. Drag down and to the right until the area is enclosed in the marquee box.
5. Release the mouse button.

You can continue magnifying until you reach the magnification limit for your screen.
To reduce the view or return to the previous view:

1. Select the Zoom tool.

2. Click on .
Either your view zooms out by a factor of two, or you return to the previous view. You 
can continue zooming out until the height or width of the drawing window reaches 48 
inches.

To return to normal view:
1. Select the Zoom tool.

2. Click on .



Viewing all objects in the drawing window
You can quickly change views to show all objects in the drawing window.

To view all objects in the drawing window:
1. Select the Zoom tool.

2. Click on .



Viewing drawings at actual size
You can view your drawing as close as possible to actual size. While not true for all types of 
monitors, the correspondence on some types will be exact.

To view objects at actual size:
1. Select the Zoom tool.

2. Click on .



Scrolling the drawing window
Scrolling the drawing window lets you see portions of a drawing outside the current viewing 
area. CorelDRAW also provides an Auto-panning feature that scrolls the drawing window 
automatically    when you drag beyond its edges. You can turn Auto-panning off with the 
Preferences command in the Special menu. 

To scroll the drawing window:
· Click on a vertical or horizontal scroll bar arrow to move the window over by 10% in the

selected direction.
· Click on a scroll bar elevator to move the window to the area next to the spot you 

clicked on.
· Drag a scroll bar thumb to move the window an arbitrary amount in any direction. 



Interrupting a screen redraw
With the Interruptible Display feature turned on, you can stop the screen during a redraw. 
Using this feature saves time by allowing you to select a menu command or tool without 
waiting for the screen to redraw completely.

To interrupt a redraw in the Editing window:
· Click with the mouse or press a key.

To resume redrawing:
Do one of the following:
· Perform another action such as selecting a tool or command.
· Choose Refresh Window from the Display menu.



Refreshing the screen
The Refresh Window command lets you clear the screen of "dirt" that sometimes results 
from editing your drawing or to resume redrawing after a display interrupt.

To refresh the screen:
Do one of the following:
· Choose Refresh Window from the Display menu.
· Press CTRL W or click on a scroll bar thumb.



Speeding up screen redraw
Using fountain fills can add significantly to the time it takes to redraw the screen in editable 
preview. The same is true of complex curves in both editable preview and wireframe view. To
help increase the speed of screen redraw, CorelDRAW provides adjustable settings which 
control the way these two elements display. 
NOTE: These settings affect the printing of fountains and complex curves on non-PostScript 
printers.
Here are some other ways you can save time or screen redrawing:

· Organize your drawing on layers and make some layers invisible. See Adding a new 
layer and Making a layer visible or invisible.

· Turn off the display of bitmaps in wireframe view by choosing Show Bitmaps in the 
Display menu.

· Increase the Greek Text Below value for Paragraph text. See Increasing the redrawing 
speed of Paragraph text.

To increase the redrawing speed of complex curves:
1. Choose Preferences from the Special menu.
2. Choose the Curves button.
3. Under Curve Flatness, select Draft for the fastest redraw times or Custom if you 

want to specify a setting between Normal and Draft.
The setting you select determines the number of line segments CorelDRAW uses to 
represent curves on the screen and on non-PostScript printers. A higher setting uses 
fewer segments resulting in faster redrawing and printing times.

To increase the redrawing speed of fountain fills:
1. Choose Preferences from the Special menu.
2. Choose the Display button.
3. Type or select a lower Preview Fountain Stripes value.

The setting you select determines the number of stripes CorelDRAW uses to represent 
fountain fills on the screen and on non-PostScript printers. A lower setting uses fewer 
stripes resulting in faster redrawing and printing times.



Coloring the drawing window and Preview screen
You can apply a non-printing color to the preview screen to match the background of your 
drawing or the paper you plan to print it on. If you are working in editable preview, the color 
will show in the drawing window when the Printable Page border is turned off. 

To add color To the Preview screen:
1. Choose Page Setup from the File menu.
2. Choose the Paper Color button.

A dialog box with a controls from selecting and creating color appears.
3. Choose or create the color you want.
4. Choose OK.

To remove the color, use the same procedure and choose white as the Paper Color.



Selecting Objects
Before you can do anything with an object on the screen, you need to select it with the Pick 
tool. Once selected, you can use menu commands or the tools to change the object's 
appearance or position.
CorelDRAW provides two basic techniques for selecting objects. The first involves selecting 
the Pick tool then clicking on a particular part of the object.    Which part you click on 
depends on the view you are working in and whether the object has a fill:

· In editable preview, click anywhere on the object's fill or outline. If the object is 
unfilled, click anywhere on its outline.

· In wireframe view , click on the object's outline.
The second selection technique involves selecting the Pick tool and dragging a box (called a 
marquee box) around the entire object you want to select. 
When an object is selected, eight sizing handles appear at the corners and midpoints of an 
otherwise invisible rectangle. This rectangle is called a highlighting box. To "deselect" an 
object, click on open space. 
NOTE:    If Multilayer selection is turned on in the Layers Roll-up window, you can select 
objects on any layer that isn't locked. If Multilayer selection is off,    then you can only select 
objects on the active layer.



Selecting an object
You select objects with the Pick tool. Eight square sizing handles appear around an object 
when it's selected.

To select an object:
1. Select the Pick tool.
2. Do one of the following:

· In wireframe view and for unfilled objects, click anywhere on the object's outline.
· In editable preview click anywhere on the object's fill or outline.

To marquee select an object:
1. Select the Pick tool.
2. Hold down the mouse button and drag a dotted rectangle (called a marquee box) so 

that it completely encloses the object you want selected.
3. Release the mouse button.



Selecting multiple objects
Selecting more than one object lets you apply the same commands, transformations or 
attributes to them. When you select multiple objects, a single highlighting box enclosing 
them all appears.

To select multiple objects:
1. Select the Pick tool.
2. Hold down the SHIFT key.
3. Do one of the following:

· In wireframe view and for unfilled objects, click anywhere on the objects' outline.
· In editable preview, click anywhere on the objects' fill or outline.

To marquee select multiple objects:
1. Select the Pick tool.
2. Hold down the mouse button and drag a dotted rectangle (called a marquee box) so 

that it completely encloses the objects you want selected.
3. Release the mouse button.

To select all objects:
· If no objects are currently selected, select at least one, then choose Select All from the 

Edit menu.



Selecting grouped objects
Selecting a single object in a group selects the entire group. When you select a group, a 
highlighting box which encloses all objects in the group appears.

To select a group of objects:
1. Select the Pick tool.
2. Do one of the following to any object in the group:

· In wireframe view and for unfilled objects, click anywhere on the object's outline.
· In editable preview, click anywhere on the objects' fill or outline.

To marquee select a group of objects:
1. Select the Pick tool.
2. Hold down the mouse button and drag a dotted rectangle (called a marquee box) so 

that it completely encloses all objects in the group.
3. Release the mouse button.

To select multiple groups:
Do one of the following:
· Hold down the SHIFT key, and click on an object in each group. 
· Drag a marquee box around all objects in the groups you want to select.



Deselecting objects
Having selected multiple objects, you can then use the SHIFT key to deselect one or more. 

To deselect an object from several selected objects:
Do one of the following to the objects you want to deselect: 
· In wireframe view and for unfilled objects, click anywhere on the object's outline.
· In editable preview, click anywhere on the objects' fill or outline.

To deselect all objects:
· Click on any open space in the drawing window or press the ESC key.



Selecting the next/previous object
As your drawing becomes more complex, you may find it difficult to select objects by 
clicking on them with the Pick tool. When this happens, you can cycle forwards or backwards
through all objects until a highlighting box appears around the one you want.

To select the next/previous object:
1. Select the Pick tool.
2. Press the TAB key to select the next object or the SHIFT and TAB keys to select the 

previous object.
3. Repeat step 2 until the object you want is selected.



Getting Started with CorelDRAW
Most software publishers claim their products are easy to use. We make the same claim 
about CorelDRAW, but more importantly, so do our customers.
As with other Windows applications, you work with CorelDRAW by choosing commands from 
menus and making selections in dialog boxes. Most of the remaining interaction involves 
using tools on the left side of the screen. What's left are the controls common to all Windows
applications: scroll bars, the window border, the minimize and maximize buttons, and so on. 
To learn about these controls and the CorelDRAW screen, see The CorelDRAW Screen.
Each drawing is composed of a single page which is represented on the screen by a 
rectangle with a drop shadow. Anything you draw on the area surrounding the page is saved 
but does not print (unless you use the Fit to Page option in the Print Options dialog box). The
Page Setup command in the File menu lets you set the dimensions of the page.
You can work on your drawings in either the editable preview or wireframe view. Editable 
preview displays the drawing as it will print and lets you see the effects of your changes 
immediately. Wireframe view displays elements in outline form for faster performance. Even 
though colors and other attributes don't display in this view, you can determine them from 
the Status Line near the top of the screen. 
As you become more familiar with CorelDRAW, you'll discover that there's often more than 
one way to perform a specific task. When selecting colors, for example, you have the choice 
of using the palette along the bottom of a screen, the Fill Roll-Up window, or a dialog box.



The CorelDRAW Screen
To learn about the CorelDRAW screen, click on the part of the screen you want information 
on. Or press the TAB key to highlight the part of the screen, and then press the ENTER key. 



Color Palette 
Contains colors for outlining and filling objects. To select a fill color, click on it with the 
primary mouse button. To select an outline color, click on it with the secondary mouse 
button.

· The Show Color Palette command in the Display menu turns the palette on or off and 
loads it with either Spot or Process color.

· Clicking on the arrows at the ends of the palette with the primary mouse button scrolls 
the colors one at a time.

· Clicking on the arrows with the secondary mouse button scrolls a screen-width of 
colors.

· Clicking on the  button at the left end of the palette removes the object's fill if you 
click with the primary mouse button, or outline if you click with the secondary button.



Control Menu Box 
Located at the left end of the Title bar in the CorelDRAW and Help windows. Clicking on the 
Control Menu box displays commands for sizing and positioning the window.



Drawing window 
The area in the CorelDRAW window in which you draw objects. You can draw anywhere in the
window, but only portions of the drawing on the Printable Page (represented by the 
rectangle with the drop shadow) will print. 
By default, objects display with their fill and outline attributes.You can display them in 
outline form only for faster screen drawing by choosing Edit Wireframe from the Display 
menu.



Maximize Button  
Clicking on the Maximize button expands the active window to fill the entire screen. After 
you expand a window, the button changes to the Restore button, . Clicking on this button 
returns the window to its former size.

· You maximize a window by choosing Maximize from the Control menu.
· You restore a maximized window to its former size by choosing Restore from the 

Control menu.



Menu Bar 
Contains the names of the available pull-down menus. Choose the desired menu by clicking 
on it, or by pressing the ALT key and the underlined character in the menu name.



Minimize Button 
Clicking on the Minimize button shrinks the window to an icon at the bottom of the screen.

· As an icon, CorelDRAW stays in memory, but its window does not take up space on 
your screen.

· To restore the window, double-click on its icon, or click once on the icon and choose    
Restore from the Control menu.



Printable Page

The rectangle with drop shadow in the drawing window represents the Printable Page. You 
can draw beyond the borders of the Printable Page, but normally only portions of the 
drawing on the page will get printed. 

· You can turn the display of the Printable Page on and off by choosing Preferences from 
the Special menu, and then choosing Show Page Border.

· For proofing drawings that extend beyond the Printable page you can use the Fit to 
Page or Scale option in the Print Options dialog box.

· Note that the Printable page corresponds to the paper size not the printer's "image 
area" which includes margins. The width of the margins varies depending on the 
printer. 



Restore Button 
Restores a window enlarged with the Maximize button, or the Maximize command in the 
Control menu, to its previous size and location.

· You restore a window by choosing Restore from the Control menu.
· Using the Restore button does not affect a window moved or resized with the Move or 

Size commands in the Control menu.



Rulers
Displayed along the top and left side of the drawing window. The rulers are useful for sizing 
and positioning objects in a drawing. 
You can pull guidelines onto the screen by dragging vertically or horizontally from the rulers. 
Dragging diagonally from the spot where the rulers meet, brings out a set of crosshairs.

· Choosing Show Rulers in the Display menu turns the rulers on or off.
· The rulers use the unit of measure specified for Grid Frequency while the 0,0 points 

are determined by the Grid Origin. You can change both of these in the dialog box 
displayed by choosing Grid Setup from the Display menu.



Scroll Bars
Bars along the bottom and right side of the screen used to view portions of a drawing 
currently outside the current viewing area.

Click on to
An arrow move the current view 10% in selected direction
An elevator move the view by one windowful
On a thumb and drag move the view an arbitrary amount in any direction
CorelDRAW provides an Auto-panning feature which scrolls the view automatically when you 
drag beyond the edges of the drawing area. You turn this feature on and off in the dialog box
displayed when you choose Preferences from the Special menu.



Status Line
Area between the Menu bar and the horizontal ruler provides information about a selected 
object or about an action you are currently performing.

· The Show Status Line command in the Display menu turns the Status Line on or off.



Title Bar 
Located along the top of the top of a window, the title bar displays the name of the program 
and the file you are working on. If it is less than full-size, dragging the Title Bar moves the 
window.
The title bar may contain the following buttons for controlling the window:

 Maximize button
 Minimize button
 Restore button
 Control Menu box



Pick Tool 
Use to select and transform (scale, move, rotate, etc.) objects.



Shape Tool 
Use to change the shape of objects, manipulate text and crop bitmaps.



Zoom Tool 
Lets you change the viewing window. Clicking on the tool displays a flyout menu with 
buttons for choosing a view. Choices include, zooming in or out and viewing at actual size.



Pencil Tool 
Use to draw lines and curves and to trace bitmaps. The menu that appears when you hold 
the mouse button down on the tool lets you choose the drawing mode--Freehand or Bezier.

Rectangle Tool 
Use to draw rectangles and squares.



Ellipse Tool 
Use to draw ellipses and circles.



Text Tool 
Use to add text and symbols. The menu that appears when you hold the mouse button down
on the tool lets you choose whether you want to add text or symbols.



Outline Tool 
Use to set the outline attributes of an object. Clicking on the tool displays a flyout menu with
buttons for choosing the outline thickness and color.
Clicking on the tool with no object selected allows you to change the default outline 
attributes assigned to newly-created objects.



Fill Tool 
Use to fill objects. Clicking on the tool displays a flyout menu with icons for choosing the 
type of fill. Choices include no fill, white, black, shades of gray, fountains, patterns or custom
colors.
Clicking on the tool with no object selected allows you to change the default fill attributes 
assigned to newly-created objects.



Window Border
Border around windows that are less than full size. Dragging the edge of the window lets you
make the window smaller or larger.

· Drag top, bottom, or side border to size in one direction only.
· Drag corner of the border to size vertically and horizontally

With the window less than full size, you can choose Size from the Control menu then use the
, ¯, ¬, ® keys to size the window.



 Screen

· Color Palette
· Control Menu Box
· Drawing window
· Printable Page
· Rulers
· Scroll Bars
· Status Line
· Toolbox
· Title Bar
· Menu Bar
· Maximize Button
· Minimize Button
· Restore Button
· Preview Screen
· Window Border



Color Palette 
Displayed along the bottom of the CorelDRAW window for selecting outline and fill colors. 
The Show Color Palette command in the Display menu toggles the palette on or off and loads
it with either Spot or Process color.

· To select a fill color, click on it with the primary mouse button.
· To select an outline color, click on it with the secondary mouse button.
· Clicking on the arrows at the ends of the palette with the primary mouse button scrolls 

the colors one at a time.
· Clicking on the arrows with the secondary mouse button scrolls a screen-width of 

colors.
· Clicking on the  button at the left end of the palette removes the object's fill if you 

click with the primary mouse button, or outline if you click with the secondary button.



Control Menu box 
Located at the left end of the Title bar in the CorelDRAW and Help windows. Clicking on the 
Control Menu box displays commands for sizing and positioning the window.



How to...
Resize the CorelDRAW window



Drawing Window
Large white area of the CorelDRAW window. You can draw anywhere in the drawing window 
but only portions of the drawing on the Printable page will get printed. 
By default, objects display with their fill and outline attributes.You can display them in 
outline form only for faster screen drawing by choosing Edit Wireframe from the Display 
menu.



Maximize button 
Located in the upper right corner of the CorelDRAW and Help windows if they are not fully 
expanded. Clicking on the Maximize button expands the window to fill the entire screen. 
After you expand a window, the button changes to the Restore button . Use this button to 
return the window to its former size.

· You can also maximize a window by choosing Maximize from the Control menu.
· You can also restore a maximized window to its former size by choosing Restore from 

the Control menu.



Menu Bar 
The horizontal bar near the top of the window contains the names of the available pull-down 
menus. Choose the desired menu by clicking on it, or by pressing the ALT key plus the 
underlined character in the menu name. 



Minimize button 
Located in the upper right corner of the CorelDRAW and Help windows. Clicking on the 
minimize button shrinks the window to an icon at the bottom of the screen. 

· As an icon, the application stays in memory but its window does not take up space on 
your screen.

· To restore the window, double-click on its icon, or click once on the icon and choose    
Restore from the Control menu.



Preview Screen
A view option that uses the entire screen to display your drawing. You can switch to the 
Preview screen by choosing Show Preview from the Display menu or pressing F9. Pressing 
any key returns you to the drawing window.

· You cannot edit your drawing in the Preview screen. 
· You can preview select objects only by choosing Preview Selected Only from the 

Display menu.



Printable Page

The rectangle with drop shadow in the drawing window represents the Printable Page. You 
can draw beyond the borders of the Printable Page but normally only portions of the drawing
on the page will get printed.

· You can turn the display of the Printable Page on and off by choosing Preferences from 
the Special menu and then choosing Show Page Border.

· For proofing drawings that extend beyond the Printable page you can use the Fit to 
Page or Scale option in the Print Options dialog box.



Restore button 
Located in the upper right corner of the CorelDRAW and Help windows. Clicking on the 
Restore button returns the window to its previous size and location.

· You can also restore a window by choosing Restore from the Control menu.
· Using the Restore button does not affect a window moved or resized with the Move or 

Size commands in the Control menu.



Maximize Button , Restore Button 

The Maximize button is located in the upper right corner of the CorelDRAW and Help 
windows if they are not fully expanded. Clicking on it expands the window to fill the entire 
screen.
After you expand a window, the button changes to the Restore button . Use this button to 
return the window to its former size.

· You can also maximize a window by choosing Maximize from the Control menu or 
double-clicking on its title bar.

· You can also restore a window by choosing Restore from the Control menu.
· Using the Restore button does not affect a window moved or resized with the Move or 

Size commands in the Control menu.



Rulers
Displayed across the top and along the left side of the editing window for sizing and 
positioning objects in a drawing.
You can also pull guidelines onto the screen by dragging vertically or horizontally from the 
rulers. 
Holding the mouse button down on  and dragging toward the center of the screen brings 
out a set of crosshairs.

· Choosing Show Rulers in the Display menu turns the rulers on or off.
· The rulers use the unit of measure specified for Grid Frequency while the 0,0 points 

are determined by the Grid Origin. You can change both of these in the dialog box 
displayed by choosing Grid Setup from the Display menu.

· You can also move the 0,0 points with the ruler crosshairs.



How to...
· Change the unit of measurement on the rulers
· Change the 0,0 point on the rulers



Scroll Bars
Bars along the bottom and right side of the screen used to view portions of a drawing 
outside the current viewing area.

Click on to
An arrow move the current view 10% in selected direction
An elevator move the view by one windowful
On a thumb and drag move the view an arbitrary amount in any direction
CorelDRAW provides an Auto-panning feature which scrolls the view automatically when you 
drag beyond the edges of the drawing area. You can turn this feature on and off in the dialog
box displayed when you choose Preferences from the Special menu.



Status Line
Area between the Menu bar and the horizontal ruler provides information about a selected 
object or about an action you are currently performing.

· The Show Status Line command in the Display menu turns the Status Line on or off.



Title Bar 
Located along the top of the top of a window, the Title Bar displays the name of the program
and the file you are working on. If it is less than full-size dragging the Title Bar moves the 
window.
The Title Bar may contain the following buttons for controlling the window:

 Maximize button
 Minimize button
 Restore button
 Control Menu box



Toolbox

Displayed along the left side of the CorelDRAW screen for quick access to the tools used to 
create, edit and view objects. Choose the tool you want information on from the list below.

 Pick Tool
 Shape Tool
 Zoom Tool
 Pencil Tool
 Rectangle Tool
 Ellipse Tool
 Text Tool
 Outline Pen Tool
 Fill Tool



Window Border 
Borders appearing around windows that are less than full size. Dragging the border lets you 
make the window smaller or larger. 

· Drag the    top, bottom, or side border to size the window in one direction only.
· Drag the corner of the border to size the window vertically and horizontally.

With the window less than full size you can also choose Size from the Control menu then use
the , ¯, ¬, ® keys to size the window.



How to...
Resize the CorelDRAW window



No Help Available
No help exists for the selected item. Either choose another item or press F1 for index of Help
topics.



 Glossary
- A -
A sizes ASCII
ABK Aspect ratio
Active window Attributes
AI Auto-panning
Artistic text Autotrace
Ascender
- B -
B size Bitmap
Backup Bleed
BAK Blend
Baseline BMP
Bezier curves Brightness
Bezier drawing mode
- C -
Calligraphic Compound blend
Cap height Constrain
CDR Continuous tone
Center of rotation Control menu
CGM Control menu box
Character attributes Control object
Character set Control point
Check box CorelCHART
Click CORELDRW.INI
Clipart CorelMOSAIC
Clipboard CorelPHOTO-PAINT
Clipping holes CorelSHOW
CMYK CorelTRACE
Color palette Crop
Color proof Crop marks
Color separation Crosshairs
Command Cursor
Command button Curve object
Composite Cusp
- D -
Default printer Dithered color
Default settings Double click
Descender Downloadable 

fonts
Deselect DPI
Destination file Drag
Device driver Drawing window
Dialog box Drive
Direction keys Drop-down list 

box
Directory DXF
- E -



Edit End node
Editable preview Envelope
Em EPS
Embedded object Extension
En Extrude
- F -
Film Fountain fill
Film Recorder Four-color process
File previewer Frame
Filter Freehand drawing 

mode
Font Full Color pattern
- G -
GDF Grid markers
GEM Group
GIF Guidelines
Gray component 

replacement (GCR)
Gutter

Gray-scale image
Grid
- H -
Halftone Hints
Halftone screen Hourglass cursor
Handles HPGL
Header HSB
Highlighting box Hue
- I -
Icon Inter-line spacing
Image header Inter-paragraph 

spacing
Image setter Inter-word spacing
Insertion point Interruptible display
Inter-character 
spacing
- J - - K -
Jaggies Kerning
Justification
- L -
Landscape Line style
Layer Linked object
Leading Lino
Limitcheck error List box
Line art LPI
- M -
Marquee box Menu bar
Marquee select Mirror
Mask Moire pattern



Maximize Monochrome
Menu Multiple select
- N - - 0 -
Negative One-point perspective
Nodes Overprint

- P -
Paint program Pixel
Page border PLT
Palette Point
PANTONE Portrait
Paragraph text Positive
.PAT PostScript
Path PostScript textures
Path name Preview screen
PCT Primary mouse 

button
PCX Printable page
Photo CD Process color
PIC Proof
Pica Pure color
PIF
- R -
Radio button RGB
Rasterizer Roll-up windows
Registration mark Rotate
Resident fonts Ruler crosshairs
Resolution Rulers
- S -
Sans Serif Skew
Saturation Smooth
Scale Snap
Scanner Source file
SCODL Spot color
Screen angles Start node
Scroll Status Line
Secondary mouse

button
Stretch
Subpaths

Segments Subscript
Select Superscript
Serif Symbol
Service bureau Symmetrical
- T -
TGA Trap
TIF TRUMATCH
Tile TrueType fonts
Tints Two-Color pattern
Title bar Two-point 

perspective
Toggle Type style



Toolbox Typeface
Transformation
- U - - V-
Undercolor removal Vector graphics
Uniform color
- W -
Weight WMF
WFN WPG
Window WYSIWG
Wireframe view
- X -
X-height



A sizes
Paper sizes measured in metric units. You can choose from A3, A4 and A5 sizes through the 
Page Setup command in the File menu.



.ABK
The filename extension for backup files created by CorelDRAW for open drawings. These files
are created at regular intervals and deleted when you exit CorelDRAW or choose the File 
New command. You can control the interval between backups and the directory in which 
they are saved by editing the CORELDRW.INI file. See also Backup.



Active window
The active window is the one in which you are working. The next action you perform applies 
to the active window.



.AI
The filename extension for Adobe Illustrator files. A vector graphic file format which 
CorelDRAW can import and export.



Artistic text
Selecting the Text tool then clicking in the drawing window allows you to add text in strings 
of up to 250 characters. Artistic text, unlike Paragraph text, can be fitted to a path and 
manipulated with commands in the Effects menu. See also Paragraph text.



Ascender

The part of the letter that extends above the main body (x-height) in lowercase letters, for 
example, b and h.



ASCII
A standard code for representing characters and non-printable control codes such as 
carriage returns and page breaks.



Aspect ratio
The ratio of the width of an image to its height. You can change the aspect ratio of an object 
in CorelDRAW by stretching it in one direction.



Attributes
Characteristics assigned to objects using the Outline and Fill tools. Outline attributes include 
thickness, color and line style (solid or dashed and dotted). An object's Fill attribute can be a 
solid color, a fountain fill or pattern. Text objects also have attributes such as typeface and 
character spacing.



Auto-panning
A feature in CorelDRAW that automatically scrolls the drawing window when you drag 
beyond it's borders. You can turn Auto-panning off in the dialog box that is displayed when 
Preferences is selected from the Special menu.



Autotrace
A feature in CorelDRAW that automatically generates a line drawing from an imported 
bitmap image.



B size
Paper size measured in metric units. You can choose the B5 size through the Page Setup 
command in the File menu.



Backup
Files in CorelDRAW with a .BAK or .ABK extension. CorelDRAW creates a backup (duplicate) of
an open drawing at regular intervals and whenever you use the Save or Save As commands 
to save it. You can open a backup file by changing the extension to .CDR.



.BAK
The filename extension for backup files CorelDRAW creates of open drawings. These files are
created each time you save a drawing using the Save or Save As commands. See also 
Backup.



Baseline

The imaginary line along which characters in a line of type align.



Bezier curves

A method CorelDRAW and other computer graphics programs use to represent curved 
surfaces. A Bezier curve has two endpoints and a set of control points that allow you to mold
the shape of the curve. You can also resize a Bezier curve without losing image quality.



Bezier drawing mode
One of two ways you can draw lines and curves using the Pencil tool. Bezier mode is 
essentially a connect-the-dots drawing method. The other mode, Freehand, involves 
dragging the mouse pointer as you would a pencil on paper. A flyout menu revealed by 
holding the mouse button down on the Pencil tool lets you switch between the two modes.



Bitmap
An image composed of a series of dots (pixels). Scanners and paint programs such as 
CorelPHOTO-PAINT generate this type of image. By contrast, CorelDRAW creates images 
using vector objects--shapes stored internally as mathematical equations.



Two Color pattern

Fill composed of repeating bitmap images. CorelDRAW supplies a collection of bitmap 
patterns to which you can add your own.



Bleed
Part of a printed drawing that extends beyond the edge of the page.



Blend

To merge one object with another through a series of intermediate shapes. The Blend 
command in the Effects menu does this automatically.



.BMP
The filename extension for Windows Bitmap files. CorelDRAW can import and export files in 
BMP format. 



Brightness
In the HSB color model, the component that determines the amount of black in a color where
0% is black and 100% is white. See also Hue and Saturation.



Calligraphic

An effect created with the Outline tool in which objects are given an outline that varies in 
thickness. Gives curved objects a hand-drawn appearance.



Cap height
The distance from the baseline to the top of an uppercase character.



.CDR
The filename extension for files created in CorelDRAW.



Center of rotation

Round marker that appears in the middle of an object selected by clicking on it twice. 
Moving this marker changes the axis around which the object rotates.



.CGM
The filename extension for Computer Graphics Metafile, a vector graphic file format which 
CorelDRAW can import and export.



Character attributes
Characteristics such as typeface, style, point size assigned to characters in a block of text 
using the Edit Text command in the Edit menu, the Character command in the Text menu or 
the Text Roll-Up window. 



Character set
The letters, punctuation marks, and special characters in a particular font. Foreign language 
accents and mathematical symbols are examples of special characters.



Check box
A square box in a dialog box used to turn options on or off. An option is on when an "X" 
appears in the check box and is off when the check box is empty. 



Click
To quickly press and release the primary mouse button. In CorelDRAW, the secondary mouse
button can have a function assigned to it using the Preferences command in the Special 
menu.



Clipart
Predrawn images that can be brought into CorelDRAW and edited or used as is. CorelDRAW 
offers a large selection of clip art in vector format. You can purchase additional images, 
including some in bitmap format, from commercial suppliers.



Clipboard
A temporary storage area used to transfer information between Windows applications. In 
CorelDRAW, you can Cut or Copy an object onto the Clipboard then Paste into another 
application or CorelDRAW file.



Clipping holes
Combining two objects using the Combine command from the Arrange menu to create a 
transparent hole through which underlying objects are visible.



CMYK
The four letters represent Cyan, Magenta, Yellow, and Black, the ink colors used in four-color 
process printing. CorelDRAW allows you to specify colors using CMYK values.



Color palette 
The strip of colors along the bottom of the CorelDRAW screen from which you can choose 
outline and fill colors for selected objects. Choosing Show Color Palette in the Display menu 
opens a sub-menu with commands for turning the palette on and off and loading it with 
either Process or Spot color.



Color proof
Sometimes called a pre-press proof, this preliminary step in the color printing process shows 
how an image will look when it's printed. Proofing provides an opportunity to make 
corrections and adjustments before final printing.



Color separation
The process of separating the colors in an image into the primary printing colors: cyan, 
magenta, yellow and black.



Command
A word or phrase in a menu that initiates an action.



Command button
A button in a dialog box used to carry out an action such as resetting values or displaying 
another dialog box.



Composite
Also called a "comprehensive" or "comp." A preliminary version of a design combining all 
image, line art, and text elements. Color composites are often printed on color PostScript 
printers before they are color-separated for four-color process printing.



Compound blend
A blend created by blending an object in one blend group with a third object. Also refers to a 
blend that's been split by holding down the CTRL key and selecting one of the intermediate 
shapes.



Constrain
Holding down the CTRL key while transforming an object with the mouse limits your 
movements. For example, holding it down while rotating an object, forces it to rotate in 15 
degree increments. You can also use Constrain while drawing, moving nodes and control 
points, and when using the Envelope and Perspective features.



Continuous tone
An image represented by graduated tones from black to white as in a photograph.



Control menu
A menu available in all Windows applications. Commands on the menu allow you to move, 
resize, minimize, maximize and close applications. Control menus in dialog boxes have 
commands for moving and closing them. Pressing the ALT key and SPACEBAR or clicking on 
the box on the left side of the Title bar opens the Control menu.



Control menu box 
Icon on the left of a window's Title bar which opens the Control menu. Dialog boxes and Roll-
Up windows also have this box. 



Control object
A term used in CorelDRAW to differentiate the original objects from those CorelDRAW creates
when you apply the Blend or Extrude command.



Control point

Points extending from nodes along a curve object that determine the angle at which the 
curve passes through the node. Control points appear when you select a node or segment 
with the Shape tool. Nodes associated with straight lines do not have Control points.



CorelCHART
A program supplied with CorelDRAW for creating charts and graphs.



CORELDRW.INI
A text file with configuration information about CorelDRAW. This file is in the CorelDRAW 
subdirectory and can be edited by double-clicking on it in File Manager. Changes you can 
make include the interval between backup files for open files that CorelDRAW creates and 
the directory in which these backup files are stored.



CorelMOSAIC
A file management program that displays thumbnail views of your CorelDRAW files. You can 
also use CorelMOSAIC for doing batch operations such as printing and exporting    and to 
archive files.



CorelPHOTO-PAINT
A program supplied with CorelDRAW for creating and editing bitmap images.



CorelSHOW
A program supplied with CorelDRAW for preparing presentations.



CorelTRACE
A program supplied with CorelDRAW that automatically traces bitmap images. The result is a
vector graphic that you can import into CorelDRAW for editing.



Crop
Reducing the visible area of an imported bitmap using the Shape tool. The parts not 
displayed or printed are still stored in the bitmap file.



Crop marks
Alignment marks at the corners of a page printed on a PostScript printer. Used as aids for 
trimming the paper to the proper size. Crop marks are turned on in the Print Options dialog 
box and appear only when the page size in CorelDRAW is smaller than the paper size of the 
printer.



Crosshairs
Also called "registration marks." Marks at the corners of a sheet of paper or film used for 
aligning color separations. CorelDRAW automatically adds crosshairs when printing color 
separations to a PostScript printer.
Also refers to the pair of intersecting lines which can be dragged from the spot where the 
rulers meet and to the crosshair cursor which can be displayed through the Preferences 
command in the Special menu.



Cursor
Also called the" mouse pointer." Used to indicate the object, command, tool or other screen 
item you want to select. The shape of the cursor changes depending on the tool or 
command selected.



Curve object
An object with nodes and control points which can be manipulated to change its shape. 
Curve objects are drawn with the Pencil tool. You can also convert text and objects drawn 
with the Rectangle and Ellipse tools into curve objects using the Convert To Curves 
command in the Arrange menu.



Cusp

A type of node that permits a curve to pass through it at a sharp angle. Node types are 
selected from the Node Edit menu revealed when you double-click on a node or segment 
with the Shape tool.



Default printer
The device that CorelDRAW automatically uses to print a drawing when you choose the Print 
command from the File menu. You can have only one default printer selected using the Print 
Setup command in the File menu.



Default settings
Preset options built into a program. Default settings you can change in CorelDRAW include 
the following: Outline and Fill attributes for new objects, page size and orientation and 
whether the rulers, Status Line and on-screen palette are turned on or off.



Descender

The part of the letter that extends below the main body (x-height) in lowercase letters, for 
example, g and p.



Deselect
To indicate by clicking on white space or selecting another object that you do not want the 
next command or action to apply to the selected object.



Destination file
The file into which an embedded or linked object is being inserted. See also Embedded 
object and Linked object.



Device driver
A program through which a computer and devices such as a mouse or printer communicate. 
A mouse driver, for example, displays a pointer on the screen and translates clicks into 
actions. 



Dialog box
A window displayed when additional information is needed to perform an action. For 
example, when you choose the Save command to save a drawing for the first time, a dialog 
box appears requesting a filename.



Direction keys
The arrow keys (, ¯, ¬, ®) and the HOME, END, PgUp and PgDn keys on the numeric keypad.
The arrow keys move objects in small steps. They also move the insertion point when 
entering or editing text on-screen or in a dialog box.
The HOME and END keys select the start and end nodes on a curve object. They also move 
the insertion point in a block of text to the beginning or end of a line.
The PgUp and PgDn keys used alone and with the SHIFT key rearrange the order of layered 
objects. They also move the insertion point in the Text dialog box to the first or last line.



Directory
A directory is part of a structure used to organize files on a disk like a drawer in a filing 
cabinet. Directories have names and can be divided into subdirectories. For example, you 
could create a directory called LOGOS for storing logo designs.    



Dithered color
Color simulated by putting dots of another color very close together. Windows uses dithering
to display colors that the graphics adaptor is unable to display. See also Pure color.



Double click
To press and release the primary mouse button twice in quick succession. In CorelDRAW, the 
secondary mouse button can have a function assigned to it through the Preferences 
command in the Special menu.



Downloadable fonts
Fonts that are stored on disk for transmission to a printer. If you have purchased 
downloadable PostScript fonts from Adobe, you can use them instead of CorelDRAW's fonts 
by selecting an option in the Print Options dialog box.



DPI
A measure of a printer's resolution in dots per inch. Typical desktop laser printers print at 
300 dpi, while image setters are capable of printing at resolutions of 1270 or 2540 dpi. The 
more dots per inch, the smoother the output.



Drag
To move the mouse while holding down the primary mouse button. Releasing the button 
completes the action.



Drawing window
The portion of the CorelDRAW screen available for drawing. While you are free to draw 
anywhere in the drawing window, only objects on the Printable Page (the rectangle with the 
drop shadow) will print.



Drive
A device in a computer that spins disks used to store    information. Personal computers 
normally have a fixed disk drive labeled C and one or two floppy disk drives labeled A and B.



Drop-down list box

A list box that appears in dialog boxes and opens to display a list of choices when you click 
on the arrow. If the list cannot accommodate all available options, scroll bars are provided. 
See also List box.



.DXF
The filename extension for AutoCAD files. CorelDRAW can import and export files in this 
format.



Edit
Changing an object using commands in the Edit, Transform, Effects, and Arrange menus or 
the Pick, Shape, Outline and Fill tools.



Editable Preview
One of two ways to view objects in the drawing window. In editable preview (the default 
view), you see the outlines and fills of objects as you create them. In the wireframe view, 
objects are displayed in skeleton form. Since objects redraw more quickly without outlines 
and fills, you may find it more efficient to edit complex drawing in wireframe view.
You can switch freely between views by choosing Edit Wireframe from the Display menu.



Em
A unit of measurement used primarily in typesetting to specify the space between 
characters and words. An em is equal to the width of the point size being used.



Embedded object
Information from a file created in one application that's been inserted into a file in another 
application. For example, you can embed a graphic created in CorelDRAW into a Microsoft 
Word document. The embedded information can be edited from within the application in 
which it is embedded.



En
A unit of measurement equal to half the width of an Em.



End node
The small square at the end of an open path which appears when you select the path with 
the Shape tool. The end node is distinguishable from the start node by it's smaller size. 



Envelope

A feature in the Effects menu that allows you to distort the shape of an object by 
manipulating the bounding box that contains the object.



.EPS
The filename extension for Encapsulated PostScript files. CorelDRAW can import EPS files 
created in Adobe Illustrator. It can also export to EPS format, but it cannot import the 
resulting file. The EPS files CorelTRACE creates can be imported by CorelDRAW plus other PC 
programs such as Ventura Publisher and Aldus PageMaker.



Extension
Characters following the period in a filename that identify the type of information in the file. 
The extension .PCX, for example, indicates the file contains a bitmap.



Extrude
A feature in the Effects menu that allows you give objects a three-dimensional look.



Film
Photo-sensitive sheets onto which images are transferred either as positives or negatives. 
These sheets are then used to create printing plates. An option in the Print Options dialog 
box lets you create film negatives for printing on an image setter.



Film Recorder
Device that reproduces images from a computer screen on film. The film can then be 
developed into slides or prints using conventional photographic processes. CorelDRAW can 
export files for use by film recorders that accept files in SCODL format.



File previewer
In the Open Drawing dialog box, a small bitmap representation that lets you see what the 
selected file contains before you open it.



Filter
A program that translates information from one format to another. CorelDRAW's import 
filters, for example, allow you to open graphics created in CorelPHOTO-PAINT, Adobe 
Illustrator and many other applications. 



Font
A set of characters in a given typeface and point size, for example, 10 point Times Roman. 
Some fonts are also available in different weights or styles such as bold and italic.



Fountain fill
A fill that fades gradually from one color to another. Also called a "gradient" or "graduated" 
fill. CorelDRAW lets you create linear or radial fountains using the Fountain Fill icon in the Fill 
tool menu and the Fill Roll-Up window.



Four-color process
Reproducing color artwork using four separate sheets of film, which represent the Cyan, 
Magenta, Yellow and Black content of the artwork. 



Frame
The rectangle that encloses a block of Paragraph text created with the Text tool. Also, a 
command in the Text menu used to format Paragraph text.    



Freehand drawing mode
One of two ways you can draw lines and curves using the Pencil tool. In Freehand mode, you 
draw by dragging the mouse pointer as you would a pencil on paper. The other mode, 
Bezier, is essentially a connect-the-dots method of drawing. You can switch between modes 
using the flyout menu revealed by holding the mouse button down of the Pencil tool.



.GDF
The filename extension for vector graphics files used by IBM mainframe computers. 
CorelDRAW imports and exports these graphics as PIF files. PIF files can be translated to GDF
format by the mainframe computer.



GEM
Graphics Environment Manager. A menu-driven interface used by programs such as Xerox 
Ventura Publisher. Also a filename extension for files created by programs such as GEM 
Artline. CorelDRAW can import and export files in this format.



.GIF
The filename extension for files in a bitmap format that is commonly used to store digitized 
color photographs. CorelDRAW imports and exports files in this format.



Gray component replacement (GCR)
A technique in which equal amounts of Cyan, Magenta and Yellow are removed and replaced
with black ink. This produces better color saturation and contrast as well as saving on ink 
costs. CorelDRAW performs GCR automatically when you create process colors using the 
Visual Selector in the Outline Color and Uniform Color dialog boxes. Also called "undercolor 
removal."



Gray-scale image
An image, typically created by a scanner, in which continuous tones are represented as 
uniform shades of gray. CorelDRAW can import and display .TIF images with up to 256 levels 
of gray and print them on a PostScript printer. 



Grid
A series of evenly spaced horizontal and vertical lines used to align objects. The spacing is 
specified through the Grid Setup command in the Display menu. You can also display the 
grid using this command and have objects snap to the grid by turning on Snap to Grid in the 
Display menu.



Grid markers
Points on the screen which help you to lay out your drawing. The grid markers are normally 
turned off. You can turn the grid markers on by choosing Grid Setup from the Arrange menu 
and selecting Show Grid. 



Group
To make one or more objects into a single selectable entity with the Group command in the 
Arrange menu. Grouping is useful when you want to keep individual elements in a graphic 
from being accidentally moved or otherwise altered. Grouped objects respond to almost all 
commands and operations collectively; for example, grouped objects move together. 
Similarly operations like rotating, filling, and outlining are applied to all members of the 
group.
Some commands and operations you cannot use on a group include Edit Text, Extrude, and 
editing with the Shape tool. 



Guidelines
Non-printing lines used to align objects. Guidelines can be placed anywhere in the drawing 
window by dragging them from the rulers or using the Guidelines Setup command in the 
Display menu. By turning on Snap To Guidelines in the Display menu, you can force objects 
to a guideline when drawn or moved near it.



Gutter
The space between columns of Paragraph text.



Halftone
The process of reproducing a continuous tone image such as a black and white photograph 
using dots of various sizes. On laser printers that cannot print different sized dots, the 
halftone is produced by printing different numbers of dots in a given area.



Halftone screen
In photography, a sheet of glass or film with a grid pattern of lines used to convert a 
continuous tone image into dots of various sizes. In CorelDRAW, halftone screens are 
specified by choosing PostScript from the Outline Color, Uniform Fill or Fountain Fill dialog 
boxes.



Hanging indent
A format applied to Paragraph text in which the first line of text begins farther right than 
subsequent lines.



Handles
Small squares that appear on the corners and sides of an object's highlighting box when the 
object is selected. You use these handles to resize, rotate and otherwise transform an object.
Click on an already selected object and the handles change to arrows. Use the handles to 
rotate and skew the object.



Highlighting box

The invisible rectangle with eight handles that encloses a selected object. When you move, 
scale or otherwise transform an object, a dotted rectangle representing the highlighting box 
appears instead of the object.



Hints
Information included with fonts to improve their appearance when printed at small point 
sizes. TrueType and Adobe Type 1 fonts supplied with CorelDRAW are "hinted."



Hourglass cursor
The mouse pointer changes to an hourglass during an operation such as printing. No other 
actions can be performed until the pointer reappears.



HPGL
The initial letters in Hewlett Packard Graphics Language. A file format created by programs 
such as AutoCAD for printing drawings on plotters. CorelDRAW can import and export HPGL 
files with the extension .PLT. 



HSB
The initial letters in Hue, Saturation and Brightness are the components in the HSB color 
model.    HSB is one of three color models CorelDRAW provides for creating process colors.



Hue
In the HSB color model, hue is the main attribute in a color that distinguishes it from other 
colors. Blue, green and red, for example, are all hues. See also Saturation and Brightness.



Icon
A small graphic symbol that represents various elements in Windows and CorelDRAW. For 
example, the tools in CorelDRAW are represented by icons. 



Image header
An optional bitmap image created when you save a CorelDRAW file or export it in .EPS 
format. If you include an image header, you can see a representation of the file contents 
before opening. If you export a file with an image header, you can see a representation in 
programs such as Xerox Ventura Publisher and Aldus Pagemaker.



Image setter
A generic term for printers capable of printing text and graphics (line art and photographs) 
at resolutions of about 1200 dots per inch or more.



Indent
A formatting option for Paragraph text which starts the first line at a specified distance from 
the left margin.



Insertion point
A flashing vertical bar that indicates where text will be inserted when you type. The insertion
point appears when you click on a text block with the Text tool and in dialog boxes that 
require you to type information.



Inter-character spacing
The amount of spacing between characters of text. It is also called "letter spacing." You can 
adjust inter-character spacing interactively with the Shape tool or by entering numeric 
values in a dialog box.



Inter-line spacing
The amount of spacing between the baselines of text. It is also called "leading." You can 
adjust inter-line spacing interactively with the Shape tool or by entering numeric values in a 
dialog box.



Inter-paragraph spacing
The amount of spacing between blocks of Paragraph text separated by pressing the ENTER 
key twice. You adjust inter-paragraph text by entering numeric values in a dialog box.



Inter-word spacing
The amount of spacing between words of text. You can adjust inter-word spacing 
interactively with the Shape tool or by entering numeric values in a dialog box.



Interruptible Display
A feature in CorelDRAW that stops the screen during a redraw whenever the mouse button 
or a key is pressed. If you are working on a complex drawing, Interruptible Display can save 
time by allowing you to select tools and commands without waiting for the screen to redraw 
completely. You can turn Interruptible Display on and off through the Preferences command 
in the Special menu. 



Jaggies

A stair-step effect that often occurs when a bitmap image is enlarged.



Justification
In CorelDRAW, a term referring to the alignment of text. You can choose from several 
justification options including left, right and center.



Kerning
Reduces the spacing between pairs of letters. With certain letter pairs, such as AV, moving 
the letters closer together improves their appearance when printed. You can kern text 
interactively with the Shape tool or by entering numeric values in a dialog box.



Landscape
A page oriented so that it prints from left to right across its longest dimension.



Layer
A transparent plane on which objects are placed. You can control how objects in your 
drawing overlay one another by moving the layer and the objects they contain. You can also 
make layers invisible and non-printable. 



Leading
The amount of spacing between baselines of text. Referred to as inter-line spacing in 
CorelDRAW. You can adjust the amount of leading interactively with the Shape tool or by 
entering numeric values in a dialog box.



Limitcheck error
A PostScript printing error that occurs when a drawing contains too many line segments for 
the printer to reproduce. CorelDRAW provides a Flatness control in the Print Options dialog 
box that helps to overcome this problem.



Line art
In traditional graphic arts, an illustration containing only black and white.



Line style
Solid, dashed, dotted or dashed and dotted line types selected from the Outline Pen dialog 
box or the Pen Roll-Up window.



Linked object
A reference or placeholder for information inserted into a file. Changes made to the 
information from the application that created the linked object are automatically reflected in 
the destination files.



Lino
Short for Linotronic, a line of PostScript image setters used for high-resolution printing. Over 
the years, the term has come to mean any type of image setter used by service bureaus.



List box

List boxes appear in dialog boxes and display a choice of options. If the list cannot 
accommodate all available options, scroll bars are provided. See also Drop-down list box.



LPI
Lines per inch.



Marquee box
The dashed box created by dragging around objects with the Pick tool or around nodes with 
the Shape tool. Enclosing objects and nodes with a marquee box selects them.



Marquee select
A method of selecting multiple objects with the Pick tool or multiple nodes with the Shape 
tool by dragging a dotted rectangle around them.



Mask
The combining two objects using the Combine command from the Arrange menu to create a 
transparent hole through which underlying objects are visible.



Maximize
To enlarge an application window to full screen size.



Menu
A list of commands which appear when you choose a name in the menu bar. The menu bar 
appears below the Title bar which is at the top of the window.



Menu bar 
The bar near the top of the window that contains the names of the program menus.



Mirror
To create a mirror reflection of an object using the Stretch & Mirror command in the 
Transform menu or by dragging across the object using a side handle.



Moire pattern
Undesirable patterns in an image printed from color separations with incorrect halftone 
screen angles.



Monochrome
An image containing a single color, usually black.



Multiple select
A method of selecting multiple objects with the Pick tool or multiple nodes with the Shape 
tool by holding down the SHIFT key and clicking on the objects or nodes.



Negative
An image in which the values in the original are reversed so that black areas appear 
white,white appears black and colors are represented by their complements. CorelDRAW can
print color separations as negatives if Film Negative is selected in the Print Options dialog 
box.



Nodes
The points at the ends of line and curve segments in a curve object. Also refers to the small 
hollow squares along the outlines of objects drawn with the Rectangle and Ellipse tools and 
those next to characters in a text object.



One-point perspective
Lengthening or shortening one side of an object's Perspective bounding box to create the 
impression that the object is receding from view in a single direction. See also Two-point 
perspective.



Orthogonal extrusion
Projecting an object using the Extrude feature so that opposite sides are parallel to one 
another. Contrasts with Perspective extrusion in which opposite sides recede toward a 
vanishing point.



Overprint
Printing over an area that has already been printed. Overprinting is used in CorelDRAW to 
create traps in color separated artwork. You can also use it to overprint selected Spot colors 
for certain visual effects. See also Trap.



Paint program
A generic term referring to computer illustration programs which store graphics as bitmaps 
which are a collection of dots arranged to represent an image. CorelPHOTO-PAINT and 
Windows Paintbrush are examples of paint programs. Programs such as CorelDRAW, which 
store images as a series of lines and curves, are called draw programs. 



Page border

In the drawing window, the rectangle with the drop shadow that represents the printable 
area. It is also called the "Printable Page." You can turn the Page border on and off through 
the Preferences command in the Special menu.



Palette
A collection of colors displayed along the bottom of the CorelDRAW screen and in the 
Uniform Color and Outline Color dialog boxes.



PANTONE
A standard color matching system in which solid (spot) colors are specified using color 
sample books. You can use this system in CorelDRAW to specify colors.



Paragraph text
Selecting the Text tool then dragging to create a bounding box allows you to add text in 
blocks of 4000 characters. Paragraph text is designed for adding text to ads, brochures and 
other text-intensive applications. You can also add text in strings of up to 250 characters. 
See also Artistic text.



.PAT
The filename extension for files containing Full Color patterns used to fill objects. You can 
open these files and edit the patterns just as you would other objects in CorelDRAW.



Path
The fundamental entity from which objects in CorelDRAW are constructed. A path can be 
open (line) or closed (circle). It can be made up a single line or curve segment or many 
joined together. When two or more paths are combined into a single path, they are called 
subpaths.



Path name
Directions to a directory or file on your system.    For example, C:\WINDOWS\CORELDRW\
LOGO.CDR is the path name for the LOGO.CDR file which is stored on drive C in a subdirectory 
of the Windows directory called CORELDRW. 



.PCT
The filename extension for vector graphics files used by Macintosh computers. CorelDRAW 
imports PICT 1 (black and white) and PICT 2 (color) files and exports PICT 2 files.



.PCX
The filename extension for bitmap files created by CorelPHOTO-PAINT and other paint 
programs such as PC Paintbrush. CorelDRAW can import and export files in this format 
including those containing color and gray-scale information.



Photo CD
A revolutionary process developed by the Eastman Kodak company that converts 35mm film
negatives or slides into digital format and stores them on a compact disc (CD). CorelMOSAIC 
can open Photo CD images and convert them into formats which CorelDRAW and 
CorelPHOTO-PAINT can import.



.PIC
The filename extension used by two different vector graphic file formats. One format is 
created by Lotus 1-2-3 and can be imported by CorelDRAW. The other format is used by 
slide-making equipment such as VideoShow or Slidemaker and can be exported by 
CorelDRAW.



Pica
A unit of measurement used primarily in typesetting. One pica equals approximately 1/6 of 
an inch.



.PIF
The filename extension for vector graphics files that CorelDRAW can import and export. PIF 
is an intermediate format which IBM mainframe computers translate to GDF format for use 
in mainframe applications. 



Pixel
Short for 'picture element.' Pixels are dots on a computer or television screen that combine 
to form an image.



.PLT
The filename extension for vector graphics files conforming to the HPGL format. These are 
primarily files created by programs such as AutoCAD for printing drawings on plotters. 
CorelDRAW can import and export HPGL files with the extension .PLT. 



Point
A unit of measurement used primarily in typesetting for designating type sizes. There are 
approximately 72 points(pts) to an inch and exactly 12 points to a pica.

10 pts      18 pts      36 pts



Portrait
A page oriented so that it prints from left to right across its shortest dimension.



Positive
An image in which dark, light and color values are the same as the original. See also 
Negative.



PostScript
A page description language or protocol by which programs describe text and graphics they 
want the printer to output. Several features in CorelDRAW require the use of a PostScript 
printer.



PostScript textures
Variable pattern fills that require the use of a PostScript printer to print. Textures are 
selected through the PS icon in the Fill tool menu.



Preview screen
A view option that uses the entire screen to display your drawing. You can switch to the 
Preview screen by choosing Show Preview from the Display menu or pressing F9. Pressing 
any key returns you to the drawing window.



Primary mouse button
Normally the left mouse button. If, however, you've swapped mouse buttons using the 
Windows Control Panel, the right mouse button becomes the primary button.



Printable page

The rectangle with the drop shadow that appears in the drawing window. Though you can 
draw outside this rectangle, only the parts of a drawing inside the boundaries will get 
printed. It is also called the "Page border."
Note that the Printable page corresponds to the paper size not the printer's "image area" 
which includes margins. The width of the margins varies depending on the printer. 



Process color
The primary colors used in four-color process printing: Cyan, Magenta, Yellow and Black. See 
also Four-color process.



Proof
To print a trial version of a graphic to see how it will look when output in its final form. Laser 
printers are commonly used to proof monochrome artwork while color artwork is often 
proofed on thermal color printers. High-quality proofing systems such as Chromalin (Du 
Pont) or Matchprint (3M) can be used to proof color separations.



Pure color
Any color that individual pixels on a computer screen can assume. On a monochrome 
screen, there are only two pure colors, black and white. Color screens typically display 8, 16 
or 256 pure colors. See also Dithered color.



Radio button
A    round or diamond-shaped button in a dialog box that turns an option on or off. When two 
or more options are available, only one can be selected. They are also called "Option" 
buttons.



Rasterizer
A program that converts vector graphics into bitmaps for printing on a non-PostScript 
printer.



Registration mark
Crosshairs or other marks on paper or film used for aligning color separations. CorelDRAW 
automatically adds registration marks when printing color separations to a PostScript printer.



Resident fonts
Typefaces permanently stored in the printer's memory. PostScript printer's typically have 35 
resident typefaces such as Times and Helvetica. You can print using these typefaces rather 
than CorelDRAW's by selecting an option in the Print Options dialog box. See also 
Downloadable fonts.



Resolution
In printing, a term referring to the number of dots per inch (dpi) the printer is capable of 
printing. Typical laser printers have resolutions of 300 dpi while image setters have 
resolutions of approximately 1200 or 2400 dpi. The more dots per inch, the smoother the 
output.



RGB
The initial letters in Red, Green and Blue, the component colors in one of three color models 
CorelDRAW provides for creating Process colors.



Roll-Up windows

A special type of window with controls for choosing and applying fills, outlines, text 
attributes and options associated with the Extrude, Blend, Layers and Fit Text to Path 
commands.

Roll-Up windows contain many of the controls found in dialog boxes: command buttons, text 
boxes, drop-down list boxes and so on. But unlike most dialog boxes, the window stays open 
after you apply the selected options. This lets you makes adjustments and experiment with 
different options without having to continually re-open a dialog box. When you are not using 
a window, you can hide the controls leaving just the Title bar visible.



Rotate
To turn an object around its center axis using the Rotate & Skew command in the Transform 
menu or by dragging a corner handle revealed when you click twice on the outline of an 
object.



Ruler crosshairs

The pair of intersecting lines which can be dragged from the spot where the rulers meet. 
Used to check the alignment of objects and to reset the 0,0 points on the rulers.



Rulers 
Measuring tools displayed on the left side and along the top of the drawing window. You can 
choose the unit of measurement the rulers use by choosing Show Grid from the Display 
menu and changing the Grid Frequency.
To show or hide the rulers, choose Show Ruler from the Display menu. 



Sans Serif

A typeface such as Helvetica that lacks serifs which are the short strokes at the ends of 
individual letters. Times Roman is an example of a serif typeface.



Saturation
In the HSB color model, the component that determines the purity or intensity of a color. See
also Hue and Brightness.



Scale
To resize an object by equal amounts horizontally and vertically using the Stretch & Scale 
command in the Transform menu or by dragging a corner handle on the object's highlighting
box. You can also scale an image when printing by entering a scaling value in the Print 
Options dialog box. 



Scanner
A device that converts images on a page or transparency into digital form. CorelDRAW can 
import scanned images (also called "bitmaps") in PCX or TIF format. 



SCODL
A file format used by film recorders for making slides. CorelDRAW exports files in SCODL 
(.SCD) format.



Screen angles
When printing color separations, the angles at which each of the four process colors are 
printed to avoid undesirable moire patterns. These angles can be specified in CorelDRAW. 
See also Halftone screen.



Scroll
To shift the view in the drawing window to see portions of a drawing outside the current 
viewing area. CorelDRAW provides scroll bars along the edges of the drawing window and an
Auto-panning feature which scrolls the drawing window automatically whenever you drag 
beyond it's borders. See also Auto-panning.



Secondary mouse button
Normally the right mouse button. If, however, you've swapped mouse buttons using the 
Windows Control Panel, the left mouse button becomes the secondary button.



Segments
Lines or curves between nodes in a curve object.



Select
To choose an object with the Pick tool or a node or segment with the Shape tool. Selected 
objects in CorelDRAW display eight handles while selected nodes and segments become 
highlighted and display control points. Once selected, you can choose the command or 
perform the action you want to affect the object or node. 



Serif

The short strokes at the ends of individual letters in some typefaces such as Times Roman. 
Sans serif typefaces, such as Helvetica, lack these strokes.



Service bureau
A commercial business that prints customer-provided documents or artwork, usually on high-
resolution PostScript devices. 



Skew
To slant an object using the Rotate & Skew command in the Transform menu or by dragging 
a side handle revealed when you click twice on an object.



Smooth
A type of node through which curves pass smoothly rather than at sharp angles. Node types 
are selected from the Node Edit menu displayed when you double-click on a node or 
segment with the Shape tool.



Snap
To force an object being drawn or moved to a grid line, guideline or another object. You can 
turn Snap on and off by choosing commands in the Display menu.



Source file
The file that contains information being embedded or linked. See also Embedded object and 
Linked object.



Spot color
In offset printing, solid colors commonly specified using the PANTONE color matching 
system. Spot color is used whenever exact colors are required. CorelDRAW also uses the 
PANTONE system to specify spot colors.



Start node
The small square at the beginning of an open path revealed when you select the path with 
the Shape tool. The start node is distinguishable from the end node by it's larger size. 



Status Line
An area below the menu bar that shows information about the currently selected object or 
node and the action in progress. Use the Show Status Line command in the Display menu to 
turn the Status Line on and off.



Stretch
To resize an object either horizontally or vertically using the Stretch & Scale command in the 
Transform menu or by dragging a side handle on the object's highlighting box.



Subpaths
Individual paths combined into a single path using the Combine command in the Arrange 
menu. See also Paths.



Subscript

Characters smaller than and positioned below the baseline of other characters in a word or 
line of text. Using the Shape tool, double-click on the character's node and select Subscript 
from the dialog box that appears or choose the subscript button from the Text Roll-Up 
window.



Superscript
Characters smaller than and positioned above the x-height of other characters in a word or 
text string. Using the Shape tool, double-click on the character's node and select Superscript
from the dialog box that appears or choose the superscript button from the Text Roll-Up 
window.



Symbol
A predrawn graphic selected from Corel's Symbol Library. You access the library by holding 
the mouse down on the Text tool and clicking on the star icon.



Symmetrical
A type of node that permits a curve to enter and leave the node at the same angle. Node 
types are selected from the Node Edit menu displayed when you double-click on a node or 
segment with the Shape tool.



.TGA
The filename extension for files in Targa format which is a bitmap format that is commonly 
used to store digitized color photographs. CorelDRAW imports and exports files in this 
format.



.TIF
The filename extension for Tag Image Format which is a bitmap graphic format that 
CorelDRAW can import and export. You can import and export color and gray-scale .TIF files.



Tile
To print a drawing larger than the printer's paper size on multiple pages. You can print 
drawings in tiles from CorelDRAW by choosing Tile in the Print Options dialog box. 



Tints
Lighter shades of a Spot color created by adjusting the %Tint value in the Outline Color or 
Uniform Fill dialog boxes.



Title bar 
The bar along the top of a Windows application that contains the name of the application, 
the Control menu box and the Maximize and Minimize boxes. In CorelDRAW, the Title bar 
also contains the name of an open file.
Dialog boxes and Roll-Up windows in CorelDRAW have Title bars too, but not Maximize and 
Minimize boxes.



Toggle
To alternately turn a program function on and off. For example, the Show Rulers, Show 
Status Line and Show Color Palette commands in CorelDRAW's Display menu toggle on and 
off.



Toolbox
The collection of icons on the right side of the CorelDRAW screen used to perform tasks from
selecting and transforming objects to choosing outline and fill attributes.



Transformation
Changing an object by moving, stretching, scaling, rotating, skewing or mirroring. You can 
use the mouse to interactively transform objects or commands in the Transform menu.



Trap
Also referred to as chokes or spreads. The process of adding a slight overlap between 
adjacent areas of color to avoid gaps caused by registration errors. You can create trap in 
CorelDRAW if you are printing color separations.



TRUMATCH
A color matching system for specifying process colors. You can use this system in CorelDRAW
to specify colors.



TrueType fonts
Fonts that print as vectors or bitmaps depending on the capabilities of your printer. TrueType
fonts print as they appear on screen and can be resized to any height.



Two-point perspective
Lengthening or shortening two adjacent sides of an object's Perspective bounding box to 
create the impression that the object is receding from view in two directions. See also One-
point perspective.



Type style
Variations within a typeface. Some common styles include roman (regular or normal), bold, 
italic and bold italic.



Typeface
Characters of a single design such as Avante Garde, Garamond or Bookman. Most typefaces 
are available in different variations or styles. Some common styles include roman (regular or
normal), bold, italic and bold italic.



Undercolor removal
In four-color process printing, a technique in which equal amounts of Cyan, Magenta and 
Yellow are removed and replaced with black ink. This produces better color saturation and 
contrast as well as saving on ink costs. CorelDRAW performs GCR automatically when you 
create process colors using the Visual Selector in the Outline Color and Uniform Color dialog 
boxes. Undercolor removal is also called "gray component replacement."



Uniform color
A solid color, black, white or shade of gray used to outline or fill objects. You can select 
uniform fills from the Outline and Fill tool menus, their respective Roll-Up windows, the 
Outline Color and Uniform Fill dialog boxes and the on-screen color palette. 



Vector graphics
Also referred to as object-based graphics. Graphics created in programs such as CorelDRAW 
in which shapes are represented as a series of lines and curves. These contrast with bitmap 
graphics which are created pixel by pixel in paint programs and by scanners.



Full Color pattern
Fill composed of repeating vector images. CorelDRAW supplies a collection of vector patterns
to which you can add your own.



Weight
The thickness of outlines assigned to objects using the Outline tool. Sometimes used to refer
to different type styles (normal, light, bold, etc.). 



.WFN
The filename extension for files containing symbols supplied with CorelDRAW. 



Window
A rectangular area on the screen in which applications are displayed. Every application 
window has a Title bar and menu bar along the top and one or two scroll bars along the 
sides or bottom.



Wireframe view
One of two ways of viewing objects in the drawing window. In wireframe view, objects 
display in skeleton form without fills or outlines. Since the screen redraws faster in this view, 
you may want to use it for editing complex drawings. In the other view--editable preview--
you see the outlines and fills of objects as you create them.
You can switch freely between views by choosing Edit Wireframe from the Display menu.



.WMF
The filename extension for Windows Metafile which is a vector graphic format that 
CorelDRAW can export.



.WPG
The filename extension for WordPerfect 5.0 graphics files which is a vector graphic format 
that CorelDRAW can export.



WYSIWYG
What-you-see-is-what-you-get. A term describing a program's ability to provide an accurate 
on-screen representation of what an image or document will look like when printed.



X-height

The part that makes up the main body of a lowercase letter.



Keyboard
· Function Keys
· Menu Command Keys
· Toolbox Keys
· Dialog Box Keys 
· Dialog Box Shortcuts



Function Keys
Press To

F1 Get help on the currently select command or open dialog box
Shift+F1 Get help on screen item or active command

F2 Select the Zoom In option from the Zoom tool menu
F3 Select the Zoom Out    option from the Zoom tool menu
F4 Change the current view to fit all objects in the drawing window
F5 Select the Pencil Tool
F6 Select the Rectangle Tool
F7 Select the Ellipse Tool
F8 Select the Text Tool
F9 Toggle between the Preview screen and the normal display mode

Shift+F9 Toggle between Editable Preview and Wireframe views
F10 Select the Shape Tool
F11 Open the Fountain Fill dialog box

Shift+F11 Open Uniform Fill dialog box
F12 Open Outline Pen dialog box

Shift+F12 Open Outline Color dialog box



Menu Command Keys
File Menu Arrange Menu

Ctrl+O Open Ctrl+1 Layers Roll-up window
Ctrl+S Save Shift+PgUp To Front
Ctrl+P Print Shift+PgDn To Back
Ctrl+X Exit PgUp Forward One

PgDn Back One
Edit Menu Ctrl+G Group
Alt+Bksp Undo Ctrl+U Ungroup

Alt+Ret Redo Ctrl+C Combine
Ctrl+R Repeat Ctrl+K Break Apart

Shift+Del Cut Ctrl+V Convert to Curves
Ctrl+Ins Copy Ctrl+A Align

Del Delete
Ctrl+D Duplicate Display Menu
Ctrl+T Edit Text Ctrl+Y Snap to Grid

F9 Show Preview
Transform Menu Shift+F9 Edit Wireframe

Ctrl+L Move Ctrl+W Refresh Window
Ctrl+N Rotate & Skew
Ctrl+Q Stretch & 

Mirror
Special Menu

Ctrl+J Preferences
Effects Menu

Ctrl+B Blend Help Menu
Ctrl+E Extrude F1 Help Contents

Ctrl+F1 Search for Help On
Text Menu

Ctrl+2 Text Roll-up window
Ctrl+F Fit Text to Path
Ctrl+Z Align to Baseline

Toolbox Keys
 Pick Tool
 Shape Tool
 Pencil Tool
 Rectangle Tool
 Ellipse Tool
 Text Tool



 Pick Tool Keys
Hold down To

Ctrl Constrain move vertically or horizontally
Stretch or scale in 100% increments
Rotate and skew in increments of user-
specified degrees

Ctrl+Shift Stretch in 100% increments in two 
directions
Scale in 100% increments in four 
directions

Press To
Esc Deselects all objects
Tab Select objects successively

Shift+Tab Select objects in reverse order
Space Bar Select the Pick Tool

Nudge selected object(s) left
Nudge selected object(s) right
Nudge selected object(s) up
Nudge selected object(s) down

+ Num. Key Leave copy of original when stretching,
scaling or skewing an object
Place duplicate behind original object

 Shape Tool Keys
Hold down To

Shift Select multiple nodes
Change complement of nodes selected
when marqueeing nodes
Move opposing Envelope handles in
opposite directions

Shift Constrain the movement of a node or
control point to multiples of 90 degrees
Constrains movement of characters to
nearest baseline
Moves opposing Envelope handles in
opposite directions
Constrains movement of Perspective
handles to vertical or horizontal

Shift+Ctrl Moves corner or side Envelope handles in
opposite directions
Moves opposing Perspective handles 
equal distance in opposite directions

Press To
Home Select the start node of a curve

End Select the end node of a curve
Del Delete the selected node

Nudge selected character(s) left
Nudge selected character(s) right
Nudge selected character(s) up
Nudge selected character(s) down

 Pencil Tool Keys
Hold down To

Shift Erase as you backtrack over a path being drawn
Ctrl Constrain the movement of control points to increments of user-specified degrees when drawing 

in Bezier mode
Constrain line to horizontal, vertical or a user-specified angle when drawing in Freehand mode



 Rectangle Tool Keys
Hold down To

Ctrl Draw squares
Ctrl+Shift Draw squares from the center out



 Ellipse Tool Keys
Hold down To

Ctrl Draw circles
Ctrl+Shift Draw circles from the center out



 Text Tool Keys
Press To

, ¯, ¬, ® Move insertion point in direction of arrow
Home Moves insertion point to start of current line

Ctrl+Home Moves insertion point to start of text
End Moves insertion point to end of current line

Ctrl+End Moves insertion point to end of text
PgUp/PgDn Scrolls the Text Editing window in Text dialog box
Shift+¬, ® Selects one character at a time in Text dialog box
Shift+ Home Selects all text left of insertion point in Text dialog box
Shift+End Selects all text right of insertion point in Text dialog box

Backspace Deletes selected text or individual characters before the insertion point
Del Deletes selected text or individual characters after the insertion point

Enter Begins a new line
Ctrl+Ins Copies selected text to the Clipboard

Shift+Del Cuts selected text to the Clipboard
Shift+Ins Pastes text from the Clipboard



Dialog Box Shortcuts
To open this dialog box Do this

Page Setup Double-click on Page Border
Guideline Setup Double-click on a guideline
Grid Parameters Double-click on a ruler

Character Attribute Double-click on character node
Fountain Fill Press F11 with object selected

'New Object' Fountain Fill Press F11 with no object selected
Uniform Fill Press Shift+F11 with object selected

'New Object' Uniform Fill Press Shift+F11 with no object selected
Outline Pen Press F12 with object selected

'New Object' Outline Pen Press F12 with no object selected
Outline Color Press Shift+F12 with object selected

'New Object' Outline Color Press Shift+F12 with no object selected



Dialog Box Keys
Press To

Tab Move to next list box, text box, check box, command button or group of option buttons
Shift+Tab Moves to previous list box, text box, checkbox, command button or group of option buttons

Arrow Keys Moves and selects within active group of option buttons
Spacebar Turns on or off active check box or chooses active command button

Letter Keys Moves to next item beginning with that letter in an active list box
Alt+Underlined letter Selects item with that underlined letter

Enter Chooses active command button
Esc Cancels command and closes dialog box



CorelDRAW .TMP files
CorelDRAW uses temporary (TMP) files to store data while it is running. These files contain objects in a 
drawing which do not fit into available memory.

With complex drawings, the temporary file can become quite large and could exceed the amount of space
available in your TMP files directory. Always ensure that the drive containing your TMP directory has 
several megabytes of free space available.

Note too that a TMP file is created for each bitmap you import into CorelDRAW. If there is insufficient 
space in the TMP files directory, you may have problems importing numerous and/or large bitmaps. 

CorelDRAW TMP files begin with the characters ~WAL and are deleted at the end of each session. If your
system hangs, you should delete any TMP files before running CorelDRAW or any other application that 
creates TMP files.

For more information see your Microsoft Windows User's Guide.



Tip on printing multiple copies of complex files
If your printer driver does not support multi-copy printing, choose File to Print and print the file to disk. 
You can then copy the resulting .PRN file to the printer from DOS as often as you require. To do that, exit 
Windows and type the following from the DOS prompt: 

copy filename.prn /b lptx          and press ENTER

where filename is the name you've given to the printer file and x is the number for the printer port you are 
using (usually lpt1 or lpt2). You must include the "/b" extension after the filename for non-PostScript 
devices.

These print files can also be sent to service bureaus or to people who may not have CorelDRAW, but do 
have printers.



Tip on using hairline outlines
Objects with thin outlines in CorelDRAW may not print properly on some printers and from certain 
software packages. If you are having this problem try using a slightly heavier outline.



Tip on choosing typefaces
If you want to check the appearance of a certain typeface, load the file Charset.CDR from your 
CorelDRAW Samples directory. This file contains a full character set to which you can assign any attribute
such as typeface, style, fill, outline, etc. You can then preview this file in the preview window or print it out 
to check the results.



Tips on using small font sizes
Because they contain "hints" typefaces supplied with CorelDRAW 3.0 look very good when printed at 
small point sizes. This is not the case, however, with WFN fonts supplied with earlier versions of the 
program. If you are using these fonts in version 3.0, CorelDRAW's internal font rasterizer will help improve
their quality when printed at small point sizes on non-PostScript printers. Even with the rasterizer, you 
should mind the following guidelines on text size:

· The font rasterizer will only be enabled if you are using text that has no outlines.

· If you are using a PostScript printer, and the font which you have selected is in the printer (i.e. 
resident or downloaded), then you need not worry since the WFN fonts are not used. All the 
PostScript fonts include scaling "hints" which provide adjustments for printing at small sizes.

· If you are using a PostScript printer at 300 dpi, and the font you have selected is NOT resident in 
the printer, try to use point sizes over 6 points; if you are printing to a Linotronic or Varityper (600 
dpi), you can easily drop down to 4 points.

· If you are using a LaserJet or Deskjet printer, try to use point sizes over 6 points.

· If you are using a PaintJet printer, try to use point sizes over 10 points.



Tip on creating graphics for export
When creating a drawing you intend to export to another format, save the drawing as a CDR file after you 
export it. If in the future you wish to edit the exported file you can open the corresponding CDR file, make 
the changes, and then re-export it in the desired format. 

Having a CDR version of the drawing is also helpful if the selected export format does not support a 
CorelDRAW feature used in the drawing. If you find that this is the case with your particular file, you can 
try exporting it to another format. 



Tip on exporting fountain fills
You can export Fountain fills to a variety of formats. However, the export of radial fountain fills in particular
can sometimes take a long time to perform. This is also true when copying a fountain fill to the clipboard.

One way around this problem involves using the Effects Blend command. You can achieve the same 
effects as a radial fill by blending two objects, each with a different color. Those colors would be the same 
ones you would choose as your start and end colors when creating a radial fill. The two blend objects 
should be exactly the same shape, but of different sizes, with one inside the other. 

By moving the inner (smaller) object around with respect to the center of the outer object before 
performing the blend, you can also simulate the effect of an offset radial fill. Before blending the two 
objects, remove off their outlines.



Software-Related Information
This section provides information on files you can edit to affect the performance of 
CorelDRAW. To edit these, use an ASCII text editor, such as Windows Notepad, or Windows 
Write with no conversion to Write format.
· WIN.INI
· CORELDRW.INI
· CORELDRW.DOT



WIN.INI File
WIN.INI contains sections which specify the path name to the subdirectory containing 
CorelDRAW, CorelCHART, CorelSHOW, CorelMOSAIC, CorelTRACE and CorelPHOTO-PAINT:
[CorelDraw3]
DrawDir=<coreldrw.ini directory>
TraceDir=<coreltrc.ini directory>
ShowDir=<corelshw.ini directory>
MosaicDir=<corelmos.ini directory>
ChartDir=<corelcht.ini directory>
PhotoPaintDir=<corelpnt.ini directory>
<coreldrw.ini directory>

Specifies the path name to the subdirectory containing CorelDRAW. It must be the full 
path, including drive. If not specified, CorelDRAW will look for the CORELDRW.INI file in the 
directory in which the WIN.INI resides.
All other relevant CorelDRAW entries reside in the CORELDRW.INI file.

Other <corel*.ini directories>
These specify the path name to the subdirectory containing the particular Corel 
application, such as CorelCHART's ChartDir=<corelcht.ini directory> entry. It must be the 
full path, including drive. If not specified, the application will look for its .INI file in the 
directory in which the WIN.INI resides.



CORELDRW.INI File
Contains various CorelDRAW configuration files organized in the following sections:
· [CDrawConfig]
· [CorelDrivers]
· [Mosaic]
· [CDrawImportFilters]
· [CDrawExportFilters]
· Miscellaneous Export Filter Information
· Color Separation Information: CMYK Angles; CMYK Frequencies
· [CorelDrwFonts]
· [CorelDrwSymbols]
· [PSResident Fonts]
· [CorelDrw20FontMap]
· [CorelHPGLPen]
· [CorelHPGL]



CORELDRW.INI File - [CDrawConfig]
This section contains the variables listed below. You can change names and values between 
angular brackets (< >) to customize the operation of the program.
Applic=<application directory>

Specifies the path name to the directory containing CorelDRAW. If you install CorelDRAW 
in a new directory (e.g., c:\windows\winapps\cdraw), then certain CorelDRAW files must 
be installed in that directory. These include:
CORELDRW.EXE CorelDRAW program file
CORELDRW.INI CorelDRAW configuration file
USERPROC.TXT Custom PostScript fills file
PROLOG.CMP Header file for PostScript printer files
*.HLP Help system text files
*.PAN Printer-specific files. If you're printing to one of the printers indicated by a 

matching .PAN file name, then copy that .PAN file over the file named 
CORELDRW.INK.

ConfigDir=<configuration directory>
Specifies the path name to the subdirectory containing the CDCONFIG.SYS and other 
internal configuration files. ConfigDir facilitates network operation, since it contains user-
specific configuration information. This directory should always reside in a local CPU, 
whereas directories such as typefaces, symbols and filters may be centralized. ConfigDir 
must include the following files:
CDCONFIG.SYS Internal configuration file
CORELDRW.BPT Bitmap fills file
CORELDRW.DOT Line-type definition file
CORELDRW.END Arrow-head definition file
CORELDRW.INK Pantone reference fills file
CORELDRW.IPL Pantone Spot reference palette file
CORELDRW.PAL CorelDRAW process colors file
*.PAT Vector fill files

FontsDir=<fonts directory>
Specifies the path name to the subdirectory containing any WFN fonts and symbol 
libraries. 

CorelFiltersDir=<import/export filter directory>
Specifies the path name to the subdirectory containing the import filter files (IMP*.DLL). 
and export filter files (EXP*.DLL).

AutoBackupDir=<backup files directory>
Specifies the path name to the subdirectory used to store automatic backup files (*.ABK) 
created by CorelDRAW. The installation procedure creates this subdirectory (called 
AUTOBACK) under the CORELDRW directory. You can turn autobackup on and off and set 
the interval between backups with the AutoBackupMins parameter. 
If this directory is not specified and the automatic backup feature is turned on, backup 
files will be placed in the same directory as CORELDRW.INI.
The automatic backup feature allows you to restore the most up-to-date copy of the CDR 



file you're currently working on, in the event that Windows crashes or your system hangs.
If you need to recover a CDR file after a crash/hang, reboot your computer, then go into 
the CORELDRW\AUTOBACK directory. Rename filename.ABK to filename.CDR then open the 
file in CorelDRAW. 
CorelDRAW deletes automatic backup files whenever you use the File Save, File Save As 
or File New commands, or whenever you exit the program using the File Exit command.

AutoBackupMins=<number of minutes>
Specifies the interval at which CorelDRAW automatically saves the current drawing to a 
filename with the extension .ABK.
0 disables autobackup
Range 1 to 99
Default 10

BigToolbox=<0 or 1>
0 specifies the standard-sized toolbox
1 specifies a larger-size toolbox. Useful if you have a large, high-resolution 

monitor such as the Sigma Laserview.
Default 0

BigPalette=<0 or 1>
0 specifies the standard-sized color palette
1 specifies a larger-sized color palette. Useful if you have a large, high-resolution

monitor such as the Sigma Laserview.
Default 0

CalligraphicClipboard=<0 or 1>
Specifies whether calligraphic pen outlines are ignored when transferred to the Clipboard 
or exported using any of the vector export filters. If your file contains many calligraphic 
outlines, ignoring them will reduce the size of the exported file and the time required to 
transfer it through the Clipboard. NOTE: Some export filters retain calligraphic outlines 
regardless of the setting specified.
0 ignore calligraphic outlines
1 keep calligraphic outlines
Default 1

ClipboardFountains=<0 or 1>
Enables/disables high-quality cutting/copying of radial fountain fills to the clipboard. 
Enabling this function produces better results when radial fountains are pasted into other 
applications for printing on a PostScript printer. This function, however can take a long 
time to perform.
If the other application imports EPS files, you can avoid the clipboard and export your 
drawing in that format. For a different approach to this problem, see Tip on exporting 
fountain fills.
0 off
1 on
Default 0

CMYKPalette=<filename.PAL>
Specifies the last process color palette file used in CorelDRAW. This entry is automatically 
updated by CorelDRAW every time you exit the program. The program will then use this 



file the next time it is started. The initial process color palette is CORELDRW.PAL, which 
identical to the PURE99.PAL file.

DefaultFont=<fontname,typestyle number,point size>
Specifies the default typeface, style and size for new text. CorelDRAW uses the normal 
Avalon typeface at 24 points as initial defaults. This can be changed to any other font and
size by typing: <fontname>,<nStyle>,<nnSize> where:
fontname is the name as it appears to the left of the = sign in the [PSResidentFonts] list.
nStyle is 1 for normal, 2 for bold, 4 for italic and 8 for bold italic.
nnSize is a number from 0.7 to 1440.
Default Avalon,1,24

DelayToDrawWhileMoving
Determines how long you must pause when moving an object before it will begin to 
redraw. Applies only when ShowObjectWhenMoving is set to 1 and 
MaxCharsToDrawDuringKern set to 10 or higher.
Range 1 to 32000 milliseconds
Default 500 milliseconds

ExportTextAsCurves=<0 or 1>
Specifies whether text is exported as curves or editable text. Since other applications 
may use proprietary fonts, exporting text as curves will ensure the exported text appears 
exactly as it did in CorelDRAW. Setting ExportTextAsCurves to 1 automatically converts 
text to curves at the time of export. Keep in mind, however, that you will not be able to 
edit the text in the destination application.
0 export text as text
1 export text as curves
Default 1

FontRasterizer=<0 or 1>
Enable/disables the internal font rasterizer. The rasterizer improves the appearance of 
CorelDRAW fonts printed at small sizes.
1 enables the font rasterizer
0 disables the font rasterizer. Disabling may be necessary for printer drivers that

have problems with the rasterizer. A symptom of this would be text printing 
incorrectly.

Default 1

INKPalette=<filename.IPL>
Specifies the last spot color palette file used in CorelDRAW. This entry is automatically 
updated every time you exit the program. The program will then use this file the next 
time it is started. The initial spot color palette is CORELDRW.IPL, which is the Pantone spot 
color reference file.

MakeBackupWhenSave=<0 or 1>
1 makes a backup file with the extension .BAK every time an open CDR file is 

saved.
0 (zero) no backup file will be created
Default 1

MaxCharsToDrawDuringKern



Sets the threshold for determining when CorelDRAW shows the outlines of characters 
kerned using the mouse. If the number of characters selected in less than or equal to the 
value specified here, CorelDRAW will display their outlines as they are being kern.
Default 25 characters

MaximizeCDraw=<0 or 1>
0 starts CorelDRAW at the default size
1 maximizes CorelDRAW on initial start-up
Default 0

OLEConvertObjectsToDraw=<0 or 1>
Setting this option to 1 allows you to use the following features to manipulate linked and 
embedded objects in your CorelDRAW files:
· Rotate & Skew
· Envelope
· Perspective
· Blend
Only OLE objects added in subsequent sessions of CorelDRAW can be manipulated with 
these features; those already added when you change the option cannot. 
Once you've manipulated an OLE object you can still edit it in the source application.
0 does not convert OLE objects to CorelDRAW format.
1 converts OLE objects to CorelDRAW format.
Default 0

OLEServerEmulateMDI=<0 or 1>
Specifies that for OLE (Object Linking and Embedding) registration, CorelDRAW should 
register itself as a server which only requires a single session for editing. This is contrary 
to the standard Windows approach which would be to launch a new session (i.e. open a 
new copy of CorelDRAW) for each edit if you don't exit the previous session. In other 
words, setting this switch to 1 means that if you already have CorelDRAW running and try 
to edit a linked or embedded drawing, it will use the current session of CorelDRAW rather 
than starting up a new one. There is little reason to change this to 0.
0 Opens a new session of CorelDRAW for each OLE edit
1 Uses a single session of CorelDRAW for each OLE edit
Default 1

PSBitmapFontLimit=<0 to 250>
This option applies to text being printed on a PostScript printer. If the font used meets 
certain criteria, a bitmap version of the font is created in the printer's memory. Bitmap 
character descriptions are used because they look better at small point sizes and printer 
faster than the normal character outline descriptions. Note however that the fonts 
created in this way consume a large amount of PostScript memory. As a result, the you 
may need to limit the number of such fonts created to avoid a PostScript error when 
printing a CorelDRAW document.
The following criteria must be met for a font to be created in this way in printer memory:
· The font is not a resident PostScript font as indicated in the PSResidentFonts section of 

CORELDRW.INI (and the All Fonts Resident option is not selected)
· The printed character size is no larger than 75 pixels.    This corresponds to a point size 

of 18 at 300 dpi, 9 points at 600 dpi, and so on
· The text is not scaled or skewed



· The text does not have an outline or a fill other than a uniform fill
· The text does not have any envelopes (non-linear transformations) applied to it
· The drawing is not being printed using the Scale option or Fit To Page option in the 

Print dialog box
Range 0 to 250
Default 8

PSComplexityThreshold=<20 to 20,000>
Specifies the threshold at which CorelDRAW decides a filled path is too complex for 
successful printing on a PostScript device. The value is a count of the number of 
segments in an individual path. If a path contains more segments than the limit set here, 
the program will break it up into sections without modifying its appearance.
Note that even shorter paths (e.g., 300 segments or less) containing complex fills such as
fountain fills, vector/bitmap fills, can cause problems with a PostScript printer (typically 
indicated as a Limitcheck Error). If this occurs, reset the variable to a lower value, such as
200 or 300.
Default 3000

ShowObjectsWhenMoving=<0 or 1>
Specifies whether the wireframe of an object that is being moved is redrawn while you're 
moving it. Sometimes with complex objects or bitmaps, redrawing the wireframe can slow
you down, so you may want to turn this function off.
0 off 
1 on
Default 0

TextOnClpMetafile=<0 or 1>
Specifies that text which has been cut or copied to the clipboard should be output as text 
rather than curves.
0 Output text as text
1 Output text as curves
Default 0

WarnBadOrientation=<0 or 1>
Specifies whether CorelDRAW issues a warning message when the page orientation in 
CorelDRAW and the printer page orientation do not match. When a mismatch is detected, 
CorelDRAW asks if you want to change the printer orientation to match the drawing's. 
NOTE: When batch printing through CorelMOSAIC, CorelDRAW will always adjust the 
printer orientation as required.
0 disable warning
1 issue warning
Default 1

3DLook=<0 or 1>
Enables/disables the gray background and custom-looking controls in all of CorelDRAW's 
dialog boxes, the rulers, and in the Status Line. With the background off, you can use the 
Windows Control Panel to select your own color scheme.
0 disable 3D look
1 enable 3D look



Default 1

SpellLanguage=<language>
Specifies the dictionary the Spell Checker uses to check spelling. The choices are    
English, French, German, Swedish, Spanish, Italian, Danish, Dutch, Portuguese, Norwegian
or Finnish.

SpellDict, HyphenateDict, ThesaurusDict=<appropriate dictionary file>
Specifies the dictionary files used by the Spell Checker, Hyphenation and Thesaurus 
features. These lines must not be changed.



CORELDRW.INI File - [Mosaic]
Contains the following information required to run the CorelMOSAIC utility:
Applic=<application directory>

<application directory>
Specifies the path name to the subdirectory containing CorelMOSAIC. This is usually your 
CORELDRW directory. This entry must be the full path, including the drive and the MOSAIC
executable filename, as the following example shows:
for example,.      Applic=C:\CORELDRW\MOSAIC\CORELMOS.EXE
This example shows CorelMOSAIC installed in a subdirectory called "MOSAIC", which is 
under the main CorelDRAW directory.



CORELDRW.INI File - [CorelDrivers]
Lists PostScript printer drivers that can be used by CorelDRAW. The number "1" after the 
driver name tells CorelDRAW that the printer is a PostScript device. If a "0" follows the driver
name, CorelDRAW treats the printer as an Non-PostScript device.
To recognize additional PostScript drivers, add their filename to this section. For example, to 
include the UltraScript PS driver (USPC.drv), add USPC=1.
The following lines are for the Micrografx PostScript driver (first line) and the Windows 
generic PostScript driver (second line).
MGXPS=1
PSCRIPT=1



CORELDRW.INI File - [CDrawImportFilters]
Lists the import filters available in CorelDRAW.
CDR=IMPCDR,"CorelDRAW!",*.CDR
TRACE=IMPAI.DLL,"CorelTRACE!",*.EPS
PCX2=IMPPCX.DLL,"CorelPHOTO-PAINT! Bitmap",*.PCX;*.PCC
WMF=IMPWMF,"Windows Metafile",*.WMF
BMP=IMPBMP.DLL,"Windows Bitmap",*.BMP
DXF=IMPDXF.DLL,"AutoCAD DXF",*.DXF
GIF=IMPGIF.DLL,"CompuServe Bitmap",*.GIF
CGM=IMPCGM.DLL,"Computer Graphics Metafile",*.CGM
GEM=IMPGEM.DLL,"GEM file",*.GEM
HPGL=IMPHPGL.DLL,"HP Plotter HPGL",*.PLT
PIF=IMPGDF.DLL,"IBM PIF",*.PIF
AI=IMPAI.DLL,"Illustrator 88, 3.0",*.AI;*.EPS
PIC=IMPPIC.DLL,"Lotus PIC",*.PIC
PICT=IMPPICT.DLL,"MAC PICT",*.PCT
TGA=IMPTGA.DLL,"TARGA Bitmap",*.TGA
TIFF=IMPTIFF.DLL,"TIFF 5.0 Bitmap",*.TIF
TXT=IMPTXT,"Text",*.TXT



CORELDRW.INI File - [CDrawExportFilters]
Lists the export filters available in CorelDRAW
BMP=EXPBMP.DLL,"Windows Bitmap",*.BMP
PCX2=EXPPCX.DLL,"CorelPHOTO-PAINT! Bitmap",*.PCX;*.PCC
DXF=EXPDXF.DLL,"AutoCAD DXF",*.DXF
GIF=EXPGIF.DLL,"CompuServe Bitmap",*.GIF
CGM=EXPCGM.DLL,"Computer Graphics Metafile",*.CGM
GEM=EXPGEM.DLL,"GEM file",*.GEM
HPGL=EXPHPGL.DLL,"HP Plotter HPGL",*.PLT
PIF=EXPGDF.DLL,"IBM PIF",*.PIF
AI=EXPAI.DLL,"Illustrator 88, 3.0",*.AI;*.EPS
PICT=EXPPICT.DLL,"MAC PICT",*.PCT
SCODL=EXPSCODL.DLL,"Matrix/Imapro SCODL",*.SCD
TGA=EXPTGA.DLL,"TARGA Bitmap",*.TGA
TIFF=EXPTIFF.DLL,"TIFF 5.0 Bitmap",*.TIF
AT1=EXPAT1.DLL,"Adobe Type 1 Font",*.PFB
TTF=EXPTTF.DLL,"TrueType Font",*.TTF
WMF=EXPWMF,"Windows Metafile",*.WMF
WPG=EXPWPG.DLL,"WordPerfect Graphic",*.WPG
EPS=EXPEPS,"Encapsulated PostScript",*.EPS



CORELDRW.INI File - Miscellaneous Export Filter Information
The following sections may appear in the CORELDRW.INI file and contain information that 
should usually not be changed. The last two sections, [CorelHPGLPens] and 
[CorelHPGLColors], do contain entries that may be modified. These are detailed elsewhere in
the CORELDRW.INI section of this file.
[CorelAIExport]
[CorelDXFExport]
[CorelBitmapExports]
[CorelPIFExport]
[CorelTTFExport]
[CorelWPGExport]
[CorelAT1Export]



CORELDRW.INI File - CMYK Angles, CMYK Frequencies
Lists CMYK screen frequencies and angles for various printer resolutions. CorelDRAW uses 
these values to prevent moire patterns when printing color separations. The selection of 
values is based on the resolution of the output device. If the resolution specified is not 
included in this section, CorelDRAW will print using the frequency selected in the Print 
Options dialog box and the angles listed below.
Screen Angles
cyan=15
magenta=75
yellow=90
black=45



CORELDRW.INI File - [CorelDrwFonts]
Lists the fonts supplied with CorelDRAW version 2.xx. If you are upgrading to CorelDRAW 3.0 
and want to use version 2.xx fonts already on your system, remove the semi-colon at the 
beginning of the appropriate line(s).
Unless you installed the CD-ROM version of CorelDRAW 3.0, the first five fonts in the list are 
the only ones available if you are running Windows 3.0.
Using Custom WFN Fonts in CorelDRAW 3.0
Typefaces created in CorelDRAW 2.xx and exported as WFN fonts can be used in the version 
3.0 of the program. You need to add a line for each of the WFN fonts you want to use in 
version 3.0 in the [CorelDrwFonts] section. Enter each line exactly as it appears in the 
[CorelDrwFonts] section of your version 2.xx CORELDRW.INI file.
You also need to add a line in the [CorelDrw20FontMap] for each WFN font as follows:
<wfnfilename.wfn>=<fontname> <avg width>
where
<wfnfilename.wfn> is the WFN file name in the [CorelDrwFonts] section of your version 

2.xx CORELDRW.INI file. 
NOTE: This entry is case-sensitive, so type the name exactly as it 
appears.

<fontname> is the WFN font name as it appears in your version 2.xx CORELDRW.INI file. 
This entry is not case sensitive and must be same as the name you enter 
in the [CorelDrwFonts] section.

<avg width> are the average character width values as determined by the 
WFNSPACE.EXE utility. This utility is supplied with CorelDRAW and is located
in the CorelDRAW directory. To use it, type the following at the DOS 
prompt:
WFNSPACE <directory>\<wfnfilename.wfn>
where directory is the path name to the subdirectory containing the WFN 
font and wfnfilename is the name of the WFN font.



CORELDRW.INI File - [CorelDrwSymbols]
Lists the symbol libraries located in the default symbols directory. The first few lines in this 
section are as follows:
Animals=animals.wfn
Architecture=arch.wfn
Arrows-Filled=arfilled.wfn
Arrows-Outlined=arrowsot.wfn
Balloons=balloons.wfn
Banners+Awards=banward.wfn

If you want to use libraries you created in earlier versions of CorelDRAW, place them in the 
same directory and add their names to this section as follows: 
your library name as it appears in CorelDRAW=filename.wfn
If you create a symbol library in CorelDRAW 3.0, you must add it to the appropriate type 
manager (Adobe Type Manager for Type 1 and the Windows Font Manager for True Type).    



CORELDRW.INI File - [PSResidentFonts]
Lists the CorelDRAW fonts and the equivalent Adobe equivalents. The first few lines in this 
section are as follows:
Aardvark-Bold=Aachen-Bold 0
Arabia-Normal=ArnoldBoecklin 0
Avalon-Normal=AvantGarde-Book 1
Avalon-Bold=AvantGarde-Demi 1
Avalon-Italic=AvantGarde-BookOblique 1
Avalon-BoldItalic=AvantGarde-DemiOblique 1
Bahamas-Normal=Bauhaus-Medium 0

CorelDRAW fonts are listed on the left, the Adobe fonts on the right. The number following 
the Adobe font name signifies the following:
0 the typeface is NOT resident in the printer.
1 the typeface IS resident in all PostScript printers.
3 the typeface IS resident in PostScript printers that support the 35 standard PostScript 

typefaces
Using Downloadable Fonts with CorelDRAW
If you have downloadable fonts for your PostScript printer which correspond to CorelDRAW's,
you can have CorelDRAW print using those fonts. Be sure to download the fonts before 
printing since CorelDRAW does not have an automatic downloading facility.
If you just want to temporarily use the downloadable fonts, select All Fonts Resident in the
Print dialog box. If you want CorelDRAW to always use a particular resident font, change the 
"0" after the font name to a "1".



CORELDRW.INI File - [CorelDrw20FontMap]
Matches fonts in previous versions of CorelDRAW with their renamed counterparts in the 
current version. This ensures that drawings created in earlier versions of CorelDRAW will use 
the correct fonts when opened in the current version of the program.
You must not change the contents of this section unless you have custom WFN fonts created
in an earlier version of CorelDRAW and want to use them in the current version. See 
[CorelDrwFonts].



CORELDRW.DOT File
Contains rows of numbers which define the Dashed and Dotted line styles available in the 
Outline Pen dialog box. By editing these definitions you can change the appearance of the 
corresponding line style. You can also add up to 25 definitions of your own for a total of 40 
line styles.
Before editing this file, make a backup copy of it somewhere, just in case you need to access
the original default values.
Defining a Dashed and Dotted line style
When you open up the CORELDRW.DOT file in your ASCII editor, you will see rows of 
numbers. Each row represents a line definition, and contains anywhere from 3 to 11 
numbers.
nNumbers    n,1DotLength    n1,SpaceLength    n2,DotLength    n2SpaceLength..... n5DotLength    n5SpaceLength
where:
n Numbers the number of elements (both dots/dashes and spaces) that define the line 

style. This must be a value between 2 and 10
nxDotLength the length of the dot/dash. A value of 1 yields a dot, anything greater yields 

a dash
nxSpaceLength the length of the spaces between the dots/dashes 

To create a line style, specify the length of the dots/dashes and the gaps between them. 
Dots are created by defining short dashes (one unit wide) and then specifying Round as 
their Line Cap style in the Outline Pen dialog box. Perfectly-round dots are not currently 
available in CorelDRAW. However, unless your line is quite heavy, the dots should appear 
round.
Definitions consisting of more than three numbers in a row, define lines made up of dots, 
spaces and dashes of varying lengths. You can define lines with up to 10 elements 
(dot/dashes and spaces). When these lines are used in a drawing, the line pattern is followed
left to right through the definition, and then repeated through the length of the line. 
Example
2 1 5
Defines a line consisting of are 2 elements. The first element is a dot (since it is only one 
unit wide) followed by a five unit-wide space. These units are relative to the line's width, 
which is considered to be 1. 
To alter the spacing between the dots in this example, change the number 5. Similarly, to 
create a dashed line with equal dash and space widths, change the 1 to a 5 in this example.



CORELDRW.INI File - [CorelHPGLPens]
Contains information which determines the number of pens available when files are 
exported and imported in HPGL format. This section will not appear in the CORELDRW.INI file 
until after you import or export an HPGL file. Initially, the section lists definitions for 8 pens 
as follows:
P1 = Black
P2 = Blue
P3 = Red
P4 = Green
P5 = Magenta
P6 = Yellow
P7 = Cyan
P8 = Brown
You can add up to 256 pen definitions as required.
The pens should be listed in numerical order. The name to the right of the equals sign must 
be identical to the name in the [CorelHPGLColors], otherwise, the pen will default to black.
If the information in this section and the [CorelHPGLColors] section is not correct, the HPGL 
Pen Color Selection dialog box may only list the eight standard pen definitions.
Note, if you export a pen number in the HPGL file that is not in your plotter, that undefined 
pen will usually default to Pen #1 in the plotter.



CORELDRW.INI File - [CorelHPGLColors]
Contains CMYK color definitions which can be assigned to pens when importing or exporting 
files in HPGL format. This section will not appear in the CORELDRW.INI file until an HPGL file is
imported or exported for the first time. Initially, the section lists eight colors definitions.
Black=    0    0    0    100
Blue=    100    100    0    0
Red=    0    100    100    0
Green=    100    0    100    0
Magenta=    0    100    0    0
Yellow=    0    0    100    0
Cyan=    100    0    0    0
Brown=    0    50    100    25
Up to 256 colors can be defined.
You can alter a pen's CMYK values to produce a unique color when importing HPGL files into 
CorelDRAW. However, when exporting, the colors should approximate the pen color 
assignments in your plotter. 
The numbers to the right of the equals sign indicate the percentage of Cyan, Magenta, 
Yellow; and Black, respectively. Each value has a range of 0 to 100.
The text to the left of the equals sign is the name given to the color and can be up to 14 
characters long. These are the names you see in the HPGL Pen Color Selection dialog box 
used to change the assignment of colors to pens.



Hardware-Related Information
This section provides information on using CorelDRAW with various hardware devices.
· PostScript Printers
· HP Paintjet Color Printers
· *.PAN Files
· LaserJets and Compatibles
· Plotters
· Video Cards and Monitors
· Graphics Tablets
· RAMdrives and Math Coprocessors
· Network Operation
· IBM-Mac Connectivity
· Working with Service Bureaus
· Unsupported Windows Devices



PostScript Printers
Regular vs PostScript Plus Printers

CorelDRAW is set for PostScript Plus printers which can print 11 typeface families. If you 
have a regular PostScript printer which prints only four typeface families, configure 
CorelDRAW to print using its own fonts. To do this, edit the [PSResidentFonts] section of 
the CORELDRW.INI file by changing the number after the font names from a "1" to "0".
Some later generation PostScript printers come with over 35 ROM-resident fonts. If any of 
these match the resident CorelDRAW fonts, you can configure the program to print using 
the printer fonts. To do this, change the "0" to a "3" at the end of the corresponding font 
names in the [PSResidentFonts] section of the CORELDRW.INI file.

IBM and Ricoh PostScript Printers
Helvetica-Condensed replaces the resident font Helvetica-Narrow in currently-marketed 
versions of the Ricoh PS and IBM 4216/30 PostScript printers. Recent purchasers of this 
equipment should change the following lines in the [PSResidentFonts] section of their 
CORELDRW.INI file:
Change:
SwitzerlandNarrow-Normal=Helvetica-Narrow 3
SwitzerlandNarrow-Bold=Helvetica-Narrow-Bold 3
SwitzerlandNarrow-Italic=Helvetica-Narrow-Oblique 3
SwitzerlandNarrow-BoldItalic=Helvetica-Narrow-BoldOblique 3
SwitzerlandCondensed-Normal=Helvetica-Condensed 0
SwitzerlandCondensed-Bold=Helvetica-Condensed-Bold 0
SwitzerlandCondensed-Italic=Helvetica-Condensed-Oblique 0
SwitzerlandCondensed-BoldItalic=Helvetica-Condensed-BoldObl 0
to:
SwitzerlandNarrow-Normal=Helvetica-Narrow 0
SwitzerlandNarrow-Bold=Helvetica-Narrow-Bold 0
SwitzerlandNarrow-Italic=Helvetica-Narrow-Oblique 0
SwitzerlandNarrow-BoldItalic=Helvetica-Narrow-BoldOblique 0
SwitzerlandCondensed-Normal=Helvetica-Condensed 3
SwitzerlandCondensed-Bold=Helvetica-Condensed-Bold 3
SwitzerlandCondensed-Italic=Helvetica-Condensed-Oblique 3
SwitzerlandCondensed-BoldItalic=Helvetica-Condensed-BoldObl 3
This will cause your printer to use the resident Helvetica-Condensed PS font instead of the
CorelDRAW font. It will also indicate that the Helvetica-Narrow typeface is no longer 
resident and the Corel version must be used.

Printing Fountain Fills
When printing at 1270 or 2540 dpi (Linotronic equipment), use a screen frequency of 128 
or 200 lines per inch respectively to avoid banding. At higher screen frequencies, some 
minor banding may still appear at the extremes. When printing at 300 or 600 dpi, reduce 
the screen frequency to between 40 and 60 lines per inch to reduce the banding.

Testing the output of your color printer
To test the color fidelity of your color printer, load and print the file Colorbar.CDR in your 
CorelDRAW Samples directory. This is a disk file of the Process Color Chart in the "Creating
Colors and Managing Color Palettes" section of your CorelDRAW User's Guide. Your 
printed output should match the card in appearance (i.e., placement of elements, text, 
etc.) and the colors should be approximately the same. The colors won't match exactly, 
since different printers and printer drivers handle colors in different ways.

Pure blacks on the QMS Colorscript 100



To get deep, saturated blacks on these printers set black fills and outlines as Cyan=100, 
Magenta=100, Yellow=100 and Black=100. Setting just Black=100 and all others to 0 will
also yield black, but it may appear spotty when it covers a large area.

Printing Problems with PostScript Devices
Sometimes printers can go idle without printing or cause a message to appear advising 
that there is a problem printing to the device.
The problem might be due to the printer "timing out" too soon or to the complexity of the 
image you are trying to print. Increasing the timeout period addresses the first problem. 
To determine whether the problem is complexity-related, you need copy the PostScript 
Error Handler which is supplied with CorelDRAW to your printer.

To increase the timeout period:
1. Open the Control Panel from the Window Program Manager.
2. Double-click on Printers, and then choose the Connect button (Windows 3.1) or 

Configure button (Windows 3.0).
3. Set Transmission Retry to 999. Leave Device Not Selected at 15.
4. If your printer has a "Timeout" setting that is selectable from its own control panel, 

make sure that it is set to infinite.
5. Open your WIN.INI file and set TransmissionRetryTimeout to 999. (Note the original 

value in case you need to revert to it.)
6. Save your changes and exit Windows.
7. Try printing your file.

To copy the PostScript Error Handler to your printer:
1. From the DOS command prompt type:

<drive>\<directory>\ehandler\pssend<n>.bat
where 
drive and directory are the drive and directory where CorelDRAW is located and <N>
is the number of the port (1 for LPT1 or 2 for LPT2) to which your printer is connected.
NOTE: If you are using another port, you will need to edit batch file. For more 
information see the README.TXT file in the Ehandler subdirectory.

2. Press ENTER.
A page will print acknowledging that the Error Handler has been loaded. The Error 
Handler will stay resident in your printer until the printer is reset. Files that are too 
complex to print (and previously caused the printer to go idle) will now generate an 
error message indicating the cause of the problem.
For information on reducing file complexity, see Printing complex drawings on a 
PostScript printer.



HP Paintjet Color Printer
Color Selection

The PaintJet simulates colors by printing dithered cells of color. A cell is about 0.04" on a 
side, and is quite visible. When using the Window's Paintjet driver, you can make the 
dithering less obvious by restricting your color selection to 0%, 25%, 50%, 75% and 100%
of the CMY inks. This still leaves you with a palette of about 125 colors, covering a fairly 
wide range.

Fountain Fills
If the printer encounters the three colors cyan, magenta and yellow in a Fountain fill, it 
will replace the sum of the three inks with black. For example, if, at some point the 
Fountain color is 30% cyan, 40% magenta and 50% yellow, the printer will substitute 30%
black (the common amount), 10% magenta and 20% yellow.
Unfortunately, this technique produces a muddy effect on the page. To avoid this, try 
using just black and white or only two of the primary ink colors as the start and end colors
in your fountains.
The maximum useful number for fountain stripes on the Paintjet is 65.



*.PAN Files
Files with the .PAN extension in your CorelDRAW directory enable better printing or display 
from certain printers and monitors. If you are using one of the devices listed below, exit 
CorelDRAW and copy the associated PAN file over your existing CORELDRW.INK file. You can 
then restart CorelDRAW. 
PAN File Device
QMS-10.PAN QMS Colorscript 100 Model 10 printer
QMS-30.PAN QMS Colorscript 100 Models 20 & 30 

printers
CMYK-150.PAN 150 line Lithographic CMYK Color Separator
HP-XL300.PAN HP Paint Jet XL300 printers
NEC-CMYK.PAN NEC Colormate PostScript printers
RGBMITSU.PAN Monitors using Mitsubishi picture tubes
RGBSONY.PAN Monitors using Sony picture tubes
OCE-5232.PAN OCE Graphics G5232 Color PostScript printer
TEK-4693.PAN Tektronix Phaser printer, Model 4693

Should you want to return to your original CORELDRW.INK file in the future, copy the file 
CMYK-150.PAN over CORELDRW.INK.
Note that while the RGBSMITSU.PAN and RGBSONY.PAN files will improve the onscreen 
representation of Pantone colors, they will also dramatically reduce the quality of printed 
output. Use these files only when creating drawings for export to slidemakers that use the 
SCODL format.



LaserJet and Compatible Printers
Many of the original LaserJets and compatibles are equipped with only 512 kilobytes of RAM. 
This means that, at 300 dpi, you are limited to printing about 25 square inches of filled area. 
Both grey and white fills count in addition to black. A fill of None does not count.
Also, if you import CorelDRAW graphics into Ventura or PageMaker, you must take into 
consideration the memory needed by other elements on the page such as text and by 
downloaded fonts. The newer LaserJets (e.g. LaserJet Series III) can have additional memory 
added, relieving this constraint.



Unsupported Windows Devices
CorelDRAW supports device drivers supplied by Microsoft Windows. Non-standard printers 
may require device drivers available through the manufacturer or Microsoft.
If you are having problems with a peripheral device, make sure Windows is properly 
configured for your hardware and that your printer is correctly installed.
Although most printers print CorelDRAW images quite well, complex ones can cause 
problems. Here are some hints that may help you get at least some output.

· Avoid fountain fills.
· If you can get simple images to print, but not complex ones, your device may be 

limited to only accepting a certain amount of data. In such cases, avoid using outlines, 
since these can generate 4-6 times as much data as just the fills. Also, avoid large 
bitmaps.

· If combined objects have thin lines joining them, then your device does not support the
printing of unconnected objects. In such cases, avoid converting text to curves. For 
text already converted to curves, use Arrange Break Apart to break apart the text, and 
Arrange Combine to recombine each letter. Also, avoid using clipping holes.



Plotters
If you are printing on a plotter, set object attributes so that only the outlines of objects in 
your CorelDRAW graphic print. Do this by assigning objects a fill of None and setting the 
outline width to 0.003 inches (hairline).



Video Cards and Monitors
Sigma Laserview Video Card & Monitor

The Sigma Laserview Windows driver may have problem displaying dotted Marquee lines 
along a diagonal. Contact the manufacturer at (415) 770-0100 for upgrade information.

High-resolution Video Cards
If you use CorelDRAW with certain high-resolution video cards such as the IBM 8514/A, you 
may find the control points are drawn quite small. This problem is unavoidable and is 
experienced on other high-resolution video cards.



Graphics Tablets
Windows and CorelDRAW can be used with a graphics tablet, instead of a mouse. The tablet 
must come supplied with a driver for Windows 3.1 and must be properly installed under 
Windows.
We recommend that you use a stylus that has the activation button on the side, rather than 
at the tip. The tip-activated types often move when you press them, which can lead to 
undesired movements in the artwork.
Most tablets come with a utility to adjust the sensitivity (i.e., inches moved on screen 
compared with inches moved on the tablet).



RAMdrives and Math Coprocessors
RAMdrives

If you have extended RAM and have set up a ramdrive, we recommend that you not use 
it to store your temporary (TMP) files. The TMP files CorelDRAW and other Windows 
applications create, can sometimes exceed the capacity of the ramdrive causing your 
system to hang.

Math Coprocessors
CorelDRAW uses integer rather than floating-point math and therefore does make use of 
math coprocessors. Having one in your system will not in any way affect the performance 
of the program.



Network Operation
CorelDRAW is not designed to operate from a file server over a local area network. However, 
certain files such as fonts, symbols and filters, can be centralized to conserve local disk 
space.
If you set such a system up, store your configuration directory locally and indicate the 
appropriate network directories in the [CDrawConfig] section of your CORELDRW.INI file.
 If you are printing to a network printer, have at least 3 megabytes of free disk space 
available for your printing queue. You should also increase the timeout of any network 
parallel printing ports on your workstation to at least 100 seconds.



IBM-Mac Connectivity
Import/Export

CorelDRAW imports and exports MAC PICT graphics files via the MAC PICT filters. In 
addition, files created on Mac-based systems can be imported via the AI, EPS filters.
Inset System's HIJAAK software also allows you to convert MAC PAINT (MAC) files to PCX or 
TIFF format, which can then be imported by CorelDRAW.

File Translation
For users needing connectivity outside of CorelDRAW, there are translational interfaces 
available such as the TOPS FlashBox and FlashCard from Sun Microsystems and the COPY 
II PC Option Board from Central Point Software. Newer MAC's can read 3.5" DOS diskettes 
directly.

File Transfer
Transferring files from the DOS environment to a MAC-based system requires special 
attention. Unlike DOS, the MAC environment does not recognize file types by the use of 
extensions. Instead, the MAC creates files with headers that provide the necessary 
information required by executable applications to use such files. This information 
includes among other things, the creator (program) of the file, the type of file it is and its 
date of creation.
When you copy a file from DOS to the MAC environment using certain hardware/software 
utilities, the creator will be assigned as MDOS and the file type as TEXT or BINA. These two 
parameters must be altered in many cases so that the MAC application you want to bring 
the file into will be able to read it. The ResEdit program from Apple Computer Inc. allows 
you edit these parameters in the required way.



Working with Service Bureaus
If you intend to send your CorelDRAW files to a service bureau for printing on Linotronic 
equipment, then note the following:

· Use the Print to File option in the Print Options dialog box and select the appropriate 
Linotronic option.

· If the service bureau uses Macintosh computers to control their Linotronic equipment, 
create the PostScript file with the For Mac option selected in the Print Options dialog 
box.

· If cross hairs, crop marks or file information is required on your Linotronic file output, 
choose a page size in CorelDRAW which is smaller than the size the output device will 
use. For instance, if the final size of your file is to be 8.5" by 11", then choose A3, 
Tabloid or 10"x14" as your printing size in the Printer Setup menu, provided the printer 
can handle these sizes.

PostScript Color Slide Production
Some slide making service bureaus can produce 35 mm slides that take full advantage of 
the PostScript functionality available in CorelDRAW. These bureaus use equipment such as
the Agfa-Matrix Adobe PostScript RIP in conjunction with their slide makers.
One such service bureau is:
Capital Presentations Inc.,
10 Post Office Road,
Silver Spring, Maryland, USA 20910.
Phone: 301-588-9540
FAX: 301-588-0669 
BBS: 301-588-066



IBM and Ricoh PostScript Printers
Helvetica-Condensed replaces the resident font Helvetica-Narrow in currently-marketed 
versions of the Ricoh PS and IBM 4216/30 PostScript printers. Recent purchasers of this 
equipment should change the following lines in the [PSResidentFonts] section of their 
CORELDRW.INI file:
Change:
SwitzerlandNarrow-Normal=Helvetica-Narrow 3
SwitzerlandNarrow-Bold=Helvetica-Narrow-Bold 3
SwitzerlandNarrow-Italic=Helvetica-Narrow-Oblique 3
SwitzerlandNarrow-BoldItalic=Helvetica-Narrow-BoldOblique 3
SwitzerlandCondensed-Normal=Helvetica-Condensed 0
SwitzerlandCondensed-Bold=Helvetica-Condensed-Bold 0
SwitzerlandCondensed-Italic=Helvetica-Condensed-Oblique 0
SwitzerlandCondensed-BoldItalic=Helvetica-Condensed-BoldObl 0
to:
SwitzerlandNarrow-Normal=Helvetica-Narrow 0
SwitzerlandNarrow-Bold=Helvetica-Narrow-Bold 0
SwitzerlandNarrow-Italic=Helvetica-Narrow-Oblique 0
SwitzerlandNarrow-BoldItalic=Helvetica-Narrow-BoldOblique 0
SwitzerlandCondensed-Normal=Helvetica-Condensed 3
SwitzerlandCondensed-Bold=Helvetica-Condensed-Bold 3
SwitzerlandCondensed-Italic=Helvetica-Condensed-Oblique 3
SwitzerlandCondensed-BoldItalic=Helvetica-Condensed-BoldObl 3
This will cause your printer to use the resident Helvetica-Condensed PS font instead of the 
CorelDRAW font. It will also indicate that the Helvetica-Narrow typeface is no longer resident 
and the Corel version must be used.



Printing Fountain fills at high resolution
When printing at 1270 or 2540 dpi (Linotronic equipment), use a screen frequency of 128 or 
200 lines per inch respectively to avoid banding. At higher screen frequencies, some minor 
banding may still appear at the extremes. When printing at 300 or 600 dpi, reduce the 
screen frequency to between 40 and 60 lines per inch to reduce the banding.



Testing the output of your color printer
To test the color fidelity of your color printer, load and print the file Colorbar.CDR in your 
CorelDRAW Samples directory. This is a disk file of the Process Color Chart in the "Creating 
Colors and Managing Color Palettes" section of your CorelDRAW User's Guide. Your printed 
output should match the card in appearance (i.e., placement of elements, text, etc.) and the 
colors should be approximately the same. The colors won't match exactly, since different 
printers and printer drivers handle colors in different ways.



Printing pure blacks on the QMS Colorscript 100
To get deep, saturated blacks on these printers set black fills and outlines as Cyan=100, 
Magenta=100, Yellow=100 and Black=100. Setting just Black=100 and all others to 0 will 
also yield black, but it may appear spotty when it covers a large area.



PostScript printing problems
Sometimes printers can go idle without printing or cause a message to appear advising that 
there is a problem printing to the device.
The problem might be due to the printer "timing out" too soon or to the complexity of the 
image you are trying to print. Increasing the timeout period addresses the first problem. To 
determine whether the problem is complexity-related, you need copy the PostScript Error 
Handler which is supplied with CorelDRAW to your printer.

To increase the timeout period:
1. Open the Control Panel from the Window Program Manager.
2. Double-click on Printers, and then choose the Connect button (Windows 3.1) or 

Configure button (Windows 3.0).
3. Set Transmission Retry to 999. Leave Device Not Selected at 15.
4. If your printer has a "Timeout" setting that is selectable from its own control panel, 

make sure that it is set to infinite.
5. Open your WIN.INI file and set TransmissionRetryTimeout to 999. (Note the original 

value in case you need to revert to it.)
6. Save your changes and exit Windows.
7. Try printing your file.

To copy the PostScript Error Handler to your printer:
1. From the DOS command prompt type:

<drive>\<directory>\ehandler\pssend<n>.bat
where 
drive and directory are the drive and directory where CorelDRAW is located and <N>
is the number of the port (1 for LPT1 or 2 for LPT2) to which your printer is connected.
NOTE: If you are using another port, you will need to edit batch file. For more 
information see the README.TXT file in the Ehandler subdirectory.

2. Press ENTER.
A page will print acknowledging that the Error Handler has been loaded. The Error 
Handler will stay resident in your printer until the printer is reset. Files that are too 
complex to print (and previously caused the printer to go idle) will now generate an 
error message indicating the cause of the problem.
For information on reducing file complexity, see Printing complex drawings on a 
PostScript printer.



COREL Support Services
COREL provides all registered software customers with access to our Technical Support 
Hotline. We also provide support on CompuServe. To access the Corel forum on 
CompuServe, type GO COREL at any ! prompt. For more information, see CompuServe 
Technical Support.

Calling our Hotline
If you have a technical problem and can't find the answer in the CorelDRAW 
documentation, call us at 613-728-1990 or FAX us a note at 613-761-9175, and we will do
our best to help you. We may request that you send us the troublesome file by 
mail/courier or via modem at one of the following numbers:
· (613) 728-4752 for Hayes Ultra 96 compatible modems
· (613) 761-7798 for US Robotics HST Dual Standard compatible modems
Both lines are set for 8 bits, 1 stop, no parity with a baud rate in the range 1200 to 9600.
It would also be helpful if you were at your computer when placing the call. This way our 
Hotline team can work through your difficulties with you.
Before calling the Hotline, please have the following information available:
· A brief description of the problem including any error messages received, and the 

steps to recreate it.
· Type of computer, monitor and video card (display adapter) you are using.
· Type of pointing device in use (i.e. mouse, tablet).
· Type of printer that you are using to print your files.
· The version of CorelDRAW, DOS and Microsoft Windows you are running.
· A list of any programs loaded into RAM.
· The contents of the AUTOEXEC.BAT and CONFIG.SYS files.

Replacement Services
We strive to produce the highest-quality products possible. If a COREL product proves to 
be defective, and its still under warranty, we will replace it free of charge. Please read 
your license agreement for information about what is covered. For further instructions, 
call your reseller or contact our Customer Service group by phone at (613) 728-8200 or 
FAX at (613) 761-9176.
Users outside North America should contact their reseller.

Change of Address Notification
We'd like to keep you informed about product updates and enhancements so let us know 
your address changes by mailing us a note, or contacting Customer Service by phone at 
(613) 728-8200 or FAX at (613) 761-9176.
Our mailing address is:
Corel Corporation
1600 Carling Avenue
Ottawa, Ontario, Canada
K1Z 8R7
Attn: Customer Service



CompuServe Technical Support
As a Corel customer, you are entitled to a free introductory Membership to CompuServe, 
including:

· a FREE one month membership to access all of CompuServe's Basic Services,
· a $15 introductory usage credit to explore the Corel Forum and CompuServe's other 

Extended and Premium Service Offerings,
· a private user ID number and password,
· a complimentary subscription to CompuServe Magazine, CompuServe's monthly 

computing publication.

Start connecting with Corel and other CompuServe members by calling:
US and Canada 1(800) 524-3388 and asking for representative #369
United Kingdom 0800-289-378
Germany 0130-37-32
Rest of Europe 44-272-255-111
Outside of US, Canada 1 (614) 457-8600 and
and Europe ask for representative #369



Notes to Upgraders
If you're upgrading from a previous version of CorelDRAW, choose the following topics for 
information about what's new in CorelDRAW 3.0.
· Overview
· Screen Layout
· The Toolbox
· The Menus
· CORELDRW.INI File



Overview
The theme for CorelDRAW 3.0 is not only to provide new functions, but to simplify the use of 
existing ones. Our goal was to provide even more flexibility, since different people work in 
different ways. As you examine the revised interface, you'll notice there is often more than 
one way to access a particular command or function. There's usually no right or wrong way 
in choosing which one to use. Use the one that suits you best.
The new applications included with this kit, CorelCHART, CorelPHOTO-PAINT and CorelSHOW,
are intended to fill the voids many people have in their collection of graphics tools. We think 
you'll find these applications powerful additions to your tools.



Screen Layout
The initial appearance of the CorelDRAW screen remains mostly as it was in release 2.0, with
a few exceptions. Some of these are more apparent than others. In summary, these are as 
follows:

Editable Preview Mode
The user may now work in one of two modes. The first of these is wireframe mode, which 
displays the object paths only. This is the mode available since the initial release of 
CorelDRAW. New for release 3.0 is the ability to work in editable preview mode, with 
objects displayed in full detail, including color. This mode is the default operating mode in
3.0, but you may toggle between the two via the Edit Wireframe command in the Display 
menu.

Status Line and Rulers
These appear as before, except they are now shaded to help separate them from other 
components of the interface. The small icon at the junction of the rulers serves as a 
reminder that you can drag crosshairs from the icon onto the screen.

Online Help
Online Help is now available in CorelDRAW. You can get Help by pressing F1 or clicking on 
the options under the Help Menu item. Context-sensitive Help can be obtained by 
pressing F1 on any open dialog box or selected menu command.
Pressing Shift-F1 gives you context-sensitive Help on screen items or any active 
commands in the menus (i.e. those appearing in solid black text in the menus, but are not
selected). Consult the online Help file's Using Help item for detailed instructions on how to
use the system.

Roll-up Windows
A new type of dialog box has been implemented in CorelDRAW 3.0. These control some 
basic functions, as well as some of the program's more complex features. We call these 
dialog boxes "Roll-up windows", or simply "Roll-ups". What makes them special is that 
they remain onscreen and active as long as you want them there. They streamline many 
operations, since you don't have to repeatedly access a dialog box through a menu item 
to fine tune a certain parameter.
The windows may be minimized or "rolled-up" like window shades and left onscreen until 
needed again. Most of the functions they control may also be accessed through more 
traditional dialog boxes and menu items, but we feel you'll find the roll-ups convenient 
and more efficient.

Auto-Panning
This selectable feature allows you to scroll the page automatically whenever drag beyond
the edges of the drawing window.



The Toolbox
 Pick Tool
 Pencil Tool
 Text Tool
 Outline Pen Tool        
 Fill Tool



Pick Tool 
This tool operates essentially as it did in version 2.0, with a couple of exceptions.

1) If you're working in editable preview mode, you can now select an object by clicking 
anywhere in its interior, provided that it has a fill. If it has no fill, or you are working in 
wireframe mode, you must click on its outline.

2) If you move an object's center of rotation, it retains its new position. In previous 
versions of CorelDRAW, once the center has been moved and the object deselected, 
the center of rotation returns to the middle of the object.



Pencil Tool 
You can now shift between drawing in Freehand or Bezier mode by clicking and holding on 
the Pencil Tool icon. A small flyout menu will appear. Click on the icon at the left to access 
Freehand drawing mode or the icon on the right to access the Bezier mode. Once you have 
made your choice, the main icon changes to reflect your choice.



Text Tool 
Adding text with the Text tool has been substantially revised in version 3.0. The most 
obvious change is the ability to enter text directly on the screen. Text content may also be 
edited on screen
The text tool is now used in one of three ways: to create artistic text or paragraph text and 
to access the CorelDRAW symbol libraries. Choose between text and symbols by selecting an
icon from the fly-out menu that appears when you hold the mouse button down on the Text 
tool.
Whether you're using the Text tool for text or symbols, simply place the cursor on the page 
where you want the text/symbol to appear. The actions that follow depend on whether you 
are adding text or symbols.
If after entering artistic or paragraph text you want to change its contents or attributes, you 
can use the Edit Text command in the Edit menu. If you just want to alter specific attributes, 
you can use the Text Roll-up window, displayed by choosing a command in Text menu.



Outline Pen Tool 
The Outline Pen fly-out menu has a new icon in the top row, and a revised one in the bottom 
row. Changes have also been made to the Outline Pen and Outline Color dialog boxes.

Outline Pen Icon 
Clicking on this icon displays the Outline Pen dialog box, similar to that in version 2.0, 
with some useful additions. Briefly, these include:
· Color -- you may now specify the outline color from this box.
· Arrows -- clicking on either the left (starting) arrow box or the right (ending) arrow box

displays a pop-up palette with a selection of arrows. The Options buttons under each 
field allow you to quickly remove an arrow from the selected object, or swap the two 
arrows shown in the left and right fields.

· Nib Shape -- adjustment of the pen's Nib Shape may now be done interactively in the 
dialog box.

Pen Roll-Up Window 
The Outline Pen tool has one of the new roll-up window associated with it. With this, you 
can make a number of adjustments to the line parameters without having to continually 
reopen a dialog field. These include: outline thickness, assignment of arrowheads, line 
type (i.e. dotted and dashed line types), and outline color. The roll-up may also be used to
copy outline styles from one object to another.

Outline Color 
Clicking on this icon displays the Outline Color dialog box. Along with it's new look, the 
dialog box includes new commands--accessed via the Palette button--for managing color 
palettes.

Onscreen Color Palette
An addition has also been made to allow for quick removal of object outlines. If you have 
an object selected and click on the "X" at the extreme left of the onscreen color palette 
with the secondary mouse button, any outline assigned to that object will be removed.



Fill Tool 
The Fill fly-out menu has been modified to include two new icons on the top row. In addition, 
the dialog boxes associated with a number of the icons have been enhanced.

Fill Roll-Up Window 
The Fill tool also has a roll-up window associated with it. With this, you can make a 
number of adjustments to the fill parameters including: changing the uniform fill color, 
assigning fountain fills, Two-Color pattern fills (formerly referred to as "Bitmap Patterns")   
and Full-Color pattern fills (formerly referred to as "Vector Patterns").
You can also use it to adjust the color and tiling of the pattern fills and to copy the fill of 
one object to another object.

Uniform Color 
Clicking on this icon displays the Uniform Color dialog box. Along with it's new look, the 
dialog box includes new commands--accessed via the Palette button--for managing color 
palettes.

Pattern Fills , 

Patterns fills can now be created using images imported in any of the formats CorelDRAW 
supports.

Fountain Fill dialog box
You can now adjust the Angle (for linear fills), Center Offset (for radial fills) and Edge 
Padding by dragging in the preview box.

Onscreen Color Palette
An addition has also been made to allow for quick removal of object fills. If you have an 
object selected and click on the "X" at the extreme left of the onscreen color palette with 
the primary mouse button, any fill previously assigned to that object will be removed.



The Menus
· File Menu
· Edit Menu
· Effects Menu
· Text Menu
· Arrange Menu
· Display Menu
· Special Menu



File Menu
New or revised items in this menu include:

Open
Provides direct access to Keywords, Notes, a link to Mosaic, a file sorting function and a 
file Find function to search for files by keyword.
Clicking on a file in the list displays the file's contents in the preview box and information 
regarding the file's creation date and size.

Save and Save As
Provides direct entry capability of Keywords and Notes. You can also specify whether or 
not to include various types of Image Headers with the saved file. Files may also be saved
in the CorelDRAW Version 2.xx format for use in previous versions of the program.

Import
The file Import dialog box now contains all controls for selecting files, file types, drives 
and directories. The new About button provides information regarding the version 
number of the currently-selected import filter. Finally, a Mosaic button has been added, 
giving you access to the Mosaic utility for locating the file you wish to import.
Three new import filters have been added to CorelDRAW version 3.0. They are 
Compuserve GIF, TARGA TGA and Windows Metafile WMF.

Export
The Export dialog box now contains all controls for selecting files, file types, drives and 
directories.
When exporting to bitmap formats, you now have much more control over various export 
parameters to ensure satisfactory results. This is done via a new dialog box that opens 
whenever exporting to these formats.
Two new export filters have been added to CorelDRAW version 3.0. They are Compuserve 
GIF and TARGA TGA.

Insert Object
This is a new command and is used to place an embedded object into your CorelDRAW 
file that was created in another application. See Linking and Embedding - An Overview.

Print
Selecting the Print command in the File menu, displays a dialog box with options that 
change depending on whether the currently active printer is a PostScript or Non-
PostScript device.
A new option, Auto Increase, automatically increases the curve flatness setting as 
required to enable your drawing to print on a PostScript device. Increasing curve flatness 
simplifies a curve by decreasing the number of segments used by the printer to render it. 
With this option selected, you should experience fewer problems printing complex 
drawings on a PostScript printer.
When you print color separations, you can specify individual Screen Frequencies for each 
of the four process colors. Frequencies you specify override the Default Screen Frequency 
setting in the Print Options dialog box.

Print setup



This new command opens the Windows Print Setup dialog box for choosing printers and 
printer options. It replaces the Control Panel command in previous versions of CorelDRAW.

Drawings List
The names of recently closed drawings appear at the bottom of the File menu for quick 
access. Up to four names will be displayed. Clicking on any listed file will open it.



Edit Menu
A few new commands appear in the Edit menu in release 3.0. These deal primarily with the 
OLE capabilities that Windows 3.1 provides and which CorelDRAW 3.0 supports. OLE is an 
acronym for Object Linking and Embedding. This function allows you to exchange 
information between files created in different applications.
The commands in the Edit menu that deal with the OLE capabilities are: Paste, Paste Special,
Edit "object" and Links. The use of these is explained in the CorelDRAW User's Guide and in 
the Procedures section of this online Help file. CorelDRAW 3.0 can both receive and supply 
linked and embedded information.



Effects Menu
The Blend and Extrude commands in the Effects menu have been substantially reworked in 
release 3.0.

Blend Roll-up
The Blend feature in release 3.0 lets you:
· Select Blend options from a roll-up window.
· Blend two objects along a path.
· Control the coloring of the intermediate shapes.
· Edit any object in the blend (including the path, in the case of objects blended along a 

path) and have the blend reform instantly to incorporate your changes.
· Use grouped objects as the Start or End objects in a blend. 
· Use a single path for numerous blends.

Extrude Roll-up
The Extrude feature in 3.0 lets you:
· Create dynamic three-dimensional forms which can be rotated on three planes and 

shaped as a single element.
· Select Extrude options from a roll-up window.
· Add a light source for enhanced realism or special effects.



Text Menu
The Text menu is new for CorelDRAW 3.0 and brings together the text commands that were 
previously in other menus. Three new commands were also added, specifically, the Text Roll-
up, Spell Checker and Thesaurus commands.

Text Roll-up
The Text Roll-up is another of the new roll-up windows. It gives you quick access to text 
attributes such as typeface, style, size and alignment.

Fit Text To Path
The Fit Text To Path feature now has its own roll-up window with many new features that 
let you:
· Edit the text or the path it's fitted to and have the text refitted automatically.
· Adjust the starting point of the text on the path interactively or with numeric precision.
· Control how the letters in a text string will sit on the path.
· Position the text above, below or on the path.
· Control the distance between the text and the path.

Spell Checker
Allows you to verify the spelling of text using a dictionary with approximately 116,000 
words. You can also create your own personal dictionaries.

Thesaurus
Allows you to look up synonyms and definitions for selected text.



Arrange Menu
Two new commands, Layers and Separate, have been added to this menu.

Layers
The Layers feature lets you organize your drawing on a series of invisible planes with 
each plane containing a portion of your drawing. To speed up editing and screen 
redrawing, you can make the layers you are not currently working on invisible. Other 
handy Layers features include:
· Printing selected layers only for faster printing.
· Locking layers to prevent accidental changes to objects on the layer.
· Displaying and printing the grid and guidelines.
· Changing the order of layers.
· Drawing objects on the guides layer and using them as guidelines.

Separate
The purpose of the Separate command is to break the dynamic link that exists between 
objects when you create a blend or extrusion or fit text to a path. Once the link is broken 
you can select and manipulate each object independently of the others.



Display Menu
New and revised commands include:

Snap to Objects
Object "snapping" makes drawing with precision even easier by allowing you to align any 
part of a moving object to a snap point on a stationary object.

Show Color Palette
The Show Color Palette command operates as it did in version 2.0, except that now a fly-
out menu offers the choice of displaying either a palette of process colors or spot colors, 
in addition to turning the palette display off.

Edit Wireframe
The Edit Wireframe command displays objects as wireframes without their outlines and 
fills. Editing in wireframe mode rather than preview mode is usually faster since only the 
object outlines are displayed and refreshed. If your computer is older, or if you have only 
limited memory resources, then you may find this a more efficient mode of working. You 
can switch to editable preview mode at any time to see your work in full detail.
Also, since only the wireframes are displayed, you can see all the outlines of all objects in 
your drawing. In editable preview, often portions of one object may be covered by 
another.

Refresh Window
This command replaces the Refresh Wire Screen command of previous releases. Whether 
you're working in wireframe mode or editable preview mode, clicking on this item will 
cause the screen to refresh.



Special Menu
Changes in this menu involve the Preferences command.

Preferences
The opening dialog box for Preferences is similar to that in version 2.0, however the 
contents have been rearranged. The changes are as follows:
· Auto-panning:    Selecting this option will cause the page to scroll automatically 

whenever you drag beyond the edges of the drawing window.
· Use Mosaic:    This option has been removed from the Preferences dialog box. It now 

appears in the dialog boxes for opening and importing files.
· Constrain Angle and Miter Limit: These have been moved up from the dialog boxes

displayed by choosing Lines & Curves and Print & Preview buttons.
· Curves button:    The Lines & Curves button in version 2.0 has been renamed to just 

Curves in this release. You'll notice that switching between Bezier and Freehand 
drawing modes is no longer selectable here. This is now handled through the Pencil 
tool's fly-out menu. In addition, the Curve Flatness option has been moved to the 
dialog box displayed by choosing the Display button.

· Display button:  The Print & Preview button in version 2.0 has been renamed to 
Display in this release. One new item appears here, Greek Text Below. It allows you to 
simplify the appearance and speed up the redraw times of small text on screen. Note 
that it applies only to paragraph text and this option only affects your display, it has no
impact on the printing of small text. 

· Preview Colors: This section has been simplified from version 2.0. Only three options 
exist now: 256-Color Dithering, Windows Dithering and Optimized Palette for Full-
Screen Preview. The availability of these options depends on the type the graphics 
adapter and the display driver you are using. See Preferences - Display dialog box.



CORELDRW.INI File
A number of new customizable entries have been added to [CDrawConfig] section of this file.
These allow you to customize the operation of CorelDRAW. For details, see CORELDRW.INI 
File - [CDrawConfig].




